CONTENTS

Book Overview and Additional Resources

Description of this guide.......................................................... xix
About this book .............................................................................xx
Additional formats ................................................................xxi
How to find business scenarios and examples .........................xxi
What’s new in this guide ........................................................xxi
Prerequisites ......................................................................... xxii
Who should use this guide ................................................... xxiii
Resources.................................................................................. xxiv
Documentation..................................................................... xxiv
Education............................................................................xxxiii
Consulting...........................................................................xxxiii
International support ...........................................................xxxiii
Technical Support.............................................................. xxxiv
Feedback ................................................................................. xxxix

1. Document Review

Introduction.................................................................................. 1
Before you begin: Document analysis overview ....................... 2
Document views in Desktop....................................................... 3
Printing a document................................................................. 4
Viewing a document as it will display in MicroStrategy Web
(Flash View and HTML View) .................................................. 5
Display modes in MicroStrategy Web...................................... 8
Designing and creating documents: An overview..................... 9
Accessing data in a document: The dataset report............... 9
Creating documents............................................................... 10
Objects in a document: Controls............................................. 11
## 2. Designing Dynamic Enterprise Dashboards

**Introduction**

- About dashboards........................................................................... 24
  - What is a dashboard? .................................................................. 24
  - Adding interactivity to dashboards ........................................... 26
  - Organizing interactivity features on a dashboard ...................... 31
- Design ideas and examples............................................................. 35
  - Designing a simulated portal environment ............................... 37
- Designing the right dashboard....................................................... 38
- Best practices for dashboarding .................................................... 40
  - Choosing datasets for a dashboard ....................................... 41
  - Layering information in a dashboard ..................................... 42
  - Planning the dashboard’s outline and structure ....................... 43
  - Placing the data and visualizations onto a dashboard .......... 45
  - Positioning and formatting the dashboard objects ............... 46
  - Enhancing dashboard performance ..................................... 47
  - Best practices: Designing Flash dashboards for printing .... 48
- Creating a dashboard: the Blank Dashboard template .............. 49
  - Designing a dashboard with the Blank Document template .. 53
- Creating document templates....................................................... 53
- Exporting dashboards to Flash for stand-alone use .................... 55
- Formatting dashboards................................................................ 56
  - Determining the display modes users can choose to work in .......... 56
  - Enabling transition animations in Flash ................................. 57
  - Uncluttering the dashboard: Full screen mode ...................... 58

## 3. Layering Data: Panels and Panel Stacks

**Introduction**

- About panels and panel stacks.................................................... 62
- Defining the parts of a panel stack ............................................ 66
  - Panel stacks and automatic target maintenance for selectors 68
- Inserting and defining panels....................................................... 69
  - Inserting a panel stack........................................................... 70
  - Displaying the title bar of a panel stack ................................ 71
  - Inserting additional panels in a panel stack ......................... 75
  - Changing the display order of panels .................................. 77
  - Choosing the panel to display initially: the current panel ...... 78
4. Providing Interactivity to Users: Selectors

Introduction .............................................................................. 105
About selectors ................................................................. 105
Defining a selector ............................................................. 113
Methods to create a selector .................................................. 117
  Selecting targets interactively (target selection mode) ..... 120
  Example: Creating a selector to control a Grid/Graph .... 121
  Creating selectors that filter metric values ...................... 123
Applying selections as filters or slices .................................. 126
  Selectors in a dashboard that is viewed off-line .......... 129
  Defining selectors to filter or slice targets .................... 129
Determining whether the selector includes or excludes data:
  selection type .................................................................... 132
Automatically maintaining targets for selectors .................. 134
  Controlling targets when targets are automatically
  maintained .......................................................................... 138
  Disabling automatic target maintenance to allow manual
  target selection ................................................................ 141
  Enabling automatic target maintenance....................... 143
Allowing users to select multiple items ............................... 145
Controlling how data updates: Automatically apply selector
  changes .............................................................................. 146
Disabling simultaneous display of all items in a selector ...... 147
  Renaming the All option of a selector ........................... 148
Determining how the target of a selector displays when no
  data exists .......................................................................... 149
Contents

Determining how the target of a selector displays (current state) .......................................................... 154
  Current State setting with a slicing selector ..................... 155
  Current State setting with a filtering selector .................. 157
  Current State settings and multiple targets .................... 159
  Defining the Current State of a selector ......................... 161

Showing totals for selectors ........................................ 163
  Conditional formatting on selector totals ....................... 164
  Showing totals in a selector ........................................ 165

Displaying and sorting forms in selectors ..................... 166

Displaying title bars in selectors ................................ 167

Formatting selectors .................................................. 170
  Formatting the selector container vs. title bar ............... 170
  Deciding which interface to use to format selectors ........ 171
  Useful formatting suggestions for selectors ................... 172
  Specifying proportional or fixed width for selector items ... 174
  Formatting the text of a selector’s items ....................... 175
  Defining the background color for selected items in Flash Mode ......................................................... 177
  Selector display in Flash Mode in MicroStrategy Web .... 180
  Selector display when exported to PDF ......................... 180

Enabling Grid/Graphs as selectors to control other
Grid/Graphs ................................................................... 183
  Formatting the background of selected items in Grid/Graphs used as selectors ........................................ 186

5. Providing Flash Analysis and Interactivity: Widgets

Introduction ..................................................................... 189

Choosing the right widget ............................................ 190

Creating widgets ....................................................... 197
  Prerequisites for creating widgets ............................... 197
  Creating a Bubble Grid widget ................................. 198
  Creating a Cylinder widget ....................................... 200
  Creating a Data Cloud widget ................................. 202
  Creating a Date Selection widget .............................. 205
  Creating a Fish Eye Selector ................................... 214
  Creating a Funnel widget ........................................ 226
  Creating a Gauge widget ........................................ 228
  Creating a Graph Matrix (deprecated) widget .......................... 230
  Creating a Graph Matrix widget .............................. 234
  Creating a Heat Map widget ................................. 236
  Creating an Image Layout widget ............................ 240
Creating an Interactive Bubble Graph widget ...................... 243
Creating an Interactive Stacked Graph widget .................... 249
Creating a Map widget......................................................... 251
Creating a Media widget ...................................................... 251
Creating a Microcharts widget ............................................. 257
Creating a Network Visualization widget.............................. 267
Creating an RSS Reader widget.......................................... 269
Creating a Thermometer widget .......................................... 274
Creating a Time Series Slider widget................................... 276
Creating a Waterfall widget.................................................. 278
Creating a Weighted List Viewer widget .............................. 282

Defining how a widget is displayed in different views and modes ........................................................................................ 285
Defining which display modes are available to users ........ 290
Displaying a message in place of a widget.......................... 291

Converting an existing Grid/Graph into a widget ....................... 292

Linking in widgets ...................................................................... 295

Specifying how prompts are answered in the target............ 297
Creating links in widgets ...................................................... 298

6. Formatting Widgets

Introduction.............................................................................. 301

Inherited formatting................................................................. 301

Formatting a widget .................................................................. 302

Formatting options by widget type ............................................. 303

Formatting a Bubble Grid widget ........................................... 303
Formatting a Cylinder widget ................................................ 305
Formatting a Data Cloud widget ............................................ 305
Formatting a Date Selection widget..................................... 307
Formatting a Date Selection widget for a mobile device...... 309
Formatting a Fish Eye Selector ............................................ 309
Formatting a Funnel widget .................................................. 313
Formatting a Gauge widget .................................................. 315
Formatting a Graph Matrix (deprecated) widget ............... 316
Formatting a Heat Map widget............................................. 318
Formatting an Image Layout widget.................................... 321
Formatting an Interactive Bubble Graph widget............... 323
Formatting an Interactive Stacked Graph widget............. 327
Formatting a Map widget ..................................................... 328
Formatting a Media widget............................................... 328
Formatting a Microcharts widget......................................... 330
Formatting an RSS Reader widget ...................................... 340
Formatting an RSS Reader widget for a mobile device ... 343
Formatting a Thermometer widget .................................. 343
Formatting a Time Series Slider widget ........................................... 344
Formatting a Waterfall widget .............................................. 346
Formatting a Weighted List Viewer widget ......................... 350

7. Viewing Data Related to Widgets: Using Widgets as Selectors

Introduction .............................................................................. 353
Using widgets as selectors ........................................................ 354
  Using a Bubble Grid widget as a selector ......................... 354
  Using a Data Cloud widget as a selector .......................... 355
  Using a Graph Matrix (deprecated) widget as a selector ... 355
  Using a Heat Map widget as a selector ......................... 357
  Using an Interactive Bubble Graph widget as a selector ... 358
  Using an Interactive Stacked Graph widget as a selector ... 360
  Using a Microcharts widget as a selector .................... 362
  Using a Time Series Slider widget as a selector ............. 362
  Using a Waterfall widget as a selector ...................... 366
  Using a Weighted List Viewer widget as a selector ......... 366
Creating the widget used as a selector ...................................... 367
Enabling widgets to be used as selectors .............................. 367
Ensuring targets are updated with hovering rather than clicking ................................................................................. 371

A. Dashboard Tutorial

Introduction .............................................................................. 373
The completed dashboard ......................................................... 374
  Panel 1: Daily Order Count .............................................. 374
  Panel 2: Inventory Analysis .............................................. 375
  Panel 3: Employee Performance ....................................... 376
High-level steps ......................................................................... 378
Creating the Daily Order Count panel ........................................ 380
  Creating the Daily Order Count report to be used as a dataset ................................................................. 380
  Creating the new dashboard and selecting the dataset .... 380
  Adding a panel stack and panels to the dashboard ......... 381
  Adding a selector to the dashboard ....................... 384
  Creating a Time Series Slider widget ...................... 384
  Adding a Gauge widget .............................................. 386
  Creating a selector for the Gauge widget ...................... 388
  Specifying Flash Mode as the default display mode .... 389
  Saving the dashboard .............................................. 390
Viewing the Daily Order Count panel in Flash Mode in MicroStrategy Web .............................................................. 390
Creating the Inventory Analysis panel ........................................... 393
   Creating the Inventory Analysis report to be used as a dataset ................................................................................. 393
   Adding a dataset to the dashboard ........................................ 393
   Switching panels in Design View ......................................... 394
   Renaming and formatting a panel ........................................ 394
   Creating a Heat Map widget ................................................ 395
   Creating a selector for the Heat Map widget ......................... 398
   Saving the dashboard ........................................................ 399
   Viewing the Inventory Analysis panel in Flash Mode in MicroStrategy Web .............................................................. 399
Creating the Employee Performance panel ........................................... 403
   Creating a custom group ..................................................... 403
   Creating the Employee Performance report to be used as a dataset .............................................................................. 406
   Adding a dataset to the dashboard ........................................ 407
   Switching panels in Design View ......................................... 407
   Renaming and formatting a panel ........................................ 408
   Creating a Bubble Graph widget .......................................... 409
   Saving the dashboard ........................................................ 410
   Viewing the Employee Performance panel in Flash Mode in MicroStrategy Web ........................................................... 411
   Enabling drilling and time series animation ......................... 411

B. Troubleshooting Dashboards

   Introduction ........................................................................... 417
   Troubleshooting selectors .................................................... 417
   Troubleshooting during document execution ....................... 419
      Troubleshooting common Flash Mode issues .................... 419

Glossary ........................................................................................................ 423

Index ........................................................................................................... 429
Description of this guide

This guide is the primary resource for you to use to learn about designing and creating MicroStrategy Report Services dashboards, a type of document that is optimized for viewing online and for user interactivity, using Desktop. It builds on the basic concepts about documents presented in the Report Services Document Creation Guide. Chapters include:

• Chapter 1, Document Review provides a brief overview of document analysis to help you understand how end users will use documents, document creation, and the objects, such as text fields and images, that you can add to documents. Use this chapter as a refresher for basic document terminology and processes.

   If you are new to documents, it is recommended that you begin with the Document Creation Guide for a basic understanding of documents before you create dashboards.

• Chapter 2, Designing Dynamic Enterprise Dashboards introduces dashboards, which are a type of document that summarizes key business indicators by presenting them in visually intuitive, easy-to-read, interactive documents. This chapter includes instructions to create dashboards.
• **Chapter 3, Layering Data: Panels and Panel Stacks** describes how you can create several different views (panels) of data, with each view (panel) containing a logical grouping of controls that display data that is related in a meaningful way.

• **Chapter 4, Providing Interactivity to Users: Selectors** describes how selectors can allow users to change the data that they are viewing. A selector can be displayed as a button bar, a drop-down list, radio buttons, and so on. A selector can change panels or the focus of a Grid/Graph.

• **Chapter 5, Providing Flash Analysis and Interactivity: Widgets** describes widgets, which are a key part of dashboards. Widgets are Flash-based displays of report results, allowing users to visualize data in different ways than traditional reports displayed as Grid/Graphs do.

You can also design and create documents using MicroStrategy Web. The concepts are the same, but the procedures differ slightly. For instructions, see the *MicroStrategy Web Help*.

---

**About this book**

This book is divided into chapters that begin with a brief overview of the chapter’s content.

The following sections provide the location of additional examples, list prerequisites for using this book, and describe the user roles the information in this book was designed for.

HTML Documents in the MicroStrategy platform, formerly called documents, are HTML shells into which you can place MicroStrategy reports and other graphics, and control the formatting and appearance with style sheets. In this guide, the term “document” means a Report Services document.
Additional formats

This book is also available as an electronic publication in the Apple iBookstore, and can be read on an iPhone or iPad with the iBooks app installed. To download this book, search for the book’s title in the iBookstore search bar, or scan the QR code below using your device’s camera.

How to find business scenarios and examples

Within this guide, many of the concepts discussed are accompanied by business scenarios or other descriptive examples. For examples of basic documents and dashboards, see the Report Services Document Analysis Guide.

For examples of reporting functionality, see the MicroStrategy Tutorial, which is MicroStrategy’s sample warehouse, metadata, and project. Information about the MicroStrategy Tutorial can be found in the MicroStrategy Basic Reporting Guide. Detailed examples of advanced reporting functionality can be found in the MicroStrategy Advanced Reporting Guide.

Other examples in this book use the Analytics Modules, which include a set of precreated sample reports and documents, each from a different business area. Sample reports and documents present data for analysis in such business areas as financial reporting, human resources, and customer analysis.

What’s new in this guide

MicroStrategy 9.3

This manual is new for MicroStrategy 9.3, containing information related to dashboards and widgets that was previously contained in the Report
Services Document Creation Guide. New features for dashboards and widgets in 9.3 include:

- The Search Box selector in a document allows a user to search for an element. Unlike other selectors, a list of elements is not initially displayed. As a user types text, matches are displayed to choose from, instead of having to pick from all available elements. This is particularly convenient if the element list is long. For an example of a Search Box selector, see Defining a selector, page 113. For steps to create selectors, see Methods to create a selector, page 117.

- When a user exports a selector to a PDF file, the selector can be exported as shown on the screen or exported with only the selected items displayed. For steps to specify the export method, see Selector display when exported to PDF, page 180.

- When you create a selector, you can determine which forms are displayed when users see the selector, as well as the order that the forms are displayed in and how their elements are sorted. For steps to specify the display of forms in selectors, see Displaying and sorting forms in selectors, page 166.

- The following widgets are available:
  - The Network Visualization widget can be displayed in Web or on an iPad with MicroStrategy Mobile. (See Creating a Network Visualization widget, page 267.)
  - The Image Layout widget can be displayed in Web. (See Creating an Image Layout widget, page 240.)
  - The Microcharts widget can be displayed on an Android device with MicroStrategy Mobile. (See Creating a Microcharts widget, page 257.)

Prerequisites

Before working with this manual, you should be familiar with the information in the Report Services Document Analysis Guide and the Report Services Document Creation Guide.

To work with Report Services documents, you must have purchased a license for Report Services and installed it on your machine. You must also have the proper privileges assigned to your user login. These privileges are described below:
• **Execute document**, to execute documents in Desktop
  
  To execute a document in Desktop, you must connect to the project in three-tier (server) mode.

• **Use document editor**, to create and edit documents using the Document Editor in Desktop

• **Web execute document**, to browse and execute documents in MicroStrategy Web

• **Web document design**, to create and edit documents in Web

• **Web manage document datasets**, to add and remove datasets from a document in Web

If you do not have Report Services, contact your MicroStrategy sales representative for more information.

**Who should use this guide**

This guide is designed for all users who need to design and create dashboards, a type of interactive document.

Document design is the process of building documents that are used widely by other users on the business intelligence platform and throughout the enterprise. To design documents you use the Document Editor in either MicroStrategy Desktop or Web. The Document Editor also allows you to create document objects (called controls) such as text fields, auto text codes, Grid/Graphs, HTML containers, images, and so on. You can also create a special type of document called dashboards, which are visually intuitive displays of data that summarize key business indicators for a quick status check. Dashboards usually provide interactive features that let users change how they view the dashboard’s data. The interaction is provided by these types of controls: panels, selectors, and widgets.

In general, the role of document designer is made available only to a group of advanced users who can design documents. The Desktop Designer and Web Professional user roles in MicroStrategy include the set of privileges required to create documents and controls, for each respective product.

For a review of basic document concepts, see Chapter 1, Document Review. If you need to brush up on document basics, this chapter is designed to help you. If you need a more in-depth refresher, or are new to creating documents and dashboards, start with the Document Creation Guide. For an introduction to documents, review the Report Services Document Analysis
Guide, which provides a basic understanding of how to manipulate the data in a document or dashboard to analyze business information.

Resources

Documentation

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

- **Manuals:** In general, MicroStrategy manuals provide:
  - Introductory information and concepts
  - Examples and images
  - Checklists and high-level procedures to get started

  The steps to access the manuals are described in *Accessing manuals and other documentation sources, page xxx*.

  Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy Account Executive with a purchase order number.

- **Help:** In general, MicroStrategy help provides:
  - Detailed steps to perform procedures
  - Descriptions of each option on every software screen

  For the most up-to-date translations of MicroStrategy documentation, refer to the MicroStrategy Knowledge Base. Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual.

**MicroStrategy overview and evaluation**


  Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide also includes a detailed,
step-by-step evaluation process of MicroStrategy features, where you perform reporting with the MicroStrategy Tutorial project and its sample business data.


  Overview of the installation and evaluation process, and additional resources.

- **Evaluate MicroStrategy for Linux Guide: In a Windows or Linux Environment with the MicroStrategy Evaluation Edition Virtual Appliance**

  Evaluate MicroStrategy for Linux, in a Microsoft Windows or Linux environment, with the MicroStrategy Evaluation Edition Virtual Appliance. This guide provides all details to download, activate, and evaluate MicroStrategy software running in a Linux environment.

- **MicroStrategy Reporting Suite: Quick Start Guide**

  Evaluate MicroStrategy as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Reporting Suite.

- **MicroStrategy Mobile Suite: Quick Start Guide**

  Evaluate MicroStrategy Mobile as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Mobile Suite.

**Manuals for query, reporting, and analysis**

- **MicroStrategy Installation and Configuration Guide**

  Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, as well as basic maintenance guidelines.

- **MicroStrategy Upgrade Guide**

  Instructions to upgrade existing MicroStrategy products.

- **MicroStrategy Project Design Guide**

  Information to create and modify MicroStrategy projects, and understand facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.
• **MicroStrategy Basic Reporting Guide**

Instructions to get started with MicroStrategy Desktop and MicroStrategy Web, and how to analyze data in a report. Includes the basics for creating reports, metrics, filters, and prompts.

• **MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application**

Instructions for advanced topics in the MicroStrategy system, building on information in the Basic Reporting Guide. Topics include reports, Freeform SQL reports, Query Builder reports, filters, metrics, Data Mining Services, custom groups, consolidations, and prompts.


Instructions for a business analyst to execute and analyze a document in MicroStrategy Desktop and MicroStrategy Web, building on basic concepts about projects and reports presented in the *MicroStrategy Basic Reporting Guide*.

• **MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents**

Instructions to design and create Report Services documents, building on information in the *MicroStrategy Report Services Document Analysis Guide*. It is organized to help guide you through creating a new document, from creating the document itself, to adding objects to the new document, and formatting the document and its objects.

• **MicroStrategy Dashboards and Widgets Creation Guide: Creating Interactive Dashboards for your Data**

Instructions for designing and creating MicroStrategy Report Services dashboards, a type of document that is optimized for viewing online and for user interactivity. It builds on the basic concepts about documents presented in the *MicroStrategy Report Services Document Creation Guide*.

• **MicroStrategy OLAP Services Guide**

Information on MicroStrategy OLAP Services, which is an extension of MicroStrategy Intelligence Server. OLAP Services features include Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.
• **MicroStrategy Office User Guide**

Instructions for using MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, Word, and Outlook, to analyze, format, and distribute business data.

• **MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile**

Information and instructions for using MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.

• **MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence**

Information and instructions to install and configure MicroStrategy Mobile, as well as instructions for a designer working in MicroStrategy Desktop or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.

• **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting your MicroStrategy Business Intelligence System**

Concepts and high-level steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.

• **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

Information and instructions for MicroStrategy administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

• **MicroStrategy Functions Reference**

Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.

• **MicroStrategy MDX Cube Reporting Guide**

Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.
Manuals for Analytics Modules

- Analytics Modules Installation and Porting Guide
- Customer Analysis Module Reference
- Sales Force Analysis Module Reference
- Financial Reporting Analysis Module Reference
- Sales and Distribution Analysis Module Reference
- Human Resources Analysis Module Reference

Manuals for Narrowcast Services products

- MicroStrategy Narrowcast Server Getting Started Guide
  Instructions to work with the tutorial to learn Narrowcast Server interfaces and features.
- MicroStrategy Narrowcast Server Installation and Configuration Guide
  Information to install and configure Narrowcast Server.
- MicroStrategy Narrowcast Server Application Designer Guide
  Fundamentals of designing Narrowcast Server applications.
- MicroStrategy Narrowcast Server System Administrator Guide
  Concepts and high-level steps to implement, maintain, tune, and troubleshoot Narrowcast Server.
- MicroStrategy Narrowcast Server Upgrade Guide
  Instructions to upgrade an existing Narrowcast Server.

Software Development Kits

- MicroStrategy Developer Library (MSDL)
  Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.
• **MicroStrategy Web SDK**
  
  The Web SDK is available in the MicroStrategy Developer Library, which is sold as part of the MicroStrategy SDK.

• **Narrowcast Server SDK Guide**
  
  Instructions to customize Narrowcast Server functionality, integrate Narrowcast Server with other systems, and embed Narrowcast Server functionality within other applications. Documents the Narrowcast Server Delivery Engine and Subscription Portal APIs, and the Narrowcast Server SPI.

**Documentation for MicroStrategy Portlets**

• **Enterprise Portal Integration Help**
  
  Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.

  This resource can be accessed using the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page xxx*.

**Documentation for MicroStrategy GIS Connectors**

• **GIS Integration Help**
  
  Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with various third-party mapping services.

  This resource can be accessed using the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page xxx*. 
Help

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

- Help button: Use the Help button or ? (question mark) icon on most software windows to see help for that window.

- Help menu: From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.

- F1 key: Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.

Accessing manuals and other documentation sources

The manuals are available from your MicroStrategy disk or the machine where MicroStrategy was installed.

Adobe Acrobat Reader is required to view these manuals. If you do not have Acrobat Reader installed on your computer, you can download it from http://get.adobe.com/reader/.

The best place for all users to begin is with the MicroStrategy Basic Reporting Guide.

To access the installed manuals and other documentation sources, see the following procedures:

- *To access installed manuals and other documentation sources on Windows, page xxxi*
• To access installed manuals and other documentation sources on UNIX and Linux, page xxxi

To access installed manuals and other documentation sources on Windows

1 From the Windows Start menu, choose Programs (or All Programs), MicroStrategy, then Product Manuals. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

2 Click the link for the desired manual or other documentation source.

3 If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be downloaded. Select Open this file from its current location, and click OK.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Acrobat Reader.

To access installed manuals and other documentation sources on UNIX and Linux

1 Within your UNIX or Linux machine, navigate to the directory where you installed MicroStrategy. The default location is /opt/MicroStrategy, or $HOME/MicroStrategy/install if you do not have write access to /opt/MicroStrategy.

2 From the MicroStrategy installation directory, open the Documentation folder.

3 Open the Product_Manuals.htm file in a web browser. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

4 Click the link for the desired manual or other documentation source.

5 If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be
downloaded. Select **Open this file from its current location**, and click **OK**.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the **View** menu click **Bookmarks and Page**. This step varies slightly depending on your version of Adobe Acrobat Reader.

**Documentation standards**

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

These standards may differ depending on the language of this manual; some languages have rules that supersede the table below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>• Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions</td>
</tr>
<tr>
<td></td>
<td>Example: Click <strong>Select Warehouse</strong>.</td>
</tr>
<tr>
<td><strong>italic</strong></td>
<td>• New terms defined within the text and in the glossary</td>
</tr>
<tr>
<td></td>
<td>• Names of other product manuals and documentation resources</td>
</tr>
<tr>
<td></td>
<td>• When part of a command syntax, indicates variable information to be replaced by the user</td>
</tr>
<tr>
<td></td>
<td>Example: The <strong>aggregation level</strong> is the level of calculation for the metric.</td>
</tr>
<tr>
<td></td>
<td>Example: <strong>Type</strong> <code>copy c:\filename d:\foldername\filename</code></td>
</tr>
<tr>
<td><strong>Courier font</strong></td>
<td>• Calculations</td>
</tr>
<tr>
<td></td>
<td>• Code samples</td>
</tr>
<tr>
<td></td>
<td>• Registry keys</td>
</tr>
<tr>
<td></td>
<td>• Path and file names</td>
</tr>
<tr>
<td></td>
<td>• URLs</td>
</tr>
<tr>
<td></td>
<td>• Messages displayed in the screen</td>
</tr>
<tr>
<td></td>
<td>• Text to be entered by the user</td>
</tr>
<tr>
<td></td>
<td>Example: <code>Sum(revenue)/number of months</code>.</td>
</tr>
<tr>
<td></td>
<td>Example: <strong>Type</strong> <code>cmdmgr -f scriptfile.scp</code> and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td><strong>+</strong></td>
<td>A keyboard command that calls for the use of more than one key (for example, <strong>SHIFT+F1</strong>).</td>
</tr>
<tr>
<td><strong>⚠️</strong></td>
<td>A note icon indicates helpful information for specific situations.</td>
</tr>
<tr>
<td><strong>🔥</strong></td>
<td>A warning icon alerts you to important information such as potential security risks; these should be read before continuing.</td>
</tr>
</tbody>
</table>
Education

MicroStrategy Education Services provides a comprehensive curriculum and highly skilled education consultants. Many customers and partners from over 800 different organizations have benefited from MicroStrategy instruction.

Courses that can help you prepare for using this manual or that address some of the information in this manual include:

- MicroStrategy Report Services: Dynamic Dashboards

For the most up-to-date and detailed description of education offerings and course curricula, visit [http://www.microstrategy.com/Education](http://www.microstrategy.com/Education).

Consulting

MicroStrategy Consulting Services provides proven methods for delivering leading-edge technology solutions. Offerings include complex security architecture designs, performance and tuning, project and testing strategies and recommendations, strategic planning, and more. For a detailed description of consulting offerings, visit [http://www.microstrategy.com/Services](http://www.microstrategy.com/Services).

International support

MicroStrategy supports several locales. Support for a locale typically includes native database and operating system support, support for date formats, numeric formats, currency symbols, and availability of translated interfaces and certain documentation.

MicroStrategy is certified in homogeneous configurations (where all the components lie in the same locale) in the following languages—English (US), French, German, Italian, Japanese, Korean, Portuguese (Brazilian), Spanish, Chinese (Simplified), Chinese (Traditional), Danish, and Swedish. A translated user interface is available in each of the above languages. For information on specific languages supported by individual MicroStrategy system components, see the MicroStrategy readme.
MicroStrategy also provides limited support for heterogeneous configurations (where some of the components may lie in different locales). Please contact MicroStrategy Technical Support for more details.

**Technical Support**

If you have questions about a specific MicroStrategy product, you should:

1. Consult the product guides, Help, and readme files. Locations to access each are described above.

2. Consult the MicroStrategy Knowledge Base online at [https://resource.microstrategy.com/support](https://resource.microstrategy.com/support).

   A technical administrator in your organization may be able to help you resolve your issues immediately.

3. If the resources listed in the steps above do not provide a solution, contact MicroStrategy Technical Support directly. To ensure the most productive relationship with MicroStrategy Technical Support, review the Policies and Procedures document in your language, posted at [http://www.microstrategy.com/Support/Policies](http://www.microstrategy.com/Support/Policies). Refer to the terms of your purchase agreement to determine the type of support available to you.

MicroStrategy Technical Support can be contacted by your company’s Support Liaison. A Support Liaison is a person whom your company has designated as a point-of-contact with MicroStrategy’s support personnel. All customer inquiries and case communications must come through these named individuals. Your company may designate two employees to serve as their Support Liaisons, and can request to change their Support Liaisons two times per year with prior written notice to MicroStrategy Technical Support.

It is recommended that you designate Support Liaisons who have MicroStrategy Administrator privileges. This can eliminate security conflicts and improve case resolution time. When troubleshooting and researching issues, MicroStrategy Technical Support personnel may make recommendations that require administrative privileges within MicroStrategy, or that assume that the designated Support Liaison has a security level that permits them to fully manipulate the MicroStrategy projects and has access to potentially sensitive project data such as security filter definitions.
Ensure issues are resolved quickly

Before logging a case with MicroStrategy Technical Support, the Support Liaison may follow the steps below to ensure that issues are resolved quickly:

1. Verify that the issue is with MicroStrategy software and not a third party software.


3. Attempt to reproduce the issue and determine whether it occurs consistently.

4. Minimize the complexity of the system or project object definition to isolate the cause.

5. Determine whether the issue occurs on a local machine or on multiple machines in the customer environment.

6. Discuss the issue with other users by posting a question about the issue on the MicroStrategy Customer Forum at [https://resource.microstrategy.com/forum/](https://resource.microstrategy.com/forum/).

The following table shows where, when, and how to contact MicroStrategy Technical Support. If your Support Liaison is unable to reach MicroStrategy Technical Support by phone during the hours of operation, they can leave a voicemail message, send email or fax, or log a case using the Online Support
Interface. The individual Technical Support Centers are closed on certain public holidays.

<table>
<thead>
<tr>
<th>Region</th>
<th>Email</th>
<th>Web</th>
<th>Fax</th>
<th>Phone</th>
<th>Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td><a href="mailto:support@microstrategy.com">support@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>(703) 842–8709</td>
<td>(703) 848–8700</td>
<td>9:00 A.M.–7:00 P.M. Eastern Time, Monday–Friday except holidays</td>
</tr>
<tr>
<td>EMEA: Europe, The Middle East Africa</td>
<td><a href="mailto:eurosupp@microstrategy.com">eurosupp@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td>+44 (0) 208 711 2525</td>
<td>+44 (0) 208 080 2182</td>
<td>The European Technical Support Centre is closed on national public holidays in each country.</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td><a href="mailto:apsupport@microstrategy.com">apsupport@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td></td>
<td></td>
<td>Japan and Korea: 9:00 A.M.–6:00 P.M. JST (Tokyo), Monday–Friday except holidays</td>
</tr>
<tr>
<td>Latin America</td>
<td><a href="mailto:latamsupport@microstrategy.com">latamsupport@microstrategy.com</a></td>
<td><a href="https://resource.microstrategy.com/support">https://resource.microstrategy.com/support</a></td>
<td></td>
<td></td>
<td>Latin America (except Brazil): 9:00 A.M.–7:00 P.M. (Buenos Aires), Monday–Friday except holidays</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Brazil: 9 A.M. - 6 P.M. (São Paulo), Monday–Friday except holidays</td>
</tr>
</tbody>
</table>
Support Liaisons should contact the Technical Support Center from which they obtained their MicroStrategy software licenses or the Technical Support Center to which they have been designated.

**Required information when calling**

When contacting MicroStrategy Technical Support, please provide the following information:

- **Personal information:**
  - Name (first and last)
  - Company and customer site (if different from company)
  - Contact information (phone and fax numbers, e-mail addresses)

- **Case details:**
  - Configuration information, including MicroStrategy software product(s) and versions
  - Full description of the case including symptoms, error messages(s), and steps taken to troubleshoot the case thus far

- **Business/system impact**

If this is the Support Liaison’s first call, they should also be prepared to provide the following:

- Street address
- Phone number
- Fax number
- Email address

To help the Technical Support representative resolve the problem promptly and effectively, be prepared to provide the following additional information:

- **Case number:** Please keep a record of the number assigned to each case logged with MicroStrategy Technical Support, and be ready to provide it when inquiring about an existing case

- **Software version and product registration numbers of the MicroStrategy software products you are using**
• Case description:
  ▪ What causes the condition to occur?
  ▪ Does the condition occur sporadically or each time a certain action is performed?
  ▪ Does the condition occur on all machines or just on one?
  ▪ When did the condition first occur?
  ▪ What events took place immediately prior to the first occurrence of the condition (for example, a major database load, a database move, or a software upgrade)?
  ▪ If there was an error message, what was its exact wording?
  ▪ What steps have you taken to isolate and resolve the issue? What were the results?

• System configuration (the information needed depends on the nature of the problem; not all items listed below may be necessary):
  ▪ Computer hardware specifications (processor speed, RAM, disk space, and so on)
  ▪ Network protocol used
  ▪ ODBC driver manufacturer and version
  ▪ Database gateway software version
  ▪ (For MicroStrategy Web-related problems) browser manufacturer and version
  ▪ (For MicroStrategy Web-related problems) Web server manufacturer and version

If the issue requires additional investigation or testing, the Support Liaison and the MicroStrategy Technical Support representative should agree on certain action items to be performed. The Support Liaison should perform any agreed-upon actions before contacting MicroStrategy Technical Support again regarding the issue. If the Technical Support representative is responsible for an action item, the Support Liaison may call MicroStrategy Technical Support at any time to inquire about the status of the issue.
Feedback

Please send any comments or suggestions about user documentation for MicroStrategy products to:

documentationfeedback@microstrategy.com

Send suggestions for product enhancements to:

support@microstrategy.com

When you provide feedback to us, please include the name and version of the products you are currently using. Your feedback is important to us as we prepare for future releases.
Introduction

A MicroStrategy Report Services document contains objects representing data coming from one or more MicroStrategy reports, as well as images and shapes. Documents can appear in almost as many ways as you can imagine and are generally formatted to suit your business needs, in a single display of presentation quality.

A dashboard is a special type of document. A dashboard is commonly only one page long, is intended to be viewed online, and usually provides interactive features that let analysts change how they view the dashboard’s data. By being only one page long, a dashboard makes it easy to view the entire document at the same time and see all the information. A dashboard allows interactivity from users, so each user can change how they see the data, within the limits of what the controls allow them.

This chapter begins with an overview of document analysis, in Before you begin: Document analysis overview, page 2, to help you understand how end users will use documents for data analysis. For more detailed examples of working with documents and dashboards, see the MicroStrategy Document Analysis Guide.
Next, this chapter provides an overview of how to design and create a MicroStrategy Report Services document, reviewing concepts from the MicroStrategy Report Services Document Creation Guide. It also includes a brief summary of the objects, such as text fields and images, that you can add to a document. These objects can be used on dashboards as well as documents. For more detailed instructions and examples, or if you have never created a document before, see the MicroStrategy Report Services Document Creation Guide.

The next chapter, Chapter 2, Designing Dynamic Enterprise Dashboards, includes detailed instructions to create a dashboard and describes objects that you can add to dashboards.

Warehouse data in the sample MicroStrategy projects is updated regularly, and these changes are reflected in the documentation whenever possible. However, the sample reports, documents, objects, and images in this guide may display warehouse data that no longer appears in the software.

Note the following:

- While you can connect an older Desktop client to a newer Intelligence Server (such as an 8.1.x Desktop client and a 9.x Intelligence Server), none of the newer 9.x functionality for Report Services documents is supported. See the Upgrade Guide for details.

- If some fonts are not available on an Intelligence Server installed on the UNIX operating system, copy True Type fonts into the Intelligence Server installation directory. Copy these fonts, which have a .ttc or .ttf extension, to INTELLIGENCE_SERVER_INSTALL_PATH\PDFGeneratorFiles. The default installation path for the Intelligence Server in UNIX is home\MicroStrategy\PDFGeneratorFiles. For the change to take effect, you must restart Intelligence Server.

Before you begin: Document analysis overview

Before you begin creating a document or dashboard, you should understand how end users will use documents and dashboards for data analysis. For instructions and examples of manipulating data in documents and dashboards, see the MicroStrategy Document Analysis Guide.
The following section reviews basic concepts, such as executing and printing documents and dashboards, covered in the MicroStrategy Document Analysis Guide. If you need to brush up on the basics, this section is designed to help you.

Although the following sections refer to documents, remember that a dashboard is a special type of document, so the procedures and concepts apply to dashboards as well as documents.

**Document views in Desktop**

In Desktop, you can open a document in the following views:

- **PDF View** (the default view), which displays the document as it will look when printed (for example, with page breaks). Use PDF View to:
  - View the document as a PDF (especially helpful to see how your changes affect the final display of the document)
  - Interactively display groups on separate pages (using page-by)
  - Navigate through large quantities of data that have been grouped into separate pages of the document
  - View associated websites by clicking hyperlinks
  - Print the document
  - Save the final PDF (by exporting it)
  - Export the PDF to Excel, PDF, Flash, or HTML

- **Flash View**, which displays a preview of the document as it will look in Flash Mode in MicroStrategy Web. In Flash View, you can interact with the document by using selectors, performing some manipulations such as pivoting and sorting, and viewing and interacting with widgets.

- **HTML View**, which displays a preview of the document as it will look in other MicroStrategy Web modes.

- **Design View**, which displays the structure of the document, or the placeholders for the document objects, without the actual results. It allows you to create and edit the document and the various objects that make up the document. Use Design View for the procedures described in this manual.
Opening a document

If a document has embedded Transaction Services, the document does not open. Instead, a message is displayed, indicating that transaction-enabled documents are not supported in Desktop.

To open a document in Design View

1. From a project in MicroStrategy Desktop, navigate to the folder containing the document.
2. Right-click the document name or icon, and select Edit. The Document Editor opens.

To open a document in PDF View

1. From a project in MicroStrategy Desktop, navigate to the folder containing the document.

To enhance PDF viewing performance, open Acrobat Reader before opening the document.

2. Double-click the document name or icon. The document opens in PDF View, in Acrobat Reader.

Printing a document

Before you print the document, you should configure various settings that control how the document is displayed and printed. Examples of these settings are pagination, page margins, and graph resolution. This ensures that the end result (the printed document) appears as you want it to. For instructions, see the Document Creation Guide.

To print a document

1. In PDF View, click the Print icon on the Acrobat Reader toolbar. The Print dialog box opens.
2 You can change print settings, such as the printer to be used and the page range to print, as needed. Click OK.

Viewing a document as it will display in MicroStrategy Web (Flash View and HTML View)

Flash View and HTML View in Desktop display the document as it will look in MicroStrategy Web.

Prerequisites to use Flash View and HTML View

Before you can switch to Flash View or HTML View, you must enable Flash View or HTML View. See Enabling MicroStrategy Web preview for a document, page 5 for directions.

Finally, if your document contains any of the following, you must embed fonts:

- Anti-alias support
- Vertical text
- Graph labels rotated 45, 90, or 180°

For more information and instructions, see the Document Creation Guide.

Enabling MicroStrategy Web preview for a document

Before you can switch to Flash View or HTML View to preview how a document will look in MicroStrategy Web, you must enable Flash View or HTML View.

To enable Flash View and HTML View

1 Open the document in Design View in the Document Editor.


3 Select Document.
4 To enable Flash View, select the **Flash** check box in the **Available display modes** list.

5 To enable HTML View, select at least one of the following check boxes in the **Available display modes** list:
   - Express
   - Interactive
   - Editable

6 Click **OK** to return to the document.

### Switching to HTML View or Flash View

Flash View and HTML View in Desktop display the document as it will look in MicroStrategy Web. Before switching to either of these views, ensure that you have completed the prerequisites described in *Prerequisites to use Flash View and HTML View, page 5.*

---

**To view a document in HTML View or Flash View**

1 In Desktop, double-click the document name or icon. The document opens in PDF View, in Acrobat Reader.

2 To preview the document for Flash mode, click **Flash View** on the toolbar.

3 To preview the document for other MicroStrategy Web modes, click **HTML View** on the toolbar.

If **Flash View** or **HTML View** is not available on the toolbar, it must be enabled. See *Enabling MicroStrategy Web preview for a document, page 5* for instructions.

---

**Opening a document in a separate browser window: Exporting a document to HTML**

You can open the current document in a separate browser window outside of MicroStrategy. This allows you to preview what the document will look like in MicroStrategy Web.
Opening a document in a separate browser window is useful for a document designer. It allows him to return to the Document Editor, switch to Design View, and edit the document while referring to a copy of the document as it looks in a browser.

To open a document in a separate browser window

1 In Desktop, double-click the document name or icon. The document opens in PDF View, in Acrobat Reader.

2 Click the Export to HTML icon in the toolbar. The Export to HTML dialog box opens.

   Note the following:
   • If the Export to HTML icon is unavailable, HTML exporting has not been made available for this document.
   • If the Export to HTML dialog box is not displayed, you do not need to complete the remaining steps of this procedure. A copy of the document opens in a browser.

3 If your document contains multiple layouts, you can choose to export the entire document or only the current layout. A multi-layout document contains multiple documents, each in its own layout, creating a “book” of documents. Each layout functions as a separate document, with its own grouping, page setup, and so on, but the layouts are generated into a single PDF document. For an example of a multi-layout document, see Multi-layout documents, page 19. For an explanation of how layouts are exported, including examples, see the Document Creation Guide.

   • To export the entire document, select All layouts.
   • To export the current layout only, select Current layout.

4 If your document contains page-by fields, you can choose to export the entire document or only the selected group element to HTML. Page-by allows you to view the document by a selected group element. For examples of a paged document, and instructions on how to disable page-by, see the Document Creation Guide.

   • To export the entire document, clear the Expand page-by check box.
   • To export only the selected group element, select the Expand page-by check box.
5  Click OK. A copy of the document opens in a browser.

### Display modes in MicroStrategy Web

In MicroStrategy Web, you can view and work with a document in the following display modes:

- **Express Mode**, which allows document analysts to view the document and interact with it. Interactions include using selectors to change panels or Grid/Graph reports, sorting grid reports, and linking to reports and other documents.

  - Internet Explorer 7 is required for the interactivity of Express Mode. If you are using Internet Explorer 6 or earlier, you cannot interact with the document. You can instead view the results only, as you might in a static PDF file.

- **Flash Mode**, which allows document analysts to access and interact with features provided by Flash, such as widgets.

- **Interactive Mode**, which allows document analysts to view the document and interact with it. It provides more interactivity than Express Mode, including formatting Grid/Graphs and creating metrics.

- **Editable Mode**, which displays the actual results of the document, while still allowing you to edit the document. All of the tasks that you can perform in Design Mode can also be performed in Editable Mode. This allows you to make changes and immediately see how they affect the look and feel of the document.

- **Design Mode**, which displays the structure of the document, or the placeholders for the document objects, without the actual results. It allows you to create and edit the document and the various objects that make up the document. You can work more quickly in Design Mode than in Editable Mode since you do not have to wait for the results of your document to load in Design Mode.

For instructions to open a document in MicroStrategy Web, and more details on the various modes, see the *MicroStrategy Web Help*.

Before the document can be viewed in MicroStrategy Web, you must select which modes it can be displayed in. For instructions, see *Determining the display modes users can choose to work in, page 56*.
Designing and creating documents: An overview

If you are new to designing documents, review the best practices for designing effective documents in the Document Creation Guide before you begin a new document.

As you, as a document designer, create documents, you specify the data that appears and control the layout, formatting, grouping, and subtotaling of data. In addition, you can insert pictures and draw borders in the document. All of these capabilities provide for documents that are suitable for presentation to management for printing boardroom quality material. They are used to create the highest-quality, Pixel Perfect™ documents such as scorecards and dashboards, managed metrics documents, production and operational documents, and more. For descriptions of the objects that you can add to a document, see Objects in a document: Controls, page 11.

To create a document, you open a blank document and select a report to use as the document's dataset. The dataset report of a document contains the MicroStrategy objects that can be displayed in the document. These objects include attributes, custom groups, consolidations, and metrics. You can select more than one dataset report to include on the document. You must define one dataset as the grouping and sorting dataset; you can group and sort only by the objects on this dataset. For an overview of the methods to create a document, see About Visual Insight: Analyses, page 19.

Accessing data in a document: The dataset report

A dataset is a MicroStrategy report that is used on a document and all of the report’s elements—attributes, custom groups, consolidations, and metrics.

Datasets provide the data that appears in documents. Datasets define which information the Intelligence Server should retrieve from the data warehouse or cache. This information can include attributes, custom groups, consolidations, and metrics.

These dataset objects are all of the objects from the dataset report, regardless of whether they are displayed on the report. For example, if a metric is in the Report Objects but not displayed on the grid, that metric is listed as a dataset object. For background information about these subset reports, including the different methods to add them to a document, see the Document Creation Guide.
When you create a new document, you can select the report or Intelligent Cube to use as the dataset. Once the document is created, you can:

- Add another dataset to the document
- Replace an existing dataset with another dataset
- Replace all the datasets in the document with a single dataset
- Remove a dataset from the document

For instructions, see the *Desktop Help.*

**Multiple datasets**

You can create a document with multiple dataset reports, and you can add more dataset reports after you create a document. One dataset must be defined as the grouping and sorting dataset; you can group and sort only by the objects on this dataset.

For details on how multiple datasets join together in a document, see the *Document Creation Guide.* For instructions to change the grouping and sorting dataset, see the *Desktop Help.*

**Intelligent Cubes as datasets**

An Intelligent Cube is a multi-dimensional cube (sets of data) that allow you to use OLAP Services features on reports, as well as share sets of data among multiple reports and documents. You can use an Intelligent Cube as a dataset, allowing you to use one Intelligent Cube for many different documents, while reducing access to the data warehouse.

For background information on using Intelligent Cubes as datasets, including how to add a Grid/Graph with an Intelligent Cube as a dataset, see the *Document Creation Guide.*

**Creating documents**

You can create a document in one of several ways, depending on your needs:

- On your own from start to finish using the Document Editor, which allows you to select the information to be included and the formatting of the document. You can add one or more dataset reports to the document.
• With the help of the Document Wizard, which provides steps to create the document.

• Using another document as a template, which allows you to pattern the new document after an existing one. The same dataset, controls, formatting, and layouts as the template are used in the new document. However, you can add to or modify the new document after it is created.

• From a report. The report is added as a Grid/Graph (an object that acts like a standard MicroStrategy report) in the Detail Header of the new document. You can also select multiple reports at the same time to create a multi-layout document (see Multi-layout documents, page 19 for an overview).

For procedures to create documents, see the Document Creation Guide or the Desktop Help.

**Objects in a document: Controls**

After you create a document, you add controls to the document. Controls are the objects that display the data, images, and shapes in a document; they are the objects shown in the document’s Layout area as you design the
document. The following document sample uses different types of controls, as described below:

<table>
<thead>
<tr>
<th>Central Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellarkamp:Nancy</td>
<td>$847,227</td>
</tr>
<tr>
<td>Galet:Loren</td>
<td>$1,669,290</td>
</tr>
<tr>
<td>Torisson:Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Zemlicka:George</td>
<td>$822,500</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$5,029,366</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mid-Atlantic Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bernstein:Lawrence</td>
<td>$1,060,632</td>
</tr>
<tr>
<td>Brown:Vernon</td>
<td>$331,735</td>
</tr>
<tr>
<td>Corcoran:Peter</td>
<td>$325,147</td>
</tr>
<tr>
<td>Folks:Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td>Hollywood:Robert</td>
<td>$1,026,874</td>
</tr>
<tr>
<td>Ingles:Walter</td>
<td>$229,439</td>
</tr>
<tr>
<td>Smith:Thomas</td>
<td>$221,379</td>
</tr>
<tr>
<td>Young:Sarah</td>
<td>$209,634</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$4,452,615</strong></td>
</tr>
</tbody>
</table>

- **Text field**, which displays text such as:
  - Data (attributes, consolidations, custom groups, and metrics) from the document’s dataset reports. In the document sample shown above, the region names (such as Central), employee names, revenue amounts, and regional revenue subtotals are populated by the attributes and metric on the dataset report.
  - Static text for labels. In the document sample, the words “Region”, “Employee”, “Revenue”, and “Total Regional Revenue” are static text.
  - Information about the document (such as the page numbers shown in the document sample) and the dataset reports (such as report names and filter information).
  - Metrics created within the document, which use the metrics on the dataset reports to obtain data not directly available from the datasets. These include:
    - Derived metrics, which are additional calculations, such as multiplying by a constant or using a function, on the metrics from the dataset reports
- Calculated expressions, which combine metrics from different dataset reports

- Summary metrics, which are totals using specific functions, other than the metric's dynamic aggregation function

The regional revenue subtotals in the document sample are calculated by placing the Revenue metric in the Region Footer. Since the metric's dynamic aggregation function is Sum, the revenue values are totaled for each region. For a review of how the placement of a metric determines its calculation, see *Document sections and metric calculations, page 17*. To use a function other than Sum (such as Average) in the regional total, create and use a summary metric.

- **Line** or **Rectangle**. The document sample displays a line below each regional revenue subtotal and a grey rectangle to highlight the regional revenue subtotal.

- **Image**. The MicroStrategy logo on the document sample is an image.

The following control types can also be used on a document, although they are not displayed in the document sample:

- **Grid/Graph**, which displays data in the same way that a MicroStrategy report does. You can use a Grid/Graph as a type of summary for a group or the entire document, because the data displayed in it is aggregated to
the level in which the Grid/Graph is placed. In the following example, a Grid/Graph is displayed as both a grid and a graph simultaneously.

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td>$8,647,238</td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td>$11,517,606</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$14,858,854</td>
</tr>
</tbody>
</table>

- **HTML container**, which displays real-time information from the web. For example, you can display a stock ticker running in real time next to a Grid/Graph displaying a MicroStrategy report and interactive graphs displaying your corporate financial data.

The interactive graphs shown on the bottom of the sample document above are displayed using widgets, which are Flash-based displays of the results of a dataset report. For a more
detailed description of widgets and how to create them, including examples, see Chapter 5, Providing Flash Analysis and Interactivity: Widgets.

For instructions to create any of these controls, see the MicroStrategy Document Creation Guide or the Desktop Help.

Other types of controls, such as selectors and widgets, provide interactivity and visually intuitive graphic images. These controls are most commonly used on dashboards. However, their use is not limited to dashboards; you can use them on any type of document. These types of controls include:

- **Panel stack**, which is a holder for a collection of panels, or layers of data, in a document. A user can navigate or flip through the panels in a panel stack; only one panel is displayed at a time.

The document sample below shows a Grid/Graph, Employee Info By Region, on a panel in a panel stack.

For more examples and instructions to create and format panels and panel stacks, see Chapter 3, Layering Data: Panels and Panel Stacks.

- **Selector**, which allows users to interact with the document, by flipping through the panels in a panel stack or by displaying different attributes or metrics in a Grid/Graph.
The selector in the document sample above is the list of Grid/Graphs at the left. When a user clicks Category Sales Report, that Grid/Graph on another panel in the panel stack is displayed, as shown below.

<table>
<thead>
<tr>
<th>Category Sales Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
<tr>
<td>Jan 2006</td>
</tr>
</tbody>
</table>

For more examples and instructions to create and format selectors, see *Chapter 4, Providing Interactivity to Users: Selectors.*

- **Widget**, which displays the results of a dataset report in Flash in MicroStrategy Web, allowing users to visualize data in different ways than traditional reports displayed as Grid/Graphs do.

For example, the Interactive Bubble Graph widget below allows dashboard analysts to drill into each bubble in the graph by clicking it. Analysts can also use the time animation toolbar at the top of the widget to watch the bubbles appear on the graph in chronological order.
For more examples and instructions to create and format widgets, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets*.

Each of these different kinds of controls is referred to as a control type.

Dragging and dropping a dataset object onto the Layout area of the Document Editor creates a control. If the dragged object is a dataset report, a Grid/Graph is created; otherwise, a text field containing the dataset object is added to the Layout area. When the document is displayed as a PDF, the Grid/Graph is displayed like a MicroStrategy report; the text field displays the elements or values of the dataset object.

The document section in which a control is placed determines not only the location of the values but also whether it is repeated and at what level it is calculated. For example, some document sections, such as the Page Header or Page Footer, are appropriate for displaying page numbers because those sections are automatically repeated throughout the document. For a summary of the different document sections, see *Document sections and metric calculations, page 17*.

A metric placed in different document sections is calculated differently. In the Detail section, the metric is calculated at the level of the attribute element, while the same metric placed in the Group Header section is calculated at the level of the group. This is described as an overview in *Document sections and metric calculations, page 17*.

After you add controls, you can move and arrange them to determine how they appear when the document is viewed as a PDF. For instructions and examples of the various ways in which you can move and arrange controls, see the *Document Creation Guide*.

**Document sections and metric calculations**

A document contains multiple document sections, although most dashboards use only one document section. Using only one allows you to easily design a dashboard using the whole screen. For example, if you create a new document using the Blank Dashboard template, only the Detail Header is displayed.

The document section that you place a control in determines where the control is displayed on the document. For a metric, the level of calculation depends on its location in the document, as summarized below. This allows you to create metric totals in documents, such as a grand total or a group total. When a metric is placed in a document section other than the Detail
section, the metric is calculated using the dynamic aggregation specified in the metric definition.

A document or dashboard can contain any of the following document sections:

• **Page Header and Page Footer**: Display at the top and bottom, respectively, of every page in the document.

  A metric in a text field in the Page Header or Page Footer calculates a grand total across the entire dataset.

• **Document Header and Document Footer**: Display at the beginning and end, respectively, of the document.

  A metric in a text field in the Document Header or Document Footer calculates a grand total across the entire dataset.

  If a document contains multiple layouts, the Document Header and Document Footer are replaced by the Layout Header and Layout Footer, which display at the beginning and end, respectively, of the layout. For an overview of multi-layout documents, see *Multi-layout documents, page 19*; for examples and instructions, see the *Document Creation Guide* or *Desktop Help*.

• **Detail Header and Detail Footer**: Display just before and just after the Detail section. It is often used for column headers and other identifying information.

• **Detail**: Displays the main content of a document. One row prints for each row of data in the document’s dataset. Typically, this is where you place most of the attributes and metrics. The Detail section provides the most detailed or granular information.

  A metric in a text field in the Detail section calculates at the level of the dataset report.

• **Group Header and Group Footer (if the document is grouped)**: Display at the beginning and end, respectively, of the group. Each group in the document has its own Group Header and Group Footer.

  A metric in a text field in the Group Header or Group Footer section calculates a total for that group.

For a more in-depth description of the various document sections, including explanations of where they appear when the document is generated and the type of information they typically contain, see the *Document Creation Guide*. For a more in-depth description of how metrics aggregate depending which
document section they are placed in, as well as placing metrics in Grid/Graphs affect the calculations, see the Document Creation Guide.

**Multi-layout documents**

A multi-layout document contains multiple documents, each in its own layout, creating a “book” of documents. Each layout functions as a separate document, with its own grouping, page setup, and so on, but the layouts are generated into a single PDF document.

In the table of contents shown below, the first-level headings are the different layouts. Each was a separate document that was imported into a single multi-layout document. Note that the pages are numbered sequentially, from the beginning of the document to the end.

<table>
<thead>
<tr>
<th>Regional Performance Management Dashboard</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Performance Dashboard</td>
<td>3</td>
</tr>
<tr>
<td>Category Sales and Profit Performance</td>
<td>5</td>
</tr>
<tr>
<td>Electronics</td>
<td>5</td>
</tr>
<tr>
<td>Computers</td>
<td>7</td>
</tr>
<tr>
<td>Central</td>
<td>11</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>19</td>
</tr>
<tr>
<td>Northeast</td>
<td>19</td>
</tr>
<tr>
<td>Northwest</td>
<td>23</td>
</tr>
<tr>
<td>South</td>
<td>27</td>
</tr>
<tr>
<td>Southeast</td>
<td>31</td>
</tr>
<tr>
<td>Southwest</td>
<td>38</td>
</tr>
</tbody>
</table>

In Design View, the layouts are displayed as tabs, so that you can easily switch between layouts. Tabs are also displayed in all modes in MicroStrategy Web.

For instructions to create a multi-layout document and import existing documents into a multi-layout document, as well as more examples and details about how a multi-layout document works, see the Document Creation Guide or Desktop Help.

**About Visual Insight: Analyses**

Visual Insight allows you to create customized, interactive analyses that you can use to explore your business data. You create and interact with analyses.
in MicroStrategy Web. In Desktop, you can view analyses, with a limited range of interactivity.

Analyses are similar to documents, and in Desktop can be displayed in Flash View, HTML View, or PDF View, as well as Design View. In Flash View, you can interact with an analysis in the following ways:

- View the data as a grid, graph, or widget (these views are created in Web, and you can select which to display)
- Interact with widgets
- Sort the data
- Move attributes and metrics around the template, quickly swapping objects between the rows and columns of the analysis
- Select which page of data to display

In HTML View and PDF View, the analysis is displayed as a static document. You can update and modify the document in Design View. You can therefore use an analysis as a starting point for a document, to add data and a structure to the document. Switch to the Document Editor to add formatting and fine-tune the document.

Saving the analysis in Desktop converts it to a document; it cannot be converted back to an analysis.

**Analyses in MicroStrategy Web**

In MicroStrategy Web, you can interact with an analysis in the following ways:

- View the data as a grid, graph, or widget:
  - Add the data to a graphical representation, such as a bar graph or pie chart
  - Display the data in an interactive widget, such as a Google Map, Graph Matrix, or Heat Map
- Filter the data, by the elements of an attribute or the value of a metric
- Group the data, by selecting the attributes to page by, and then selecting which element to display
- Sort data
• Drill into the data

• Move attributes and metrics around the template, quickly swapping objects between the rows and columns of the analysis

• Add data from existing reports, documents, and Intelligent Cubes

In MicroStrategy Web, you can quickly and efficiently create a meaningful display, since you do not need to switch to Design View to change the data that is displayed in the analysis. You can quickly create an analysis from an existing source: a report, document, or Intelligent Cube. Once you select the data from the source, the data is automatically added to an interactive grid. You can immediately begin sorting, pivoting, and filtering data. For information on working with analyses in MicroStrategy Web, including instructions and examples, see the MicroStrategy Report Services Document Analysis Guide or the MicroStrategy Web Help. For information on creating analyses in MicroStrategy Web, including instructions and examples, see the MicroStrategy Web Help.
Introduction

A dashboard is a special type of document. A dashboard is commonly only one page long, is intended to be viewed online, and usually provides interactive features that let analysts change how they view the dashboard’s data. By being only one page long, a dashboard makes it easy to view the entire document at the same time and see all the information. A dashboard allows interactivity from users, so each user can change how they see the data, within the limits of what the controls allow them.

The designer can create more flexible data presentations with dashboards than with documents, since more users can be served with a single dashboard. Each user can interact with the dashboard to display only the subset of data they are interested in (using panels and selectors) or only specific attribute elements or metrics (using a selector). Panels and selectors are described in detail later in this chapter (see Chapter 3, Layering Data: Panels and Panel Stacks and Chapter 4, Providing Interactivity to Users: Selectors).

This chapter assumes that you understand the various MicroStrategy controls (such as Grid/Graphs, text fields, and so on) discussed elsewhere in this guide; understanding these controls is important to understanding panels and selectors in dashboards.
About dashboards

This chapter describes dashboards and how to create them. The chapter includes the following sections:

- *What is a dashboard?*, page 24
- *Adding interactivity to dashboards*, page 26
- *Design ideas and examples*, page 35
- *Designing the right dashboard*, page 38
- *Best practices for dashboarding*, page 40
- *Creating a dashboard: the Blank Dashboard template*, page 49
- *Exporting dashboards to Flash for stand-alone use*, page 55
- *Enabling transition animations in Flash*, page 57
- *Uncluttering the dashboard: Full screen mode*, page 58

Flash Player version 10.1 is required to view and interact with dashboards in Flash Mode.

What is a dashboard?

A dashboard is a display of related sets of data on one screen. A dashboard is commonly used to assess company or personal performance, to take a quick status check of the company, or to monitor personal work or work group contributions to overall goals of the business. Dashboards summarize key business indicators by presenting them in visually intuitive, easy-to-read, interactive documents.
The following dashboard presents several common dashboarding qualities:

Common dashboard characteristics in the example shown above include:

- The gauge, which shows corporate revenue at a glance.
- The two graphs, which display regional and product performance in an easy-to-understand format.
- The buttons at the top right (Corporate, Regional, and City), which allow a user to view different areas of the business, providing a quick status check across the company. This set of buttons is one of the interactive features of the dashboard. Interactive features are described in *Adding interactivity to dashboards, page 26*.

More generally, a typical dashboard contains the following characteristics:

- Only one page, so that it is easy to view the entire dashboard and see all the information.
- Used online rather than printed out.
• Provides interactive functionality so users can change how they see the data. For example, a user can select exactly which data to see by selecting metrics or attribute elements to be displayed in a Grid/Graph.

There is no single feature that you use to design a dashboard; you can choose selectors, widgets, panels, and other controls, to create a personalized, custom dashboard that suits your user’s specific needs. Various formatting options such as gradient colors and 3D effects also help you create dashboards with a style appropriate for the boardroom.

Adding interactivity to dashboards

A key aspect of a dashboard is the interactivity it allows. Interactivity lets analysts dynamically change the data displayed in Grid/Graphs or change other objects on the dashboard.

You can add interactivity to your dashboards using a mix of the following features.

Analyzing specific attributes, elements, or metrics: Button bar

In the dashboard sample above, the buttons in the Subcategory Analysis grid can be used to change the product category displayed.

The dashboard initially displays data for the Music category. Click the Books button to show data for that product category instead, as shown below.

<table>
<thead>
<tr>
<th>Subcategory Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
</tr>
<tr>
<td>Subcategory</td>
</tr>
<tr>
<td>Science &amp; Technology</td>
</tr>
<tr>
<td>Art &amp; Architecture</td>
</tr>
<tr>
<td>Business</td>
</tr>
<tr>
<td>Sports &amp; Health</td>
</tr>
<tr>
<td>Literature</td>
</tr>
<tr>
<td>Books - Miscellaneous</td>
</tr>
</tbody>
</table>
This example uses a Grid/Graph and a button bar selector. For a description of Grid/Graphs and procedures to create them, see the Document Creation Guide or the Desktop Help. For a description of selectors and procedures to create them, see Chapter 4, Providing Interactivity to Users: Selectors.

**Analyzing across the company: Button bar**

Another example of a button bar in this example is the buttons at the top right of the dashboard. An analyst can use them to switch views, displaying a different set of grids and graphs which show a different set of data.

When you click the **Regional** button at the top of the dashboard, a different set of grids and graphs is displayed, as shown below:

![Corporate Sales Overview](image)

*Category Analysis*

<table>
<thead>
<tr>
<th>Category</th>
<th>Profit Margin</th>
<th>Units Sold</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>21.56%</td>
<td>192,666</td>
<td>$6,640,094</td>
</tr>
<tr>
<td>Electronics</td>
<td>17.59%</td>
<td>63,734</td>
<td>$24,381,100</td>
</tr>
<tr>
<td>Merces</td>
<td>10.21%</td>
<td>267,611</td>
<td>$4,093,943</td>
</tr>
<tr>
<td>Mexico</td>
<td>4.62%</td>
<td>265,684</td>
<td>$3,893,287</td>
</tr>
</tbody>
</table>

*Subcategory Revenue by Payment Type*

**Analyzing ranges of time: Slider**

In the dashboard sample in *What is a dashboard?, page 24*, an analyst can use the slider along the bottom of the Regional Performance graph to change
the length of time displayed and specific range of time covered in the graph’s data.

The dashboard initially displays regional performance for August 2005 to February 2006. You can move the slider to change the range of time, for example, to display March to May 2008. You can extend the length of time displayed by dragging the right end of the slider to lengthen or shorten the slider. The graph now shows performance for March to September 2008, as shown below.

![Regional Performance Graph](image)

This example uses a Grid/Graph and a slider-style selector. For a description of Grid/Graphs and procedures to create them, see the Document Creation Guide or the Desktop Help. For a description of selectors and procedures to create them, see Chapter 4, Providing Interactivity to Users: Selectors.

**Analysis at a glance: Gauges, thermometers, cylinders, funnels**

You can use objects such as gauge graphs, funnel graphs, gauge widgets, thermometer widgets, and cylinder widgets to provide dashboard analysts with a quick view of important KPIs. These graphs and widgets are good for analyzing data at a quick glance. They are most effective when placed near the top of a dashboard.
The image below is an example of a gauge graph that is used at the top of a dashboard to highlight corporate revenue and regional performance.

![Corporate Performance (YTD)](image)

Revenue in millions of dollars

The image below is an example of a funnel graph that provides a quick look at current revenue projections.

![Current Revenue Projection - $1,342,500](image)

*Select Funnel Series to display Opportunities below*
The image below is an example of a thermometer widget in a dashboard in MicroStrategy Web. It allows a dashboard analyst to quickly glance at the number of units sold.

The image below is an example of a cylinder widget in a dashboard in MicroStrategy Web. A dashboard analyst such as a regional manager can quickly glance at the cylinder to see how much revenue was produced.
For descriptions and examples of the widgets that you can add to a dashboard, as well procedures to add them, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets*.

**Organizing interactivity features on a dashboard**

The result of a user’s interactive selections can affect multiple objects simultaneously. You can design this using a panel stack, which is a collection of panels, each of which can contain groups of objects. Panels help you display only those groups of data that should be seen at the same time.

Additional features let the user navigate between panels, and quickly change the display of data within a panel. Each is described below.

**Panels and panel stacks**

A control is any selectable item in the dashboard’s Layout area. This can be a text field, line, rectangle, image, panel, panel stack, selector, or Grid/Graph object. When designing a dashboard, controls are organized together in small groups. These groups of controls are placed in a holder called a panel. Because the controls are grouped together on a panel, they can be presented to the dashboard user one group at a time. This lets the designer create several different views (or panels) of data, each view (panel) containing a logical grouping of controls that display data that is related in some meaningful way.

A panel stack is a collection of individual panels, stacked on top of each other. Only one panel can be displayed at a time. An analyst can flip from panel to panel within a dashboard’s panel stack, displaying exactly the set of information he wants to see grouped together on the screen.

The sample dashboard shown in the examples above uses a panel stack to provide the Corporate, Regional, and City “views”. Each view is an individual panel in the panel stack.

For more information, examples, and procedures for panels and panel stacks, see *Chapter 3, Layering Data: Panels and Panel Stacks*.
Selectors

A selector is an element of a dashboard that allows a user to change the data he is viewing. A selector can be displayed as a button bar, a drop-down list, radio buttons, and so on. A selector can change panels or the focus of a Grid/Graph. Examples of selectors are shown below:

```
<table>
<thead>
<tr>
<th>Head Count</th>
<th>Regional Revenue</th>
<th>Monthly Profit</th>
<th>Head Count</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>⊗ Regional Revenue</td>
<td>⊗ Monthly Profit</td>
<td>⊗ Head Count</td>
</tr>
</tbody>
</table>
```

Selectors allow a user, in Interactive Mode and Editable Mode in MicroStrategy Web, to:

- Flip through the panels in a panel stack to display the different panels. The selector for the panel stack in the sample dashboard is a button bar, which appears to the analyst as the “view” buttons.
- Display different attribute elements or metrics in a Grid/Graph. For example, a user can slice or filter the data on a graph by selecting specific regions or metrics. In the sample dashboard, the slider is the selector for the Regional Performance graph, while the category buttons are the selector for the Subcategory Analysis grid.

For more information, examples, and procedures for selectors, see Chapter 4, Providing Interactivity to Users: Selectors.

Title bars

A title bar is simply an area across the top of a panel stack or Grid/Graph. You can choose whether to display the title bar for each panel stack and Grid/Graph. When it is displayed, the title bar contains a title and several buttons.

- The title identifies the panel, panel stack, or Grid/Graph.
- The buttons allow users to minimize and maximize Grid/Graphs in MicroStrategy Web.

For examples and procedures to add a title bar to a Grid/Graph, see the Document Creation Guide or Desktop Help. For examples and procedures to add a title bar to a panel stack, see Displaying the title bar of a panel stack, page 71.
**Quick switch**

Quick switch is a button that allows an analyst to quickly change a Grid/Graph from Graph view to Grid view and back, with a single click. The quick switch button is available in MicroStrategy Web only, in both Interactive Mode and Editable Mode; you cannot use it in Desktop. However, in Desktop you can determine whether quick switch is available in Web.

The button to perform the quick switch is located at the top of the Grid/Graph, as shown below.

For instructions to enable quick switch, see the *Grid/Graphs* chapter of the *Document Creation Guide* or the *Desktop Help*.

**Widgets**

A widget is a type of Report Services control that presents data in a visual and interactive way. You can think of widgets as interactive Flash-only graphs that dynamically update when you select a new set of data to view. The dashboard user can even interact with some types of widgets to manually select a set of data to analyze. A variety of widget types, such as Gauge, Heat Map, and Stacked Area widgets, are available for use in MicroStrategy dashboards. Although each type of widget looks different and is used in a unique way, the main purpose of all widgets remains the same: to provide dashboard analysts with a visual and interactive look into their data.

For example, the Interactive Bubble Graph widget below allows dashboard analysts to drill into each bubble in the graph by clicking it. Analysts can also use the time animation toolbar at the top of the widget to watch the bubbles appear on the graph in chronological order.
Graph styles for dashboards

The following graph styles are particularly suitable to use in graph reports included in dashboards:

- Gauge
- Funnel
- Area
- Vertical stacked bar
- Combination: Line and horizontal bar
- Bubble
- Pie

For information about designing these types of graphs, see the Graphing chapter in the MicroStrategy Advanced Reporting Guide.
Design ideas and examples

Additional design ideas can be found in *Best practices for dashboarding, page 40.*

- Design a dashboard that monitors individual or group contributions to overall business goals. Provide a gauge widget or thermometer widget so users can measure their progress toward goals at a glance. For example, use a widget to showcase some key metrics, such as average number of transactions per customer, or average revenue per customer. For more information on widgets, see Chapter 5, *Providing Flash Analysis and Interactivity: Widgets.*

- Design a dashboard for regional sales managers at two levels: One level shows an overview of sales in the region, and the other level contains grid reports displaying details on each account representative’s individual accounts. The following two images show samples of each of these levels in a single dashboard. The first image shows the regional (or Territory) overview level:
The next image shows the second layer, displaying details of the accounts for each account representative:

The layers in this dashboard were created using panel stacks and selectors. For more information, see Chapter 3, Layering Data: Panels and Panel Stacks and Chapter 4, Providing Interactivity to Users: Selectors.

- Design a key performance indicators dashboard that lets users look at one or more gauges to instantly assess key performance data. Provide graphs that let users compare current performance against established targets so they can identify opportunities or issues. Include a report or two that
provide supporting data so users can see what is behind the performance numbers. An example is shown below.

- Design a financial dashboard that monitors all key financial statements in one screen. For example, you might include an income statement as the main feature of the dashboard, then add a smaller grid report and a graph report below it. Add a selector to the income statement and connect it to the two supporting reports. When a user selects a line item in the income statement, such as Total Operating Expenses, the supporting reports show detailed operating expenses in the grid, and actual and planned operating expenses by quarter in the graph.

Designing a simulated portal environment

You can create a dashboard with the look and feel of a portal. To do this, add several Grid/Graph objects to the dashboard. Each one will display a grid or graph report. Then add the following functionality to each Grid/Graph:

- Add a title bar to each Grid/Graph. Be sure to enable the Minimize/Maximize feature on the title bar. Users can click a button to minimize...
any “portlet window” to use their screen space efficiently and to focus more easily on pertinent reports. For instructions, see the Desktop Help.

- Connect one Grid/Graph to a related Grid/Graph. This means that when the user changes the data displayed in one of the dashboard reports, the connected report automatically updates to coordinate its display of the related information. For more information, see Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.

Designing the right dashboard

The following table lists common goals for dashboards and provides suggestions on how to achieve them. This table can also provide ideas about what you might want to include in your dashboards.

<table>
<thead>
<tr>
<th>Dashboard Goal</th>
<th>Features to Use on the Dashboard</th>
</tr>
</thead>
</table>
| Present a style appropriate for the executive boardroom. | • Use drop shadows, gradients, 3D effects, and rounded rectangles on various parts of the dashboard. For examples and procedures for these effects, see the Document Creation Guide or the Desktop Help.  
  • Use 3D effects, bevels, gradients, transparency, and curved lines on graphs in the dashboard. For examples and procedures, see the Document Creation Guide or Desktop Help. |
| Instantly show details in a densely populated dashboard. | • Enable tooltips in graphs, so that users can mouse-over graph data to see underlying data in detailed form. See Document Creation Guide or the Desktop Help for instructions.  
  • Apply quick switch to Grid/Graphs so that Web users can switch between Graph view and Grid view, allowing detailed data to be seen in a table. For an example and procedure, see the Desktop Help.  
  • Use Grid/Graphs with title bars to allow an area to be enlarged to see details on complex graphs or grids. For examples and procedures, see the Desktop Help. |
| Present many layers of data in a single dashboard, keeping the layers organized and focused. The layers, or views of the data, must be instantly available to the users. | Use panels and panel stacks to provide the layers of data in the following ways:  
  • Multiple independent layers within a single dashboard page  
  • Multiple independent dashboard pages layered within a single dashboard  
For examples and procedures, see Chapter 3, Layering Data: Panels and Panel Stacks. |
<table>
<thead>
<tr>
<th>Dashboard Goal</th>
<th>Features to Use on the Dashboard</th>
</tr>
</thead>
</table>
| Allow users to change the context of dashboard. For example, a user can change the following for a specified set of graphs or tables:  
  • The focus of the KPI  
  • The timeframe being viewed  
  • The subject areas displayed |  
  • Add selectors that target attribute elements so that users can change the context of the data. You can use a wide range of selectors: radio buttons, check boxes, drop-down lists, and so on. For examples and procedures, see Chapter 4, Providing Interactivity to Users: Selectors.  
  • Define an attribute in a Grid/Graph as a selector that targets a panel stack or another Grid/Graph. Users can then click an attribute element in the Grid/Graph and initiate a context change in related Grid/Graphs on the dashboard. For examples and procedures, see Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183. |
| Create dashboards in Flash that can be used even when disconnected from the network. These dashboards include full interactivity, visualization, and data content. |  
  • Embed Flash dashboards within Microsoft Office documents, including Word, PowerPoint, Excel, and Outlook. For more information, refer to the MicroStrategy Office User Guide.  
  • Embed Flash dashboards within emails and distribute them. For more information on this Narrowcast Server feature, see the Narrowcast Server documentation. |
| Use interactive Flash graphs rather than static graphs to provide an engaging way to view data and understand relationships. |  
  • Use time series animation to allow users to play graphical “movies,” driven by data, that provide rapid insight into business trends. Users can rewind and fast forward through a time series. They can also pause the movie and drill down for more details. For an example, see Creating a Time Series Slider widget, page 276.  
  • Use the library of visualization widgets in MicroStrategy Web to extend the display of information beyond traditional graphing. See Chapter 5, Providing Flash Analysis and Interactivity: Widgets. |
| Unlimited visualization extensibility via Flash uses MicroStrategy's integration with Adobe's FlexBuilder 2 IDE to allow you to:  
  • Expand your library of visualizations  
  • Extend the reach of your business intelligence to operational applications |  
  • Build any visualization you need using FlexBuilder IDE integration and add it to your MicroStrategy library of visualizations.  
  • Customize any Flex-compatible visualization and add it to your MicroStrategy library of visualizations.  
  • Use the Adobe FlexBuilder integration to add MicroStrategy dashboards and reports to any Flex-compatible Rich Internet Application (RIA).  
  
For more information on MicroStrategy’s Visualization Framework, the FlexBuilder plug-in, and the visualization editor, see the MicroStrategy Developer Library (MSDL) provided with MicroStrategy SDK. In particular, the Understanding the Visualization Framework section is helpful. The path to this section in the MSDL is Web SDK -> Integrating with an External Application -> Visualization Integration.  
  
To purchase MicroStrategy SDK, contact your account executive for more information. |
Best practices for dashboarding

The goal of most dashboards is to magnify specific points of data, making them easy for users to identify. To achieve this goal effectively, you must make certain decisions before you begin creating your dashboard.

These best practices are grouped into the following sections:

- Choosing datasets for a dashboard, page 41
- Layering information in a dashboard, page 42
- Planning the dashboard’s outline and structure, page 43
- Placing the data and visualizations onto a dashboard, page 45
- Positioning and formatting the dashboard objects, page 46
- Enhancing dashboard performance, page 47
- Best practices: Designing Flash dashboards for printing, page 48

For information on the objects that allow you to implement these objectives, see the following sections:

- Chapter 3, Layering Data: Panels and Panel Stacks
- Chapter 4, Providing Interactivity to Users: Selectors
- Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183
- Chapter 5, Providing Flash Analysis and Interactivity: Widgets
- Enabling transition animations in Flash, page 57
- Title bars, page 32, for panel stacks and Grid/Graphs
- Quick switch, page 33, for Grid/Graphs
- Linking to other documents and to reports (drilling) in the Document Creation Guide

For general best practices related to designing a document, see the Document Creation Guide.
Choosing datasets for a dashboard

You can use existing reports and documents as datasets in a new dashboard. This can save you time and help avoid unnecessary duplication in your MicroStrategy metadata. You can also create new datasets for your dashboard.

• A dataset should have enough data to be useful as a rich source of analysis for many users, but it should not have extra data that is not needed on the dashboard. For example, do not include product item information when you only want to display product category information.

• As you gather or create datasets, focus on important indicators such as performance stakes, trends, and variances.

• Users typically browse a large number of reports somewhat randomly, looking for interesting trends. You can gather related reports to use on your dashboard, so that all the data is available together in a single context. Users can then locate the data more easily and analyze it more efficiently.

• When choosing reports to incorporate into a single layer on a dashboard (a dashboard page or panel), consider the ratio of graph to grid reports to display. Common graph:grid ratios range from 4:1 to 1:3. The average graph:grid ratio from a general sample of dashboards was approximately 2:1.

• Consider using a dashboard to replace 8-12 existing reports in your MicroStrategy project. You will generally use 3-5 reports on each layer of the dashboard; dashboards generally have from 1 to 3 layers (see Layering information in a dashboard, page 42).

• Consider using a dashboard to replace three to four existing documents in your MicroStrategy project. If you have three documents that contain data from a related subject area, you can use each document as a single layer (or panel) of your dashboard. Having all this related information in one dashboard can provide a more productive analysis experience for your users.

For example, you have three documents for your human resources department. Each document is related to salaries and other benefits, headcounts, or hiring. Create a dashboard with a panel stack sized to take up the entire screen. Add two more panels so you have three panels in the panel stack. Then re-create the first document on the first panel of the dashboard, the second document on the second panel, and so on. Add a selector of three tabs (buttons) at the top of the panel stack. Users can tab between the layers of human resources data, depending on whether they
are interested in headcounts, hiring, or salaries. The image below shows a sample of this dashboard:

Layering information in a dashboard

- Plan to have from one to three layers for your dashboard. You can visualize these layers as pages of your dashboard; analysts will see one page at a time. Multiple layers allow you to design a dashboard that contains much more information overall, but presents only a reasonable subset of that information in the layer currently being displayed.

- Create layers by adding a panel stack to your dashboard. Size the panel stack so it is large enough to take up the entire screen. Then place enough panels on the panel stack to equal the number of layers needed in your dashboard. Each panel becomes one layer of your dashboard. Finally, create a set of tabs above the panel stack by adding a button or link bar selector, with one tab (button) for each layer (panel).
• Consider grouping data by layers according to subject areas or business dimensions, with one subject area or business dimension per layer. For example, one layer might show income at the corporate level, while a second layer might also show income but at a departmental level or a regional level. The final layer might show detailed income data. This lets you serve diverse user communities without overwhelming users, as they can each flip to and work with the dashboard layer that specifically interests them.

• Consider grouping data by layers according to regions of the country or regions of the world, so that, for example, sales metrics can be displayed within a given regional context.

Planning the dashboard’s outline and structure

• Use Microsoft Excel, Paint, PowerPoint, or another tool to create a mock-up of the dashboard. The mock-up should convey a clear vision of the information, structure, layout, and formatting. Send the mock-up to your user community to gather feedback on its usefulness. This can save time creating and formatting a complex, finished dashboard that may need to be redone.

• The Quick switch feature lets users toggle between grid display and graph display without requesting data from the server. The Quick switch feature can therefore help improve response time for users.

• To minimize the amount of data passed between the web server and the web browser:
  □ Use the grouping feature and/or incremental fetch, for dashboards designed to be viewed in MicroStrategy Web. For instructions to group a dashboard or implement incremental fetch, see the Document Creation Guide or Desktop Help.
  □ Use selectors for attributes and metrics if a dashboard will be viewed in DHTML mode in Web. This is not necessary if users will be viewing dashboards in Flash mode, because all dashboard data is downloaded to the web browser when the dashboard is executed.

• Group related reports so they can be placed in a small panel stack, each panel displaying a single report. As users flip through the panels, they will be flipping through the related reports. The reports in a panel stack should not be reports that a user might want to see side by side in a dashboard; rather, the reports should show different levels of detail about the same or closely related data.
• Plan to provide visualizations. These can include any of the available widgets, such as a gauge, thermometer, heat map, and so on, which can help users understand data at a glance.

  Do not add so many graphical objects that the focus of the dashboard is no longer the data. Too many visualizations can detract from the importance of the data.

• Plan to provide interactivity. This can include any of the available selectors, such as tabs, buttons, and sliders, which let users change a report’s metrics, attribute elements, and filters, or interactive widgets. Interactive features let users customize the display of data without needing a developer or designer to perform any work.

• Consider common user workflows when designing a dashboard. Think about how analysts are going to move through the dashboard, what links they will want to click, and so on. Try to embed this workflow directly into the dashboard. Do this by placing objects so that data can be interpreted from the top left to the bottom right.

• Granularity should increase from top to bottom on a dashboard. For example, place objects that display key performance indicators at the top of the dashboard. These objects might include large graphs such as a funnel graph (also called a pipeline), a pie graph, widgets such as a gauge, and so on.

• Allow users to drill within the dashboard to determine the level of detail that they need to display. Use pre-defined drill paths to direct the users' analysis. Drilling can provide more details and more information without interrupting the workflow. Use links to other dashboards, documents, or prompted reports to provide the drilling paths.

• Decide which objects on the dashboard should share the same formatting styles, and which objects should be physically aligned with each other. These decisions are important time-savers if you make them before you spend a lot of time actually formatting objects and fine-tuning object placement.

• Use effects for trends, summaries, and other high-level data. If users want to analyze details in a report, too many effects can make it difficult to understand more detailed data.

  For example, if you apply the curved effect to the line in a line graph, the exact points where the line hits the graph are adjusted so that the line can be curved smoothly. This looks nice, but users who rely on seeing every detail will have difficulty. If you want to apply the curved effect, you can also provide a grid report alongside showing exact
values. An alternative is adding tooltips which display actual values for points on the graph when you move the cursor over the graph.

### Placing the data and visualizations onto a dashboard

- Place reports into appropriate areas on the dashboard, and then resize them as needed to achieve your planned appearance. Placement should take into account the user workflow and granularity discussions above. Also, a user usually looks to the upper left first, and the bottom right last. Large graphics grab a user’s attention, no matter where they are placed.

- Keep the number of objects on the screen to a minimum, to achieve a clean look. Use graphical objects sparingly. Make use of abbreviated text in text fields as appropriate, to make the best use of space. You can add a tooltip (a mouseover) to explain any abbreviations that may not be clear to all users.

- For any graph or widget, provide a tooltip (a mouseover) so that users who are interested in specific details can see the actual values behind the general trends displayed by graphic visualizations. This is an excellent way to support two sets of users who need widely differing levels of information on the same subjects.

- Provide a quick switch capability for all graph reports, so users can switch with a single click between the graphical display of data and its corresponding grid report showing individual cells with specific values.

- Provide a title bar on reports (Grid/Graphs) on the dashboard so users can maximize and minimize the individual reports. This ability to minimize and maximize reports provides users with a portal-like environment, with each report behaving like a portlet window. This allows users to control how space is used on their screens, and to focus on the data they are interested in.

- If you have a panel stack on the dashboard, add a selector so users can flip between the panels on the panel stack.

- Sliders are best used on graphs that specify a date range. Sliders can not only change the time frame of the data displayed in a report or set of reports, they can also change the span of time being analyzed.

- If you have related reports on a dashboard layer, add a selector to one of the reports and connect it to the related report. When users choose to see a certain aspect of the first report, the second report automatically changes to display the related data. When the user clicks on one grid or graph, his selection serves as a filter for the related grid or graph. For
example, in a pie graph showing revenue for all products, a user clicks a slice of the pie graph representing electronics revenue. The connected report below the pie graph, displaying detailed sales numbers, automatically updates its data to reflect the user’s selection, displaying sales numbers for various electronic products.

- Add selectors to different parts of the dashboard so users can customize the data they see at many levels. For example, add a selector at the top of the dashboard itself, so users can switch between layers of the dashboard. Then add a selector at the top of an individual layer, so users can change metrics, for example, to change the focus of that layer of the dashboard. Finally, add a selector to each of the reports on that layer, so users can focus the details of their analysis on a specific area.

### Positioning and formatting the dashboard objects

- Use the color palette to match your corporate standards, or create any other color desired. Consider the following best practices:
  - Colors are especially effective when used as a background that visually groups a set of reports or other related objects.
  - Contrasting colors support quick comparisons between two measurements, such as actual vs. forecasted values.
- To make visual analysis easy, use drop shadows, rounded edges, geometric lines and shapes, color gradients, transparency, and borders to visually link related sets of data. For example, group related sections of information under the same title bar and use the same background color to tie them together visually.
- Include text fields as needed. For example, a concise text field explaining a set of buttons can make the difference between users who are confused by a busy layout, and users who know exactly what to select so that the data displayed provides the information they need.
- Edit titles as necessary to make sense of your final display.
- Improve readability for grid reports by adding special formatting, such as background colors or a drop shadow, to alternating or important rows so those rows stand out.
- Add thresholds to any important grid report data. A threshold is special formatting that is applied automatically when a value in a cell reaches a certain number. For example, if any of your regions returns sales numbers that fall below a specified low mark, the appropriate cell of the
grid is automatically formatted, perhaps with a red background and bold numbers, to alert you to the condition. For details on applying thresholds to grid and graph reports, see the *MicroStrategy Basic Reporting Guide*.

- If there are other reports or documents that cover analysis areas related to data on your dashboard, consider adding one to three link bars, which are links from the dashboard directly to the separate report or document. You may find it helpful to ask your users what common investigative paths they might follow after using the dashboard. Links can help make that transition easy.

- If a grid report takes up too much room, make it smaller and add a scrollbar. The data will remain accessible but the report itself will use less space on the total dashboard area.

- Display your finished dashboard in the same format your users will be viewing it in—for example, HTML, PDF, Excel, or printed—and ensure that the display is effective for your planned output.

**Enhancing dashboard performance**

- Use as few datasets as possible when designing the dashboard. For example, one dataset report with 1000 rows displays faster than ten smaller dataset reports. However, be aware that combining dataset reports can create a Cartesian join, which inflates the size of the combined dataset and results in slower performance.

- Having all the data in the rows negatively impacts the rendering time for Editable Mode and Interactive Mode in MicroStrategy Web.

- A selector with many items (for example, the buttons or check boxes) increases the time it takes for the dashboard to execute. For example, if you increase the number of items by a factor of ten, server execution times can increase up to 50%. In essence, a larger number of items translates into a larger dataset.

- Flash Mode in MicroStrategy Web provides better performance when selectors have many targets. (A target is a Grid/Graph and/or panel stack affected by the selectors.)

- A selector that controls attributes displayed on a Grid/Graph performs faster than a selector that controls attributes that are not displayed on a Grid/Graph.
• When you place a panel stack on a panel, you are nesting panel stacks. Nesting panel stacks increases client rendering time. To reduce that time, include data in both panel stacks, not just the nested panel stack.

• In Flash Mode in MicroStrategy Web, after the dashboard is initially loaded, manipulations such as choosing a selector item are executed on the client machine. In contrast, such manipulations in Interactive Mode send additional requests from Web Server to Intelligence Server. Since Flash Mode uses minimal server resources after the initial load is complete, system overhead is reduced for multiple users concurrently manipulating their dashboards. Therefore, Flash Mode has faster response times for manipulations, regardless of the number of users accessing the dashboard. However, these same users must accept longer dashboard execution times due to the initial loading of Flash.

• In MicroStrategy Web, graphs perform better in Flash Mode than in Editable Mode and Interactive Mode.

Best practices: Designing Flash dashboards for printing

If your dashboard contains Flash content, such as interactive widgets, consider formatting the dashboard to help ensure that your dashboard is displayed correctly when it is printed.

The following recommendations are designed to optimize print quality for a Flash dashboard printed on 8.5” x 11” paper. When printing your dashboard using a different paper size, you may need to modify the settings below to accommodate your dashboard. Be sure to test your dashboard by printing it to ensure that the content is printed as expected.

When designing a Flash dashboard for printing, make sure of the following to help ensure that your dashboard is displayed correctly:

• The paper size selected in the printer’s print options should be 8.5 x 11.
• The dashboard’s Paper Size option should be set to Letter 8.5” x 11”. For steps to modify the Paper Size, see the Designing and Creating Documents chapter in the Document Creation Guide.
• The left, right, top, and bottom margins for the dashboard should be set to .75”. For steps to define the page margins for a dashboard, see the Designing and Creating Documents chapter in the Document Creation Guide.
• The Document Zoom Level option for the dashboard should be set to Fit Page. To specify the Document Zoom Level for a dashboard open in Web, click Home from the menu bar of the dashboard. The Home options are displayed in the dashboard’s toolbar. From the second drop-down list, select Fit Page.

• Leave a margin of .1” between any content in the dashboard and the dashboard’s rightmost edge.

• Leave a margin of 2.5” between any content in the dashboard and the dashboard’s bottom edge.

• Be sure that the dashboard is exported using the PDF file format when the user chooses to export the dashboard to Flash. To do so, you must set the Export to Flash option to PDF in Desktop. For steps, see the Desktop Help.

Once you have configured your dashboard with the above settings, users can print the dashboard by first exporting the dashboard to Flash. Once the dashboard opens in a new window, users can then print the dashboard as they would any PDF file. For steps to export a document or dashboard to Flash, see the MicroStrategy Web Help.

Creating a dashboard: the Blank Dashboard template

A document template provides a predefined structure to help you create a new document or dashboard. Any new dashboard made using a document template contains the same underlying datasets, fields, formatting, and layouts as the template dashboard. After the new dashboard is created, you can customize the new dashboard as you want.

MicroStrategy provides predefined document templates, including the Blank Document template and the Blank Dashboard template. Use the Blank
Dashboard template to help you create the look and feel of a dashboard with the key features described below:

- A dashboard is commonly only one page long, so the Blank Dashboard template uses only one document section. The height of the document section is defined as seven inches.

  For descriptions of the various document sections that are available in a document, see *Document sections and metric calculations, page 17.*

- Grid/Graphs are formatted with a background fill and a border. Title bars are displayed for Grid/Graphs, and they use a gradient color (a two-color combination) to provide more sophisticated formatting. The Grid/Graph has a fixed width and height; if the Grid/Graph is larger, scroll bars are displayed.

  These defaults help you create the feel of a portal if you include several Grid/Graphs on your dashboard. A user can display all the Grid/Graphs, or minimize the ones that are not relevant at the moment to focus on a particular Grid/Graph.

- Panel stacks are formatted with a background fill and a title bar. The title bars, which help users identify the objects, are formatted with a gradient color. Again, these defaults help you create the feel of a dashboard or a portal.

The following dashboard, which is shown in Design View, was created using the Blank Dashboard template. It contains a Grid/Graph and a panel stack.
Notice that the Grid/Graph is formatted with a light grey background fill (the Backcolor).

These are the default settings of the Blank Dashboard, so you can change them if necessary. For example, you can change the height of the section, display additional sections, remove title bars from a Grid/Graph, and so on.

Other predefined dashboard templates provide other common structures for dashboards, such as four evenly-spaced panel stacks to place contents in, one panel stack on the left side of the dashboard and two smaller ones on the right, or a text field across the top of the dashboard for a title bar with a panel stack below it.

To create a traditional document rather than a dashboard, use the Blank Document template.

For information on title bars, see Title bars, page 32. For a description and an example of a Grid/Graph, see About Visual Insight: Analyses, page 19; for more detailed examples and procedures to create and format Grid/Graphs, see the Document Creation Guide. For a detailed description, examples, and procedures to create panel stacks, see Chapter 3, Layering Data: Panels and Panel Stacks.
To create a dashboard using the Blank Dashboard template

1. From the File menu, point to New, and then select Document. The New Document dialog box opens, showing a selection of pre-designed document templates.

   If the Select a report dialog box opens, object templates are disabled for documents. You must enable them before you can select a document template. For instructions, see the Desktop Help.

2. Click the Dashboards tab, select Blank Dashboard, and then click OK. The Select a Report dialog box opens.

3. Navigate through the report folders and select the MicroStrategy report or reports to use as datasets. To select multiple reports, hold the SHIFT or CTRL key while selecting the reports.

   If you select multiple reports, all the selected reports are added to the dashboard. The first dataset in alphabetical order is defined as the grouping and sorting dataset. You can sort and group the dashboard using fields from the grouping and sorting dataset only. For instructions to change the grouping and sorting dataset and background information on using multiple datasets in dashboard, see the Document Creation Guide or Desktop Help.

4. Click OK. The Document Editor opens.

   The datasets that you chose are displayed in the Datasets pane.

5. Add data fields, auto text codes, text labels, images, panel stacks, selectors, widgets, and other controls. For instructions, see:

   - Chapter 3, Layering Data: Panels and Panel Stacks
   - Chapter 4, Providing Interactivity to Users: Selectors
   - Chapter 5, Providing Flash Analysis and Interactivity: Widgets

   For procedures to add any other objects, see the Desktop Help.

6. Arrange the controls as you like. For instructions, see the Desktop Help.

7. Format the various controls and sections, as well as the dashboard as a whole. For descriptions of the various formatting options, and instructions to apply them, see the Desktop Help.
8 Group and sort the data. For instructions and background information, see the Desktop Help.

9 Add totals, if desired. For instructions, see the Document Creation Guide or Desktop Help.

10 Save the dashboard by selecting Save from the File menu.

11 You can now preview how the dashboard will display in MicroStrategy Web. This is useful to help you size and place objects. You can also manipulate the data in some of the ways that are available in Flash Mode.

   • Use Flash View to preview the document as it will look in Flash mode in MicroStrategy Web. You can use selectors and perform some manipulations such as pivoting and sorting. To open the dashboard in Flash View, from the View menu, select Flash.

   • Use HTML View to preview the document as it will look in other MicroStrategy Web modes. To open the dashboard in HTML View, from the View menu, select HTML.

12 For a list of actions that you can perform in Flash View and HTML View, see the MicroStrategy Document Analysis Guide or the Desktop Help.

13 To print the dashboard, use PDF View, as described in Printing a document, page 4.

Designing a dashboard with the Blank Document template

You can create a dashboard using the standard MicroStrategy document template, which is named the Blank Document; all the standard document sections are displayed by default. However, you can hide or display sections to help you create a dashboard.

For instructions, see the Document Creation Guide or the Desktop Help.

Creating document templates

You can create new document templates by:

   • Creating the template from scratch, as described in To create a new template for dashboards, page 54.

To export a document template, page 54, and To import a document template, page 55.

Copying dashboards across projects using portable documents. Unlike a document template imported and exported between projects, a portable document can contain dependencies on schema or application objects, such as a dataset report. After importing a portable document into a project, you reconcile the document to the new project. For more details on portable documents and the reconciliation process, including reasons to use them and instructions, see the Document Creation Guide.

To create a new template for dashboards

If you want a dashboard to be available as a template so that you can format your other dashboards based on it, either save it or copy it to the following folder:

Project name\Object Templates\Documents

The dashboard will then be available as a template for selection in the New Document dialog box when you create a new document or dashboard.

The Object Templates folder is hidden by default. To display it, follow the directions below.

To display the hidden Object Templates folder

1 In Desktop, from the Tools menu, select Desktop Preferences. The Desktop Preferences dialog box opens.

2 Click the Desktop tab.

3 Click Browsing Options.

4 Select the Display Hidden Objects check box and click OK.

To export a document template

A document or dashboard can be exported from one project and then imported into another project to use as a template to create a new document.
or dashboard. The document cannot have any dependencies on schema or application objects, such as a dataset report.

1 In Desktop, select the document or dashboard to export.

2 From the Tools menu, select Export Document Template. The Browse for Folder dialog box opens.

3 Navigate to the folder to save the file in, then click OK.

The document, named document_name.rst, is saved in the selected folder.

**To import a document template**

After you export a document or dashboard from one project, you can import it into another project to use it as a template to create new documents and dashboards.

1 From the Tools menu in Desktop, select Import Document Template. The Open dialog box opens.

2 Navigate to and select the file to import as a document template.

3 Click Open.

The document template is saved in the Object Templates/Documents folder in Desktop.

**Exporting dashboards to Flash for stand-alone use**

After you create a dashboard, adding widgets, selectors, and other Flash content, users can view it and interact with it in Flash Mode in MicroStrategy Web. If you export the dashboard to a Flash file, users can also view it and interact with it off-line, without a connection to MicroStrategy Intelligence Server or MicroStrategy Web Server. The Flash file is a fully interactive, stand-alone Flash dashboard. The Flash file allows HTML content, images, Flash content, and other types of information to be exported in a single file that can be opened by an Internet browser.
For background information on exporting dashboards to Flash, including whether to export to an MHT file or PDF file, see the MicroStrategy Document Analysis Guide.

---

To export a dashboard to Flash

1. Open the dashboard in Design View or PDF View.

2. Switch to Flash View by clicking the Flash View icon on the toolbar.
   - If the Flash View icon is not available, you must enable Flash View. For instructions, see Determining the display modes users can choose to work in, page 56.

3. From the File menu, select Export to Flash.
   - If the Export to Flash option is unavailable, you must select Flash as an export format. For instructions, see the Document Creation Guide or Desktop Help.

4. Name and save the file. Do not change the file type.

---

Formatting dashboards

Determining the display modes users can choose to work in

The document designer can select the modes that are available for a specific document by enabling each mode that you want to make available for users to view the document.

For descriptions of the modes, see Display modes in MicroStrategy Web, page 8.

---

To select display modes to be available to users

1. In MicroStrategy Web, open a document in Design or Editable Mode.
2 From the **Tools** menu, click **Document Properties**. The Properties dialog box opens.

3 From the left, select **Document**.

4 To make a mode available in the document, select the check box in the **Available display modes** column for that display mode. For example, if you want to ensure that Flash Mode is the only display mode available for the document to be viewed in, select that check box.

5 Clear the check boxes for any display modes that you do not want users to have access to for this document.

6 Click **OK** to apply the changes and return to the document. The next time the document is executed, only the display modes that you selected are available in the **View** menu or on the **Standard** toolbar.

---

**Enabling transition animations in Flash**

You may notice that when controls such as Grid/Graphs and panel stacks are first displayed in Flash Mode in MicroStrategy Web, they fade in as they are being displayed. These visual animations are transitions that you can enable in Grid/Graphs and panel stacks. For example, you can specify whether a transition animation takes place when a user chooses an item in a selector that affects a Grid/Graph. The affected Grid/Graph can fade slowly onto the screen once a user selects an item from a selector in the dashboard.

You can select the type of transition to use and also the speed of the transition. Examples of the types of transitions include Blur, Fade, and Wipe Down. The speed can be:

- **Very slow**
- **Slow**
- **Medium**
- **Fast**
- **Very fast**

You can also set the speed to automatic; the speed is then determined by the type of transition.
To enable a transition animation for Flash Mode (Web)

1. Open the dashboard using the Document Editor in Design View.
2. Select the Grid/Graph or panel stack to update.
3. In the Property List: Flash section, select a type of transition animation from the Selected transition drop-down list. This is the animation that is used when users switch to Flash Mode in Web.
4. Select the speed from the Speed drop-down list. This determines how quickly the transition animation takes place for the object. If you select Automatic, the speed is determined by the type of transition.

You can also use the Properties dialog box to enable a transition animation.

To view the transition animation, you must open the dashboard in Flash Mode in MicroStrategy Web.

Uncluttering the dashboard: Full screen mode

You may want Web users to view a dashboard or other document without all the navigation information—toolbars, menus, and panels such as the Datasets pane—located on the interface. Hiding the navigation information:

- Focuses attention on the data itself
- Allows easier analysis of the data by maximizing the amount of the dashboard that can be shown at one time

This view in MicroStrategy Web is called Full Screen mode, and it is particularly helpful when analyzing a dashboard that contains multiple Grid/Graphs, sections, and images. Full Screen mode helps you create interfaces that are easy for users to read.

For example, the first image below shows a Shipping Analysis dashboard in MicroStrategy Web. The screen area at the top is used by the various MicroStrategy Web toolbars and menus. The same dashboard is viewed in
Full Screen mode in the second image. More of the dashboard is displayed in the same space.

Shipping Analysis

The Shipping Timeliness report focuses on the effectiveness of the Distribution Centers in fulfilling orders. Days to Ship represents the number of days between an Order’s Order Date and Ship Date.

### Fargo

<table>
<thead>
<tr>
<th>Days to Ship</th>
<th>Number of Orders</th>
<th>Order Totals (K$)</th>
<th>% Orders Shipped</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>219</td>
<td>46</td>
<td>6%</td>
</tr>
<tr>
<td>2</td>
<td>149</td>
<td>37</td>
<td>10%</td>
</tr>
<tr>
<td>3</td>
<td>1,823</td>
<td>422</td>
<td>59%</td>
</tr>
<tr>
<td>4</td>
<td>1,193</td>
<td>757</td>
<td>91%</td>
</tr>
</tbody>
</table>

### Milwaukee

<table>
<thead>
<tr>
<th>Days to Ship</th>
<th>Number of Orders</th>
<th>Order Totals (K$)</th>
<th>% Orders Shipped</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>219</td>
<td>46</td>
<td>6%</td>
</tr>
<tr>
<td>2</td>
<td>149</td>
<td>37</td>
<td>10%</td>
</tr>
<tr>
<td>3</td>
<td>1,823</td>
<td>422</td>
<td>59%</td>
</tr>
<tr>
<td>4</td>
<td>1,193</td>
<td>257</td>
<td>91%</td>
</tr>
<tr>
<td>5</td>
<td>347</td>
<td>88</td>
<td>100%</td>
</tr>
</tbody>
</table>
MicroStrategy Web’s core set of toolbar buttons and the Grouping panel still appear in Full Screen mode, so the user can interact with the dashboard as usual.

• The toolbar buttons allow you to quickly switch viewing modes, save, print, export, and deliver the dashboard, among other tasks.

• The Grouping panel allows you to display the different groups of data in the dashboard.

Full Screen mode is available in MicroStrategy Web only; you cannot use it in Desktop. However, in Desktop you can select whether a dashboard automatically appears in Full Screen mode when a user opens it in Web. The following procedure shows you how to ensure a dashboard opens in Full Screen mode by default.

For more information on working with dashboards in MicroStrategy Web, see Display modes in MicroStrategy Web, page 8 or the MicroStrategy Document Analysis Guide.

---

**To have a dashboard open in Full Screen mode**

1. Open the dashboard using the Document Editor in Design View.


3. On the Document tab, select the **Always open this document in full screen mode** check box.

4. Click **OK** to return to the dashboard.

The next time this dashboard is opened in MicroStrategy Web, it is displayed in Full Screen mode. Web users can switch between full screen mode and normal view by clicking the Full Screen Mode icon.
3

LAYERING DATA: PANELS AND PANEL STACKS

Introduction

A control is any selectable item in the dashboard’s area. This can be a text field, line, rectangle, image, panel, panel stack, selector, or Grid/Graph object. When designing a dashboard, controls are organized together in small groups. These groups of controls are placed in a holder called a panel. Because the controls are grouped together on a panel, they can be presented to the dashboard user one group at a time. This lets the designer create several different views (or panels) of data, each view (panel) containing a logical grouping of controls that display data that is related in some meaningful way.

A panel stack is a collection of individual panels, stacked on top of each other. Only one panel can be displayed at a time. An analyst can flip from panel to panel within a dashboard’s panel stack, displaying exactly the set of information he wants to see grouped together on the screen.
About panels and panel stacks

A control is a Grid/Graph, text field, shape, and so on. You can display different controls in a dashboard so that users can navigate them as if they were pages or subsets of the larger document. These “pages” or layers of data are called panels, and a group of panels is referred to as a panel stack. Panel stacks allow a designer to create several different views (panels) of data, with each view (panel) containing a logical grouping of controls that display data that is related in a meaningful way.

Panels are essential building blocks for interactive dashboards, which summarize key business indicators in easy-to-read interfaces. For an in-depth explanation of dashboards, see What is a dashboard?, page 24.

Use panel stacks to provide interactive data layering. You can create:

- Stacks of analytic layers on a single dashboard page by creating two panels, each containing a different Grid/Graph. In Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web, a user can flip between the panels, quickly replacing one Grid/Graph with the other. Using panels in this fashion permits many independent layers of data within a single dashboard page.

- Multiple layers of dashboards by adding multiple controls to each panel of a panel stack. This creates layers of complex dashboards.

- An Information Window, to display additional information about an attribute element. A user clicks an element in a grid or graph. The Information Window pops up over the element, displaying an additional visualization, based on the element. Information Windows are displayed in Express Mode and Flash Mode in MicroStrategy Web, and in documents displayed in MicroStrategy Mobile. For an example and instructions to create an Information Window, see Defining Information Windows, page 81.

- A panel of selectors, which allows users to filter targets and interact with the various filters (for an example and a more detailed description, see Filtering a dashboard: Filter panels, page 84).

The first two methods are described in the examples that follow, Example: Layering Grid/Graphs on panels, page 63 and Example: Layering multiple dashboards in a single document, page 64.
The rest of the chapter describes how to create and format panels and panel stacks:

- *Defining the parts of a panel stack, page 66*
- *Inserting and defining panels, page 69*
- *Loading panels on demand in MicroStrategy Web, page 79*
- *Formatting panels and panel stacks, page 91*

These procedures apply to panel stacks and to filter panels, with the following exceptions:

- For instructions to create a filter panel, see *Filtering a dashboard: Filter panels, page 84.*

- Filter panels have an additional setting that determines whether or not changes to the selectors on the filter panel are automatically submitted. For instructions to change this setting, see *Controlling how data updates in a filter panel: Automatic apply, page 89.*

**Example: Layering Grid/Graphs on panels**

For example, you can stack two panels, each containing a different Grid/Graph. In Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web, a user can flip between the panels, quickly replacing one Grid/Graph with the other. In the following image, a Grid/Graph is displayed on a panel. Notice the name of the panel, in the title bar at top of the panel: Employee Info by Region. Notice also that the Grid/Graph is the only control on the panel.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Cost</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$720,449</td>
<td>$126,778</td>
<td>$847,227</td>
</tr>
<tr>
<td>Central</td>
<td>Gale</td>
<td>Loren</td>
<td>$1,416,036</td>
<td>$253,254</td>
<td>$1,669,290</td>
</tr>
<tr>
<td>Central</td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,430,865</td>
<td>$259,465</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Central</td>
<td>Zemlicka</td>
<td>George</td>
<td>$697,693</td>
<td>$124,807</td>
<td>$822,500</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$901,702</td>
<td>$159,930</td>
<td>$1,060,632</td>
</tr>
</tbody>
</table>

Above the Grid/Graph is a list box containing the names of the panels in the panel stack: Employee Info by Region and Category Sales Report. When you select the Category Sales Report, the other panel is displayed. Notice the
name of the panel in the title bar: Category Sales Report. Also, notice that this panel includes a text field in addition to the Grid/Graph. The text field reads “Forecast based on 2002-2004 data.”

Using panels in this fashion allows many independent layers of data within a single dashboard page. You can also layer dashboards in a single document with the use of panels, as described in the next example.

The list box is a selector, a type of control which allows a user to interact with the panel stack. While selectors are discussed briefly throughout this section, more details on creating them and examples of their various options are provided in *Chapter 4, Providing Interactivity to Users: Selectors.*

**Example: Layering multiple dashboards in a single document**

The example above placed only one or two controls (Grid/Graphs and a text field) on each panel. However, you can add multiple controls to each panel of a panel stack, creating layers of complex dashboards. For example, the following dashboard contains a gauge for corporate revenue, a bubble graph for category analysis, a line graph for regional performance, and a grid report for subcategory analysis. A button bar labeled Select View is displayed at the
top left of the dashboard, and the Corporate button is currently selected. This dashboard provides a company-wide view of revenue and performance.

If you click Regional in the Select View button bar, another dashboard is displayed. As shown below, this dashboard contains an area graph for daily revenue, a grid report for category analysis, and a bar graph for subcategory
revenue. This dashboard provides a more detailed view of information, at the regional and daily level.

Each of these dashboards is on a panel, and the Select View button bar is a selector that allows you to switch between the panels. Using panels to layer multiple dashboards in the same document can organize related information and provide increasing levels of detail on different dashboards.

**Defining the parts of a panel stack**

The **panel stack** is the holder for a group of panels. You must add a panel stack before you can insert more panels (a new panel stack already contains one panel). The **panels** contain the controls (Grid/Graphs, text fields, and so on) that display the data, such as metrics and graphs, that a user sees.

The border of the panel stack is visible to the user. The border settings include 3D borders, drop shadows, and rounded corners (displayed in Flash Mode only), as well as standard border options such as color and style. The
background color comes from the individual panel; you can format each panel to have a different background color.

Most of the settings that control a group of panels are set in the panel stack. These settings include whether a title bar or pop-up text is displayed, as well as size and position information.

The **title bar**, when displayed, is an area across the top of the panels that shows the title. You can choose whether the title bar displays the name of the panel stack or of the panel currently being displayed. By default, the title bar also displays Next and Previous arrows to allow users to change panels, although you can hide these arrows. For an example of the arrows, see *Panel selector arrows on the title bar, page 73.*

The **current panel** is the panel currently displayed in Design View. This panel is displayed on the panel stack when the dashboard is viewed in PDF View or in MicroStrategy Web.

If a panel stack contains more than one panel, a user needs a way to change panels. By default, the title bar displays arrows that allow users to move through the panels. If you choose to hide the arrows or hide the title bar, you need to add a **selector**, such as a radio button or pull-down list, to allow users to display the different panels of a panel stack.

- When a user switches to PDF View or to Express Mode in MicroStrategy Web, whichever panel was current becomes the only panel displayed, as well as the only panel that can be printed. The user cannot change to a different panel in PDF View or Express Mode.
- In Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web, a user can click the selector to switch panels.

A selector is not part of a panel stack, unlike the other items described in this section. A selector is a different type of control and is added to the dashboard separately. The title bar, for instance, is an area of the panel stack, and each panel is contained in the panel stack. However, a selector is an important and necessary addition to a panel stack because a selector allows the user to switch panels. The selector can also display the names of the different panels, so that a user can tell at a glance which panel he wants to view. The default arrow selectors on the title bar do not display the panel names. For more information, including examples and procedures, about selectors, see *Chapter 4, Providing Interactivity to Users: Selectors.*

The following diagram shows a panel stack and the selector that targets it, in Design View. The panel is the light gray area containing the text fields Region and Revenue. The title bar is the darker gray area at the top, labeled Panel1. The panel stack border is displayed as a thick black line; note that it
surrounds the entire panel, including the panel and the title bar. The selector (labeled Elements Selector) is a separate control placed above the panel stack. In MicroStrategy Web, the selector allows the user to choose the region to display.

The following diagram shows the same panel stack and selector in Interactive Mode in MicroStrategy Web. The panel, panel stack, and border appear the same, except that the text fields have been replaced by data. The selector is rendered as a drop-down list of the regions. The Central region has been selected, so its data is displayed in the panel.

Panel stacks and automatic target maintenance for selectors

Selectors allow a user to display different elements of attributes, custom groups, or consolidations in a panel stack (the target of the selector). Targets can be automatically maintained in a layout. This means that when you add a panel stack, the panel stack automatically becomes the target of all selectors in the same panel or document section as the panel stack. For more information about automatically maintaining targets for selectors, including
instructions to enable and disable the functionality, see *Automatically maintaining targets for selectors, page 134.*

Selectors can also allow a user to flip through the panels in a panel stack. Targets are not automatically maintained for this type of selector; you always manually define the targets for panel selectors.

## Inserting and defining panels

To insert and define panels, follow the high-level steps below:

1. Insert a panel stack (the holder for the panels). A single panel is automatically added to the panel stack. For instructions, see *Inserting a panel stack, page 70.*

2. By default, the title bar, which displays either the panel stack title or the panel name to help identify the panel stack, is displayed. The title bar also displays, by default, arrows to allow users to flip through the panels. For instructions to hide and display the title bar, and examples of a title bar, see *Displaying the title bar of a panel stack, page 71.* For instructions to hide and display the arrows, and an example of the arrows, see *Panel selector arrows on the title bar, page 73.* (If you hide the arrows or the title bar, you should add a selector to allow users to switch between panels, as described below.)

3. Insert as many additional panels as you need to hold the layers of data. For instructions, see *Inserting additional panels in a panel stack, page 75.*

4. Add controls to each panel, to display the data. You can add Grid/Graphs, text fields, shapes, images, and panel stacks, just as you can to a dashboard. For a brief description of these controls, see *Chapter 1, Document Review;* for more detailed descriptions, including examples and procedures, see the *Document Creation Guide* or the *Desktop Help.*

5. Panels are displayed in the order in which they were added. If you want to display them in a different order, move the panels to reorder them. For an example and instructions, see *Changing the display order of panels, page 77.*

6. Ensure that the correct panel will be displayed when the user initially views the dashboard. For instructions, see *Choosing the panel to display initially: the current panel, page 78.*
7 Determine how to load panels in panel stacks when the dashboard is viewed in MicroStrategy Web. All the panels can be pre-loaded, or only the first panel. For instructions, see *Loading panels on demand in MicroStrategy Web, page 79*.

- When all the panels are pre-loaded, they display immediately when the user selects a different panel.

- However, if the user is unlikely to access all the panels in a panel stack, or if you want to optimize the initial load time of the dashboard, you can specify that the panels load only when a user changes to a different panel. Note that this on-demand panel loading only occurs when the dashboard is executed in MicroStrategy Web with DHTML enabled.

8 Format the panel stack, panels, and title bar (if displayed). For examples and procedures, see *Formatting panels and panel stacks, page 91*.

9 (Optional) Add a selector to allow the user to switch between panels. See *Chapter 4, Providing Interactivity to Users: Selectors*.

By default, the title bar displays arrows that allow users to move through the panels. If you choose to hide the arrows or hide the title bar, add a selector, such as a radio button or pull-down list, to allow users to switch between the different panels of a panel stack. A selector can also display the names of the different panels, so that a user can tell at a glance which panel he wants to view. The arrow selectors on the title bar do not display the panel names.

### Inserting a panel stack

To create panels, you must first insert a panel stack (the holder for the collection of panels) into the dashboard. A new panel stack already shows a single panel by default. After you insert a panel stack, you can add more panels to it.

The following procedure walks you through inserting a panel stack.

---

**To insert a panel stack**

1 Open the dashboard using the Document Editor in Design View.
2 If you used the Blank Dashboard template to create the document, only one section is displayed. If you used a different template:

- Expand the section where you want the panel stack by clicking the plus sign next to the section name.

You cannot add a panel stack in the Details section. Since controls in the Detail section are repeated once per row of the dataset, the panel stack would be repeated on each row.

3 From the Insert menu, select Panel Stack or click the Panel Stack icon in the toolbar. When you move the cursor to the Layout area, the pointer becomes crosshairs.

4 Click in the desired location in the Layout area. If you click and drag in the Layout area, you can size the panel stack.

The panel stack is added to the dashboard, with a single panel. Next, you can display a title bar (see below) or insert additional panels (see page 75).

**Displaying the title bar of a panel stack**

For each panel stack you can choose whether to show the title bar, which displays either the title of the panel stack or the name of the current panel to help identify what the user is looking at. By default, the name of the panel currently displayed on the panel stack is shown in the title bar, as shown below. When a user switches panels, the name in the title bar changes.

You can choose to display the same title regardless of which panel is displayed. To do this, display the panel stack title instead of the panel name,
and then specify the title for the panel stack. The same panel stack is shown below, with the panel stack title displayed instead.

The following image shows a similar panel stack without a title bar.

For a filter panel (a type of panel stack that contains only selectors), the title bar allows a user to clear all filters, and expand or collapse all the filters. For an example of a filter panel with a title bar, see Filtering a dashboard: Filter panels, page 84.
Panel selector arrows on the title bar

The title bar of a panel stack displays **Next** and **Previous** arrows to allow users to change panels, as shown below:

The arrow on the left allows a user to display the previous panel in the panel stack. The arrow on the right is grayed out because this is the last panel in the panel stack.

These arrows are displayed by default, but you can hide them from users by following the steps in *To hide the panel selector arrows on the title bar, page 75*. Hiding the arrows also disables changing panels in iPad documents by horizontal swiping. For background information on using selectors in iPad documents, see the *MicroStrategy Mobile Design and Administration Guide*.

If you hide the arrows or the title bar that they display in, you should create a selector that targets the panel stack and allows users to change panels. For instructions, see *Methods to create a selector, page 117*.

The following procedures walk you through displaying or hiding the title bar, specifying the height of the title bar, and displaying or hiding the panel selector arrows.

These procedures continue where the previous procedure, *To insert a panel stack, page 70*, finished. They assume you have already created a panel stack and are still in the Document Editor in Design View.

---

**To display the title bar**

1. Select the panel stack in the Layout area.
2 In the **Property List: View** section, set **Show title bar** to **True**. A title bar is displayed on the panel stack in the Layout area.

3 By default, the name of the panel currently displayed on the panel stack is shown in the title bar. To display the title of the panel stack instead:

- Change **Title bar display** to **Title of panel stack**.
- The title of the panel stack is blank by default. To change it, type the desired text into the **Title** field.

---

**To hide the title bar**

1 Select the panel stack in the Layout area.

2 In the **Property List: View** section, set **Show title bar** to **False**.

For a filter panel (a type of panel stack that contains only selectors), the title bar allows a user to clear all filters, and expand or collapse all the filters. If you remove the title bar from a filter panel, a user cannot make those changes. For background information on filter panels, including examples and instructions, see *Filtering a dashboard: Filter panels, page 84*.

---

**To display the panel selector arrows on the title bar**

1 Right-click the panel stack in the Layout area, and select **Properties**. The Properties dialog box opens.

2 On the **General** tab, select the **Allow current panel to be changed without selector** check box.

Displaying the arrows also enables changing panels in iPad documents by horizontal swiping. For background information on changing panels in iPad documents, see the *MicroStrategy Mobile Design and Administration Guide*.

3 Click **OK** to return to the dashboard.
To hide the panel selector arrows on the title bar

1. Right-click the panel stack in the Layout area, and select Properties. The Properties dialog box opens.

2. On the General tab, clear the Allow current panel to be changed without selector check box.

   Hiding the arrows also disables changing panels in iPad documents by horizontal swiping. For background information on using selectors in iPad documents, see the MicroStrategy Mobile Design and Administration Guide.

3. Click OK to return to the dashboard.

To specify the height of the title bar

By default, the height of the title bar is .2 inches, but you can change it.

1. Select the panel stack in the Layout area.

2. In the Property List: View section, enter the height in the Title height field.

Inserting additional panels in a panel stack

Insert as many additional panels as you need to hold the layers of data.

When you add a panel, it is added after the currently displayed panel. For example, a panel stack contains Panel1, Panel2, and Panel3, in that order. Panel2 is displayed. A new panel (Panel4) is added. The order of the panels is now Panel1, Panel2, Panel4, and Panel3. That order can be changed; see Changing the display order of panels, page 77 for instructions.

The new panel is now displayed on the panel stack. To continue with the example above, Panel4 is displayed instead of Panel2. It is therefore the current panel, which is displayed when a user views the dashboard in another view. For more information about the current panel, and how to change it, see Choosing the panel to display initially: the current panel, page 78.
By default, panels are named Panel1, Panel2, and so on, but you can rename them. You may want to give the panels more meaningful names since the panel name is shown in the selector (the button bar or other object that allows a user to switch panels) and can be displayed in the title bar. The following procedures walk you through inserting and renaming a panel.

These procedures continue where the previous procedure, *Inserting a panel stack*, page 70 or *Displaying the title bar of a panel stack*, page 71, finished. They assume you have already created a panel stack and are still in the Document Editor in Design View.

These procedures use the Property List, but you can also use the Properties dialog box for the same tasks.

---

**To insert an additional panel in a panel stack**

1. Right-click the panel stack, point to Panels, and then select **Insert**.

   The new panel is added to the panel stack, after the selected panel. The new panel is displayed on the panel stack, which means that the new panel is set as the current panel. You can do any of the following next:
   - Add another panel
   - Rename a panel (see below)
   - Change the display order of the panels (see page 77)
   - Choose the panel to display initially (see page 78)

---

**To copy an existing panel**

1. Right-click the panel stack, point to Panels, and select **Display Next** or **Display Previous** to display the panel to be copied.

2. Right-click the panel stack, point to Panels, and then select **Duplicate**.

   The new panel is added to the panel stack, after the selected panel. The new panel is displayed on the panel stack, which means that is set as the the current panel. You can do any of the following next:
   - Add another panel
   - Rename a panel (see below)
• Change the display order of the panels (see page 77)
• Choose the panel to display initially (see page 78)

To rename a panel

1 Right-click the panel stack, point to Panels, and then select Manage. The Panels tab of the Properties dialog box opens.

2 In the panel list, select the panel to rename.

3 Click Rename.

4 Type the new name in the panel list, and then press ENTER.

5 Click OK to return to the document.

Changing the display order of panels

The order in which you add panels to a panel stack affects the order in which they are displayed in the selector (such as a row of buttons) attached to the panel stack. For example, a panel stack contains three panels. By default, the panels are named Panel1, Panel2, and Panel3, in the order they were added. The selector attached to the panel stack is a button array. It displays Panel1 on the left, Panel3 on the right, and Panel2 in the middle, as shown below.

<table>
<thead>
<tr>
<th>Panel 1</th>
<th>Panel 2</th>
<th>Panel 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td>Region</td>
<td>Metrics</td>
</tr>
<tr>
<td>Bates</td>
<td>Michael</td>
<td>Southwest</td>
</tr>
<tr>
<td>Becker</td>
<td>Kyle</td>
<td>Northwest</td>
</tr>
<tr>
<td>Bell</td>
<td>Caitlin</td>
<td>Southwest</td>
</tr>
<tr>
<td>Benner</td>
<td>Ian</td>
<td>Southeast</td>
</tr>
<tr>
<td>Bernstein</td>
<td>Lawrence</td>
<td>Mid-Atlantic</td>
</tr>
</tbody>
</table>

If this display order is incorrect, you can move the panels to change the order. See the procedure below for instructions.
To change the display order of panels

This procedure continues where the previous procedure, To insert an additional panel in a panel stack, page 76, finished.

1 Right-click the panel stack, point to Panels, and then select Manage. The Panels tab of the Properties dialog box opens.

   If you only have two or three panels, select Move Forward or Move Backward instead of Manage. Since these options move one panel at a time, using the Properties dialog box is more efficient if you have a large number of panels.

2 Select a panel in the list of panels, and select one of the options described below:

   • Use Move Forward to incrementally move the selected panel forward in the panel stack.
   • Use Move Backward to incrementally move the selected panel backward in the panel stack.

3 Click OK to return to the dashboard.

Next, you can specify the current panel, which is the panel that is initially displayed.

Choosing the panel to display initially: the current panel

You can choose which panel should be displayed on the panel stack when the dashboard is viewed in PDF View or in MicroStrategy Web. This is referred to as the current panel.

When a user switches to PDF View, the current panel is the only one displayed as well as the only one that can be printed. In MicroStrategy Web, the current panel is displayed when a user first opens the dashboard, but the user can change to a different panel by using a selector.

The panel displayed in Design View is set as the current panel. If you add a panel to a panel stack, the new panel becomes the current panel. To select a different panel for the current panel, follow the instructions below.
In MicroStrategy Web, the current panel is displayed when a user first opens the dashboard, although he can use a selector to change to a different panel. If DHTML is enabled and panels are defined to load on demand, only the current panel is downloaded when the dashboard is executed in MicroStrategy Web; other panels are loaded when the user requests them. If the panel stack is defined to pre-load all the panels, all the panels are downloaded when the dashboard is executed. For more information about loading panels, including instructions, see *Loading panels on demand in MicroStrategy Web, page 79.*

---

**To choose the panel to display initially**

This procedure continues where the previous procedure, *To change the display order of panels, page 78,* finished.

1. Right-click the panel stack, point to Panels, and then select Manage. The Panels tab of the Properties dialog box opens.

2. Select the panel from the list of panels.

3. Click Set as Current to choose the selected panel to display initially.

4. Click OK to return to the dashboard.

The selected panel is displayed in the panel stack. Next, you can format the panel stack, individual panels, and (if displayed) the title bar.

---

**Loading panels on demand in MicroStrategy Web**

In MicroStrategy Web, all the panels of a panel stack can load when the dashboard is executed, even though only one panel is displayed to the user. This ensures that these pre-loaded panels display immediately when the user selects a different panel. However, if the user is unlikely to access all the panels in a panel stack, or if you want to optimize the initial load time of the dashboard, you can specify that the panels load on demand.

When panels are loaded on demand, only one panel is loaded when the dashboard is executed in MicroStrategy Web. Other panels are loaded only when the user selects them. The dashboard therefore opens faster, although panels loaded on demand will take some time to load when they are selected.
After a panel is loaded, it remains cached on the client until the dashboard is closed.

On-demand panel loading occurs when the dashboard is executed in MicroStrategy Web with DHTML enabled. In Desktop, only the current panel is displayed, selectors are not active, and therefore other panels are not available. On-demand panel loading does not occur in Flash View (Desktop) or Flash Mode (MicroStrategy Web).

If your browser supports DHTML, DHTML is enabled in MicroStrategy Web by default. For more information on DHTML, and instructions to enable it, see the MicroStrategy Web Help.

You can define how panels are loaded at two levels:

• For all the panel stacks in the document (the document-level setting)
• For each panel stack

This allows you to easily set different panel load settings for different panel stacks. For example, a dashboard contains multiple panel stacks. You want to pre-load all the panels of all the panel stacks, except for the panel stack that contains many panels. At the document level, define the default panel load setting to pre-load all panels. For the specific panel stack, specify that only the current panel is pre-loaded. Instructions for both levels follow.

**To specify the default panel load setting for all panel stacks in a dashboard**

The document-level setting applies to all panel stacks that use the default panel load setting. You can change the panel load setting for specific panel stacks as well, as described in *To specify how to load panels for a specific panel stack, page 81.*

This setting applies to all layouts of a multi-layout document. For a brief description of multi-layout documents, see *Multi-layout documents, page 19;* for more details, including examples and procedures, see the Document Creation Guide.

1 Open the dashboard using the Document Editor in Design View.

2 From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.

3 Select **Advanced**.
4 Choose one of the **Pre-load** options:

- **To pre-load all panels when the dashboard is executed in MicroStrategy Web**, unless the panel load setting for a specific panel stack is defined differently, select **All panels of all panel stacks**.
- **To load only the current panel of all the panel stacks in the dashboard**, select **Current panel only of all panel stacks**. Other panels are loaded when the user requests them.

Panels are loaded on demand only in MicroStrategy Web when DHTML is enabled. For steps to enable DHTML, see the *MicroStrategy Web Help*.

5 Click **OK** to return to the dashboard.

---

**To specify how to load panels for a specific panel stack**

1 Open the document using the Document Editor in Design View.

2 Right-click the panel stack to modify and select **Properties**. The Properties dialog box opens.

3 Select one of the following **Pre-load (DHTML only)** settings:

- **To use the document-level setting**, select **Inherit from document**.
- **To pre-load all panels when the dashboard is executed in MicroStrategy Web**, select **All panels**.
- **To load only the current panel when the dashboard is executed in MicroStrategy Web**, select **Current panel only**.

Panels are loaded on demand only in MicroStrategy Web when DHTML is enabled. For instructions on enabling DHTML, see the *MicroStrategy Web Help*.

4 Click **OK** to return to the dashboard.

---

**Defining Information Windows**

Information Windows let users view additional information about an attribute element by tapping the element in a grid or graph. The Information
Window pops up over the element, displaying an additional visualization, based on the element. An example of an Information Window in an iPad dashboard is shown below:

In this example, the Region column in the grid is used as a selector. When a user taps an element in the column, the Information Window appears.

The Information Window displays on MicroStrategy Mobile, and in Express Mode and Flash Mode in MicroStrategy Web. The Information Window shown below is displayed in Express Mode:
In other MicroStrategy Web modes, the Information Window is displayed as a panel stack in the location that you added it to the dashboard, not as a tooltip over the Grid/Graph. The Information Window is still interactive, controlled by the Grid/Graph.

The following are suggestions for controls to add to an Information Window:

- Images, such as corporate logos or buttons. For instructions to add images to a dashboard, see the *Document Creation Guide* or *Desktop Help*.

- Data fields to display information about attributes and metrics in the dashboards, or other details. For example, you can add the \{Store@Name\} data field to an Information Window. When the store location is selected in the widget, the Information Window displays the name of the store. For instructions to add data fields to a dashboard, see the *Document Creation Guide* or *Desktop Help*.

- Links to mobile device applications, such as a link to call the phone number of a selected store location. For steps to add a link to a mobile device application, see the *MicroStrategy Mobile Design and Administration Guide*.

- Links to other reports, dashboards, or documents. For steps to add a link to a mobile document, see the *MicroStrategy Mobile Design and Administration Guide*.

**Prerequisites**

The following procedure assumes that the dashboard contains:

- A panel stack that will be used as the Information Window. The panel stack must contain a Grid/Graph with data related to the Grid/Graph used as a selector. In the example above, the panel stack contains a pie chart representation of yearly revenue by region. For instructions to create a panel stack, see *Inserting and defining panels, page 69*.

- A Grid/Graph used as a selector. This control must target the panel stack, and contain data related to the Grid/Graph in the panel stack. In the example above, the Region attribute is used as the selector in the Grid/Graph, targeting the panel stack. For instructions to create a Grid/Graph, see the *Document Creation Guide* or *Desktop Help*. For instructions to define the Grid/Graph as a selector, see *Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183*.
To define an Information Window

1. Open a dashboard in the Document Editor.
2. Right-click the panel stack, and select Properties. The Properties dialog box opens.
3. On the General tab, select the **Use as Information Window** check box.
4. Select **Title of panel stack** from the **Title** drop-down list.
5. Type a title in the **Title** field. This text is used as the title of the Information Window.
6. Click **OK**.
7. Save the dashboard.

Filtering a dashboard: Filter panels

A filter panel is a type of panel stack that contains only selectors, which users interact with to filter the data displayed in a dashboard. For example, a dashboard displays sales data by product category for the years 2007 to 2010. A user can filter the data to display sales data for only the books and movies categories, and only for 2010.
The filter panel in the following dashboard, shown in Express Mode, contains selectors that target the grid report. The three selectors filter the grid report for region, employee, and revenue. An analyst can use the selectors to filter the data on the grid report, as shown below.

- The analyst has selected Central, Mid-Atlantic, Northeast, and Northwest in the region selector. Notice that the title of the region selector indicates that four of the eight elements are selected.
- The analyst collapsed the employee selector, to focus on the selectors that she is using.
- The analyst has selected a revenue range of $933,237 to $1,845,606, which explains why only two regions of the selected four are displayed.
(The other two regions do not have employee revenue that falls within the selected range.)

In Express Mode and Flash Mode in MicroStrategy Web, and on an iPad with MicroStrategy Mobile, an analyst can:

- Filter the target by using the various selectors on the filter panel
- Expand and collapse each selector on the filter panel, using the Expand and Collapse icons on each selector
- Expand and collapse all the selectors on the filter panel, using the drop-down menu on the filter panel
- Clear a selector, using the Clear Selector icon on each selector
- Clear all the filters on the filter panel, using the Clear All Selectors icon on the filter panel
The drop-down menu on the filter panel is shown in Express Mode:

By default, changes made to the selectors on the filter panel are automatically applied to the targets. You can change the automatic apply setting so that an Apply button is displayed on the filter panel. When a change is made to a selector on the filter panel, the Apply button is enabled. For a more detailed description, including examples, and instructions, see Controlling how data updates in a filter panel: Automatic apply, page 89.

---

**To insert a filter panel**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**. Filter panels are created in MicroStrategy Web.

2. Expand the document section where you want the filter panel by clicking the plus sign next to the section name. You cannot add a filter panel to the Details section.

3. From the **Insert** menu, select **Filter Panel**.

4. Click in the desired section of the document layout area. The filter panel is added to the document, with a single panel.

5. By default, the filter panel displays a title bar, which allows the user to clear all filters, and expand or collapse all the filters. If you remove the title bar from a filter panel, a user cannot make those changes. For steps to remove the title bar, see To hide the title bar, page 74.

6. You can change the position or size of a filter panel, and format titles, borders, background color, and title bar. To do so, right-click the panel stack and select **Properties and Formatting**. The Properties and Formatting dialog box is displayed. For steps to format the panel stack, see Formatting panels and panel stacks, page 91.
You can change the panel name, which can be displayed on the title bar or on a selector that allows users to switch between panels. For steps, see To rename a panel, page 77.

Add a selector to the filter panel by following the steps below:

a. Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.

b. Click the **Insert** icon.

c. From the drop-down list that opens, select a style of selector. (For examples of each selector style, see Defining a selector, page 113.)

d. Right-click the selector and choose **Properties and Formatting**. The Properties and Formatting dialog box opens.

e. From the left, choose **General**.

f. By default, a title bar is displayed for the selector. The title bar can help to identify what the user is looking at, and also allows the user to expand and collapse the selector in the filter panel. For element selectors, the number of selected elements is displayed in the title bar.

g. Type a title for the selector in the **Title** field. If you leave this field blank, the selector’s name is displayed in the title bar by default.

h. From the left, choose **Selector**. Follow the steps in Methods to create a selector, page 117, to define the selector, including selecting the source, the metric qualification (value or rank), the action type, the targets, and so on.

i. Repeat these steps for each selector that you want to add to the filter panel.

The selectors in the filter panel are displayed vertically, in the order that they were added. To change the order, drag and drop a selector to its new position.

You can add more panels to the filter panel, as described in Inserting additional panels in a panel stack, page 75.

If the filter panel contains multiple panels, users can flip through the panels using the arrows on the title bar. You can also add a selector to allow change the displayed panel. For steps, see Chapter 4, Providing Interactivity to Users: Selectors.
12 Panels are displayed in the order in which they were added. For steps to display them in a different order, see Changing the display order of panels, page 77.

13 To ensure that the correct panel will be displayed when the user first views the dashboard, select the filter panel and pass your cursor near the top of it. A toolbar of icons is displayed. Then click the Display Previous Panel or Display Next Panel icon until the panel that you want to be the current panel is displayed.

Controlling how data updates in a filter panel: Automatic apply

By default, once a user chooses an item in selector on a filter panel, the target immediately and automatically updates without any additional user interaction. If a user selects multiple items, the target is automatically updated after each individual selection, which can take some time. Instead, you can disable automatic application of selector changes, allowing a user to select items in the selector, then choose when to apply the selections to the target. If changes are not made automatically, the Apply Now icon is displayed on the filter panel but is disabled; when a change is made to a selector on the filter panel, the Apply Now icon is enabled.

For example, the dashboard shown below in Express Mode contains a Grid/Graph that is currently displaying all regions. Automatic application is disabled for the filter panel. A user has selected Northeast and Northwest in the Region selector on the filter panel, and the Apply Now icon is enabled. Once the user clicks the icon, the Grid/Graph will be updated to display only those two regions.
Filter panels are fully interactive in Express Mode and Flash Mode in MicroStrategy Web. In other modes, filter panels work as panel stacks with selectors; the drop-down menu to interact with the filter panel is not available. (The menu allows users to expand and collapse selectors, for example. For a complete list of actions, see *Filtering a dashboard: Filter panels, page 84*.)

The **Automatically apply selector changes** setting for a filter panel applies in Express Mode and Flash Mode. The **Automatically apply selector changes** setting at the document level applies to selectors in a filter panel displayed in other modes. (For a description of the document level setting, see *Controlling how data updates: Automatically apply selector changes, page 146*.)

The dashboard shown below in Interactive Mode has automatic application disabled at both the filter panel and document level. The dashboard contains a selector that is not on a filter panel (the metric selector). All metrics are currently displayed, but the user has clicked Revenue in the metric selector. The Apply button displays in a floating toolbar; once the user clicks the button, the Grid/Graph will be updated to display only Revenue.

---

**Prerequisite**

The following procedure assumes that the document contains a filter panel with selectors. For instructions to add a filter panel, see *To insert a filter panel, page 87*.

For instructions to enable the floating toolbar, see the MicroStrategy Web Help.
To enable or disable automatic target update for a filter panel

1 In MicroStrategy Web, open the document in Design or Editable Mode.

Filter panels are defined in MicroStrategy Web.

2 Right-click the filter panel and select Properties and Formatting. The Properties and Formatting dialog box opens.

3 Select General in the list on the left.

4 Do one of the following to determine how targets are updated for the filter panel:
   - To enable automatic target update, select the Automatically apply selector changes check box.
   - To disable automatic target update, clear the Automatically apply selector changes check box.

5 Click OK to save your changes and return to the document.

Formatting panels and panel stacks

When you insert a panel stack into a document or dashboard, its formatting is determined by the control default for panel stacks. Each control type (text field, selector, panel stack, and so on) has a control default, which contains a full set of formatting settings to specify the default format. For more information on control defaults, including how to apply them and how to change them, see the Document Creation Guide.

You can change the formatting of each new panel stack as desired. You can use different interfaces to define the formatting. Which interface you use depends on your personal preference and what options you want to change. For more information on the different formatting interfaces, see Deciding which interface to use to format panels and panel stacks, page 95.

For panel stacks, you can apply different formats to different parts of the control (see Defining the parts of a panel stack, page 66 for detailed
descriptions of the various parts). The following table summarizes the formatting options available for each part of a panel stack.

<table>
<thead>
<tr>
<th>Panel Stack Part</th>
<th>Formatting Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Container</td>
<td>• Borders, including 3D borders, drop shadows, and rounded corners (Flash only), as well as standard border options such as color and style</td>
</tr>
<tr>
<td>Title bar</td>
<td>• Font</td>
</tr>
<tr>
<td></td>
<td>• Background color options, including gradients</td>
</tr>
<tr>
<td>Individual panels</td>
<td>• Background color options, including gradients</td>
</tr>
</tbody>
</table>

**Example: Formatting a panel stack**

The following images contain a selector as well as a panel stack, and are displayed in MicroStrategy Web. The panel stack (the holder for the panels) contains two panels, named Panel1 and Panel2, and a title bar. The selector, which is displayed as a button bar, allows you to switch between panels. The formatting of the selector is not discussed in this section; for information on formatting selectors, see *Formatting selectors, page 170*.

The panel stack container has a raised 3D effect, visible around the border of the panel stack, including the title bar. The title bar, which displays the text “Panel2” in the sample below, is formatted grey with italicized text.

In the image above, the panel named Panel2 is displayed, and its background is white. In the image below, Panel1 is displayed. Its background uses gradient colors, blending from black to grey.
Notice that the formatting of the border and the title bar do not change when different panels are displayed. Borders are applied to the panel stack and the title bar formatting is the same for all panels.

The following procedure re-creates this example, using a variety of interfaces. Complete instructions for formatting panel stacks using various interfaces are provided in the Desktop Help. See also Deciding which interface to use to format panels and panel stacks, page 95 for information on formatting tasks and the interfaces to use.

---

### To format a panel stack

1. Open the dashboard using the Document Editor in Design View.
   
   **Add the panel stack and selector**

2. Add a panel stack. Insert a second panel (Panel2) into the panel stack. This panel becomes the current panel (the panel currently displayed in Design View). For detailed instructions, see Inserting a panel stack, page 70 and Inserting additional panels in a panel stack, page 75.

3. Create a selector linked to the panel stack (set the target to the panel stack). Use a button bar for the selector style. For detailed instructions, see Chapter 4, Providing Interactivity to Users: Selectors.

4. Select the panel stack to begin formatting it.
   
   **To apply a 3D effect to the panel stack container**

   You can use either the Property List or the Format Objects dialog box to format the panel stack container. The following steps use the Property List.

5. To make the panel stack appear three-dimensional, set 3D Effect in the Property List: Appearance section to Raised. Raised outsets the panel stack like a button, as opposed to Sunken, which insets the panel stack like a pushed button.

6. Set 3D Weight to 3, to increase the thickness of the 3D line. This setting is measured in points.
To apply a color to Panel2

You can use the toolbar, the Property List, or the Format Objects dialog box to format the current panel, which is Panel2. The following steps use the toolbar.

7 Click the arrow next to the Fill icon in the toolbar and select **White**.

To change the current panel

Background formatting applies to the current panel only. By changing the current panel, you can format the background of each panel in the panel stack.

8 Right-click the panel stack, point to **Panels**, and then select **Display previous**. Panel1 is displayed and is now the current panel.

To apply a gradient color to Panel1

Gradient colors gradually change the background of the current panel from one color to another. The following steps use the Property List to apply the gradient color to the current panel.

9 In the **Property List: Appearance** section, set **Backcolor** to **light grey**.

10 Set **Backstyle** to **Gradient**.

11 Set **Gradient color** to **black**.

12 Set **Gradient variant** to **Right to left**, which sets the direction of the shading between the backcolor and the gradient color. The backcolor (grey) is shaded into the gradient color (black) from right to left.

To format the title bar

Use the Format Objects dialog box to format the title bar.

13 Right-click the panel stack and select **Format**. The Format Objects dialog box opens.

14 In the object list on the left, click **Title**.

15 On the **Background** tab, select **Grey-50%** as the **Fill color**.

16 On the **Font** tab, select **Arial** as the **Font Name**.

17 Set **Italic** to **Yes**.
18 Set Color to Blue.

19 Click OK to return to the dashboard.

Deciding which interface to use to format panels and panel stacks

For comprehensive formatting, the Property List is the easiest interface to use, as it contains most of the options of the other interfaces on the same screen as the Layout area. However, you cannot use it to format the title bar. Use the Format Objects dialog box instead for that task. Most of the settings in the Property List apply to the panel stack (the holder for the panels). For example, if you apply a drop shadow in the Property List, all the panels in the panel stack use the same drop shadow.

The remaining settings in the Property List format the current panel and determine the background. These settings are listed below:

- Backcolor
- Backstyle
- Gradient Color
- Gradient Variant

The following table presents formatting tasks and the most effective interface to use for each.

<table>
<thead>
<tr>
<th>To Format....</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Borders, which apply to the entire panel stack: Standard border options such as color and style</td>
<td>Formatting toolbar, right-click menu, or Property List, as follows: Formatting toolbar or right-click menu</td>
</tr>
<tr>
<td>3D borders and drop shadows</td>
<td>Property List</td>
</tr>
<tr>
<td>Rounded corners (displayed in Flash Mode only)</td>
<td>Property List</td>
</tr>
<tr>
<td>The background of the current panel (the panel currently displayed on the panel stack)</td>
<td>Formatting toolbar</td>
</tr>
<tr>
<td>Gradient colors for the background of the current panel</td>
<td>Property List</td>
</tr>
</tbody>
</table>
You can format the background of each panel in the panel stack by changing the current panel.

This table applies to formatting panels and panel stacks in Desktop only; panel and panel stack formatting in MicroStrategy Web differs slightly. For details, see the MicroStrategy Web Help.

### Useful formatting suggestions

The following list provides some additional formatting suggestions. For information on basic options such as formatting borders, and examples and instructions for all the formatting listed below, see the Desktop Help.

- Make the panel stack and all the panels in it appear three-dimensional, like a button, with the 3D effect. For an example on a panel stack, see Example: Formatting a panel stack, page 92.

- “Float” the panel stack and all the panels in it above the background by using a drop shadow.

- In Flash Mode, display rounded corners on the panel stack and all the panels in it. You can define the radius and select whether rounded corners are displayed for the top corners or all four corners. For an example, see Displaying rounded corners on panel stacks (Flash Mode only), page 97.

- Create a gradual color change by blending two colors using gradient colors. Each panel in a panel stack can have different gradient colors. For an example on a panel, see Example: Formatting a panel stack, page 92.

- Display pop-up text when a user positions the cursor over the panel stack in MicroStrategy Web with a tooltip. The tooltip can provide extra information, such as an expanded description of the panel stack.

- Display information to other document designers in Design View while hiding it from users viewing the document in PDF View (Desktop and...
Web) and Interactive Mode, Editable Mode, and Express Mode on MicroStrategy Web. To do this, you hide the control that contains the information by using the Visible option. For instance, you could include a graph with additional details about the data in a panel stack.

- Enable a transition animation for Flash Mode in MicroStrategy Web. A transition animation is a visual transition that occurs when a panel is first displayed in Flash Mode. Examples are Blur, Fade, and Iris. For more information, see Enabling transition animations in Flash, page 57.

- You can determine how a panel stack is displayed when it is exported to Excel and PDF. You can specify whether or not to clip the contents of the panel stack if the contents of the panel stack are bigger than the panel stack itself. If the panel stack is clipped, you can determine whether to export all the panels or only the current panel. For instructions and examples, see Formatting a panel stack for export, page 99.

Example: Formatting a panel stack, page 92 provides some formatting instructions; Displaying rounded corners on panel stacks (Flash Mode only) below contains an example of rounded corners and procedures to define them. For complete instructions for formatting panel stacks and panels using various interfaces, see the Desktop Help.

Displaying rounded corners on panel stacks (Flash Mode only)

A panel stack can have rounded corners instead of square, right-angle corners. Rounded corners are displayed only in MicroStrategy Web and only in Flash Mode. In the following dashboard sample, shown in Flash Mode in MicroStrategy Web, the panel stacks on the top have rounded corners, while the one on the bottom has straight corners.

The rounded corners settings apply to Flash Mode only. In PDF View in Desktop or in other Web display modes, rounded corners display as square, right-angle corners.
You can control how rounded corners are displayed for panel stacks in Flash Mode by:

- Defining the radius, which sets how round the corners are. A larger radius produces a more rounded corner. The range is 1-20.
- Selecting whether rounded corners are displayed for all four corners or only for the top corners.

In the image above, notice that the corners of the panel stack on the upper right are more rounded than those on the upper left. The corner radius of the right panel stack is set to the maximum of 20, while the left panel stack has a radius of five. Notice also that the right panel stack has rounded corners on the top only, while all four corners of the left panel stack are rounded.

The following procedure re-creates the sample.

- Rounded rectangles also use rounded corners. For information on rounded rectangles, see the Document Creation Guide; for instructions to control how rounded rectangles are displayed, see the Desktop Help.

---

To display rounded corners for panel stacks in Flash Mode

1. Open a dashboard using the Document Editor in Design View.
2. Add three panel stacks, as shown in the sample above. For a procedure to create panel stacks, see Inserting a panel stack, page 70.
3. In the Layout area, select the rectangle on the bottom.
4. In the Property List: Appearance section, set Use rounded corners to False.
5. In the Layout area, select the rectangle on the upper right.
6. Set the Rounded corner radius to 20.

   The range for the corner radius is 1 to 20. Higher numbers produce a more rounded corner, while lower numbers produce a straighter corner.
7 By default, all four corners are rounded. To round the top corners only, set *Top corners only* to *True*.

The panel stack on the upper left uses the default settings (rounded corners on all four corners and a radius of five), so no changes need to be made to it.

To view the effect, open the dashboard in Flash Mode in MicroStrategy Web.

**Formatting a panel stack for export**

You can determine how a panel stack is displayed when it is exported to Excel and PDF. First, you determine whether or not to clip the contents of the panel stack if the contents of the panel stack are bigger than the panel stack itself (for example, a wide Grid/Graph).

- If the panel stack is clipped, the object in the panel stack is not fully displayed, since panel stacks cannot grow in size. The document below has been exported to PDF. The Grid/Graph is cut off on the right, but you can see the panel stack and the panel name in the title bar.

![Panel Stack Example](image)

- If the panel stack is not clipped, the panel stack is essentially not exported, allowing the contents to be fully displayed. The PDF shown below is the same document as above, but with panel stack is no longer...
clipped. The full Grid/Graph is displayed, without the panel name or panel stack title bar.

If the panel stack is clipped, you can determine whether to export all the panels or only the current panel. The panels can be displayed vertically (from top to bottom) or horizontally (from left to right). The first example above exported only the current panel, although the panel stack contains three
panels. The following PDF shows the three panels exported horizontally (page one is on the top, followed by page two):
If the panel is displayed vertically, you can select whether an individual panel can display across multiple pages. The PDF below is the same document, displayed vertically, with panels displayed on separate pages.

To format a panel stack for export

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2 Right-click the panel stack to format and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, select **Advanced**.

4 Select whether or not to clip the panel stack:
   - To clip the panel stack, select the **Clip contents of panel stack when exporting** check box. If the contents of a panel stack are bigger than the panel stack itself (for example, a wide Grid/Graph), the object is clipped and not fully displayed when the document is exported, since panel stacks cannot grow in size.
   - To display all the contents of the panel stack, clear the **Clip contents of panel stack when exporting** check box. If the contents are bigger than the panel stack, the panel stack is essentially not exported, allowing the contents to be fully displayed.

   If you clear this check box, the remaining Export settings are not available. Click **OK** to save your changes and return to the document.

5 Define whether all panels are exported or only the current panel is exported. Select one of the following options from the **Expand panels** drop-down list:
   - To export only the current panel, select **None**. The current panel is the panel that is displayed.
   - To export all the panels and display them vertically, select **Vertical**.
   - To export all the panels and display them horizontally, select **Horizontal**.

6 If you selected Vertical or Horizontal, specify the amount of **Spacing** between the panels. The unit of measurement is inches.

7 If you selected Vertical, determine whether or not an individual panel can be split across pages:
   - To allow panels to display vertically across multiple pages, select the **Allow panels to split across pages** check box.
   - To specify that panels must display on a single page, clear the **Allow panels to split across pages** check box. The contents of the panels are clipped to fit on the page.

8 Click **OK** to save your changes and return to the document.
PROVIDING INTERACTIVITY TO USERS: SELECTORS

Introduction

Selectors provide dashboards with interactivity, allowing each user to change how he sees the data. When a user clicks a selector, a selector can change panels, the focus of a grid or graph report on the document, or dynamic text fields (a text field that is a reference to an object on a report) in a panel stack, as described below. For an in-depth explanation of dashboards, see *What is a dashboard?, page 24.*

About selectors

Selectors allow a user, in Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web, to:

- Flip through the panels in a panel stack. A panel stack is a collection of panels, which allow the user to see different predefined views of data in the same document.
For example, each panel can display a different Grid/Graph, and the selector allows the user to choose which panel, and thus which Grid/Graph, to view.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>$1,300,732</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$673,084</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>$336,675</td>
<td></td>
</tr>
</tbody>
</table>

The items of the selector are the buttons across the top, and the target is the panel stack. For more information on panels, see Chapter 3, Layering Data: Panels and Panel Stacks.

- Display different metrics or different elements of attributes, custom groups, or consolidations in a Grid/Graph.

For example, a Grid/Graph contains Region, Call Center, Year, and various metrics, as shown in the example below. This particular selector allows the user to select which regions to display on the Grid/Graph. The user can therefore slice or filter the Grid/Graph by the selected region or regions. Similarly, a selector can allow the user to select which metrics to display. All regions and employees would be displayed, but with only the metrics chosen in the selector.

<table>
<thead>
<tr>
<th>Region</th>
<th>Cal Center</th>
<th>Year</th>
<th>Metrics</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>Boston</td>
<td>2006</td>
<td></td>
<td>$62,469</td>
<td>15.35%</td>
</tr>
<tr>
<td>Northeast</td>
<td>Boston</td>
<td>2007</td>
<td></td>
<td>$76,011</td>
<td>14.97%</td>
</tr>
<tr>
<td>Northeast</td>
<td>New York</td>
<td>2006</td>
<td></td>
<td>$277,492</td>
<td>15.09%</td>
</tr>
<tr>
<td>Northeast</td>
<td>New York</td>
<td>2007</td>
<td></td>
<td>$359,690</td>
<td>15.23%</td>
</tr>
<tr>
<td>Southeast</td>
<td>Atlanta</td>
<td>2006</td>
<td></td>
<td>$40,109</td>
<td>14.97%</td>
</tr>
<tr>
<td>Southeast</td>
<td>Atlanta</td>
<td>2007</td>
<td></td>
<td>$56,668</td>
<td>15.01%</td>
</tr>
<tr>
<td>Southeast</td>
<td>Miami</td>
<td>2006</td>
<td></td>
<td>$49,458</td>
<td>15.05%</td>
</tr>
<tr>
<td>Southeast</td>
<td>Miami</td>
<td>2007</td>
<td></td>
<td>$57,230</td>
<td>14.97%</td>
</tr>
<tr>
<td>Central</td>
<td>Milwaukee</td>
<td>2006</td>
<td></td>
<td>$163,091</td>
<td>15.32%</td>
</tr>
<tr>
<td>Central</td>
<td>Milwaukee</td>
<td>2007</td>
<td></td>
<td>$209,937</td>
<td>15.26%</td>
</tr>
<tr>
<td>Central</td>
<td>Fargo</td>
<td>2006</td>
<td></td>
<td>$33,210</td>
<td>14.48%</td>
</tr>
<tr>
<td>Central</td>
<td>Fargo</td>
<td>2007</td>
<td></td>
<td>$44,533</td>
<td>15.30%</td>
</tr>
<tr>
<td>South</td>
<td>New Orleans</td>
<td>2006</td>
<td></td>
<td>$131,455</td>
<td>15.34%</td>
</tr>
</tbody>
</table>

In this example, the regions listed in the selector are the items of the selector; the target is the Grid/Graph. For more information on Grid/Graphs, see the Document Creation Guide.
• Filter data based on a metric's values. This type of selector can be either of the following styles:

  ▪ A slider, which the user moves to select the minimum and maximum values to display. For example, a dashboard contains a Grid/Graph with Region and the Revenue, Cost, and Profit metrics. A selector displays the range of revenue values, including the minimum and maximum values (in the example below, $1,761,187.19 and $8,554,414.55). A user can move the slider to select a new minimum and maximum revenue to display. In this example, the selector is filtering the Revenue metric to display only those regions with Revenue values between $3,343,953 and $7,983,672.

    "Select the range of Revenue values to display
    Between 3,343,953.49 and 7,983,672.10"

    
    | Region  | Revenue       | Cost     | Profit    |
    |---------|---------------|----------|-----------|
    | Central | $5,029,366    | $4,265,043| $764,323  |
    | Mid-Atlantic | $4,452,615    | $3,779,531| $673,084  |
    | South   | $5,389,280    | $4,582,324| $806,956  |
    | Southwest | $3,694,132    | $3,132,800| $561,331  |
    | Web     | $3,902,762    | $3,319,225| $583,538  |

  ▪ A qualification, which the user completes to filter the metric's values. This type of metric condition selector allows a user to select the operator (equals, greater than, between, and so on) and to type the value to filter on. For example, given the same regional Grid/Graph described above, a user could display only the revenue values greater than $5,000,000 or only the top-ranking 5 regions in term of revenue.

    "Filter the Revenue metric:
    Select an operator and type a value."

    | Region  | Revenue       | Cost     | Profit    |
    |---------|---------------|----------|-----------|
    | Central | $5,029,366    | $4,265,043| $764,323  |
    | Northeast | $8,554,415    | $7,253,683| $1,303,732|
    | South   | $5,389,280    | $4,582,324| $806,956  |

If a title bar is displayed for the selector, a user can also select whether to filter on the metric values or rank.
• Filter another selector. For example, a dashboard contains a Grid/Graph with Subcategory and Item, filtered to display only the Books category. The dashboard also includes two selectors. One selector displays the subcategories in the Books category (the Subcategory selector), while the other selector contains a list of individual books (the Item category). Both selectors target the Grid/Graph, to display data for the selected Subcategory and Item. The Subcategory selector targets the Item selector, filtering the Item selector to display only the books in the subcategory chosen in the Subcategory selector. For example, if the user selects Literature from the Subcategory selector, the Item selector is updated to display only books that fall under the Literature subcategory, instead of displaying a long list of every available book. This is shown below:

<table>
<thead>
<tr>
<th>Subcategory</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Literature</td>
<td></td>
</tr>
<tr>
<td>Literature</td>
<td>The Prince</td>
</tr>
<tr>
<td>Literature</td>
<td>The Fountainhead</td>
</tr>
<tr>
<td>Literature</td>
<td>The Old Man and the Sea</td>
</tr>
<tr>
<td>Literature</td>
<td>Lord of the Flies</td>
</tr>
<tr>
<td>Literature</td>
<td>Atlas Shrugged</td>
</tr>
<tr>
<td>Literature</td>
<td>The Catcher in the Rye</td>
</tr>
<tr>
<td>Literature</td>
<td>Brave New World</td>
</tr>
<tr>
<td>Literature</td>
<td>The Weight of Water</td>
</tr>
</tbody>
</table>

• Display different elements of attributes, custom groups, or consolidations in a panel stack using dynamic text fields. A dynamic text field is a text field populated by the dataset; it is essentially a reference to an object on a report.

For example, a panel contains the dynamic text fields Region and Revenue from the Basic Report dataset. The image below shows the panel in Design View; the dynamic text fields are indicated by braces `{ }`.

The selector allows the user to select which region to display on the panel. The following image shows the same selector and panel in Interactive Mode in MicroStrategy Web. Mid-Atlantic has been selected from the
drop-down list of the selector. Mid-Atlantic replaces {Region}, and the revenue amount for the Mid-Atlantic region replaces {Revenue}.

In this example, the regions listed in the drop-down list are the items of the selector; the target is the panel stack. For a more detailed description of dynamic text fields, including examples, as well as instructions to add them to a dashboard, see the Document Creation Guide.

An element selector or a metric condition slider selector can include or exclude the selected data. For example, the attributes that a user chooses in the selector can display in the target, or they can be hidden. For an example and instructions, see Determining whether the selector includes or excludes data: selection type, page 132.

A selector can target multiple objects. The same selector can control both a Grid/Graph and dynamic text fields on the same panel. As described in the "filter another selector" example above, the same selector can target both a Grid/Graph and another selector.

A selector can either filter or slice the data. The selections made in a filtering selector are used to filter the underlying dataset before the metric values are aggregated at the level of the Grid/Graph that is displayed in the dashboard. The selections made in a slicing selectors are used to determine which slices of data are combined and shown in the Grid/Graph. For more details on the differences, including examples, see Applying selections as filters or slices, page 126.

**Initial display of a selector**

For a selector that targets attribute elements on a Grid/Graph, whether a selector filters or slices data determines how the selector is first displayed in MicroStrategy Web:

- If it is a filtering selector, no items are selected in the selector. A drop-down list will have blank space, a button bar will not have any buttons selected, no radio buttons will be selected, and so on. This means that the target is unfiltered and therefore displays all of the available items.
For example, a panel contains the dynamic text fields Region and Revenue from the Basic Report dataset. The selector allows the user to select which region to display on the panel. If the selector filters regions, when the dashboard is first displayed in MicroStrategy Web, all the regions are displayed in the panel.

- If it is a slicing selector, the first item in the target is selected in the selector, and its target displays data for that item.

If the selector instead slices regions, the data for the Central region is displayed when the dashboard is first opened, since Central is the first attribute element. Central is selected in the selector.

These are the default settings, but you can change how a slicing selector is displayed. You can change the number of items displayed and whether they are the first or last elements. You can also opt to display all the items.

Once a user makes selections in the selector and saves the dashboard, those selections are saved and displayed when the document is executed again.

For more information on these settings, including detailed examples, a description of how selectors with multiple targets use these settings, and instructions, see Determining how the target of a selector displays (current state), page 154.

**How drilling and selectors work together**

When a user drills on a document that contains an element selector, the attribute, consolidation, or custom group used in the selector becomes the page-by element for the drilled-to report or document.

- If only one element is chosen in the selector, the drilled-to report displays that element.
- If multiple elements are chosen in the selector, the drilled-to report displays the first selected element.

For example, a document contains a Grid/Graph that displays revenue values by Category and Subcategory. The document also contains a selector on Year that targets the Grid/Graph. (Although Year is not displayed on the Grid/Graph, it is included in the dataset report.) The document is displayed
below in Interactive Mode, after 2010 has been selected in the selector. Note that the revenue for the Art & Architecture subcategory is $158,651.

Drill to Item from Art & Architecture. On the drilled-to report, display subtotals (from the Data menu, select Show Totals). Notice that the report is
paged by Year (2010 only) and the revenue total for Art & Architecture is $158,651, the same as shown in the Grid/Graph in the document.

Return to the original document, which still has 2010 selected. Select 2011 in the selector as well. The revenue amount for Art & Architecture is now $365,872, as shown below. (Only a portion of the full document is shown in the sample.)

Once again drill to Item from Art & Architecture. On the drilled-to report, display subtotals. Notice that the report is paged by Year (2010 only, since it is the first year selected in the original report) and the revenue subtotal for
Art & Architecture is $158,651, the same as shown in the Grid/Graph in the document.

Defining a selector

When you add a selector to a dashboard, you must define how it looks and what it controls. The following settings define a selector:

- **DHTML style** is how the items in the selector are displayed in Editable, Interactive, and Express Mode in MicroStrategy Web. (Items are the elements, metrics, or panels, as described in the examples above.) The DHTML style options are:
  - Button Bar (use to create tabs in your dashboard)
  - Check Boxes

    | Cost | Profit | Revenue |
    |------|--------|---------|
    |      |        |         |
- Drop-down

- Link Bar (use to create tabs in your document):

- Listbox

- Qualification (available only for metric condition selectors; allows users to complete the metric qualification)

- Radio Buttons

- Search Box (available only for element selectors; must be created in MicroStrategy Web). This style allows users to search for an element. Unlike other selectors, a list of elements is not initially displayed. As
the user types text, matches are displayed for the user to choose from. This is particularly convenient if the element list is long.

You can determine whether the search is performed on the server or the client. To fetch elements directly from the data warehouse or Intelligent Cube as the user performs the search, select the **Search on server** check box in the **Layout** options on the Properties and Formatting dialog box.

- **Slider** (most effective selector for browsing data in a graph; also available for metric condition selectors)

  Place the graph slider under or above the graph it will control, then specify the graph as the target of the slider selector. Next, specify one of the attributes or metrics in the graph as the selector’s source. This allows an analyst to drag the slider to view different sets of data in a graph and to adjust the size of the slider to view different ranges of values in the graph.

- **Flash Style** is how the selector is displayed in Flash Mode in MicroStrategy Web if it is an interactive Flash-only selector. The options are listed below:
  - **Automatic**: The default, which uses the DHTML Style (described above) for Flash Mode.
  - **Fish Eye Selector**: An interactive style of selector that is displayed only in Flash Mode. It magnifies an item when a user hovers the cursor over it. This style of selector is useful because it allows a user to choose from a large list of elements without having to see all of the elements displayed at one time. Any item that a user hovers over or selects remains magnified, while the remaining items are minimized and hidden from view.

  Since a Fish Eye Selector is displayed only in Flash Mode, determine how the selector is displayed in non-Flash modes by specifying a **DHTML Style** (described above).

  For more information about creating this type of selector, and an example, see *Creating a Fish Eye Selector*, page 214.
• **Date Selection**: An interactive style of selector that is displayed only in Flash Mode. It is a calendar selector that allows you to select which dates you want to see data about in a dashboard. You are able to see all of the dates of each month in the widget, which allows you to be able to select dates more easily.

Since a Date Selection widget is displayed only in Flash Mode, determine how the selector is displayed in non-Flash modes by specifying a **DHTML Style** (described above).

For more information about creating this type of selector, and an example, see *Creating a Date Selection widget, page 205.*

• **Action Type** determines whether the selector displays elements, metrics, metric conditions (such as “greater than $5,000”), or panels.

For element selectors, you can select which forms are displayed in the selector, the order that they are displayed in, and how their elements are sorted. If multiple forms are displayed, you can choose which character separates the different forms. For an example and instructions to display and sort forms, see *Displaying and sorting forms in selectors, page 166.*

• **Source** is the attribute, custom group, or consolidation whose elements are displayed in the selector (for an element selector) or the metric whose values are qualified on (for a metric condition selector).

• **Selection Type** determines whether the selector includes or excludes the selected items from the target. It is available only for element selectors and metric condition slider selectors. For example, the attributes that a user chooses in the selector can display in the target, or they can be hidden. For instructions to specify the selection type, see *Determining whether the selector includes or excludes data: selection type, page 132.*

• **Qualify on** determines whether the selector filters metric values or rank, and is available only for metric condition selectors. The options are:
  
  ▪ **Value** filters the metric's values.
  
  ▪ **Rank Highest** ranks the metric's values in descending order, and then filters by rank. For example, Rank Highest=2 displays the two highest values.
  
  ▪ **Rank Lowest** ranks the metric's values in ascending order, and then filters by rank. For example, Rank Lowest=2 displays the two lowest values.
  
  ▪ **Rank % Highest** ranks and filters by the number of metric values (or rows) in the target, in descending order. For example, if the target
Grid/Graph contains eight items, the Rank % Highest =25 displays the two highest values.

- **Rank % Lowest** ranks and filters by the number of metric values (or rows) in the target, in ascending order. For example, if the target Grid/Graph contains eight items, the Rank % Lowest =25 displays the two lowest values.

If a title bar is displayed for the metric condition selector, a user can change this setting.

- **Target(s)** are the Grid/Graphs, panel stacks, and/or other selectors that the selector affects.
  - If targets are automatically maintained in the layout, attribute and metric selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector.
  - If targets are not automatically maintained, you must manually select the targets when you create selectors.
  - You must always select the target for panel selectors, regardless of whether targets are automatically maintained.
  - To choose another selector as the target of this selector, you must disable automatic target maintenance and manually select the target. You can keep automatic target maintenance if you can place the target selector on a panel in the same document section as the source selector; the source selector will automatically target that panel stack.

For instructions to disable automatic target maintenance, as well as the advantages and disadvantages of automatic and manual target selection, see *Automatically maintaining targets for selectors, page 134.*

### Methods to create a selector

You can create a selector in a variety of different ways, depending on what the target and source are, as well as personal preference for a particular interface. The following table helps you choose between the methods. Full directions for all these methods are provided in the *Desktop Help.*

- If targets are automatically maintained in the layout, attribute and metric selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector. You do not need to manually select the targets. You must always select targets for panel selectors, regardless of whether targets are automatically
To target another selector, automatic target maintenance must be disabled. Alternatively, you can keep automatic target maintenance if you can place the target selector on a panel in the same document section as the source selector; the source selector will automatically target that panel stack. For more information on automatically maintaining targets, including how to enable and disable it, see *Automatically maintaining targets for selectors*, page 134.

<table>
<thead>
<tr>
<th>To Create a New Selector...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>With a panel stack as the target.</td>
<td>Right-click the panel stack and select <strong>Insert Panel Stack Selector</strong>. Note that you cannot use check boxes with a panel stack, since check boxes allow multiple selections and multiple panels cannot be displayed simultaneously.</td>
</tr>
</tbody>
</table>
| With a Grid/Graph as the target and metrics as the source. | • In Desktop, insert a selector. Change the action type of the selector to metrics, as described below this table. If targets are not automatically maintained, specify the Grid/Graph to use as the target.  
• In Web, right-click the word **Metrics** on the Grid/Graph and select **Create Selector Control**. |
| With a Grid/Graph as the target and elements as the source. | • In Desktop, insert a selector. Specify the attribute, custom group, or consolidation to use as the source, as described below this table. If targets are not automatically maintained, specify the Grid/Graph to use as the target.  
• In Web, right-click the attribute, custom group, or consolidation on the Grid/Graph and select **Create Selector Control**. |
| That filters a metric's values. | Insert a selector. Change the action type of the selector to metric condition, as described below this table. Select whether to display the selector as a slider or a qualification which the user completes to filter the metric's values. Specify the metric to use as the source. Select whether to filter the metric's values, rank, or percent rank. If targets are not automatically maintained, specify the Grid/Graph to use as the target. For descriptions of these options, see *Creating selectors that filter metric values*, page 123. |
| With an attribute as the source. | Right-click the attribute in the Datasets pane and select **Create Selector**.  
If targets are not automatically maintained, the new selector does not have a target. Therefore, you must specify the Grid/Graph or panel stack to use as the target, as described below this table. |
<table>
<thead>
<tr>
<th>To Create a New Selector...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>That is formatted differently in Flash Mode and becomes interactive when a user hovers the cursor over it. An example is the Fish Eye Selector, which magnifies the item that is hovered over, while the remaining items are minimized and displayed in the background of the selector. For an example, see Creating a Fish Eye Selector, page 214.</td>
<td>Click the <strong>Selector</strong> icon in the toolbar, and then select <strong>Fish Eye</strong>. Next, click in the Layout area to add the selector. The default action type is <strong>Select Elements</strong>, although you can change it to select metrics or panels. If targets are not automatically maintained, the new selector does not have a target. Therefore, you must specify the Grid/Graph or panel stack to use as the target, as described below this table. The Fish Eye style is viewable only in Flash Mode in MicroStrategy Web. By default, it is displayed as the Listbox style in other modes and views; to change that, select a different DHTML style.</td>
</tr>
<tr>
<td>That updates a dynamic text field on a panel stack.</td>
<td>Insert a selector. Specify the attribute for the source. If targets are not automatically maintained, the new selector does not have a target. Therefore, you must specify the panel stack to use as the target, as described below this table.</td>
</tr>
</tbody>
</table>
| With a specific style. | Do one of the following:  
• From the **Insert** menu, point to **Selector**, and then choose the style from the list.  
• Click the arrow next to the **Selector** icon on the toolbar, and then choose the style from the list.  
Next, click in the Layout area to add the selector. The default action type is **Select Elements**, although you can change it to select metrics or panels. If targets are not automatically maintained, the new selector does not have a target. Therefore, you must specify the Grid/Graph or panel stack to use as the target, as described below this table. |
| With the same style as the last selector you added. | Click the **Selector** icon in the toolbar. Click in the Layout area to add the selector. The default action type is **Select Elements**, although you can change it to select metrics or panels, or metric condition. If targets are not automatically maintained, the new selector does not have a target. Therefore, you must specify the Grid/Graph or panel stack to use as the target, as described below this table. |
| That filters another selector. | Insert the target selector (the one to be filtered by the source selector). If you want to keep automatic target maintenance, ensure that the target selector is on a panel in the same document section as the source selector (the selector that affects the target). Insert the target selector. Specify the attribute for the source. If you want to select the targets manually, disable automatic target maintenance, then select the target selector and target Grid/Graph or panel stack. |

You can also use an attribute on a Grid/Graph as a selector that targets a panel stack or another Grid/Graph. If a user clicks an attribute on the first Grid/Graph, the target changes to display...
Providing Interactivity to Users: Selectors

Methods to create a selector © 2012 MicroStrategy, Inc.

For more information, see Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.

After you create a new selector, you can use the Property List or Properties dialog box to change any settings, such as style or action type, of the selector. For example, the default DHTML style of a new selector is a drop-down list, which may not always suit your needs. If automatic target maintenance is enabled, you cannot change the targets of the selector in either interface. You can disable automatic target maintenance for the entire layout in the Properties dialog box, if you desire. For more information about automatic target maintenance, including the effects of enabling or disabling it, see Automatically maintaining targets for selectors, page 134.

The Property List is the easier method to use, as it is displayed on the same screen as the Layout area. The target selection mode, described in the next section, allows you to quickly and easily choose the target of the selector.

Selecting targets interactively (target selection mode)

Target selection mode allows you to choose targets interactively. You can click the Grid/Graph, panel stack, or selector to use as the target of the selector.

Target selection mode is not available when targets are automatically maintained. For more information about automatic target maintenance, including instructions to disable it, see Automatically maintaining targets for selectors, page 134.

To select targets for a selector

This procedure assumes you have already created a selector (see Methods to create a selector, page 117 for procedures) and are in Design View in Desktop.

1 Right-click the selector and choose Select Targets. The selector is outlined in orange to indicate target selection mode is on.
2 Click the Grid/Graph, panel stack, or selector to specify as the target. The sizing handles of the target are displayed in orange.

3 To select multiple targets, hold down the CTRL key while you click each control.

4 Click anywhere in the Layout area to turn target selection mode off.

The next section provides a procedure for creating and defining a selector for a Grid/Graph using the toolbar and the Properties dialog box. For procedures to create selectors with other interfaces and methods, see the Desktop Help.

Example: Creating a selector to control a Grid/Graph

The following procedure walks you through creating a selector for a Grid/Graph, similar to the first example shown in About selectors, page 105.

To create a selector to control a Grid/Graph

1 Create a new dashboard in Desktop. To re-create the example, select the following report as the dataset:

Reports\MicroStrategy Platform Capabilities\Advanced Reporting Guide\01 Basic Report

2 In Design View, click the plus sign next to the section name where you want the Grid/Graph in the Layout area. This expands the section.

3 Click and drag the Grid/Graph into the section.
Insert the selector

4 Click the arrow next to the **Selector** icon in the toolbar, and then choose the style of selector from the drop-down list. The style determines how the selector is displayed. For this example, choose **Check Boxes**. See *Defining a selector, page 113* for a description and example of each style.

When you move the cursor into the Layout area, the pointer changes to crosshairs.

5 Click in the desired section of the Layout area. If you click and drag in the section, you can size the selector. The selector is added to the dashboard.

Define the selector

6 Right-click the new selector, and select **Properties**. The Properties dialog box opens.

   ![You can also set these options using the Property List.]

7 Click the **Selector** tab, and choose **Select attribute element** as the **Action Type**.

   When the dashboard is displayed in MicroStrategy Web, the selector displays a list of the elements from the attribute selected in the **Source** field.

8 Select the attribute in the **Source** drop-down list. In the example that you are re-creating, Region is selected.

   The **Source** list contains all of the attributes in all of the datasets in the document. The selector displays the attribute elements of the attribute selected as the **Source**.

9 Select the target by doing one of the following:

   - If the **Available targets** and **Selected targets** lists are unavailable, targets are automatically maintained. The **Selected targets** list contains all the Grid/Graphs and panel stacks in the same document section as the selector. In this example, that is the Grid/Graph you added above.

   - If the **Available targets** and **Selected targets** lists are available, targets are not automatically maintained and you must manually specify the target of the selector. From the list of **Available targets** on the left, select the Grid/Graph and click > to add it to the list of **Selected targets**.
For background information on automatic target maintenance, see
*Automatically maintaining targets for selectors, page 134.*

10 For Slider, Radio Buttons, Check Boxes, Link Bar, and Button Bar
selector styles, the **Orientation** option is available. You can select whether
to display the selector horizontally (on a single line from left to right) or
vertically (in a single column). The example we are re-creating lists the
elements vertically.

11 Click **OK** to return to the dashboard.

**Add a border to the selector**

The example uses a border to outline the selector. Other formatting
options, such as fonts and colors, are discussed in *Formatting selectors,
page 170.*

12 Right-click the selector, point to **Border**, and then choose **All**.

**Creating selectors that filter metric values**

You can create a selector that allows a user to filter on a metric's values,
ranks, or percent ranks. The selector can be either of the following:

- A slider, which the user moves to select the minimum and maximum
  values to display. For example, a dashboard contains a Grid/Graph with
  Region and the Revenue, Cost, and Profit metrics. A selector displays the
  range of revenue values, including the minimum and maximum values
  (in the example below, $1,761,187.19 and $8,554,414.55). A user can
  move the slider to select a new minimum and maximum revenue to
display. In this example, the selector is filtering the Revenue metric to
display only those regions with Revenue values between $3,343,953 and $7,983,672.

For a slider, you can choose to either include or exclude the values from the target. This means that the values that a user chooses in the selector can display in the target, or they can be hidden. For examples, see Determining whether the selector includes or excludes data: selection type, page 132.

In addition, if the selector title bar is displayed, a user can change whether the selector filters on metric values, ranks, or percent ranks.

- A qualification, which the user completes to filter the metric's values. This type of metric condition selector allows a user to:
  - Select whether to filter on the metric values or ranking
  - Select the operator (equals, greater than, and so on)
  - Type the value to filter on

For example, given the same regional revenue Grid/Graph described above, a user could display only the revenue values greater than $5,000,000 (as shown in the example below) or only the top-ranking 5 regions in term of revenue. After the user completes the qualification, he clicks the check mark ✓ to apply the qualification.
To change whether the selector filters on metric values, ranks, or percent ranks, the user clicks the down arrow in the title bar to open the drop-down list, as shown below:

For either a slider selector or a qualification selector, the title bar contains a drop-down list to select whether to filter on metric values, ranks, or percent ranks, as described below. If the title bar is hidden, the option chosen when the selector was defined is used. For instructions to display the title bar, see Displaying title bars in selectors, page 167.

- **Value** filters the target by the metric's values.
- **Rank Highest** ranks the metric's values in descending order, and then filters by rank. For example, Rank Highest=2 displays the two highest values.
- **Rank Lowest** ranks the metric's values in ascending order, and then filters by rank. For example, Rank Lowest=2 displays the two lowest values.
- **Rank % Highest** ranks and filters by the number of metric values (or rows) in the target, in descending order. For example, if the target Grid/Graph contains eight items, the Rank % Highest =25 displays the two highest values.
- **Rank % Lowest** ranks and filters by the number of metric values (or rows) in the target, in ascending order. For example, if the target Grid/Graph contains eight items, the Rank % Lowest =25 displays the two lowest values.
You can choose to either automatically maintain the targets of attribute and metric selectors, or manually define these targets.

- If targets are automatically maintained in the layout, attribute and metric selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector.
- If targets are not automatically maintained, you must manually select the targets when you create all types of selectors.

For more information on automatically maintaining targets, including instructions to enable or disable it, see *Automatically maintaining targets for selectors, page 134*.

For complete instructions to create a metric condition selector, refer to the *Desktop Help*.

## Applying selections as filters or slices

The selections a user makes in a selector affects how data is calculated and displayed in the selector’s target. You can define the selector to either filter or slice the target:

- **Filtering** means that the data for the current selection is calculated only when it is requested by the user. The selections are used to filter the underlying dataset before the metric values are aggregated at the level of the Grid/Graph that is displayed in the dashboard. If the source attribute is not included in the Grid/Graph, the metric values from all the selected elements are aggregated and shown at the level specified in the Grid/Graph.

  All metric condition selectors, which filter metric values or ranks, and selectors that target other selectors are filtering selectors. You cannot change them to slicing selectors.

- **Slicing** means that the data for each available item in the selector is calculated in advance when the document is first displayed. The selections are used to determine which slices of data are combined and shown in the Grid/Graph. Even if the source attribute is not included in the Grid/Graph, the data is still sliced at the level of the source attribute, and therefore the metric values from multiple selected items are not added together. Instead, the data for each selected element is shown separately in the Grid/Graph, the same as if the source attribute had been included in the Grid/Graph.
For example, the dataset report of a dashboard contains Region, Year, and the Revenue metric. A Grid/Graph displays Year and Revenue only, and is targeted by a selector with Region as its source. The selector is defined to slice the data. When Central is selected, three rows, one for each year, are displayed, as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td></td>
<td>$1,293,634</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$1,667,004</td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td>$2,058,728</td>
</tr>
</tbody>
</table>

If you select Mid-Atlantic as well as Central, six rows are displayed, two for each year, as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td></td>
<td>$1,293,634</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$1,667,004</td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td>$2,058,728</td>
</tr>
</tbody>
</table>

This occurs because the selector slices the data by region before the user selections are made, and cannot aggregate the slices for multiple regions.

If you change the selector to filter rather than slice the data, the yearly revenue is aggregated across the selected regions. The yearly revenue is
calculated by adding the Central and Mid-Atlantic values for each year, and only one row for each year is displayed in the Grid/Graph, as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007</td>
<td></td>
<td>$2,433,643</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$3,185,596</td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td>$3,862,742</td>
</tr>
</tbody>
</table>

Other important differences between filtering and slicing selectors are described below:

- Slicing allows the total to be displayed as an item in the selector. A filtering selector does not display the total as a selector item. (For background information on selector totals, see *Showing totals for selectors, page 163*.)

- Slicing allows you to specify that the selector automatically uses a default selection when other changes in the dashboard cause the selection made by the user to return no data. Default selections are not available for filtering selectors. (For background information on default selections, see *Determining how the target of a selector displays when no data exists, page 149*.)

- Slicing is performed on Intelligence Server in Express Mode in MicroStrategy Web and on the client in Flash Mode in MicroStrategy Web. Filtering is performed on the Intelligence Server in both modes. This means that when a user chooses different items in a selector, a call is made to the web server to update the document, except when a slicing selector is used in Flash Mode. In that case, the web server is not called, which can make the document run faster as users change selections. In contrast, a filtering selector can speed up the initial load time of a document in Flash Mode, since all the slices do not need to be initially downloaded to the client. However, when a filtering selector targets a panel stack, all static content, dynamic text fields, and links in the target panel are copied and sent to the client for every new slice of data. To maximize performance, MicroStrategy recommends removing all content that is either static or independent of the selector out of the target panel.

- If a selector is sliced, you can define the current state, which determines how the target is displayed when the dashboard is executed. The target can display all the selector items, a specific number of the first items, or a
specific number of the last items. If a selector is filtered, you can define the current state as unset only, which displays all the selector items. For more information on the different states, see Determining how the target of a selector displays (current state), page 154.

Selectors in a dashboard that is viewed off-line

When a dashboard is viewed off-line (exported to Flash, in a subscription, or in MicroStrategy Office):

- If a selector is applied using filtering, only the data for the current selections are included in the dashboard. An off-line user cannot change the selector and update the target.

- If a selector is applied using slicing, all the slices, and therefore all the data, are included in the dashboard. An off-line user can change the selector and update the target.

For example, the dataset report of a dashboard contains Region, Year, and the Revenue metric. A Grid/Graph displays Year and Revenue only, and is targeted by a selector with Region as its source. The selector is applied as a filter. Only Central is selected, and the dashboard is exported to a Flash file to be used off-line, without using MicroStrategy. The Flash file contains only the data for Central, and no other selections can be made.

If the selector is applied as a slice instead, all the data is sliced and included in the Flash file. Even if only the Central region is selected when the dashboard is exported, you can use the selector in the Flash file and display other regions.

For instructions to export a dashboard to Flash, see Exporting dashboards to Flash for stand-alone use, page 55.

Defining selectors to filter or slice targets

You can define whether:

- A specific selector slices or filters the data. See To apply selections as filters or slices for a specific selector, page 130 for instructions.

  All metric condition selectors, which filter metric values or ranks, and selectors that target other selectors are filtering selectors. You cannot change them to slicing selectors.
• A specific target is sliced or filtered by a selector, allowing you to filter one target and slice another using the same selector. See To apply selections as filters or slices for a specific target, page 131.

• Selectors in the entire dashboard slice or filter the data. This document-level setting is used to define the behavior of new selector targets, except when the target being added is already the target of another selector that uses the same source. In that case, the target uses the behavior defined in the other selector. For instructions, see To apply selections as filters or slices (document-level), page 131.

For example, at the document level, selectors are defined as filters.

- Selector1 targets Grid/Graph1 as a filter, using Region as the source.
- Selector2 targets Grid/Graph2 as a slice, using the same attribute, Region, as the source.
- The dashboard also contains a third Grid/Graph, which is not the target of any selectors.

Open Selector1 and add Grid/Graph2 as a target. It is automatically defined as a slice, because Grid/Graph2 is already the target of Selector2 (a slicing selector), and both selectors use the same attribute, Region.

Add Grid/Graph3 as a target to Selector1. It is automatically defined as a filter, because Grid/Graph3 is not already the target of another selector.

---

To apply selections as filters or slices for a specific selector

1 Open the dashboard in Design View in the Document Editor.

2 Right-click the selector to update, and select Properties. The Properties dialog box opens.

3 Click the Selector tab.

4 To define how the selector is applied to all targets, do one of the following:

   - To apply the selections as a filter, select the Apply selections as a filter check box.
• To apply the selections as a slice, clear the **Apply selections as a filter** check box.

> If **Apply selections as a filter** is unavailable, the selector is applied as both a filter and a slice for different targets. Use the **Type** column in the **Selected targets** list instead, as described below.

5 To define how the selector is applied to a specific target, change the **Type** in the **Selected targets** list. This allows you to filter one target and slice another using the same selector.

6 Click **OK** to return to the dashboard.

---

**To apply selections as a filters or slices for a specific target**

1 Open the dashboard in Design View in the Document Editor.

2 Right-click the selector to update, and select **Properties**. The Properties dialog box opens.

3 Click the **Selector** tab.

4 In the **Selected targets** list, select the **Type** for the target that you want to change.

5 Click **OK** to return to the dashboard.

---

**To apply selections as filters or slices (document-level)**

This document-level setting is applied to all new selectors that do not have a target, except when the new target is already the target of another selector that uses the same source.

1 Open the dashboard in Design View in the Document Editor.

2 From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.

3 Click **Document** in the list on the left.
4  Do one of the following:

• To apply the selections as a filter, select the **Apply selections as a filter for all new targets** check box.

• To apply the selections as a slice, clear the **Apply selections as a filter for all new targets** check box.

5  Click **OK** to return to the dashboard.

**Determining whether the selector includes or excludes data: selection type**

You can specify whether an element selector or a metric condition slider selector includes or excludes the selected data, by defining the Selection Type option. (An element selector displays different elements of attributes, custom groups, or consolidations; a metric condition slider displays a slider to filter metric values or rank.)

For example, a dashboard contains an element selector that displays regions and targets a Grid/Graph. A user can select regions and by default they are displayed rather than hidden in the Grid/Graph, as shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$156,930</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Foks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td>Hollywood</td>
<td>Robert</td>
<td></td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
<tr>
<td></td>
<td>Ingles</td>
<td>Walter</td>
<td>$229,439</td>
<td>$194,851</td>
<td>$34,588</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
<td>$188,010</td>
<td>$33,368</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$209,634</td>
<td>$178,331</td>
<td>$31,303</td>
</tr>
<tr>
<td>Northeast</td>
<td>De Le Torre</td>
<td>Sandra</td>
<td>$507,885</td>
<td>$514,795</td>
<td>$93,100</td>
</tr>
<tr>
<td></td>
<td>Kelly</td>
<td>Laura</td>
<td>$2,250,720</td>
<td>$1,992,726</td>
<td>$357,994</td>
</tr>
<tr>
<td></td>
<td>Kieferon</td>
<td>Jack</td>
<td>$564,933</td>
<td>$497,463</td>
<td>$67,470</td>
</tr>
<tr>
<td></td>
<td>Sawyer</td>
<td>Leanne</td>
<td>$2,411,912</td>
<td>$2,043,693</td>
<td>$368,219</td>
</tr>
<tr>
<td></td>
<td>Sonder</td>
<td>Melanie</td>
<td>$285,108</td>
<td>$251,183</td>
<td>$43,925</td>
</tr>
<tr>
<td></td>
<td>Yager</td>
<td>Beth</td>
<td>$2,303,847</td>
<td>$1,953,823</td>
<td>$350,024</td>
</tr>
</tbody>
</table>

Change the selection type to exclude items, and update the text displayed in the title bar to reflect that change. When the dashboard is executed again, and the user selects Mid-Atlantic and Northeast, all regions except
Mid-Atlantic and Northeast are displayed. Notice that Mid-Atlantic and Northeast are still selected, but are also crossed out, in the selector.

The following procedure assumes you have already created an element selector or a metric condition slider selector. For instructions, see *Methods to create a selector, page 117*.

To define the selection type

1. Open the dashboard in Design View in the Document Editor.
2. Right-click the selector to update, and select **Properties**. The Properties dialog box opens.
3. Click the **Selector** tab.
4. From the **Selection Type** drop-down list, select either:
   - **Include**: (The default) The target displays the items that the user chooses.
   - **Exclude**: The target hides the items that the user chooses.
5. Click **OK** to return to the dashboard.
Automatically maintaining targets for selectors

If targets are enabled to be automatically maintained:

- All attribute, metric, and metric condition selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector.

- You cannot change the target of an attribute, metric, or metric condition selector, except by moving controls to different document sections.

- You cannot choose a selector as the target of another selector. (You can place the target selector on a panel in the same document as the source selector. The target selector is the selector updated by the source selector. With automatic target maintenance, the source selector will automatically target that panel stack.)

- Any new Grid/Graph or panel stack is automatically added as the target of all attribute, metric, and metric condition selectors in the same panel or document section.

Targets are not automatically maintained for panel selectors; you always manually define the targets for panel selectors. For instructions, see Methods to create a selector, page 117.

For example, a dashboard has automatic target maintenance enabled. The document contains the following objects, as shown in Design View below:

- Grid/Graph 1 in the Document Header section
- Grid/Graph 2 in the Detail Header section
- Panel stack 1, which displays region, in the Detail Header

Insert a selector (Selector 1) into the Document Header, and another (Selector 2) into the Detail Header.

- Selector 1 automatically targets Grid/Graph 1, as shown in the Property List below, since they are both in the same document section.

- Selector 2 automatically targets Grid/Graph 2 and Panel Stack 1, as shown in the Properties dialog box below, since all three objects are in the same document section. Grid/Graph 1 is not a target of Selector 2. (You can tell that automatic target maintenance is enabled, because the
Available targets list and arrow buttons are grayed out, and the Manual Targets button is available.

The selectors are not completely defined by the automatic target maintenance. They do not have a Source, as shown in the Property List image above. For both selectors, define the Source as Region. Open the dashboard in Interactive Mode in MicroStrategy Web. Select Mid-Atlantic in Selector 1 (the selector above Grid/Graph 1), and Central in Selector 2 (the selector above Grid/Graph 2). The dashboard displays as shown below:

- Grid/Graph 1 displays data for the region chosen in Selector 1 (Mid-Atlantic).
• Grid/Graph 2 displays data for the region chosen in Selector 2 (Central).
• Panel Stack 1 will display the region name chosen in Selector 2 (Central).

Insert a second panel stack (Panel Stack 2) in the Detail Header section. The new panel stack is automatically added as a target of Selector 2. Add the Region attribute to Panel Stack 2. When you view the dashboard in Interactive Mode in MicroStrategy Web, Panel Stack 2 displays the region name chosen in Selector 2, which is Central in the dashboard sample shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$866,702</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
<td>$871,679</td>
</tr>
<tr>
<td></td>
<td>Ingle</td>
<td>Walter</td>
<td>$229,439</td>
<td>$194,651</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
<td>$188,010</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$209,634</td>
<td>$178,331</td>
</tr>
</tbody>
</table>

Insert a panel stack selector for Panel Stack 1 (right-click the panel stack and select **Insert Panel Stack Selector**). The new selector’s target is defined as Panel Stack 1, and the selector will change which panel is displayed in the target. A panel stack selector automatically targets the panel stack that it is created for; targets are not automatically maintained for panel stack selectors. If the automatic target maintenance applied to panel stack selectors, both Panel Stack 1 and Panel Stack 2 would be targeted, since both panel stacks are in the same document section as the selector. When you view the dashboard in Interactive Mode in MicroStrategy Web, Panel Stack 1 displays the panel chosen in the panel stack selector. In the following
example, the panel stack selector has been used to select Panel 2. Note that Panel Stack 1 now displays Panel 2, rather than a region name.

An attribute on a Grid/Graph can be used as a selector that targets a panel stack or another Grid/Graph. If a user clicks an attribute on the first Grid/Graph, the target changes to display information for only that attribute. Automatic selector maintenance applies to these types of selectors, as well. All the Grid/Graphs and panel stacks in the same document section or panel as the selected Grid/Graph are automatically chosen as targets. For more information, see Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.

Controlling targets when targets are automatically maintained

When targets are automatically maintained, you can still control what target is chosen for a selector, by placing controls in different document sections. For example, a dashboard should have a selector that targets Grid/Graph 1 but not Grid/Graph 2. Simply place Selector 1 and Grid/Graph 1 in one document section, where they are automatically linked. Place Grid/Graph 2 in another document section, and the Grid/Graph is not targeted by Selector...
1. (You can insert additional document sections as necessary; see the Desktop Help for instructions.)

If an object is moved between panels or document sections, selector targets are updated to automatically maintain the targets. For example, Selector 1 targets Panel Stack 1, located in the Document Header section. The Detail Header section contains Selector 2, which targets Panel Stack 2 and Grid/Graph 1 which are also in the Detail Header section. If you move Panel Stack 2 from the Detail Header to the Document Header:

- Selector 1 now automatically targets Panel Stack 2, as well as Panel Stack 1.
- Selector 2 now automatically targets only Grid/Graph 1.

If you cannot move controls, you can place them in different panel stacks in the same document section. Make the panel stack invisible by using a transparent background and no borders, and hiding the title bar.

For example, a dashboard contains two Grid/Graphs, 01 Basic Report and Region-Category Inventory, in the Detail Header, as shown in Design View below.

![Diagram of dashboard with two Grid/Graphs: 01 Basic Report and Region-Category Inventory.](Diagram)

You need a selector in the Detail Header that targets only the Basic Report. When a user selects a different region, the Basic Report should change, but never the Inventory report. Automatic target maintenance is enabled in the layout, because you want targets in other parts of the layout to continue to be automatically updated when you add new panel stacks and Grid/Graphs.

If you add the selector in the Detail Header, it will target both the Basic Report and the Inventory report. Instead, create a panel stack in the Detail Header, and format it to be invisible (a transparent background, no borders, and hidden title bar). Move the Basic Report into the panel stack. Add a
selector to the panel stack. The selector targets the Basic Report, because they are on the same panel stack. The selector does not target the Inventory report, because the Inventory Report, although in the same document section as the selector, is not on the same panel stack. The following image of the Selector tab of the Properties dialog box for the selector shows that:

1 Automatic target maintenance is enabled (the Available targets and Selected targets lists are unavailable)

2 Only the Basic Report is selected as a target

The dashboard is shown below, in Interactive View in MicroStrategy Web. Notice that you do not see the panel stack at all.
Click the Southeast button on the selector to display data for only Southeast in the Basic Report. The Inventory report does not change, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>Benner Ian Lynch Sam McCain Sean Strome Fred</td>
<td>$520,737 $592,471 $531,371 $595,372</td>
</tr>
</tbody>
</table>

Disabling automatic target maintenance to allow manual target selection

You may want to manually select the targets for attribute, metric and metric condition selectors. For example, you may want a selector to target a Grid/Graph or panel stack that is not in the same document section or panel as the selector. You may want a selector to target another selector.

To allow this, disable automatic target maintenance. Targets that were automatically maintained are saved; no targets are deleted or changed. You can now define new targets, including other selectors, for existing attribute, metric, and metric condition selectors. If you create any new selectors, you must manually select the targets for them.
For example, a dashboard has automatic target maintenance enabled. The dashboard contains the following objects:

- In the Document Header section:
  - Grid/Graph 1
  - Selector 1, which targets Grid/Graph 1 to display data about the selected Region

- In the Detail Header section:
  - Grid/Graph 2
  - Panel Stack 1
  - Selector 2, which targets Grid/Graph 2, to display data about the selected region, and Panel Stack 1, to display the selected region name
  - Panel Stack Selector, which targets Panel Stack 1 to switch panels

Disable automatic target maintenance. The selector targets remain the same, but you can now modify them manually, as shown in the Properties dialog box below:

![Properties dialog box](image)

Add another selector to the Detail Header section. No targets are automatically defined, so you must manually define the targets.

### To disable automatic target maintenance while editing a selector

This procedure assumes that you are editing the settings of a selector.

1. On the **Selector** tab of the Properties dialog box, click **Manual Targets**. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance.

2. Click **OK**. You are returned to the Properties dialog box. Automatic target maintenance has been disabled for all selectors in the layout.
To disable automatic target maintenance

1. Open the dashboard in the Document Editor.
3. Click Layout in the list on the left.
4. Clear the Automatically maintain targets for all selectors in this Layout check box.
5. Click OK to return to the dashboard.

Enabling automatic target maintenance

When you enable automatic target maintenance on a layout, the targets of all existing attribute, metric, and metric condition selectors are replaced with all the Grid/Graphs and panel stacks that are in the same panel or document section as the selector. However, if a selector is the target of another selector, it is not replaced.

For example, a dashboard has automatic target maintenance disabled. The dashboard contains the following objects:

- In the Document Header section:
  - Grid/Graph 1
  - Selector 1, which targets Grid/Graph 1 and Grid/Graph 2 to display data about the selected Region

- In the Detail Header section:
  - Grid/Graph 2
  - Panel Stack 1
  - Selector 2, which targets Panel Stack 1 to display the selected region name
  - Panel Stack Selector, which targets Panel Stack 1 to switch panels
Notice that Selector 1 targets Grid/Graph 2, which is not in the same document section as the selector.

Enable automatic target maintenance. The targets of all existing selectors are redefined to those Grid/Graphs and panel stacks in the same document section as the selector. Now the dashboard contains the following objects:

- In the Document Header section:
  - Grid/Graph 1
  - Selector 1, which targets Grid/Graph 1 to display data about the selected Region (Grid/Graph 2 has been removed from the target list)

- In the Detail Header section:
  - Grid/Graph 2
  - Panel Stack 1
  - Selector 2, which targets Grid/Graph 2 to display data about the selected Region, and Panel Stack 1 to display the selected region name (Grid/Graph 2 has been added to the target list)
  - Panel Stack Selector, which targets Panel Stack 1 to switch panels (panel stack selectors are not affected by automatic target maintenance)

To enable automatic target maintenance

1. Open the dashboard using the Document Editor in Design View.
3. Click Layout in the list on the left.
4. Select the Automatically maintain targets for all selectors in this layout check box.
5. Click OK to return to the dashboard.
Allowing users to select multiple items

Recall that items in a selector are the elements, metrics, metric values, or panels that are listed in the selector. The user selects an item to change the panel, Grid/Graph, or other selector. If the style of a selector is one of those listed below, the user can choose more than one item in the selector:

- Slider (except for metric condition selectors)
- Search Box
- Listbox
- Link Bar
- Button Bar
- Check Boxes

Use the **Allow multiple selections** option to determine whether users can select more than one item in a selector. For all other styles, this option is unavailable, since those styles do not support multiple selections.

The Check Boxes style always allows multiple selections; you cannot change the **Allow multiple selections** option.

### To allow multiple selections in a selector

1. Open the dashboard using the Document Editor in Design View.
2. From the **Format** menu, select **Properties**. The Properties dialog box opens.
3. On the **Selector** tab, select the **Allow multiple selections** check box.
4. Click **OK** to return to the dashboard.

### To disable multiple selections in a selector

1. Open the dashboard using the Document Editor in Design View.
2. From the **Format** menu, select **Properties**. The Properties dialog box opens.
3 On the **Selector** tab, clear the **Allow multiple selections** check box.

4 Click **OK** to return to the dashboard.

### Controlling how data updates: Automatically apply selector changes

Once a user chooses an item in the selector, the target immediately updates without any additional user interaction. This is referred to as automatic submission. If multiple items are selected, the target is automatically updated after each individual selection, which can take some time. Therefore, if multiple items are allowed, disable the **Automatically apply selector changes** option, allowing the user to choose when to update the target. The user can pick either a single item or multiple items, and then click **Apply** to update the target.

For metric condition selectors that use a qualification, the user must click the check mark to apply the qualification to the target.

The **Automatically apply selector changes** option is set for an entire dashboard, not for an individual selector. Selectors on a filter panel (a type of panel stack that contains only selectors) are controlled by a similar setting for filter panels, which applies in Express Mode and Flash Mode. The document level setting applies to selectors in a filter panel displayed in other modes. For details on how the filter panel setting works, see *Controlling how data updates in a filter panel: Automatic apply, page 89.*

The **Apply** button is displayed only if the **Automatically apply selector changes** option is disabled and the user clears or selects an item in the selector.

---

### To disable automatic submission for a dashboard

1 Open the dashboard using the Document Editor in Design View.

2 From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.

3 On the **Document** tab, clear the **Automatically apply selector changes** check box.
4 Click **OK** to return to the dashboard.

**Disabling simultaneous display of all items in a selector**

The dashboard in the following image is shown in Editable Mode in MicroStrategy Web. It contains a Grid/Graph with a link bar selector. The items of the selector are the regions from the Grid/Graph. The user has clicked (All) in the selector, so all the regions are displayed on the Grid/Graph.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Central</strong></td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrmion</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td><strong>Mid-Atlantic</strong></td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$886,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
</tbody>
</table>

The All option is displayed by default in a selector, but you can remove it by disabling the **Show option All** setting. The same dashboard, with this setting disabled, looks like the following:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Central</strong></td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrmion</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
</tbody>
</table>
Now a user can only display each region separately; he cannot display all regions simultaneously.

- The All option is not available when the target of the selector is a panel stack, since you cannot display multiple panels simultaneously. It is also unavailable for metric condition selectors.

### To disable simultaneous display of all items

1. Open the dashboard using the Document Editor in Design View.
2. Select the selector to modify.
3. In the Property List: Data section, set **Show option All** to False.
   
   - You can also use the Properties dialog box to change the setting.

### Renaming the All option of a selector

The All option allows a user to display all the items in the selector. For example, a Grid/Graph displays metrics for employees and regions. The user can choose which regions to display by using a selector. If the user clicks the (All) item, all the regions are displayed in the Grid/Graph. This example is shown in *Disabling simultaneous display of all items in a selector, page 147.*

By default, this item is displayed as (All), but you can replace the text of the item. To continue with the example, replace (All) with All Regions to provide an explicit description of the item. This is shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$688,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
<td>$671,679</td>
<td>$155,195</td>
</tr>
</tbody>
</table>
To rename the All option of a selector

1. Open the dashboard using the Document Editor in Design View.
2. Select the selector to modify.
3. In the Property List: Data section, enter the new name of the item in the Alias for All setting.

You can also use the Properties dialog box to rename the All option.

Determining how the target of a selector displays when no data exists

A panel displays a Grid/Graph with Call Center and Region as the attributes. The panel also contains a selector that lists Call Centers and targets the Grid/Graph. Outside of the panel stack, another selector lists Regions. Its target is the panel stack and therefore the selector on that panel as well. Refer to these selectors as the regional selector and the call center selector. This dashboard is shown below in Design View.

In Interactive Mode in MicroStrategy Web, choose Central in the regional selector. The first Call Center, Milwaukee, is displayed in the Grid/Graph, as
shown below in Interactive Mode. Notice that the call center selector automatically shows Milwaukee as selected.

Select Fargo in the call center selector, and the Grid/Graph is updated, as shown below.

Click Central in the region selector to clear it. Since no regions, and therefore no call centers, are selected, the Grid/Graph cannot display any data. A message is displayed that no data exists, as shown below:

Select Northwest in the regional selector. The Grid/Graph displays a message that no data is returned, and no call center is selected in the call
center selector. The Grid/Graph tries to return data that is both Region = Northwest and Call Center = Fargo, but no such data exists, as shown below.

To automatically display the first Call Center in the new Region instead, allow the call center selector to be automatically updated. If you follow the same path as before, when you select **Northwest** in the regional selector, the Grid/Graph is updated to display San Francisco, as shown below. Notice that the call center selector shows San Francisco as selected.

**Prerequisites**

Before you can allow a selector to be automatically updated, the following requirements must be met:

- The selector that you want to be automatically updated must be both:
  - On a panel.
  - A slicing selector, not a filtering selector. For a comparison of filtering and slicing selectors, see *Applying selections as filters or slices, page 126*.

- The selector that updates the automatically updated selector must target the panel stack.

  You can create cascading selectors, where one selector updates another, and the second updates a third. To ensure that a selection
in one selector affects all its targets, you must define the selectors in the order of the attributes’ hierarchy. For an example, see *Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.*

The following procedure re-creates the example shown above, using MicroStrategy Tutorial data.

---

**To allow a selector to be automatically updated when no data exists**

**Create the dataset report**

1. Create a report with Call Center and Region on the rows, and the Revenue metric on the columns.

2. Save the report, naming it **Call Center Revenue by Region.**

**Create the dashboard**

3. Create a new dashboard, selecting **Call Center Revenue by Region** as the dataset. The new dashboard opens in the Document Editor in Design View.

4. Insert a panel stack. For directions, see *To insert a panel stack, page 70.*

5. Drag the **Call Center Revenue by Region** dataset from the Datasets pane onto the panel.

**Create the Call Center selector**

6. From the **Insert** menu, point to **Selector**, then choose the **Button Bar** selector style. When you move the cursor to the Layout area, the pointer becomes crosshairs.

7. Click to the left of the Grid/Graph in the panel. Click and drag to size the selector, using the dashboard samples in *Determining how the target of a selector displays when no data exists, page 149* as a guide.

8. Right-click the selector and choose **Properties.** The Properties dialog box opens.

9. Click the **Selector** tab.

10. Specify **Select attribute element** as the **Action type.**
11 In the Source drop-down list, select Call Center. The Call Center elements will display as items in the selector.

12 Notice that the Grid/Graph is automatically placed in the Available targets list. The selector will change the call center displayed on the Grid/Graph.

Allow the Call Center selector to be automatically updated

13 Clear the Apply selections as a filter check box. If the selector is not a slicing selector, the Automatically update when there is no data for the current selection check box is not available. For a comparison of filtering and slicing selectors, see Applying selections as filters or slices, page 126.

14 Select the Automatically update when there is no data for the current selection check box.

15 Notice that the Current State is defined as Use First and Number of Elements is set to 1. By default, when a slicing selector is first displayed in MicroStrategy Web, the first item in the target is selected in the selector, and its target displays data for that item (in this case, Atlanta). For a complete description of the Current State setting, including examples, see Determining how the target of a selector displays (current state), page 154.

16 Click OK to return to the dashboard.

Create the Region selector

17 From the Insert menu, point to Selector, then choose the Check Boxes selector style. When you move the cursor to the Layout area, the pointer becomes crosshairs.

18 Click and drag in the Document Header section to size the selector, using the document samples in Determining how the target of a selector displays when no data exists, page 149 as a guide.

19 Right-click the selector and choose Properties. The Properties dialog box opens.

20 Click the Selector tab.

21 Specify Select attribute element as the Action type.
22 Select Region in the Source drop-down list. The Region elements are displayed as items in the selector.

23 Clear the Show Option for All check box.

24 Click Manual Targets, then select OK at the prompt. The Available targets and Selected targets lists are now available.

25 Select the panel stack in the list of Available targets and click > to move it to the list of Selected targets. The selector will change the region displayed on the Grid/Graph in the selector and update the call centers listed on the Call Center selector.

26 Click OK to return to the dashboard.

Save the document

27 Save and close the dashboard.

To interact with the selectors, you must view the dashboard in Interactive Mode, Editable Mode, or Flash Mode in MicroStrategy Web.

Determining how the target of a selector displays (current state)

By default, when a filtering selector is first displayed in MicroStrategy Web, none of the selector items are selected, so the selector's target displays all of the available items (all the regions, for instance, if the selector's source is Region). If the selector slices rather than filters the data, by default the first item in the target is selected in the selector, and its target displays data for that item (for example, Central, if the source is Region).

Selector items are the elements that are listed in the selector. The user selects an item to update the target panel, Grid/Graph, or other selector.

A user can make selections in the selector, which updates the target. If the user does not save the dashboard, when the dashboard is re-executed, the selector and target are displayed according to the default (all data for a filtering selector, the first item for a slicing selector). If the user saves the dashboard with his selections, when the document is re-executed, the selector and target are displayed according to those selections.
You can change these defaults by using the Current State setting to define how a slicing selector and its target are first displayed. You can define the Current State to display all items in the target or only a specific number of items. When a user saves the dashboard after selecting items in the selector, the Current State setting is Set to Specific Elements (the ones that the user specified).

A filtering selector always displays as unset (all items are displayed) until a user saves the dashboard after selecting items, when the Current State setting is Set to Specific Elements (user-specified).

For both slicing and filtering selectors, you cannot set the Current State to Set to Specific Elements; this state only occurs when a user saves the dashboard with updated selections.

You can define the Current State only for selectors that target attribute elements on Grid/Graphs or panel stacks (See Methods to create a selector, page 117 for descriptions). Since selectors work only in MicroStrategy Web, this setting is applied only in MicroStrategy Web.

This section contains the following information on setting the Current State:

- For a more detailed description of the various Current State options, see Defining the Current State of a selector, page 161.
- For examples of the Current State setting in a slicing selector, see Current State setting with a slicing selector, page 155.
- For examples of the Current State setting in a filtering selector, see Current State setting with a filtering selector, page 157.

Slicing selectors and filtering selectors are discussed separately because they have different Current State options.

- For examples of the Current State settings used with multiple targets, see Current State settings and multiple targets, page 159.
- For a procedure to define the current state setting, see To determine how the target of a selector displays, page 162.

**Current State setting with a slicing selector**

For example, a dashboard contains a Grid/Graph and a slicing selector that targets the Grid/Graph. The Region attribute is the source of the target. By
default, the selector's current state is defined to display the first selector item.

When the dashboard is executed in MicroStrategy Web, the check box for the first region, Central, is selected in the selector, so the target Grid/Graph displays data only for the Central region, as shown below:

In the selector, a user selects the Mid-Atlantic and Northeast check boxes, and clears the Central check box. Now only Mid-Atlantic and Northeast are displayed in the Grid/Graph. The user closes the dashboard without saving it, then re-executes the dashboard. As defined by the selector's Current State setting, Central is once again selected in the selector and displayed in the target.

As before, the user selects the Mid-Atlantic and Northeast check boxes, and clears the Central check box. Mid-Atlantic and Northeast are displayed in the Grid/Graph. This time, the user saves the dashboard before closing it, then re-executes it. The Grid/Graph displays the Mid-Atlantic and Northeast data, with Mid-Atlantic and Northeast checked in the selector, as shown below:

When the user saved the dashboard, the selector's state was saved and therefore it automatically changed the Current State setting to Set to
specific elements. This allows the user's saved selector choices to be displayed when the dashboard is re-executed.

If desired, you can reset the Current State setting of the selector, so that it once again automatically displays the first region when the dashboard is executed. To do this, define Current State as Use first, and set Number of Elements to one.

You can enter any number of elements. You can also define the Current State to display all the elements or to display the last number elements, then specify the number of elements to display.

Current State setting with a filtering selector

A dashboard contains a Grid/Graph and a filtering selector that targets the Grid/Graph. The Region attribute is the source of the target, and the selector filters the target. By default, the selector's Current State is defined as Unset. This means that the target Grid/Graph is unfiltered and therefore displays all the regions.
When a user executes the dashboard in MicroStrategy Web, all of the regions are displayed in the target Grid/Graph, as shown below. Notice that none of the check boxes in the selector are selected, since the selector state is unset.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$947,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loran</td>
<td>$1,669,300</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,593</td>
<td>$124,897</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$159,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Varnon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,674</td>
<td>$871,579</td>
<td>$155,195</td>
</tr>
<tr>
<td></td>
<td>Ingles</td>
<td>Walter</td>
<td>$229,430</td>
<td>$194,851</td>
<td>$34,588</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
<td>$188,010</td>
<td>$33,368</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$209,634</td>
<td>$178,331</td>
<td>$31,303</td>
</tr>
<tr>
<td>Northeast</td>
<td>De La Torre</td>
<td>Sandra</td>
<td>$607,805</td>
<td>$514,795</td>
<td>$93,100</td>
</tr>
<tr>
<td></td>
<td>Kelly</td>
<td>Laura</td>
<td>$2,350,720</td>
<td>$1,992,726</td>
<td>$357,994</td>
</tr>
<tr>
<td></td>
<td>Kieferon</td>
<td>Jack</td>
<td>$584,933</td>
<td>$497,463</td>
<td>$87,470</td>
</tr>
<tr>
<td></td>
<td>Sawyer</td>
<td>Leanne</td>
<td>$2,411,912</td>
<td>$2,043,693</td>
<td>$368,219</td>
</tr>
<tr>
<td></td>
<td>Sonder</td>
<td>Meanie</td>
<td>$295,108</td>
<td>$251,183</td>
<td>$43,925</td>
</tr>
<tr>
<td></td>
<td>Yager</td>
<td>Bath</td>
<td>$2,303,847</td>
<td>$1,953,823</td>
<td>$350,024</td>
</tr>
<tr>
<td>Northwest</td>
<td>Becker</td>
<td>Kyle</td>
<td>$508,234</td>
<td>$430,346</td>
<td>$77,887</td>
</tr>
<tr>
<td></td>
<td>Godot</td>
<td>Harriet</td>
<td>$739,741</td>
<td>$629,086</td>
<td>$110,655</td>
</tr>
<tr>
<td></td>
<td>Hall</td>
<td>David</td>
<td>$513,213</td>
<td>$434,770</td>
<td>$78,443</td>
</tr>
<tr>
<td>South</td>
<td>Conner</td>
<td>Beatrice</td>
<td>$1,650,752</td>
<td>$1,397,270</td>
<td>$253,472</td>
</tr>
<tr>
<td></td>
<td>Nelson</td>
<td>Arthur</td>
<td>$1,654,297</td>
<td>$1,402,779</td>
<td>$251,519</td>
</tr>
<tr>
<td></td>
<td>Pierce</td>
<td>Charles</td>
<td>$2,084,241</td>
<td>$1,792,276</td>
<td>$301,956</td>
</tr>
<tr>
<td></td>
<td>Banner</td>
<td>Ian</td>
<td>$520,737</td>
<td>$441,073</td>
<td>$79,664</td>
</tr>
<tr>
<td></td>
<td>Lynch</td>
<td>Sam</td>
<td>$592,471</td>
<td>$503,833</td>
<td>$88,638</td>
</tr>
<tr>
<td></td>
<td>McCan</td>
<td>Sean</td>
<td>$531,371</td>
<td>$453,072</td>
<td>$78,299</td>
</tr>
<tr>
<td></td>
<td>Strome</td>
<td>Fred</td>
<td>$595,372</td>
<td>$505,298</td>
<td>$90,074</td>
</tr>
<tr>
<td>Southeast</td>
<td>Bates</td>
<td>Michael</td>
<td>$1,068,907</td>
<td>$904,996</td>
<td>$163,911</td>
</tr>
<tr>
<td></td>
<td>Bell</td>
<td>Caitlin</td>
<td>$1,040,481</td>
<td>$883,441</td>
<td>$157,039</td>
</tr>
<tr>
<td></td>
<td>Hunt</td>
<td>Matthew</td>
<td>$731,413</td>
<td>$619,634</td>
<td>$111,779</td>
</tr>
<tr>
<td></td>
<td>Johnson</td>
<td>Andrew</td>
<td>$445,052</td>
<td>$378,221</td>
<td>$66,831</td>
</tr>
<tr>
<td></td>
<td>Sclafani</td>
<td>Rose</td>
<td>$408,280</td>
<td>$346,508</td>
<td>$61,772</td>
</tr>
<tr>
<td>Web</td>
<td>Walker</td>
<td>Robert</td>
<td>$3,902,762</td>
<td>$3,319,225</td>
<td>$583,538</td>
</tr>
</tbody>
</table>

The user selects Central in the selector. The Grid/Graph updates to display the data for the Central region only.

The user closes the dashboard without saving it, and then re-executes it. The selector's Current State is still set to the default setting of **Unset**, which means that all the regions are displayed in the target Grid/Graph.

The user then selects the Central check box again, so that the data for the Central region is displayed in the Grid/Graph. This time, the user saves the dashboard before closing it. When the user re-executes it, the Grid/Graph
displays the Central data, with Central checked in the selector, as shown below:

This time, because the user saved the dashboard, the selector's state was saved and therefore it automatically changed the Current State setting to **Set to specific elements**. This allows the user's saved selector choices to be displayed when the dashboard is re-executed.

### Current State settings and multiple targets

If a selector has multiple targets, the selector display is affected by whether all the targets contain the same elements. If they do not, the Current State settings are applied differently.

One way that target Grid/Graphs can contain different elements is if one Grid/Graph has a view filter. For example, a dashboard contains two Grid/Graphs. The Employee Revenue Grid/Graph contains the Region attribute, Employee attribute, and Revenue metric. The Regional Revenue Grid/Graph contains the Region attribute and Revenue metric. Both Grid/Graphs are targeted by a selector. Both Grid/Graphs contain the same elements. A view filter is applied to the Regional Revenue Grid/Graph, to exclude Central. Now the Grid/Graphs contain different elements, since Employee Revenue includes the Central region and Regional Revenue does not.

For a slicing selector, the default Current State displays the first element in the targets, with the first element selected in the selector. Both Grid/Graphs display data for the Central region. If the targets contain different elements, the first element for each target is displayed: Central in the Employee Revenue Grid/Graph and Mid-Atlantic in the Regional Revenue Grid/Graph.
Because the displayed elements are different, no item is selected in the selector, as shown below:

For a filtering selector, the default Current State displays all the elements in the targets, with no element selected in the selector. Both Grid/Graphs display data for all the regions. If the targets contain different elements, each target still displays all its elements, but the Regional Revenue Grid/Graph does not contain Central, as shown below:
Defining the Current State of a selector

The state of a selector is controlled by the Current state and Number of Elements settings, as described below:

- For a slicing selector, the following scenarios are possible:
  - The target displays the first Number of Elements, where Number of Elements is selector items. For example, if the selector source is Region and Number of Elements is defined as two, the first two regions (Central and Mid-Atlantic) are displayed.
    
    To do this, set **Current State** to **Use first** and specify the Number of Elements.
  
  - The target displays the last Number of Elements, where Number of Elements is selector items. For example, if the selector source is Region and Number of Elements is defined as one, the last region (Web) is displayed.
    
    To do this, set **Current State** to **Use last** and specify the Number of Elements.
  
  - The target displays data for all the items in the selector.
    
    To do this, set **Current State** to **All**.
  
  - When a user chooses items in the selector, the target displays the selected items. When the user saves the dashboard with his selections, **Current State** is automatically switched to **Set to specific elements**.
    
    **Current State** is automatically defined as **Set to specific elements**; you cannot select this option.

- For a filtering selector, the following scenarios are possible:
  
  - The target is not filtered and therefore displays data for all items in the selector. In the selector, none of the selector items is selected. A drop-down list will have blank space, a button bar will not have any buttons selected, no radio buttons will be selected, and so on.
    
    To do this, set **Current State** to **Unset (no filter)**.
  
  - When a user chooses items in the selector, the target displays the selected items. When the user saves the dashboard with his selections, **Current State** is automatically switched to **Set to specific elements**.
**Current State** is automatically defined as **Set to specific elements**; you cannot select this option.

For the differences between slicing and filtering selectors, see *Applying selections as filters or slices, page 126.*

**Prerequisites**

The following procedure assumes that the dashboard contains:

- A selector that targets attribute elements on a Grid/Graph. For instructions to create a selector, see *Methods to create a selector, page 117.*
- A Grid/Graph that is used as the target of the selector. For instructions to add a Grid/Graph to a dashboard, see the *Desktop Help.*

**To determine how the target of a selector displays**

1. Open the dashboard using the Document Editor in Design View.

2. Right-click the selector to modify and choose **Properties.** The Properties dialog box opens.

3. Click the **Selector** tab.

4. Select one of the following options from the **Current State** drop-down list:

   - If **Apply selections as a filter** is cleared (which means that the selector slices data):
     - To display the first **Number of Elements**, select **Use first.** For example, if the selector source is Region and Number of Elements is defined as two, the first two regions (Central and Mid-Atlantic) are displayed.
     - To display the last **Number of Elements**, select **Use last.** For example, if the selector source is Region and Number of Elements is defined as one, the last region (Web) is displayed.
     - To display data for all the items in the selector, select **All.**
• If **Apply selections as a filter** is selected:
  - To display data for all items in the selector, select **Unset (no filter)**.

  When a user has chosen items in the selector, **Set to specific elements** is selected automatically. The target displays the items that the user chose in the selector. This option is shown only when a user has chosen selector items, and is available for both filtering and slicing selectors.

5 If **Current state** is set to either **Use first** or **Use last**, type the number of elements to display in the **Number of elements** field. For example, if the selector source is Region, **Use last** is selected, and **Number of elements** is defined as one, the last region (Web) is displayed.

6 Click **OK** to return to the dashboard.

### Showing totals for selectors

Selectors that contain attribute, custom group, or consolidation elements as selector items can also include an option to display totals. The total is calculated for all the selector items. A user can choose whether to display specific elements, all of the elements at the same time, or the totals.

For example, a dashboard contains a Grid/Graph with Region and several metrics. A selector (the check boxes on the left) targets the Grid/Graph and displays all the regions, as well as the Total option, as selector items. In the following sample, all the regions are selected, and the total is displayed:

<table>
<thead>
<tr>
<th>Region/Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td>$764,323</td>
<td>15.20%</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>15.12%</td>
</tr>
<tr>
<td>Northeast</td>
<td>$3,504,415</td>
<td>$1,300,732</td>
<td>15.21%</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
<td>$266,986</td>
<td>15.16%</td>
</tr>
<tr>
<td>South</td>
<td>$5,389,280</td>
<td>$806,956</td>
<td>14.97%</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
<td>$336,675</td>
<td>15.03%</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
<td>$561,331</td>
<td>15.20%</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
<td>$583,528</td>
<td>14.95%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$35,023,708</strong></td>
<td><strong>$5,293,624</strong></td>
<td><strong>15.11%</strong></td>
</tr>
</tbody>
</table>
The All option does not have to be selected for the total to be displayed. For example, only Central, Mid-Atlantic, and Total are selected in the following sample:

- Central
- Mid-Atlantic
- Total

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$3,029,366</td>
<td>$764,323</td>
<td>15.20%</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>15.12%</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>$35,023,708</td>
<td>$5,293,624</td>
<td>15.11%</td>
<td></td>
</tr>
</tbody>
</table>

Notice that the values in the Total line remain the same as in the previous sample—the total is always calculated using all the selector items (in this instance, all the regions).

The following example shows a drop-down selector that targets an attribute on a panel stack. When Total is chosen in the selector, the total revenue of all the regions is displayed.

**Conditional formatting on selector totals**

Conditional formatting allows you to format specified data in your dashboard depending on predefined criteria. In Desktop and in MicroStrategy Web, if the selector's target is a Grid/Graph, you can choose whether to apply conditional formatting to metrics only, to metrics and their corresponding selector totals, or to the subtotals only. In MicroStrategy Web, if the target is a text field, you can select whether to apply conditional formatting to metrics only, or to metrics and their corresponding selector totals. (See the MicroStrategy Web Help for instructions.) When you create a conditional format in Desktop, if the target is a text field, the conditional format is not applied to the total, but rather to the metric values only.
For example, a dashboard contains the Region attribute and the Revenue metric on a panel stack. The panel stack is targeted by a selector, which allows a user to choose the region to display in the panel stack. The selector includes the option to display the total, which is calculated for all the regions. The conditional formatting on the Revenue metric displays low revenue in red and high revenue in green. The conditional formatting can be applied to the regional revenue values only, or to both the regional revenue values and the total value.

To select metrics or metrics and totals, use the Advanced Conditional Formatting in MicroStrategy Web. When you apply a conditional format in Desktop, the conditional format is applied to the metric values only. For instructions to specify this setting, see the *MicroStrategy Web Help*. For instructions to create conditional formatting, see the *Desktop Help*.

### Showing totals in a selector

**To show totals in a selector**

1. Open the dashboard in the Document Editor.
2. Right-click the selector and select **Properties**. The Properties dialog box opens.
3. Click the **Selector** tab.
4. Select the **Show option for Total** check box.

    - Note the following:
      - If the **Action type** is defined as **Select metric** or **Select panel**, the **Show option for Total** check box is not available.
      - If **Apply selections as a filter** is selected, the **Show option for Total** check box is not available. For a comparison of filtering and slicing selectors, see *Applying selections as filters or slices*, page 126.

5. Click **OK**.
Displaying and sorting forms in selectors

For element selectors, you can use MicroStrategy Web to select which forms are displayed in the selector, the order that they are displayed in, and how their elements are sorted. If multiple forms are displayed, you can choose which character separates the different forms.

For example, a document contains the Customer attribute. By default, the selector displays the customer last name and first name, separated by a colon. The customers are sorted in alphabetical order, as shown below:
By defining the attribute forms to display, the same selector can display the customers by last name and then ID, separated by a comma and a space. The customers are now sorted in reverse alphabetical order, as shown below:

For instructions to select and sort forms for an element selector, see the MicroStrategy Web Help.

**Displaying title bars in selectors**

A title bar on a selector can help to identify the selector or provide instructions about using the selector. For example, the title bar can indicate which Grid/Graph or panel stack the selector targets. In the sample shown below, the title bars are used to provide instructions, as well as to identify that the top selector uses Region to update the grid and the graph, while the bottom selector filters just the grid on the Revenue values. Notice that the Revenue total for Northeast in the grid is $7,066,478, while the Revenue amount for Northeast in the graph is $8,554,415. This discrepancy occurs because the grid is not displaying employee revenue values below $209,634,
as indicated by the slider selector, while the graph is including all revenue values for Northeast.

For metric slider and metric qualification selectors, which filter metric values, the title bar contains a drop-down menu that allows a user to select whether to filter on the metric values or rank, as shown in the metric qualification selector below. For descriptions of the different options, see *Creating selectors that filter metric values, page 123.*

For a metric slider selector, the drop-down menu in the title bar also allows a user to select whether to include or exclude the selected data. For example, in the image below, cost values greater than or equal to $2,724,912 are selected in the slider. When Include is selected from the title bar drop-down menu, data for all regions with cost values greater than or equal to $2,724,912 is
displayed. Note that the drop-down menu also includes the options to select whether to filter on the metric values or rank.

<table>
<thead>
<tr>
<th>Region</th>
<th>Call Center</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Milwaukee</td>
<td>$4,162,136</td>
<td>$387,645</td>
<td>$3,644,694</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>New York</td>
<td>$7,006,476</td>
<td>$1,076,237</td>
<td>$5,920,241</td>
<td></td>
</tr>
<tr>
<td>South</td>
<td>New Orleans</td>
<td>$3,306,039</td>
<td>$504,000</td>
<td>$2,600,048</td>
<td></td>
</tr>
<tr>
<td>Web</td>
<td>Web</td>
<td>$3,902,762</td>
<td>$583,635</td>
<td>$3,319,225</td>
<td></td>
</tr>
</tbody>
</table>

Note the following:

- These procedures use the Properties dialog box, but you can also use the Property List to perform the same tasks.
- These procedures assume that the dashboard contains a selector. For instructions to create a selector, see Defining a selector, page 113.

To display the title bar

1. Open the dashboard in Design View in the Document Editor.
2. Right-click the selector in the Layout area, and choose Properties. The Properties dialog box opens.
3. On the General tab, select the Show title bar check box.
4. Type the text to display in the title bar in the Custom title field.

   If you leave this field blank, the selector's Name is displayed in the title bar, unless the selector's Action Type is defined as Select attribute element or Metric condition. In those cases, the Source of the target (such as Region or Revenue) is displayed. (For a description of the various action types, see Defining a selector, page 113.)

5. By default, the height of the title bar is .2 inches, but you can change it:
   a. Click the Layout tab.
   b. Enter the height in the Title height field.
6. Click OK to return to the dashboard. The title bar is displayed on the selector in the Layout area.
Formatting selectors

As with any other control, when you insert a selector into a dashboard, its formatting is determined by the control default. However, you can change any of the formatting options, such as background and border colors. For a list of formatting options, and which interface to use, see *Deciding which interface to use to format selectors, page 171* and *Useful formatting suggestions for selectors, page 172.*

You can format the selector container and the title bar separately, as described in *Formatting the selector container vs. title bar* below.

**Formatting the selector container vs. title bar**

A selector can have a title bar, which displays above the selector items. For instructions to display the title bar, and an example, see *Displaying title bars in selectors, page 167.* You can format the container (which displays the selector items) differently than the title bar. For example, if you apply a background color to the container of a selector, the title bar is not displayed in that color.

The following table lists the various formatting options available for a container and for a title bar.

<table>
<thead>
<tr>
<th>Object</th>
<th>Formatting Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selector container</td>
<td>Alignment (horizontal and vertical)</td>
</tr>
<tr>
<td></td>
<td>Background, including:</td>
</tr>
<tr>
<td></td>
<td>• Transparency</td>
</tr>
<tr>
<td></td>
<td>• Gradient colors</td>
</tr>
<tr>
<td></td>
<td>• Selection color (background color for cells selected by a selector)</td>
</tr>
<tr>
<td>Border</td>
<td>Effects, including:</td>
</tr>
<tr>
<td></td>
<td>• 3D borders</td>
</tr>
<tr>
<td></td>
<td>• Drop shadow</td>
</tr>
<tr>
<td>Font</td>
<td></td>
</tr>
</tbody>
</table>
Deciding which interface to use to format selectors

The Property List is the easiest interface to use, as it contains most of the options of the other interfaces on the same screen as the Layout area. The Property List allows you to format the selector container but not the title bar, while the Format Objects allows you to format both the container and the title bar.

You can change the formatting and other settings of selectors as described below:

- To change most options for a selector (size, settings specific to selectors such as action type and targets, and container formatting), use the Property List. You can also specify whether the width of the selector items (for example, the check boxes or buttons in the selector) is fixed or proportional; for instructions, see *Specifying proportional or fixed width for selector items, page 174*. You cannot format the title bar.

- To quickly set basic borders for the container, use either the Formatting toolbar or the right-click menu.

- To quickly choose a single color for the background of the container, use either the Formatting toolbar or the right-click menu.

- To use more complex backgrounds, such as gradient (two-color) and transparent backgrounds for the container and title bar, use the Format Objects dialog box. You can also define the background color for items selected in the Drop-down, Listbox, and Link Bar selectors; for instructions, see *Defining the background color for selected items in Flash Mode, page 177*.

- To quickly set the font color of the selector items, use either the Formatting toolbar or the right-click menu.
To change layout settings (such as position, selector size, and item size), you can use the Property List or the Properties dialog box. You can also set options specific to selectors, such as action type and targets. You can also specify whether the width of the selector items (for example, the check boxes or buttons in the selector) is fixed or proportional. The main difference between the interfaces is that formatting options are available in the Property List but not in the Properties dialog box.

To change the alignment, font, border, and color options, including gradient colors (two-color combinations), use the Format Objects dialog box. You can select 3D borders and drop shadows, as well as gradient colors for the background, with this interface. You can format both the container and the title bar with the Format Objects dialog box.

To format the text of the selector items, use the Format Objects dialog box. Options include font type, color, and size. For instructions, see Formatting the text of a selector’s items, page 175. (To format the font color only, use the Formatting toolbar or the right-click menu.)

For comprehensive formatting, the Property List is the easiest to use, as it contains most of the options of the other interfaces on the same screen as the Layout area. To format the title bar, use the Format Objects dialog box. For complete instructions, refer to the Desktop Help.

See Useful formatting suggestions for selectors below for descriptions of formatting options and ways they can enhance your selectors.

### Useful formatting suggestions for selectors

The following list provides some useful formatting suggestions. For information on basic options such as formatting fonts and borders, and examples and instructions for all the formatting listed below, see the Desktop Help.

- Make the selector container appear three-dimensional, like a button, with the **3D effect**.

  ![3D effect](https://via.placeholder.com/150)

  3D effects do not apply to Search Box selectors.

- Let the content behind the selector show through by setting the **backstyle** to transparent. You can also allow a fill color to cover what is behind the selector by setting the **backstyle** to opaque.

- “Float” the selector above the background by using a **drop shadow**.

  ![Drop shadow](https://via.placeholder.com/150)

  Drop shadows do not apply to Search Box selectors.
• Create a gradual color change in the selector's background by blending two colors using **gradient colors** on the selector.

• By default, the background for selected items is automatically chosen to provide contrast with the selector's background. You can define the background color for items selected in Drop-down, Listbox, and Link Bar selectors. The color is displayed in Flash Mode in MicroStrategy Web. In all other MicroStrategy Web modes, only Link Bar selectors use the selection color. For an example and procedure, see *Defining the background color for selected items in Flash Mode, page 177.*

  Selected item color does not apply to Search Box selectors.

• Display pop-up text when a user positions the cursor over the control in MicroStrategy Web with a **tooltip**. The tooltip can provide extra information, such as an expanded description of the control.

• Display a selector to other document designers in Design View while hiding it from users viewing the document in PDF View (Desktop or Web), and Interactive Mode, Editable Mode, and Express Mode on MicroStrategy Web. To do this, you hide the control that contains the information by using the **Visible** setting. For instance, you could prevent a user from changing panels in a panel stack by hiding the panel stack’s selector.

• Control the sizing behavior of the selector items with the **Make all items the same width** setting, which can be set to proportional (the default) or fixed (same width for all items). The items are the buttons or check boxes, for example, of the selector. For an example, see *Specifying proportional or fixed width for selector items, page 174.*

  Item width does not apply to Search Box selectors.

• Format the font of the text for the items in the selector, including style, size, and color. For an example, see *Formatting the text of a selector’s items, page 175.*

These formatting options apply to all selector types, but to a Fish Eye selector only when it is displayed in non-Flash modes. In non-Flash modes, a Fish Eye selector is displayed according to its DHTML style. For information on creating a Fish Eye selector, see *Creating a Fish Eye Selector, page 214;* for information on formatting a Fish Eye selector for display in Flash Mode, see *Formatting a Fish Eye Selector, page 309.*

Complete instructions for formatting selectors using various interfaces are provided in the *Desktop Help.*
Specifying proportional or fixed width for selector items

You can control the sizing behavior of the selector items with the **Make all items the same width** option. The items are the buttons or check boxes, for example, of a selector.

By default, items are sized proportionally, which means that the width of each item is proportional to the length of the text inside the item. This allows the complete text of each item to be displayed, with little wasted space. To use the same width for all the items, specify a fixed item size.

In the example below, the width of the selector items (the links above the Grid/Graph) are sized proportionally—Northwest is longer than (All), for example. This is the default behavior.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>$331,735</td>
<td>$260,504</td>
<td>$71,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>$1,047,775</td>
<td>$868,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
</tbody>
</table>

If the **Make all items the same width** option is selected, the width of each selector item is the same size as the others, as shown below. In this case, the
(All) item has extra space, while Northwest is cut off, displaying as Northwe instead.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
</tbody>
</table>

The following procedure re-creates this example using the Property List. You can also use the Properties dialog box to specify proportional or fixed width for selector items; see the Desktop Help for instructions.

- Item width does not apply to Search Box selectors.

To specify selector item width as fixed

1. Open a dashboard in Design View in the Document Editor.
2. Add the panel stack and selector as shown in the example. For instructions to add a panel stack, see Inserting a panel stack, page 70; for instructions to add a selector, see Methods to create a selector, page 117.
3. Select the selector.
4. In the Property List: Size section, set Make all items the same width to True.

Formatting the text of a selector’s items

You can format the font of the text for the items in a selector. The items of a selector are the elements, metrics, or panels that are listed in the selector. The user selects an item to change the display of the panel or Grid/Graph.
Font formatting options for selector items include style, size, and color. You can also align text horizontally and vertically.

The following dashboard sample shows a button bar. The size of the selector, as well as the font and alignment of the item’s text, has not been changed from the default appearance. The orientation of the button bar has been changed from vertical to horizontal.

In the following dashboard sample, the same selector has been formatted. The button bar has been expanded to the width of the panel stack. The item’s text is now centered vertically and horizontally within each button. The font type, size, and color have changed, and the text is italicized.

The following procedure re-creates the formatted sample.

**To format the text of a selector’s items**

1. Open a dashboard in Design View in the Document Editor.

2. Add the panel stack and a selector as shown in the example. For instructions to add a panel stack, see *Inserting a panel stack, page 70*; for instructions to add a selector, see *Methods to create a selector, page 117*.

3. Select the button bar selector in the Layout area, and resize it by dragging the sizing handles. Make the button bar as wide as the panel stack.
4 In the Property List: Data section, set Style to Button Bar. Change the Orientation to Horizontal.

5 From the Format menu, select Format. The Format Selector dialog box opens.

6 Click Container in the list of objects on the left.

7 Click the Alignment tab.

8 Set Horizontal to Center and Vertical to Center.

9 Click the Font tab.

10 In the Font area, set Name to Times New Roman.

11 In the Settings area, set Size to 12.

12 Set Italic to Yes.

13 Set Color to White.

14 Click OK to return to the dashboard.

Defining the background color for selected items in Flash Mode

By default, the background for selected items is automatically chosen to provide contrast with the selector's background. For Drop-down, Listbox, and Link Bar selectors, you can specify the color for selected items. The color is displayed in Flash Mode in MicroStrategy Web. In all other MicroStrategy Web modes, only Link Bar selectors use the selection color. (For details on the different types of selectors, see Defining a selector, page 113.)

For example, a dashboard contains a Link Bar selector that targets a Grid/Graph. The selector's background is set to light gray, and the background for selected items is set to automatic. In Flash Mode, the background is
automatically displayed in light gray, with the selected item (Central) automatically displayed in a lighter gray to provide contrast, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$947,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$922,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
</tbody>
</table>

The same document in Interactive Mode displays with a light gray background for the selector, as specified, with the selected item (Central) is automatically displayed in a blue background to provide contrast, as shown below:
Change the selected item’s background to dark red. In Flash Mode, the selected item’s background is dark red, as specified, and the selector’s background is still displayed in light gray, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,663,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torsion</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
</tbody>
</table>

In all modes, an item that the cursor is pointed at is displayed in a lighter shade of the selected item’s background. In the Flash Mode example above, Mid-Atlantic is displayed with a pink background, while the Interactive Mode example displays Northwest in a light blue.

The following procedure assumes you have added a Drop-down, Link Bar, or Listbox selector to the dashboard. For instructions, see Methods to create a selector, page 117.

To format the background of selected items

1. Open the dashboard to be formatted in the Document Editor in Design View.

2. Choose the selector to be formatted.

3. From the Format menu, select Format. The Format Objects dialog box opens.

4. Select Container in the object list on the left.

5. Click the Background tab.

6. By default, Selection color is set to Automatic, which means that the color of the selected items are automatically set to contrast with the
selector's background. To choose a specific color instead, click **Selection color**, and pick a color from the color palette.

The **Selection color** is applied in Flash Mode in MicroStrategy Web. In all other MicroStrategy Web modes, the **Selection color** is applied only to Link Bar selectors.

7. Click **OK** to save your changes and return to the dashboard.

**Selector display in Flash Mode in MicroStrategy Web**

You can define how a selector displays in Flash Mode in MicroStrategy Web. This allows you to override the rendering of the selector with a custom widget selector style that you created. For more information on creating widgets, see the MicroStrategy Developer Library (MSDL) provided with MicroStrategy SDK. To apply the custom widget to a selector, follow the procedure below. The procedure assumes you have already created a selector and a custom widget.

---

**To specify a widget for a selector**

1. Open a dashboard in Design View in the Document Editor.
2. Select the selector.
3. In the **Property List: Flash** section, choose the widget from the **Selected widget** drop-down list.

**Selector display when exported to PDF**

When a dashboard containing a Button Bar, Check Boxes, Link Bar, or Radio Button selector is exported to PDF, you can determine whether the selector is exported to a PDF file as shown in MicroStrategy Web or whether it is exported with only the selected items displayed. If it is exported as shown in Web, the check boxes or radio buttons are displayed in the PDF, as well as all the selector items, whether or not they are selected. The setting also applies to PDF View in Desktop.
For example, a dashboard contains a Grid/Graph targeted by:

- A Radio Button selector for Category, defined to export to PDF as shown in Web
- A Check Boxes selector for Subcategory, defined to export only the selected items to PDF

A user selects the Books category and the Literature and Books - Miscellaneous subcategories in the selectors, as shown below in Express Mode in MicroStrategy Web:

<table>
<thead>
<tr>
<th>Select a category</th>
<th>Select subcategories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Books - Miscellaneous</td>
</tr>
<tr>
<td>Electronics</td>
<td></td>
</tr>
<tr>
<td>Movies</td>
<td></td>
</tr>
<tr>
<td>Music</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Item</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Literature</td>
<td>The Prince</td>
<td>$14,878</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Fountainhead</td>
<td>$17,585</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Old Man and the Sea</td>
<td>$17,353</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lord of the Flies</td>
<td>$12,952</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Atlas Shrugged</td>
<td>$17,770</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Catcher in the Rye</td>
<td>$18,140</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Brave New World</td>
<td>$17,660</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Weight of Water</td>
<td>$26,087</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Great Gatsby</td>
<td>$20,390</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1984</td>
<td>$18,425</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Catch-22</td>
<td>$19,959</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Thin Red Line</td>
<td>$29,992</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ulysses</td>
<td>$22,035</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lolita</td>
<td>$24,665</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To Kill a Mockingbird</td>
<td>$18,190</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Test Your Baseball IQ</td>
<td>$10,982</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Art of Getting Even</td>
<td>$21,335</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Complete Course in Magic</td>
<td>$33,371</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40 Most Wanted Cats</td>
<td>$30,047</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Rules for Cats</td>
<td>$17,237</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Test Your Return IQ</td>
<td>$16,090</td>
</tr>
</tbody>
</table>

The dashboard is exported to PDF, as shown below. The Category selector displays with the radio buttons and all categories, since the selector is defined to export as shown in Web. The Subcategory selector displays only
Literature and Books - Miscellaneous, without check boxes, since the selector is defined to export only the selected items.

<table>
<thead>
<tr>
<th>Select a category</th>
<th>Select subcategories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>Literature</td>
</tr>
<tr>
<td>Electronics</td>
<td>Books - Miscellaneous</td>
</tr>
<tr>
<td>Movies</td>
<td></td>
</tr>
<tr>
<td>Music</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
<th>Item</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Literature</td>
<td></td>
<td>The Pride</td>
<td>$14,878</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Fountainhead</td>
<td>$17,565</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Old Man and the Sea</td>
<td>$17,533</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lord of the Flies</td>
<td>$12,942</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Atlas Shrugged</td>
<td>$17,770</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Catcher in the Rye</td>
<td>$18,140</td>
</tr>
<tr>
<td>Books</td>
<td></td>
<td>Brave New World</td>
<td>$17,600</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Weight of Water</td>
<td>$20,057</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Great Gatsby</td>
<td>$20,200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1984</td>
<td>$15,424</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Catcher</td>
<td>$19,656</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Thin Red Line</td>
<td>$20,002</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ulysses</td>
<td>$22,005</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Les Mis</td>
<td>$34,688</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To Kill a Mockingbird</td>
<td>$15,162</td>
</tr>
<tr>
<td>Books - Miscellaneous</td>
<td></td>
<td>Test Your Baseball IQ</td>
<td>$10,300</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Art of Getting Even</td>
<td>$21,528</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Complete Course in Magic</td>
<td>$55,577</td>
</tr>
<tr>
<td></td>
<td></td>
<td>48 Most Wanted Cases</td>
<td>$20,547</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Rules for Cats</td>
<td>$17,252</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Test Your History IQ</td>
<td>$11,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Great Comedians Talk about Comedy</td>
<td>$17,298</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Complete Prude of Woody Allen</td>
<td>$20,404</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Test Your Own IQ Again</td>
<td>$19,151</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Games for the Superintelligent</td>
<td>$17,473</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Most of Andy Rooney</td>
<td>$27,884</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Guide to Life</td>
<td>$25,524</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mental Lateral Thinking</td>
<td>$18,207</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Completely Mad</td>
<td>$22,467</td>
</tr>
<tr>
<td></td>
<td></td>
<td>How to Live with a Neurotic Dog</td>
<td>$17,784</td>
</tr>
</tbody>
</table>

**Prerequisites**

The following procedure assumes that the dashboard already contains a Button Bar, Check Boxes, Link Bar, or Radio Buttons selector. For instructions to create a selector, see *Methods to create a selector, page 117.*

**To define selector display for PDF export**

1. In MicroStrategy Web, open the dashboard in Design or Editable Mode.
2. Right-click the selector and choose **Properties and Formatting.** The Properties and Formatting dialog box opens.
3. In the list on the left, select **Layout.**
4 To define the selector display when exported to PDF, do one of the following:

- To export the selector as shown on the screen (with all selector items and the check boxes, radio buttons, button bar, or link bar), select the **Export selector to PDF as shown on screen** check box.

- To export only the selected items (without check boxes, radio buttons, button bar, or link bar), clear the **Export selector to PDF as shown on screen** check box.

The **Export selector to PDF as shown on screen** check box is available only when the selector’s DHTML style is Button Bar, Check Boxes, Link Bar, or Radio Buttons.

5 Click **OK** to save your changes and return to the dashboard.

---

**Enabling Grid/Graphs as selectors to control other Grid/Graphs**

In the following image, two Grid/Graphs are shown in MicroStrategy Web. The grid on the left shows revenue by region. The graph on the right shows revenue by quarter and region. Notice that the two Grid/Graphs share a particular attribute (Region) and that Region in the grid is underlined, indicating a link.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,137</td>
</tr>
<tr>
<td>South</td>
<td>$5,369,290</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>
Click a specific region, such as Mid-Atlantic, in the grid. The graph changes to display information for that region only, as shown below:

![Regional revenue by quarter](image)

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,815</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$6,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,260</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,951</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

The grid on the left is controlling the graph on the right. In other words, this scenario uses one Grid/Graph as a selector targeting another Grid/Graph. The Grid/Graph does not become a selector, but performs in a manner similar to a selector. A panel stack, rather than another Grid/Graph, can be the target of a Grid/Graph.

By default, the background for items selected in the Grid/Graph is automatically chosen to provide contrast with the Grid/Graph’s background, as shown above. For Flash Mode and Express Mode in MicroStrategy Web, you can specify the color for the selected items. For an example and instructions, see *Formatting the background of selected items in Grid/Graphs used as selectors, page 186.*

You can use Grid/Graphs as cascading selectors, where one Grid/Graph updates another Grid/Graph, and the second updates a third. For example, a dashboard contains the following:

- A Grid/Graph containing the Revenue metric
- A Grid/Graph containing the Call Center attribute, targeting the Revenue Grid/Graph
- A Grid/Graph containing the Region attribute, targeting both the Call Center and Revenue Grid/Graphs
A Grid/Graph containing the Country attribute, targeting the Region, Call Center, and Revenue Grid/Graphs

This dashboard is shown below. USA is selected for Country, Southeast for Region, and Atlanta for Call Center. The Revenue metric displays the value for Atlanta. If you select Miami instead, the Revenue value changes accordingly.

<table>
<thead>
<tr>
<th><strong>Country</strong></th>
<th><strong>Region</strong></th>
<th><strong>Call Center</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>Central</td>
<td>Atlanta</td>
</tr>
<tr>
<td>Web</td>
<td>Mid-Atlantic</td>
<td>Miami</td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northwest</td>
<td></td>
</tr>
<tr>
<td></td>
<td>South</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southeast</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southwest</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>

To ensure that a selection in one Grid/Graph affects its targets, especially the Revenue Grid/Graph, you must define the Grid/Graphs in the order of the attributes’ hierarchy. In this case, define the Grid/Graph for Country, then another for Region, and finally the last for Call Center. If you define Call Center first, then Region, and then Country, the targets are not updated or return no data.

To use a Grid/Graph as a selector

This procedure assumes you have already created a Grid/Graph to use as the selector, as well as the panel stack or Grid/Graph to use as the target. The selector and target must have an attribute or metric in common. If targets are automatically maintained, and you add a Grid/Graph or panel stack to the same document section or panel after defining this selector, the Grid/Graph or panel stack is automatically added as a target. For more information about automatic target maintenance, including instructions to disable it, see Automatically maintaining targets for selectors, page 134.

1. Open the dashboard using the Document Editor in Design View.
2 Double-click the Grid/Graph to use as the selector. A red hashed border displays around it, indicating that the Grid/Graph is in edit mode.

3 Right-click the attribute to use as the selector, and choose **Use as Selector**. The Selector dialog box opens.

4 Select the target Grid/Graph or panel stack in the list of available controls on the left, and click > to add it to the list of selected targets. You can select multiple targets.

   If targets are automatically maintained in the layout, you cannot select targets. All Grid/Graphs and panel stacks in the same document section or panel as the selected Grid/Graph are chosen as targets. You can disable automatic targets by clicking **Manual Targets**. If you do, all targets in the layout are no longer automatically maintained. For more information about disabling automatic target maintenance, see *Automatically maintaining targets for selectors, page 134*.  

5 Click **OK** to return to the dashboard.

6 Press **ESC** or click anywhere in the document’s Layout area outside of the Grid/Graph to exit edit mode.

**Formatting the background of selected items in Grid/Graphs used as selectors**

By default, the background for items selected in the Grid/Graph is automatically chosen to provide contrast with the Grid/Graph's background, but you can specify the color for the selected items. The color is displayed in Flash Mode and Express Mode in MicroStrategy Web.

For example, a dashboard contains two Grid/Graphs. The one on the left, which is displayed as a grid, shows revenue by region. Region is used as a selector, targeting the Grid/Graph on the right, which is displayed as a graph. The graph shows revenue by category and region. When a region is selected in the grid, the graph is updated to display data for that region only.

By default, the grid's background is set to transparent, and the background for selected items is set to automatic. In Flash Mode, the grid is displayed automatically with a white background (transparent to the section's
background, which is white). The selected item (Central) is displayed in blue to provide contrast, as shown below:

<table>
<thead>
<tr>
<th>Region Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,306</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
</tr>
<tr>
<td>South</td>
<td>$6,380,280</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
</tr>
<tr>
<td>Web</td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

Change the grid’s background for selected items to dark gray. In Flash Mode, the selected item's background is dark gray, as specified, and the grid's background is still automatically displayed in white, as shown below:

In all other modes except Express Mode, the background of the selected item is automatically defined, so it appears in blue, as shown in the first example above.
To format the background of selected items

This procedure assumes that the dashboard contains a Grid/Graph used as a selector. For instructions on adding Grid/Graphs, see the Desktop Help. For instructions to enable the Grid/Graph as a selector, see Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.

1. Open the dashboard to be formatted in the Document Editor in Design View.
2. Select the Grid/Graph to format.
3. From the Format menu, select Format. The Format Objects dialog box opens.
4. Select Container in the Format list on the left.
5. Click the Background tab.
6. Define the Selection color, which is the background color for items that are selected in the Grid/Graph.
   - If you want to specify a color, click Selection color, and choose a color from the color palette.
   - If you want the color to be automatically set to contrast with the Grid/Graph's background, choose Automatic from the Selection color drop-down list.
   
   The Selection color is applied in Flash Mode and Express Mode in MicroStrategy Web.
7. Click OK to return to the dashboard.
5

Providing Flash Analysis and Interactivity: Widgets

Introduction

A widget is a Flash-based display of the results of a dataset report, allowing users to visualize data in different ways than traditional reports displayed as a grid report or graph report do. Widgets are sophisticated visualization techniques that can combine with rich interactivity to enable users to understand their data more effectively. You can use a variety of widget types, such as Gauge, Heat Map, and Stacked Area widgets, in MicroStrategy dashboards. Although each type of widget looks different and is used in a unique way, the main purpose of all widgets remains the same: to provide dashboard analysts with a visual and interactive look into their data.

For example, the Interactive Bubble Graph widget below allows dashboard analysts to drill into each bubble in the graph by clicking it. Analysts can also
use the time animation toolbar at the top of the widget to watch the bubbles appear on the graph in chronological order.

For more information on Bubble Graph widgets in particular, including a detailed description of the data structure and a procedure to enable drilling, see *Creating an Interactive Bubble Graph widget, page 243.*

This chapter helps you choose the right widget and describes each type of widget, its purpose, how to create it, and how a dashboard analyst can use it to analyze a specific set of data.

**Choosing the right widget**

This section briefly summarizes each type of widget that you can use in a dashboard, and provides a quick reference table to determine how a widget will display, whether the widget is interactive, and whether users can save their changes, based on which view/mode your users will use.

A dashboard designer creates widgets in Design Mode or Editable Mode in MicroStrategy Web, or in Design View in Desktop. The designer and other
users can interact with widgets in MicroStrategy Web, Desktop, and MicroStrategy Mobile devices, as shown in the table below.

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Widget Can Display As</th>
<th>Interact with Widget?</th>
<th>Save Widget Changes?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Desktop</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design View</td>
<td>Empty Grid/Graph (no data)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Flash View   | • Widget *  

| HTML View | • Grid/Graph  

| PDF View | • Grid/Graph  

| **MicroStrategy Web** |                       |                       |                      |
| Design Mode | Empty Grid/Graph (no data) | N/A | N/A |
| Editable Mode | Grid/Graph | N/A | N/A |
| Express Mode | • Widget **  

| Flash Mode | • Widget  

| Interactive Mode | • Widget **  

| **MicroStrategy Mobile** |                       |                       |                      |
| Android Must define in MicroStrategy Web | Android widgets:  

| iPad | iPad widgets:  


### Choosing the right widget

Choosing the right widget © 2012 MicroStrategy, Inc.

For steps to change how widgets are displayed in the various views and modes of MicroStrategy Web and Desktop, see *Defining how a widget is displayed in different views and modes, page 285.*

The following list briefly summarizes each type of widget that you can use in a dashboard.

You can access additional MicroStrategy widgets from the MicroStrategy Widget download site, [https://resource.microstrategy.com/Support](https://resource.microstrategy.com/Support).

- **Bubble Grid**: Bubbles of different colors and sizes representing the values of two metrics. It can help identify important trends or anomalies in data, relative to the total contribution of accompanying data. See *Creating a Bubble Grid widget, page 198* for steps and an example.

- **Cylinder**: A simple status indicator that displays a vertical cylinder with fluid in it. The level of the fluid within the cylinder is a visual representation of a single metric value. See *Creating a Cylinder widget, page 200* for steps and an example.

---

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Widget Can Display As</th>
<th>Interact with Widget?</th>
<th>Save Widget Changes?</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPhone</td>
<td>iPhone widgets:</td>
<td>Yes (iPhone widgets only)</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• Widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>All other widgets are displayed as Grid/Graphs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exporting</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export to Excel</td>
<td>• Grid/Graph</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export to Flash</td>
<td>• Widget *</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export to PDF</td>
<td>• Grid/Graph</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Except for widgets for mobile devices and SDK widgets, which cannot be displayed as widgets in Flash View/Mode.

** Except for the following widgets, which cannot be displayed as widgets in Interactive Mode or Express Mode: Cylinder, Date Selection widget created as a selector, Fish Eye Selector created as a selector, Interactive Stacked Graph, Network Visualization, Thermometer, and Time Series Slider.
- **Data Cloud**: A list of attribute elements displayed in various sizes to depict the differences in metric values between the elements. The varying sizes allow a user to quickly identify the most significant, positive, or negative contributions. See *Creating a Data Cloud widget, page 202* for steps and an example.

- **Date Selection**: A calendar selector that allows you to select which dates you want to see data about in a dashboard. You are able to see all of the dates of each month in the widget, which makes selecting dates easier. See *Creating a Date Selection widget, page 205* for steps and an example.

- **Fish Eye Selector**: An interactive selector that magnifies an item when you hover the cursor over it. It allows a user to choose from a list of attribute elements, metrics, or images without having to see all of the elements, metrics, or images. Any item that a user hovers over or selects remains magnified, while the remaining items are minimized and hidden from view. This can be especially helpful when the user has to browse through a lengthy list. See *Creating a Fish Eye Selector, page 214* for steps and an example.

- **Funnel**: A variation of a stacked bar graph that displays data that adds up to 100%. It allows a user to visualize the percent contribution of a metric to the whole. See *Creating a Funnel widget, page 226* for steps and an example.

- **Gauge**: A simple status indicator that displays a needle that moves within a range of numbers displayed on its outside edges. An example of a gauge is a car's speedometer. See *Creating a Gauge widget, page 228* for steps and an example.

- **Graph Matrix (deprecated)**: A group of area graphs that display actual values and line graphs that display forecasted values. It allows a user to quickly analyze various trends across several metric dimensions. See *Creating a Graph Matrix (deprecated) widget, page 230* for steps and an example.

- **Graph Matrix**: The Graph Matrix widget allows you to display your data using a variety of graph styles, such as the line graph, bubble graph, or grid, then customize it to suit users’ needs. See *Creating a Graph Matrix widget, page 234* for steps and an example.

- **Heat Map**: A combination of colored rectangles, each representing an attribute element, that allow you to quickly grasp the state and impact of a large number of variables at the same time. See *Creating a Heat Map widget, page 236* for steps and an example.
• **Image Layout**: You can add an Image Layout widget to a document to display an image overlaid with colored areas or bubble markers. For example, you can display a map of the United States, with a bubble marker displayed over each state. You can have states with a high number of stores displayed using large bubble markers, and states with a low number of stores displayed using small bubble markers. See *Creating an Image Layout widget, page 240* for steps and an example.

• **Interactive Bubble Graph**: A conventional bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. See *Creating an Interactive Bubble Graph widget, page 243* for steps and an example.

• **Interactive Stacked Graph**: A combination of a check box list and area graph. The graph allows a user to see the contribution of various metric series to the change in value of a larger set of data. See *Creating an Interactive Stacked Graph widget, page 249* for steps and an example.

• **Map**: Specific geographical locations displayed on a map, along with additional data for those locations, such as store revenue or a phone number. This widget is designed to be used on a mobile device or in Web. For an example and steps to create and format a Map widget for display in Web, see the *GIS Integration Help*.

• **Media**: Video, audio, images, or website content. One of the primary purposes of the Media widget is to present supplemental information about the data on a dashboard. It can also be used for instructional content or HTML content from a website. See *Creating a Media widget, page 251* for steps and an example.

• **Microcharts**: One or more compact representations of data that allow analysts to quickly visualize trends. Use a Microcharts widget to quickly visualize the trend of a metric at a glance without having to know many additional details. The bar, sparkline, and bullet microcharts used in the Microcharts widget convey information that an analyst can understand just by looking at the graph once. See *Creating a Microcharts widget, page 257* for steps and an example.

• **Network Visualization**: Data is displayed as nodes in the widget, with lines (called edges) drawn between the nodes to represent relationships between data elements. Once the widget is created, users can visualize characteristics of the nodes and the relationships between them, using display options such as node size, edge thickness, and edge color. The Network Visualization widget allows you to quickly and easily identify relationships between related items and clusters. See *Creating a Network Visualization widget, page 267* for steps and an example.
- **RSS Reader:** RSS (Really Simple Syndication) is a data format used to display updated Web content when you click a URL. An RSS document is called a feed, and it contains either a summary of the content from an associated website or the full text. The RSS Reader widget can help provide context to your business data. Use RSS Reader widgets on a dashboard to view and update RSS feeds as a user analyzes grids, graphs, and other objects in the same dashboard. See *Creating an RSS Reader widget, page 269* for steps and an example.

- **Thermometer:** A simple status indicator that displays a thermometer set to a certain temperature level. The temperature level within the thermometer is a visual representation of a single metric value. See *Creating a Thermometer widget, page 274* for steps and an example.

- **Time Series Slider:** An area graph that allows an analyst to choose which section of the graph to view at a time. See *Creating a Time Series Slider widget, page 276* for steps and an example.

- **Waterfall:** A group of clustered bars displayed from left to right. It highlights the increments and decrements of the values of metrics over time. The widget can help identify what is contributing to fluctuations in the metric values and can be used for “what-if” analyses. See *Creating a Waterfall widget, page 278* for steps and an example.

- **Weighted List Viewer:** A combination of the data visualization techniques of thresholds and graphical weighting in a single visualization. This enables the analyst to assess the performance of a group of items. See *Creating a Weighted List Viewer widget, page 282* for steps and an example.

### Widgets for mobile devices

You can define a Grid/Graph to display as a widget on a document when the document is executed on a mobile device that has the MicroStrategy Mobile application. For examples of the widgets available for mobile devices, and
steps to create them, see the MicroStrategy Mobile Design and Administration Guide.

SDK widgets

The following customized widgets are available. See the MicroStrategy Developer Library (MSDL), part of the MicroStrategy SDK product, for information to customize and use these widgets. With the MicroStrategy SDK, you can access additional MicroStrategy widgets, add third-party widgets, and create and use custom widgets.

- **Google Graph Visualization**: A simple chart of data. The widget is created using the Google API.
- **Store Layout**: A layout image of a retail store. Different departments in the store are displayed in different colors, depending on the conditions defined. For example, departments whose profit is less than 75% of their profit goal are displayed in red.
- **Map Visualization**: Displays a map with regions that appear in different colors, depending on the conditions defined. You can specify the type of map displayed, including a world map, regions or states in a country, or departments in a retail store. For example, in a map of the United States, you can display states with stores whose revenue is greater than $5 million with a green fill color.
- **Table**: A simple tabular layout.
- **Timeline**: A timeline that displays a series of events. The timeline can be examined at the yearly, monthly, and weekly level as a series of bands. This lets users quickly spot trends, such as the times when call congestion is most likely to affect a call center.
- **USA Map**: A map of the United States, which acts as a selector to determine the data displayed in another control. For example, a user can click a region in the United States, such as Central, to display revenue data for the Central region in a target Grid/Graph.

Formatting widgets

By default, most type of widgets automatically inherit some of the formatting contained in their underlying graph reports. For example, the font colors and types defined for the underlying graph report can be displayed in the widget.
A widget also has additional formatting specific to the type of widget. For example, you can change the number format of the metric values in a Bubble Grid widget, Cylinder widget, or Gauge widget. For an Interactive Stacked Graph widget, you can change the font of the text that appears in the graph and the color of the check boxes on the left side of the graph. For descriptions of the types of formatting that are available for each type of widget, as well as steps to format widgets, see Chapter 6, Formatting Widgets.

Widgets and automatic target maintenance for selectors

Selectors allow a user to control what is displayed in a widget or Grid/Graph (the target of the selector). Targets can be automatically maintained in a layout. This means that when you add a Grid/Graph or widget, the Grid/Graph or widget automatically becomes the target of all selectors in the same panel or document section as the Grid/Graph or widget. For background information on selectors, see Chapter 4, Providing Interactivity to Users: Selectors. For more information about automatically maintaining targets for selectors, including instructions to enable and disable the functionality, see Automatically maintaining targets for selectors, page 134.

Creating widgets

Prerequisites for creating widgets

- To test the widgets you have created and to view and interact with widgets, Flash Player is required. See the MicroStrategy Readmes for the latest version support information.

- To successfully create a useful widget that can be used to analyze data, you must have the appropriate attributes and metrics (or other objects) to define the widget. The report objects and their placement on the Grid/Graph determine whether the widget can be successfully generated and display data. For example, a Grid/Graph that you want to display as a Gauge widget must have one attribute on the rows and one metric on the columns. These data requirements are detailed in the steps for creating each widget.

  - Unlike other widgets, the RSS Reader and Media widgets do not require attributes or metrics on their Grid/Graphs, unless the widget is a target of an attribute selector in the dashboard. For instructions
Creating a Bubble Grid widget

The Bubble Grid widget conveys information to help an analyst identify important trends or anomalies in data, relative to the total contribution of accompanying data. In the widget, metric values are plotted as bubbles of different colors and sizes; the colors and sizes of the bubbles represent the values of two distinct metrics on the Grid/Graph that contains the widget. Each bubble is generated at the intersection of two different attribute elements. For example, in the widget below, a single bubble depicts the profit and revenue for books (an element of the Category attribute) in the South region (an element of the Region attribute).

The Bubble Grid widget is most beneficial when it is used to perform analyses involving key business ratios, such as the number of customers in a store vs. the revenue generated per customer. For example, the widget can help analysts investigate questions such as “Does the number of customers that visit a certain store correlate to the amount of money each customer spends?” Analysts can use the widget to answer these types of questions in
the context of business attributes, such as different stores, regions, and times of the day or year. Positive correlations in the data show that stores with a large number of customers generate a large amount of revenue, and negative correlations show the opposite. When analysts detect negative correlations for stores in specific regions, they can investigate reasons for the issue and recommend changes such as adding more sales personnel to the stores.

A Bubble Grid widget does not need a separate selector to allow a user to interact with it. However, you can use a Bubble Grid widget as a selector. For an example and more information, see *Using a Bubble Grid widget as a selector, page 354.*

**To create and add a Bubble Grid widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Bubble Grid**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

5. From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   a. Place two attributes, custom groups, or consolidations on the Grid/Graph’s rows. Bubbles are generated at the intersections of the elements from these objects.
      - Elements from the first (left-most) object are displayed on the X-axis of the widget. This object represents one of the business areas that can be analyzed in the widget.
      - To analyze data along the X-axis relative to time, use a time-based attribute such as Hour, Day, or Month. If you use an Hour or Day attribute, apply a view filter to the Grid/Graph to limit the number of hours or days displayed in the widget at the same time. For details on how view filters affect Grid/Graphs, and instructions to add them, see the *Document Creation Guide.*
Elements from the second attribute are displayed on the Y-axis of the widget. This attribute represents the other business area that can be analyzed in the widget.

At least two metrics on the columns. The values of these two metrics produce the bubbles in the widget, as described below:

- The first (left-most) metric determines the size of the bubbles. The smaller metric values produce the smaller bubbles in the widget; the larger metric values produce the larger bubbles.

- The second metric determines the color of the bubbles. For example, if Profit is the second metric on the columns, the colors of the bubbles depict the range of profit values. You can determine which colors are used for minimum and maximum metric values, as described in Formatting a Bubble Grid widget, page 303. This range of colors is depicted in the legend at the bottom of the widget, if the legend is enabled.

- Any additional metrics are displayed in tooltips when an analyst hovers the cursor over a bubble in MicroStrategy Web. These metrics do not have an effect on the size or color of the bubbles in the widget.

To enable the widget to be displayed

View and test your results in one of two ways:

- Select Flash Mode from the Home menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

- Select Interactive Mode from the Home menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 285.

Creating a Cylinder widget

A Cylinder widget is a simple status indicator that displays a vertical cylinder with fluid in it. The level of the fluid within the cylinder is a visual
representation of a single metric value. Like the Gauge and Thermometer widgets, this type of widget is designed to display the value of a single metric.

The Cylinder widget is most useful when combined with a selector because this allows users to choose specific metric values to display in the cylinder.

In the image below, the liquid level in the cylinder represents the amount of revenue generated (the Revenue metric).

To create and add a Cylinder widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Cylinder.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.
To add objects to the Grid/Graph that contains the widget

5 To allow users to change the metric value displayed in the widget with a selector, complete the following substeps:

a Insert a selector next to the Cylinder widget, then select an attribute as its source. Users choose attribute elements from this selector to change the display in the Cylinder widget. For steps to insert a selector and choose a source for it, see Methods to create a selector, page 117.

b Set the Cylinder Grid/Graph as the target of the selector. For steps to select an object as the target of a selector, see Selecting targets interactively (target selection mode), page 120.

6 It can be useful to drag the dataset report from the Dataset Objects panel and place it beneath the selector. This allows users to see the report’s values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.

To enable the widget to be displayed

7 View and test your results by selecting Flash Mode from the Home menu.

– If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

Creating a Data Cloud widget

A Data Cloud widget displays attribute elements in various sizes to depict the differences in metric values between the elements. This widget is similar to a Heat Map widget in that they both allow an analyst to quickly identify the most significant positive or negative contributions.

A Data Cloud widget is a list of attribute elements. The font size of each attribute element represents a metric value for that element. A bigger font for an element indicates a larger metric value. In the Data Cloud widget shown below, the size of each attribute element from the Subcategory attribute...
represents the amount of revenue generated by each type of book. Any additional metrics are displayed when a user hovers over a subcategory.

A Data Cloud widget does not need a separate selector to allow a user to interact with it. However, you can use a Data Cloud widget as a selector. For an example and more information, see Using a Data Cloud widget as a selector, page 355.

To create and add a Data Cloud widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Data Cloud.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

   To add objects to the Grid/Graph that contains the widget

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

   a. Place at least one attribute on the Grid/Graph’s rows.

      – The elements of the left-most attribute are displayed in the widget. For example, if the attribute is Year, a list of years is displayed in the widget.

      – If you include additional attributes to the right of the first attribute, elements from all of the attributes are combined and displayed in the widget. For example, if Year is the first attribute
and Quarter is the second attribute, every combination of year and quarter is displayed in the widget, such as 2007 Q4 and 2007 Q3.

b Place at least one metric on the Grid/Graph’s columns.

– The first (left-most) metric on the columns determines the size of the font of the attribute elements in the widget.

– If you include additional metrics to the right of the first metric, the additional metrics are displayed in the tooltips. When a user hovers the cursor over an attribute element in MicroStrategy Web, a tooltip is displayed. The tooltip lists the attribute element and metric values for that attribute element.

To enable the widget to be displayed

6 View and test your results in one of two ways:

• Select Flash Mode from the Home menu.

  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

• Select Interactive Mode from the Home menu.

  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 285.

You may want to place the corresponding Grid/Graph below the Data Cloud widget to display the exact metric values for the attribute elements displayed in the widget. For instructions to insert a Grid/Graph, see the Desktop Help or the MicroStrategy Web Help.

You can add links to a Data Cloud widget. Linking allows users to connect from a widget in a dashboard (the source) and open a document or report (the target). If you add a link to a Data Cloud widget, the Links menu is displayed when a MicroStrategy Web user hovers the cursor over an attribute element in the widget. The user can click a link in the Links menu to open the target. See Linking in widgets, page 295 for instructions and examples.
Creating a Date Selection widget

A Date Selection widget is a calendar selector that allows users to select dates for which they want to see related data. You are able to see all of the dates of each month in the widget, which allows you to select dates more easily.

For example, the Date Selection widget is useful if you are working with a dashboard that displays data from Q4 2007 and you want to view data from a date before that. You can select the date that you want to see and the data for that date will display on the dashboard, as shown below:

<table>
<thead>
<tr>
<th>Date</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/6/2007</td>
<td>$22,501</td>
<td>$3,939</td>
<td>17.51%</td>
<td></td>
<td>550</td>
</tr>
</tbody>
</table>

The same dashboard is shown below in Interactive Mode in MicroStrategy Web. The Date Selection widget is defined to not display as a widget in DHTML. The Date Selection widget was created as a widget (as opposed to creating it as a selector), so the selector is now displayed as a Grid/Graph. Notice the scroll bar at the left: all the dates are not shown in this sample, because the list is so long. Because the list is so long, dates even further down
the list do not appear in the same screen as the graph, which is why the Date Selection widget is so useful.

<table>
<thead>
<tr>
<th>Day</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/5/2007</td>
<td></td>
<td>$22,601</td>
<td>$3,939</td>
<td>17.51%</td>
<td>550</td>
</tr>
</tbody>
</table>

On a mobile device with MicroStrategy Mobile, the Date Selection widget can display as an interactive event calendar, which users can view in Day, Week, or Month view. For steps to create and format a Date Selection widget for display on a mobile device, see the MicroStrategy Mobile Design and Administration Guide.

If the Date Selection widget was created as a selector rather than a widget, in Interactive Mode the dashboard looks like the sample shown below. You can set the style of the selector, which in this example is left as the default,
Listbox. Again, all the dates are not shown, because the list is so long. The scroll bar allows the user to view and select dates further down in the list.

<table>
<thead>
<tr>
<th>Day</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/6/2007</td>
<td></td>
<td>$22,501</td>
<td>$3,939</td>
<td>17.51%</td>
<td>550</td>
</tr>
</tbody>
</table>

(All)
1/1/2007
1/2/2007
1/3/2007
1/5/2007
1/6/2007
1/7/2007
1/8/2007
1/9/2007
1/10/2007
1/11/2007
1/12/2007
1/13/2007
1/14/2007
1/15/2007
1/16/2007

A panel stack can also be the target of a Date Selection widget. However, a Date Selection widget created as a widget cannot switch panels on a panel stack.

The table below summarizes the differences between a Date Selection widget created as a widget and as a selector.

<table>
<thead>
<tr>
<th>Created as a Widget</th>
<th>Created as a Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Targets panel stacks and Grid/Graphs</td>
<td>Yes</td>
</tr>
<tr>
<td>Switches panels on a panel stack</td>
<td>No</td>
</tr>
<tr>
<td>Allows user to make multiple selections</td>
<td>No</td>
</tr>
<tr>
<td>Can be the target of another selector</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For steps to create a Date Selection widget as a widget, see Creating a Date Selection widget as a widget, page 208. For steps to create a Date Selection widget as a selector, see Creating a Date Selection widget as a selector, page 211.
Creating a Date Selection widget as a widget

A Date Selection widget is an interactive style of widget.

When created as a widget and displayed in Flash Mode, a Date Selection widget displays as a Date Selection widget.

When created as a widget and displayed in non-Flash modes, a Date Selection widget can be displayed as any of the following:

- Date Selection widget
- Grid/Graph used as a selector
- Empty Grid/Graph placeholder
- Hidden

A Date Selection widget created as a widget can target Grid/Graphs and panel stacks, but cannot switch panels on a panel stack. (For more information on Grid/Graphs controlling panel stacks or other Grid/Graphs, see Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.) If you want the Date Selection widget to display as a standard selector such as a listbox or button bar in non-Flash modes, or to allow multiple selections, create it as a selector instead. For steps, see Creating a Date Selection widget as a selector, page 211.

---

To create and add a Date Selection widget as widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

   **To create the target**

2. Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. For instructions, see the MicroStrategy Web Help.

   **To create the selector widget**

3. From the Insert menu, point to Widgets, then Flash, and select Date Selection.

4. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the
bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

5 If desired, resize the widget by clicking and then dragging its handles.

6 From the Dataset Objects panel on the left, select one attribute and drag it on top of the Grid/Graph’s rows. The attribute must be of a date type (examples in the MicroStrategy Tutorial project include Day and Ship Date).

If targets are automatically maintained and you place the selector widget and target in the same document section or panel, you will not need to disable automatic target maintenance to select the target. For information on the effects of disabling it, see Disabling automatic target maintenance to allow manual target selection, page 141.

To connect the selector to the target

7 Right-click the attribute to use as the selector, and choose Use As Selector. The Configure Selector dialog box opens.

8 Do one of the following:

- If targets are automatically maintained and you added the widget and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector. Click Create to finish adding the target.

- If targets are automatically maintained but the widget and target are not in the same document section or panel, you must disable automatic target maintenance and then manually select the target, as described below:
  
a Click Click here. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see Disabling automatic target maintenance to allow manual target selection, page 141.

  
b Click OK. You are returned to the Selector dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

  
c Select the target in the Available Targets list, and click the Add to selections arrow to move it to the Selected Targets list.

  
d Click Create.
• If targets are not automatically maintained, you must manually specify the target of the selector, as described below:

  a  Select the target in the Available Targets list, and click the **Add to selections** arrow to move it to the Selected Targets list.

  b  Click **Create**.

**To specify the widget display**

9  Right-click the widget and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

10  From the left, click **Widget**.

11  You can change the **Alternative Display** option, which determines how the widget looks in non-Flash modes. The widget can display as a placeholder or as a Grid/Graph, or can be hidden. For more information, see *Defining how a widget is displayed in different views and modes*, page 285.

12  By default, the Date Selection widget is displayed as a widget in Flash. To display it as a grid or graph report instead, clear the **Flash** check box in the **Display Widget As** column.

13  By default, the Date Selection widget is displayed as a widget in DHTML (Express Mode and Interactive Mode in MicroStrategy Web). To use the Alternative Display option instead, clear the **DHTML** check box in the **Display Widget As** column.

14  Click **OK** to apply your changes.

**To enable the widget to be displayed**

15  View and test your results in one of two ways:

  •  Select **Flash Mode** from the **Home** menu.

     –  If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in*, page 56.

  •  Select **Interactive Mode** from the **Home** menu.

     –  To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes*, page 285.
A Date Selection widget created as a widget can be displayed as a widget using Flash in DHTML interactive documents.

**Creating a Date Selection widget as a selector**

In Flash Mode, a Date Selection widget created as a selector displays as a standard Date Selection selector.

In non-Flash modes, a Date Selection widget created as a selector can be displayed as a standard selector such as a listbox or button bar. To display the Date Selection widget as a Grid/Graph, or to hide it completely, create it as a widget instead. For instructions, see *Creating a Date Selection widget as a widget*, page 208. A Date Selection widget created as a selector allows multiple selections, unlike a Date Selection widget created as a widget.

You can create a Date Selection widget from scratch or by applying its style to an existing selector. The following procedure creates it from scratch.

To apply the style to an existing selector, set the **Flash style** option (found in the Property List or the Properties dialog box) to **Date Selection**.

---

**To create and add a Date Selection widget as selector to a document**

1. In MicroStrategy Web, open the document in **Design Mode** or **Editable Mode**.

   **To create the target**

2. Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. The target must contain a date attribute, such as Day or Quarter. For instructions, see *Inserting a panel stack*, page 70 and the MicroStrategy Web Help.

   **To create the selector**

3. From the **Insert** menu, scroll to **Selector**, then select **Date Selection**. When you move the cursor to the document layout area, the cursor becomes crosshairs.

4. Click the location on your document where you want to place the selector. The Grid/Graph containing the selector is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of selector you have added to the document.
If desired, resize the selector by clicking and then dragging its handles.

**To define the selector**

Right-click the new selector and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

On the left, click **Selector**.

Choose **Select attribute element** from the **Action Type** drop-down list.

Select a date attribute from the **Source** drop-down list. (In the MicroStrategy Tutorial project, Day and Ship Date are examples of date attributes.)

The Source drop-down list contains all of the attributes in all of the datasets in the document. The source attribute that you choose becomes the attribute whose elements are displayed in the selector for a user to choose from.

**To connect the selector to the target**

You can select one or multiple Grid/Graphs or panel stacks, or any combination of Grid/Graphs and panel stacks, as the target. The target Grid/Graph or panel stack displays the attribute elements or metrics that the user chooses from the Fish Eye Selector.

- If targets are automatically maintained and you added the selector and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector.

- If targets are automatically maintained but the selector and target are not in the same document section or panel, you must disable automatic target maintenance before selecting targets, as described below:

  a. Click **Click here**. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see **Disabling automatic target maintenance to allow manual target selection, page 141**.

  b. Click **OK**. You are returned to the Properties and Formatting dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

- If targets are not automatically maintained or you disabled automatic maintenance, you must manually specify the target of the selector.
Select the target in the Available Targets list, and click the Add to selections arrow to move it to the Selected Targets list.

To set a default selector style for non-Flash modes/views

11 From the list on the left, click Layout.

12 In Flash Mode in MicroStrategy Web, the Date Selection widget is viewable as designed above. In non-Flash modes, the Date Selection widget is displayed by default as a Listbox style selector. To change the default selector style (for non-Flash Mode display), select a different DHTML style.

13 For Slider, Radio Buttons, Check Boxes, and Button Bar selector styles, you can use the Orientation option to display the selector horizontally (on a single line from left to right) or vertically (in a single column).

14 The user must select an item in a selector to change the target of the selector. For the List Box selector style, you can allow a user to select an item by hovering the cursor over it, without clicking, if you select the Change selection on mouseover check box. If the user points the cursor away from the selector without clicking an item, the target reverts to its previous state.

The mouseover option is applied only in Flash Mode.

To allow multiple selections and define the All option for users

15 By default, users can only select one item from the following selector styles: Slider, Listbox, Link Bar, and Button Bar. To allow users to make multiple selections for these selector styles, select the Allow multiple selections check box. This check box is cleared by default. This option is unavailable for other selector styles (except for Check Boxes) because those styles do not support multiple selections.

16 From the list on the left, click Selector.

17 By default, the user can display all attribute elements in the target at one time, by selecting the All option. To disable the All option, clear the Show option for All check box.

The Show option for All check box is not available if the DHTML style is set to Slider and the Allow multiple selections check box is selected.

18 By default, the All option is labeled (All) in the selector. You can rename the All option by typing text into the Alias for All field. You can rename the All option only if the Show option for All check box is selected above.
19 Click **OK** to return to the document.

20 Save the document.

**To enable the selector to be displayed**

21 View and test your results by selecting **Flash Mode** from the **Home** menu.

- If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

### Creating a Fish Eye Selector

The Fish Eye Selector magnifies an item when a user hovers the cursor over it in Flash Mode, Interactive Mode, or Express Mode in MicroStrategy Web. Any item that a user hovers over or selects remains magnified, while the remaining items are minimized and displayed in the background of the selector. A Fish Eye Selector is shown below in Flash Mode, targeting a graph, which changes as the selection on the left changes.

You can create a Fish Eye Selector as either a widget or a selector. Which you choose depends on how you want to display the Fish Eye Selector in different modes. In general, a Fish Eye Selector created as a widget can display as a Fish Eye Selector, a grid or graph, a placeholder, or hidden. A Fish Eye Selector created as a selector can display as a Fish Eye Selector or any
standard selector, such as list box or slider. For a complete list of how Fish Eye Selectors are displayed in MicroStrategy Web modes and Desktop views, see *Fish Eye Selector: Widget vs. selector*, page 218. Also, a Fish Eye Selector created as a widget cannot switch panels on a panel stack, unlike a Fish Eye Selector created as a selector.

For example, you can choose to display a Fish Eye Selector as a grid, instead of a widget. The same dashboard shown above in Flash Mode is shown below in Interactive Mode. The widget, which is displayed as a Fish Eye Selector in Flash Mode, is displayed as a grid in Interactive Mode. The grid functions as a selector, targeting and changing the graph, just as the Fish Eye Selector did in the previous example.

| Employee | Bates
|----------|----------------|
| Kyle     | Becker
| Caitlin  | Bell
| Ian      | Benner
| Lawrence | Bernstein
| Vernon   | Brown
| Beatrice | Conner
| Peter    | Corcoran
| Sandra   | De Le Torre
| Nancy    | Ellerkamp
| Adrienne | Folks
| Loren    | Gale
| Harriet  | Gedot
| David    | Hall
| Robert   | Hollywood
| Matthew  | Hunt
| Walter   | Ingles
| Andrew   | Johnson
| Laura    | Kelly
| Jack     | Kieferson
| Sam      | Lynch

All the employees are not shown in this sample, because the list is so long. Notice that the previous selection, Jack Kieferson, is far down the list. Because the list is so long, names even further down the list may not appear in the same screen as the graph, which is why the Fish Eye Selector is so useful.

The Fish Eye Selector in the previous example was created as a widget, which is why it can be displayed as grid. If the Fish Eye Selector was created as a
selector instead, you can choose the selector style for display in non-Flash modes. For example, the Fish Eye Selector can display as a button bar, as shown in the Interactive Mode example shown below. The button bar targets and changes the graph.

Again, all the employees are not shown, because the list is so long. Notice that the selection shown in Flash Mode, Jack Kieferson, is not even shown in this image, because he is so far down the list.

For more examples of displaying a widget in different modes, see Defining how a widget is displayed in different views and modes, page 285.

**Fish Eye Selector targeting a panel stack**

A Fish Eye Selector can target a panel stack, updating the dynamic text fields on a panel. For example, the Fish Eye Selector in the following dashboard, shown in Flash Mode, changes which employee is displayed on the panel.
The other data fields (region, revenue, and profit) also change to reflect that employee’s information.

If the Fish Eye Selector is created as a selector, it can switch panels on a panel stack, as shown below:
A Fish Eye Selector created as a widget cannot switch panels on a panel stack, although it can update dynamic text fields on a panel.

**Fish Eye Selector: Widget vs. selector**

The table below summarizes the differences in functionality between a Fish Eye Selector created as a widget and as a selector.

<table>
<thead>
<tr>
<th></th>
<th>Created as a Widget</th>
<th>Created as a Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Targets Grid/Graphs and dynamic fields on panel stacks</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Switches panels on a panel stack</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Replaces selector item text with images</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Can be the target of another selector</td>
<td>Yes</td>
<td>Only if the selector is on a panel stack (see Determining how the target of a selector displays when no data exists, page 149)</td>
</tr>
</tbody>
</table>

For steps to create a Fish Eye Selector as a widget, see *Creating a Fish Eye Selector as a widget, page 219*. For steps to create a Fish Eye Selector as a selector, see *Creating a Fish Eye Selector as a selector, page 222*.

How a Fish Eye Selector is created affects how it can be displayed in various Web modes and Desktop views, as shown in the following table.

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Fish Eye Selector Created as a Widget</th>
<th>Fish Eye Selector Created as a Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroStrategy Web</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Editable Mode</td>
<td>• Grid or graph</td>
<td>• Standard selector</td>
</tr>
<tr>
<td>Express Mode</td>
<td>• Widget</td>
<td>• Standard selector</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
</tr>
<tr>
<td>Flash Mode</td>
<td>• Widget</td>
<td>• Widget</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph</td>
<td></td>
</tr>
<tr>
<td>Interactive Mode</td>
<td>• Widget</td>
<td>• Standard selector</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
</tr>
<tr>
<td><strong>Desktop</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating a Fish Eye Selector as a widget

The Fish Eye Selector is an interactive style of widget.

When created as a widget and displayed in Flash Mode, a Fish Eye Selector displays as a Fish Eye Selector.

When created as a widget and displayed in non-Flash modes, a Fish Eye Selector can be displayed as any of the following:

- Fish Eye Selector
- Grid/Graph used as a selector
- Empty Grid/Graph placeholder
- Hidden

A Fish Eye Selector created as a widget can target Grid/Graphs and dynamic text fields on panel stacks, but cannot switch panels on a panel stack. (For more information on Grid/Graphs controlling panel stacks or other Grid/
Graphs, see *Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.*) If you want the Fish Eye Selector to switch panels or display as a standard selector such as a listbox or button bar in non-Flash modes, create it as a selector instead. For instructions, see *Creating a Fish Eye Selector as a selector, page 222.*

**To create a Fish Eye Selector as a widget**

1. In MicroStrategy Web, open the document in Design or Editable Mode.

   **To create the target**

2. Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. For instructions, see the MicroStrategy Web Help.

   **To create the selector widget**

3. From the Insert menu, point to Widgets, then Flash, and select Fish Eye.

4. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

5. If desired, resize the widget by clicking and then dragging its handles.

6. From the Dataset Objects panel on the left, select an attribute or metric and drag it on top of the Grid/Graph’s rows. The attribute elements or metric values will be displayed in the selector.

   The selector and target must have an attribute or metric in common. If targets are automatically maintained and you place the selector and target in the same document section or panel, you will not need to disable automatic target maintenance to select the target. For information on the effects of disabling it, see *Disabling automatic target maintenance to allow manual target selection, page 141.*

   **To connect the selector to the target**

7. Right-click the attribute or metric to use as the selector, and choose Use As Selector. The Configure Selector dialog box opens.
8 Do one of the following:

- If targets are automatically maintained and you added the selector Grid/Graph and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector. Click **Create** to finish adding the target.

- If targets are automatically maintained but the widget and target are not in the same document section or panel, you must disable automatic target maintenance and then manually select the target, as described below:

  a Click **Click here**. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see *Disabling automatic target maintenance to allow manual target selection, page 141*.

  b Click **OK**. You are returned to the Selector dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

  c Select the target in the Available Targets list, and click the **Add to selections** arrow to move it to the Selected Targets list.

  d Click **Create**.

- If targets are not automatically maintained, you must manually specify the target of the selector, as described below:

  a Select the target in the Available Targets list, and click the **Add to selections** arrow to move it to the Selected Targets list.

  b Click **Create**.

**To specify the widget display**

9 Right-click the widget and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

10 From the left, click **Widget**.

11 You can change the **Alternative Display** option, which determines how the widget looks in non-Flash modes. The widget can display as a placeholder or as a Grid/Graph, or can be hidden. For more information, see *Defining how a widget is displayed in different views and modes, page 285*.
12 By default, the Fish Eye Selector is displayed as a widget in Flash. To display it as a grid or graph report instead, clear the Flash check box in the Display Widget As column.

13 By default, the Fish Eye Selector is displayed as a widget in DHTML (Express Mode and Interactive Mode in MicroStrategy Web). To use the Alternative Display option instead, clear the DHTML check box in the Display Widget As column.

14 Click OK to apply your changes.

To enable the widget to be displayed

15 View and test your results in one of two ways:

- Select Flash Mode from the Home menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

- Select Interactive Mode from the Home menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 285.

The Fish Eye Selector can display a list of images from which analysts can select. These images replace any attribute element, metric, or panel names in the selector. When an image is selected, any target panel stacks or Grid/Graphs are updated with related data. For steps to have images displayed in place of element, metric, or panel names, see Formatting a Fish Eye Selector, page 309.

Creating a Fish Eye Selector as a selector

When created as a selector and displayed in Flash Mode, a Fish Eye Selector displays as a Fish Eye Selector.

When created as a selector and displayed in non-Flash modes, a Fish Eye Selector can be displayed as a standard selector such as a listbox or button bar.

A Fish Eye Selector created as a selector can target Grid/Graphs and dynamic text fields on panel stacks. It can also switch the panels of a panel
stack. If you want the Fish Eye Selector to display as a Grid/Graph, display as a widget, or hide it completely in non-Flash modes, create it as a widget instead. For instructions, see Creating a Fish Eye Selector as a widget, page 219.

You can create a new Fish Eye Selector or apply the Fish Eye style to an existing selector. The following procedure creates a new Fish Eye Selector. To apply the style to an existing selector, set the Flash style option (found in the Properties and Formatting dialog box) to Fish Eye.

To create and add a Fish Eye Selector as selector to a document

1 In MicroStrategy Web, open the document in Design or Editable Mode.

   To create the target

2 Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. For instructions, see the MicroStrategy Web Help.

   To create the selector

3 From the Insert menu, point to Selector, and select Fish Eye. When you move the cursor to the Layout area, the cursor appears as a crosshair.

4 Click the location on your document where you want to place the selector.

5 If desired, resize the selector by clicking and then dragging its handles.

   To define the action type

6 Right-click the new selector and select Properties and Formatting. The Properties and Formatting dialog box opens.

7 From the left, click Selector.

8 From the Action Type drop-down list, select one of the following:

   • To display attribute elements in the selector, choose Select attribute element. Users will choose from this list of elements to update target panel stacks and Grid/Graphs in the document. Later in this procedure, you specify the attribute whose elements users will choose from.
• To display metric names in the selector, choose **Select Metric**. Users will choose from this list to update target Grid/Graphs in the document. Later in this procedure, you specify the target Grid/Graph or panel stack whose metrics users will choose from.

  Metrics in text fields within the target are not listed when the document is displayed. For example, a panel stack is selected as a target and contains a metric in a text field. That metric is not shown as an item in the selector.

• To display panels in the selector, choose **Select Panel**. Users will choose from this list to update target panel stacks in the document. Later in this procedure, you specify the target panel stack whose panels users will choose from.

  – If DHTML style is set to Checkboxes, the Select Panel option is not available, since check boxes allow multiple selections and you cannot display multiple panels simultaneously. To make the Select Panel option available, select a different DHTML style.

9 If you chose Select attribute element from the Action Type drop-down list above, specify an attribute from the **Source** drop-down list.

  The Source drop-down list contains all of the attributes in all of the datasets in the document. The source attribute that you choose becomes the attribute whose elements are displayed in the selector for a user to choose from.

**To connect the selector to the target**

10 If you choose Select panel as the Action Type, from the **Panel Stack** drop-down list, select the panel stack that the selector will change.

  The Panel Stack drop-down list contains all of the panel stacks in the document. The selector displays the panels of the panel stack selected in this option.

11 If users will be selecting attribute elements or metrics (in other words, if you set the Action Type above to either Select attribute element or Select metric), you can select one or multiple Grid/Graphs or panel stacks, and any combination of Grid/Graphs and panel stacks. The target Grid/Graph or panel stack displays the attribute elements or metrics that the user chooses from the Fish Eye Selector.

• If targets are automatically maintained and you added the selector and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector.
• If targets are automatically maintained but the selector and target are not in the same document section or panel, you must disable automatic target maintenance before selecting targets, as described below:

a  Click Click here. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see Disabling automatic target maintenance to allow manual target selection, page 141.

b  Click OK. You are returned to the Properties and Formatting dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

• If targets are not automatically maintained or you disabled automatic maintenance, you must manually specify the target of the selector. Select the target in the Available Targets list, and click the Add to selections arrow to move it to the Selected Targets list.

To set a default selector style for non-Flash modes/views

12  From the list on the left, click Layout.

13  In Flash Mode in MicroStrategy Web, the Fish Eye Selector is displayed as designed above. In non-Flash modes, the Fish Eye Selector is displayed by default as a Listbox style selector. To change the default selector style (for non-Flash Mode display), select a different DHTML style.

14  For Slider, Radio Buttons, Check Boxes, and Button Bar selector styles, you can use the Orientation option to display the selector horizontally (on a single line from left to right) or vertically (in a single column).

15  The user must select an item in a selector to change the target of the selector. For the List Box selector style, you can allow a user to select an item by hovering the cursor over it, without clicking, if you select the Change selection on mouseover check box. If the user points the cursor away from the selector without clicking an item, the target reverts to its previous state.

The mouseover option is applied only in Flash Mode.

To allow multiple selections and define the All option for users

16  By default, users can only select one item from the following selector styles: Slider, Listbox, Link Bar, and Button Bar. To allow users to make multiple selections for these selector styles, select the Allow multiple
**selections** check box. This check box is cleared by default. This option is unavailable for other selector styles (except for Check Boxes) because those styles do not support multiple selections.

17 From the list on the left, click **Selector**.

18 By default, the user can display all attribute elements or metrics in the target at one time, by selecting the All option. To disable the All option, clear the **Show option for All** check box.

The Show option for All check box is not available if either of the following is true:

- The **Action Type** is set to **Select Panel**.
- The **DHTML style** is set to **Slider** and the **Allow multiple selections** check box is selected.

19 By default, the All option is labeled (All) in the selector. You can rename the All option by typing text into the **Alias** field. You can rename the All option only if the Show option for All check box is selected above.

20 Click **OK** to return to the document.

21 Save the document.

**To enable the selector to be displayed**

22 View and test your results by select **Flash Mode** from the **Home** menu.

- If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

The Fish Eye Selector can display a list of images from which analysts can select. These images replace any attribute element, metric, or panel names in the selector. When an image is selected, any target panel stacks or Grid/Graphs are updated with related data. For steps to have images displayed in place of element, metric, or panel names, see *Formatting a Fish Eye Selector, page 309*.

**Creating a Funnel widget**

A Funnel widget allows you to quickly analyze various trends across several metric values. It can be used for a wide variety of business purposes,
including application management, click management, pipeline analyses for sales forecasts, and sales process analysis.

The widget is a variation of a stacked percent bar graph that displays data that adds up to 100%. Therefore, it can allow analysts to visualize the percent contribution of sales data. It can also show the stages in a sales process and reveal the amount of potential revenue for each stage. When the widget is used to analyze a sales process, analysts can use the widget to drill down to key metrics such as deal size, profit potential, and probability of closing. The widget can also help identify potential problem areas in an organization’s sales processes.

For example, the following Funnel widget displays the percent contribution of revenue data by region. Each section of the funnel is a different region, and the size of each section is proportional to the amount of revenue that the region contributed.

---

**Revenue and Profit Trends by Region, Category and Quarter**

- Revenue Central
- Revenue Mid-Atlantic
- Revenue Northeast
- Revenue Northwest
- Revenue South

---

**To create and add a Funnel widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Funnel**.
3 Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4 If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

5 From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a Place at least one attribute on the Grid/Graph’s rows. The attributes are displayed as separate cross-sections of the funnel.

b Place at least one metric on the Grid/Graph’s columns. The size of each section of the widget is determined by the values of the metric.

**To enable the widget to be displayed**

6 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

- Select **Interactive Mode** from the **Home** menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285*.

A Funnel widget does not need a separate selector to allow a user to interact with it.

**Creating a Gauge widget**

A Gauge widget is a simple status indicator that displays a needle that moves within a range of numbers displayed on its outside edges. A real-world example of a gauge is a car’s speedometer. Like the Cylinder and Thermometer widgets, this type of widget is designed to display the value of a single metric. The needle within the gauge is a visual representation of that single metric value.
The Gauge widget is most useful when combined with a selector because this allows users to choose specific metric values to display in the gauge. In the image below, the location of the needle in the gauge represents the amount of revenue generated (the Revenue metric).

To create and add a Gauge widget to a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Gauge**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

5. From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   a. Place at least one attribute on the Grid/Graph’s rows.
   b. Place at least one metric on the Grid/Graph’s columns. The metric values determine the location of the needle on the gauge.
6 To allow users to change the metric value displayed in the widget with a selector:

   a Insert a selector next to the Gauge widget, then select an attribute as its source. Users choose attribute elements from this selector to change the display in the Gauge widget. For steps to insert a selector and select a source for it, see *Methods to create a selector, page 117*.

   b Set the Gauge widget as the target of the selector. For steps to select an object as the target of a selector, see *Selecting targets interactively (target selection mode), page 120*.

7 It can be useful to drag the dataset report from the Dataset Objects panel and place it beneath the selector. This allows users to see the report’s values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.

**To enable the widget to be displayed**

8 View and test your results in one of two ways:

   • Select **Flash Mode** from the Home menu.
     
     – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

   • Select **Interactive Mode** from the Home menu.

     – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285*.

**Creating a Graph Matrix (deprecated) widget**

A Graph Matrix (deprecated) widget allows you to quickly analyze various trends across several metric dimensions. You can use the widget to assess questions such as “How are sales comparing vs. forecast, by time and region?”.

The Graph Matrix (deprecated) widget consists of several area graphs that display current values. Each area graph also has a line graph above it to show forecasted values. One graph is displayed for every combination of elements from the attributes on the rows and columns of the Grid/Graph that contains the widget. For example, in the widget below, the rows of the report contain...
the Category attribute elements and the columns contain the Region attribute elements. Twelve graphs are displayed because data exists for four regions and three categories of products.

<table>
<thead>
<tr>
<th>Category</th>
<th>Northeast</th>
<th>Mid-Atlantic</th>
<th>South</th>
<th>Southeast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td><img src="image1.png" alt="Graph" /></td>
<td><img src="image2.png" alt="Graph" /></td>
<td><img src="image3.png" alt="Graph" /></td>
<td><img src="image4.png" alt="Graph" /></td>
</tr>
<tr>
<td>Electronics</td>
<td><img src="image5.png" alt="Graph" /></td>
<td><img src="image6.png" alt="Graph" /></td>
<td><img src="image7.png" alt="Graph" /></td>
<td><img src="image8.png" alt="Graph" /></td>
</tr>
<tr>
<td>Music</td>
<td><img src="image9.png" alt="Graph" /></td>
<td><img src="image10.png" alt="Graph" /></td>
<td><img src="image11.png" alt="Graph" /></td>
<td><img src="image12.png" alt="Graph" /></td>
</tr>
</tbody>
</table>

A separate area graph is produced for each combination of region and product category. For example, one area graph focuses solely on electronics product figures in the Northeast region. Values in that graph are plotted across quarter (on the X-axis) and revenue (on the Y-axis). The line graph at the top of the area graph represents revenue forecast metric values, or the amount of revenue the company predicted it would generate.
You can maximize a specific area graph by double-clicking it. The graph opens in a new window, as shown below.

Each area graph in a Graph Matrix (deprecated) widget has the following characteristics, as shown above.

- The X-axis provides the time scale. For example, the X-axis can represent weeks, quarters, or years.
- The Y-axis provides the metric values. For example, the Y-axis can represent revenue, profit, or units sold.
- The area graph shows the current values, allowing you to see how values changed over time. The area graph represents the values of the first metric on the Grid/Graph that contains the widget.
- The line graph at the top of the area graph shows the predicted, or forecasted, values. The line graph represents the values of any additional metrics on the Grid/Graph.
- The black reference line in the area graph (not displayed above) shows the average for only the specific graph you are looking at.
- The red reference line in the area graph (not displayed above) shows the average metric value for all of the graphs in the same row of the Graph Matrix (deprecated) widget. This allows you to easily compare one graph in the widget to another.
To create and add a Graph Matrix (deprecated) widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Graph Matrix (deprecated).

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

- You must place either two attributes on the Grid/Graph’s rows, one attribute on the columns, and one metric on the columns; or you must place three attributes on the rows and one metric on the columns:
  - Place at least two attributes on the rows. The first (left-most) attribute on the rows (and the second, third, fourth, and so on) provide the row headers in the widget. The last (right-most) attribute on the rows provides the X-axis of the graphs. This attribute, which is generally time-based, is used to drive the time series of the graphs.
  - If there are fewer than three attributes on the rows, place at least one attribute on the columns. The first (left-most) attribute on the columns provides the column headers in the widget. These values are used to slice the data by grouping it based on the column attributes. Additional attributes on the columns produce separate line graphs within each area graph in the widget.
  - Place at least one metric on the Grid/Graph’s columns. (If there is an attribute on the columns, place the metric the right of, or below, the attribute.) The value of this metric is graphed on the Y-axis. The first metric on the columns is depicted as the colored series in the area graphs. Any additional metrics are depicted as the forecast lines in each area graph.
To enable the widget to be displayed

6 View and test your results in one of two ways:

• Select **Flash Mode** from the **Home** menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

• Select **Interactive Mode** from the **Home** menu.
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285*.

A Graph Matrix (deprecated) widget does not need a separate selector to allow a user to interact with it. However, you can use a Graph Matrix (deprecated) widget as a selector. For an example and more information, see *Using a Graph Matrix (deprecated) widget as a selector, page 355*.

Creating a Graph Matrix widget

The Graph Matrix widget allows you to quickly analyze various trends across several metric dimensions. The widget consists of a matrix of graphs that allow users to analyze and compare trends in metric data.
An example of the Graph Matrix widget is shown in the image below.

You can access the following additional options by creating the Graph Matrix widget as a visualization:

- Organize the data displayed in the graph based on a specific attribute. For example, a bar graph contains units sold data for several regions. You can choose to display a different bar for each individual store within each region.

- Color graph elements (such as bubbles, lines, or bar risers) by an attribute or a metric. For example, you can choose to display a different color for each element in an attribute. You can choose to have graph elements automatically colored based on the value of a metric, with the darkest colors being displayed for the largest metric values.

- Automatically size graph elements based on the value of a metric, with the largest elements being displayed for the largest metric values.

- Slice your data, by displaying a graph for each combination of attribute elements in the rows and columns of the Graph Matrix visualization. For example, you can display the revenue data for each Region as a separate line graph, or display a bar graph containing store sales for each year.

To access these options, you must first create a Graph Matrix visualization in a Visual Insight analysis, then convert the analysis into a Report Services document. For instructions to create a Visual Insight analysis, see the MicroStrategy Web Help.
Prerequisites

For a report to be displayed as a Graph Matrix widget, it must meet the following requirements:

- At least one attribute, either on the row or the columns.
- At least one metric on the columns, below all attributes that are on the columns.

To create a Graph Matrix widget

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Graph Matrix.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. If desired, resize the widget by clicking and then dragging its handles.

4. From the Dataset Objects panel on the left, select attributes and metrics, and drag them onto the Grid/Graph, as described in the prerequisites above.

Creating a Heat Map widget

A Heat Map widget presents a combination of colored rectangles, each representing an attribute element, that allow you to quickly grasp the state and impact of a large number of variables. Heat Maps are often used in the financial services industry to review the status of a portfolio.

The rectangles contain a variety and shadings of colors, which emphasize the status of the various components. In a Heat Map:

- The size of each rectangle represents its relative weight.
- The color represents the relative change in value of that rectangle.
- You can hover over each rectangle to see which attribute element the rectangle represents and its metric values.
Each part of the example below is explained in the following list:

- The large areas (such as the Large Blend area in the image above) represent different categories of mutual funds. These areas are generated by the first attribute on the rows of the Grid/Graph that contains the widget. In this case, the first attribute is Mutual Fund Category. Notice that the name of each category is displayed in the headers of each of these areas. You can change the aggregation function used to calculate the size of these areas. For steps, see *Formatting a Heat Map widget, page 318*. This aggregation function is also displayed in a tooltip when the user hovers the cursor over an area.
• The colored rectangles (colored shades of red and blue in the image above) represent different mutual funds. These rectangles, such as the Vanguard Small Cap Index and Legg Mason Value Prim rectangles above, are generated by any additional attributes on the rows. In this case, a second attribute, Mutual Fund, is on the rows of the Grid/Graph.

• The size of each rectangle represents its relative weight. This is determined by the first metric on the columns of the Grid/Graph. This widget shows that Large Blend funds are weighted more heavily than Mid-Cap Blend funds in regard to net assets. In this case, the first metric on the columns of the Grid/Graph is Net Assets.

• The colors displayed in the widget represent different ranges of return year-to-date percentages generated by the mutual funds. (In the image above, blue denotes higher percentages, while red and purple denote lower percentages.) The colors applied to each rectangle are generated by the second metric on the Grid/Graph. (In the image above, the second metric on the report is Return YTD %.) You can define the colors used to denote these values. For steps, see Analyzing data in a Heat Map widget in the MicroStrategy Web Help.

You can create a dynamic heat map that an analyst can control using a selector. This type of heat map is considered dynamic because a user can use the selector, such as a drop-down list, to choose a different attribute element to view on the heat map. Steps to create both a static and a dynamic Heat Map widget are included below.

---

**To create and add a Heat Map widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Heat Map**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.
To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a Place at least one attribute on the rows. This attribute is used to create the large rectangles whose names are displayed in the widget.

b You can place additional attributes on the Grid/Graph:
   - To group each element of the first attribute inside the larger area, place a second attribute to the right of the first. For example, the Region attribute contains the element South and the Call Center attribute contains the elements New Orleans and Memphis. If Region is placed to the left of Call Center, a large area called South is displayed in the widget, with smaller rectangles New Orleans and Memphis inside.
   - You can add additional attributes to further group the rectangles in the Heat Map. Attributes that have a parent-child relationship work best, because they are nested within one another in the Heat Map.

c Place at least two metrics on the columns:
   - The first metric on the columns determines the size of the small rectangles within each large rectangle. Items with lower values are represented by smaller rectangles.
   - The second metric on the columns must be placed at the bottom of the columns. It determines the color of each rectangle. It must include values in the range of -1 to 1. This range is used to provide different shadings of color.
   - If more than two metrics are placed on the Grid/Graph, the additional metrics are displayed in a tooltip when the user hovers a cursor over the area.

6 To enable a legend for the widget, right-click the widget and select Properties. On the Display tab, select the Show Legend check box and click OK. A legend is displayed near the widget.

7 If you are creating a dynamic Heat Map widget, perform the following:

a Insert a selector, such as a Drop-down list, next to the widget. Users choose attribute elements from this selector to change the display in the widget. For steps to insert a selector, see Methods to create a selector, page 117.
b Choose an attribute from the dataset that is not already in the Grid/Graph and set this attribute as the Source of the selector. Do not include this attribute in the Grid/Graph. It is used to populate the selector.

c Set the Grid/Graph as the target of the selector.

**To enable the widget to be displayed**

8 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56.*

- Select **Interactive Mode** from the **Home** menu.
  
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285.*

You can use a Heat Map widget as a selector. For an example and more information, see *Using a Heat Map widget as a selector, page 357.*

You can add links to a Heat Map widget. Linking allows users to connect from a widget in a dashboard (the source) and open a document or report (the target). If you add a link to a Heat Map widget, a Links menu is displayed when a MicroStrategy Web user hovers the cursor over an attribute element in the widget. The user can click a link in the Links menu to open the target. See *Linking in widgets, page 295* for instructions and examples.

**Creating an Image Layout widget**

You can add an Image Layout widget to a document to display an image overlaid with colored areas or bubble markers. For example, you can display a map of the United States, with a bubble marker displayed over each state. You can have states with a high number of stores displayed using large bubble markers, and states with a low number of stores displayed using small bubble markers. As another example, you can display the layout of a store in the widget, with each aisle displayed as a separate region, then have Web automatically color each aisle based on the number of visits each aisle receives. The image below shows an Image Layout widget with a map of the
United States, in which each state is displayed as a separate colored region.
Steps are below to create and add an Image Layout widget to a document.

You can display the Image Layout widget on a mobile device with MicroStrategy Mobile. For background information on widgets for mobile devices, see the MicroStrategy Mobile Design and Administration Guide.

Prerequisites

This procedure assumes that an administrator has already created the following:

- The shape file you want to use to display the widget. A shape file is an HTML file that contains the image that you want to display in the widget, as well as the location of each bubble marker or area you want to display on top of the image. Web provides several default shape files for you to choose from, including a map of countries of the world and a map of states in the United States. You can define your own shape file for use in the widget, using the same steps as you would to customize an Image Layout visualization. For steps, see the MicroStrategy Web Help.

- An attribute with the name of each location that you want to display in the widget. Each element in this attribute should contain the name of a location defined in the shape file described above, as listed in the ALT parameter for the location. For example, if the shape file defines a bubble marker for Washington state as follows: `<AREA SHAPE="triangle"`
the attribute should contain an element named Washington.

Web uses this attribute to determine the default shape file to display in the widget. If a geo role, such as City, State, or Country, has been assigned to this attribute, the widget will automatically display the first shape file with the same geo role as the attribute. For example, if the attribute's geo role is State, the States of USA shape file will be displayed in the widget by default. The attribute can also be used to display a specific shape file by assigning it a shape key. A shape key is a unique identifier given to each shape file. If a shape key has been assigned to the attribute, the widget will automatically display the shape file with the same shape key. You can assign a geo role or shape key to an attribute during the Import Data process, or when editing an attribute in Desktop. For steps to assign a geo role or shape key while importing data, see the MicroStrategy Web Help.

To create and add an Image Layout widget to a document

1. Open the document in Design or Editable Mode.
2. From the Insert menu, point to Widget, then Flash. Select Image Layout.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.
5. From the Dataset Objects panel on the left, select report objects and drag them on top of the widget, based on the following requirements for this widget:
   - To specify the areas or bubble markers to display in the widget, place one attribute on the rows of the widget's Grid/Graph. This attribute must contain the name of each location that you want to display in the widget, as described in the prerequisites above.
   - Place metrics on the columns of the widget's Grid/Graph, as follows:
     - The first metric is used to automatically size bubble markers in the widget.
     - The second metric is used to automatically color elements in the widget or automatically replace bubble markers with images based on...
on the value of the metric. To do this, you must define a threshold on this metric, as described below.

– Any additional metrics on the rows will be displayed in a pop-up tooltip when the user hovers the cursor over a location in the widget.

6 To have Web automatically color areas or bubbles in the widget based on the value of a metric, right-click the second metric on the widget's columns, point to **Conditional Formatting**, then select **Visual**. The Visual Conditional Formatting Editor opens. Select the appropriate options to define threshold conditions and specify the colors you want to have applied to the areas or bubbles, or the images you want to use to replace the bubble markers. For background information and steps to define a threshold, see the *Formatting Documents* chapter in the *Document Creation Guide*.

7 View and test your results by selecting **Flash Mode** from the **Home** menu.

– If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

### Creating an Interactive Bubble Graph widget

An Interactive Bubble Graph widget is a conventional bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. The data structure for an interactive bubble graph is very specific. At minimum, one attribute and three metrics are required. In the bubble graph:

- One bubble is displayed for each attribute element.
- Each bubble's position on the X-axis represents the value of the first metric.
- Each bubble's position on the Y-axis represents the value of the second metric.
The Interactive Bubble Graph is interactive, unlike a standard bubble graph report. For example:

- Analysts can change which metric is displayed on which axis, if a designer adds this functionality. For example, in the widget shown above, the Profit Margin is displayed on the X-axis (the horizontal axis) and the Minimum Revenue per Customer on the Y-axis (the vertical axis). An analyst can switch the metrics, so that the Profit Margin is shown on the Y-axis and the Minimum Revenue per Customer on the X-axis.

- Analysts can zoom into a section of the widget to enlarge it, if a designer adds this functionality. For example, the user can draw a selection box (or lasso) around a cluster of bubbles and enlarge that area of the widget to focus on information for those cities.

- Analysts can drill into the components of a bubble to see the underlying data within that bubble’s data, if a designer adds this functionality. For example, an analyst can click on any Region bubble (the parent attribute) to drill down to bubbles that represent different cities (child attributes) within that region.

- Analysts can see a time-series animation that plots the bubble values through time, if a designer adds this functionality. To see the animation, an analyst moves the time slider or clicks the animation’s Play button.
For steps to enable or disable any of the features described above, see *Formatting an Interactive Bubble Graph widget, page 323*.

**Supporting drilling in an Interactive Bubble Graph widget**

If you want to support drilling in an Interactive Bubble Graph widget, the objects on the widget must be structured in a specific way. There are two easy methods to structure the objects so that drilling is supported: using a custom group on the widget, or using subtotals on the widget. Both methods are described below. This information is presented before the steps to create the widget, so that you can perform any necessary object creation described below, before you begin creating the widget.

**Supporting drilling using a custom group**

The structure required for drilling can be created with a custom group. The child attribute must be structured in a specific way. For an introduction to custom groups, see the *Advanced Reporting Guide*.

The data for the child attribute must be displayed so that the total for the child attribute is in the top row of data, followed by the data for (the elements of) the child attribute. An example in grid form is shown in the image below. In the custom group, notice that the first element within the Northeast region is Northeast. This is followed by the two child attribute elements, Boston and New York.

In the metric data, the first row represents the total (Average for the first two metrics, Sum for the third) of the other two rows. The first row must include totals for drilling to work properly.

<table>
<thead>
<tr>
<th>Year</th>
<th>Region</th>
<th>Call Center Custom Group</th>
<th>Metrics</th>
<th>Profit per Employee</th>
<th>Revenue per Employee</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005</td>
<td>Central</td>
<td>Milwaukee</td>
<td>$71,272</td>
<td>$455,929</td>
<td>32,736</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fargo</td>
<td>$77,672</td>
<td>$499,411</td>
<td>27,254</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>Northeast</td>
<td>$52,071</td>
<td>$325,461</td>
<td>5,462</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Boston</td>
<td>$95,772</td>
<td>$493,013</td>
<td>52,462</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>New York</td>
<td>$30,908</td>
<td>$179,468</td>
<td>9,794</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$140,636</td>
<td>$806,530</td>
<td>42,560</td>
<td></td>
</tr>
<tr>
<td>2006</td>
<td>Central</td>
<td>Milwaukee</td>
<td>$86,290</td>
<td>$545,558</td>
<td>39,256</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fargo</td>
<td>$96,194</td>
<td>$608,032</td>
<td>32,044</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$56,577</td>
<td>$356,536</td>
<td>6,652</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>Northeast</td>
<td>$109,159</td>
<td>$611,461</td>
<td>65,347</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Boston</td>
<td>$39,617</td>
<td>$220,527</td>
<td>11,396</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>New York</td>
<td>$178,721</td>
<td>$1,002,955</td>
<td>53,951</td>
<td></td>
</tr>
</tbody>
</table>

© 2012 MicroStrategy, Inc.
The structure requirements for the child attribute are as follows:

- The child attribute must group attribute elements together at the level of the parent attribute. For example, elements in the Call Center Custom Group above are sorted by Region.
- The child attribute must contain attribute elements that represent totals across each group. For example, the Northeast element above represents all of the call centers in the Northeast Region.
- The elements that represent totals must be displayed at the top of each group. For example, the Northeast element is immediately followed by the call centers in the Northeast region, Boston and New York. Directly below is the Central element, followed by each call center in the Central region.

**Supporting drilling using subtotals**

As an alternative to creating a custom group, you can add subtotals, without grand totals, when you create the original report. The subtotals must be calculated by row, across the level of the child attribute, and must be displayed at the top of each level. This ensures that the total for the second attribute is displayed in the top row of data, followed by the data for that attribute. Be sure to add the Grid/Graph to the dashboard with formatting, so that this structure is used.

For example, the following report is subtotaled across the level of Call Center, which is the child attribute of Region. The subtotals are displayed at the top of each region.

<table>
<thead>
<tr>
<th>Region</th>
<th>Call Center</th>
<th>Metrics</th>
<th>Profit per Employee</th>
<th>Revenue per Employee</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Total</td>
<td></td>
<td>$487,910</td>
<td>$3,083,308</td>
<td>122,302</td>
</tr>
<tr>
<td></td>
<td>Milwaukee</td>
<td></td>
<td>$301,205</td>
<td>$1,914,563</td>
<td>101,659</td>
</tr>
<tr>
<td></td>
<td>Fargo</td>
<td></td>
<td>$181,705</td>
<td>$1,169,245</td>
<td>20,543</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td></td>
<td>$1,176,476</td>
<td>$6,005,901</td>
<td>104,809</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Washington, DC</td>
<td></td>
<td>$937,403</td>
<td>$5,425,540</td>
<td>73,269</td>
</tr>
<tr>
<td></td>
<td>Charleston</td>
<td></td>
<td>$390,076</td>
<td>$1,300,441</td>
<td>31,510</td>
</tr>
<tr>
<td>Northeast</td>
<td>Total</td>
<td></td>
<td>$669,913</td>
<td>$3,791,804</td>
<td>202,163</td>
</tr>
<tr>
<td></td>
<td>Boston</td>
<td></td>
<td>$119,441</td>
<td>$675,703</td>
<td>35,661</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td></td>
<td>$550,472</td>
<td>$3,116,101</td>
<td>166,302</td>
</tr>
</tbody>
</table>

For steps to add a Grid/Graph with formatting, see the *Desktop Help*. For steps to display subtotals, see the *Basic Reporting Guide*. 
Creating and adding an Interactive Bubble Graph widget to a document

To create and add an Interactive Bubble Graph widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Interactive Bubble Graph.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

   a. Place at least one attribute on the rows. You can add additional attributes, as described below:

      - To support drilling on the bubble graph, add one additional attribute to the right of the attribute in the rows. This attribute must be a child attribute of the attribute already on the rows. For example, City is a child attribute of the State attribute. For details on methods to structure objects to support drilling, see Supporting drilling in an Interactive Bubble Graph widget, page 245.

      - To support time series animation, add a time-based attribute on the left-most side of the rows.

      - To enable both drilling and time series animation, you must have at least three attributes on the rows. The left-most attribute must be associated with time; the second and third attributes must be children of the left-most attribute (the parent attribute).

      - To ensure that different groups of attribute elements are displayed as different colored bubbles, you can add a fourth attribute above the first three metrics on the columns.
Once the widget is created, if you provided objects to support drilling or time series animation, you must enable these features. For steps to enable drilling or time series animation in the widget, see Formatting an Interactive Bubble Graph widget, page 323.

b. Place at least three metrics on the columns. The first three metrics are displayed along the X-axis, the Y-axis, and the Z-axis, in order from left to right, by default. For example, the first metric is displayed on the X-axis. The Z-axis value determines the size of the bubbles. (You can enable or disable the ability for an analyst to change which metric displays along each axis. For steps, see Formatting an Interactive Bubble Graph widget.)

To enable the widget to be displayed

6. View and test your results in one of two ways:

- Select Flash Mode from the Home menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

- Select Interactive Mode from the Home menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 285.

Once the widget is created, if you provided objects to support drilling or time series animation, you must enable these features. For steps to enable drilling or time series animation in the widget, see Formatting an Interactive Bubble Graph widget, page 323.

An Interactive Bubble Graph widget does not need a separate selector to allow a user to interact with it. However, you can use an Interactive Bubble Graph widget as a selector. For an example and more information, see Using an Interactive Bubble Graph widget as a selector, page 358.

You can add links to an Interactive Bubble Graph widget. Linking allows users to connect from a widget in a dashboard (the source) and open a document or report (the target). If you add a link to an Interactive Bubble Graph widget, a Links menu is displayed when a MicroStrategy Web user hovers the cursor over a bubble in the widget. The user can click a link in the Links menu to open the target. See Linking in widgets, page 295 for instructions and examples.
Creating an Interactive Stacked Graph widget

An Interactive Stacked Graph widget presents a combination of a check box list and an area graph. The graph allows a user to see the contribution of various metric series to the change in value of a larger set of data.

- By selecting individual attribute elements (for example, a list of years) using the check boxes, analysts determine what data is displayed on the area graph on the right. When all check boxes are selected, the area graph is at its maximum size because it is representing contributions from each individual element.

- This widget allows you to visualize total metric values as one large stacked area, and the individual pieces of that total as smaller stacked areas within the large stacked area. You can quickly analyze how the individual parts make up the whole, which is useful when making percent-to-total comparisons. To see how the individual parts make up the whole, click the name of the attribute element on the left; you can select multiple items by holding CTRL and selecting elements.

The image below shows a sample Interactive Stacked Graph widget:
To create and add an Interactive Stacked Graph widget to a document

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 From the Insert menu, point to Widgets, then Flash, and select Interactive Stacked Graph.

3 Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4 If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a Place at least two attributes, one on the rows and one on the columns, as described below:

   - The attribute placed on the rows is displayed on the graph’s X-axis, at the bottom of the area graph in the widget. For example, if you place a Region attribute in the rows and then switch to Flash Mode, the regions are listed on the X-axis (horizontal graph line) at the bottom of the area graph.

   - Attributes placed on the columns must appear above (or to the left of) the metric on the columns. Attributes placed on the columns appear as a list of check boxes on the left side of the widget. For example, if you place a Category attribute on the columns and then switch to Flash Mode, the list of categories is displayed on the left as check boxes. The user can select each check box to show or hide that specific data on the area graph.

b Place only one metric on the columns. The metric values are displayed on the Y-axis of the graph. The metric must appear below (or to the right of) any attributes on the columns.
To enable the widget to be displayed

6 View and test your results by selecting **Flash Mode** from the **Home** menu.

   – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

An Interactive Stacked Graph widget does not need a separate selector to allow a user to interact with it. However, you can use an Interactive Stacked Graph widget as a selector. For an example and more information, see *Using an Interactive Stacked Graph widget as a selector, page 360*.

Creating a Map widget

You can create a Map widget to search and view information for locations on a map. For example, you can display locations on a map using map markers. Tapping a map marker displays an Information Window with additional details about the selected location. For steps to create and format a Map widget for display on a mobile device, see the *MicroStrategy Mobile Design and Administration Guide*. For steps to create and format a Map widget for display in Web, see the *GIS Integration Help*. This widget is designed for use in Web or a mobile device with MicroStrategy Mobile.

Creating a Media widget

The Media widget allows you to present a variety of media such as video, audio, images, or website content on your dashboard. You can include media in the widget to provide background information about data, or instructions on how to use the dashboard. You can also use the Media widget to enhance the look and feel of a dashboard. In the following dashboard, the Media
A widget in the top left corner shows a company’s CEO addressing his employees on important trends in the latest figures.

One of the primary purposes of the Media widget is to present supplemental information about the data on a dashboard. For example, a regional manager can record a video that summarizes quarterly sales and discusses the significance of the data in a sales dashboard. Analysts can then view the dashboard in the context of this additional information and commentary.

The media file used in the widget can come from an online source, be stored locally on your machine, or be stored remotely on your corporate network.

The Media widget can be used for instructional purposes. For instance, a dashboard designer can include audio or video files that explain how to use a dashboard. Analysts can use this information to focus on key data and take advantage of the dashboard’s interactive features, allowing them to work with the dashboard more efficiently.

You can display HTML content from a website in the widget. For example, you can display a section of your internal corporate website that contains a business presentation. Website content that is refreshed frequently, such as
numeric indicators on system usage, can also be useful media to present in the widget.

You can configure the Media widget to play a media file based on the attribute, dashboard, or dataset report selected in the dashboard. For example, select a quarter in the dashboard, and a manager's video about the revenue for that quarter is displayed. Similarly, you can choose a region to play a video about the performance of the stores in that particular region.

You can export a dashboard containing a Media widget into a Flash file, so that users can view the widget and interact with it off-line, without a connection to Intelligence Server or your web server.

**Prerequisites for the Media widget**

- If your machine is running Microsoft Windows 2003 SP2 (R2) and Microsoft Internet Information Services (IIS) 6, you must add `.flv` files to the Multipurpose Internet Mail Extension (MIME) types in IIS Manager:
  
a. From the Start menu, select Control Panel, then Administrative Tools.
  
b. Double-click Internet Information Services (IIS) Manager.
  
c. Expand the (local computer) folder, expand Web Sites, then expand Default Web Site.
  
d. Right-click MicroStrategy and select Properties.
  
e. On the HTTP Headers tab click MIME Types. Then click New.
  
f. In the Extension field, type flv.
  
g. In the MIME Type field, type video/x-flv.
  
h. Click OK until the MicroStrategy Properties window closes.
  
i. Restart IIS.

- To ensure that the Media widget can play the media file off-line, the file name for the media file must be specified without a path. The media file must be stored in the same folder as the Flash file. When specified this way, the media file is not accessible when the dashboard is viewed online. For background information about Flash files and how to export dashboards, see the MicroStrategy Document Analysis Guide or the Desktop Help.
To use a graphic, video, or audio clip that is available on your network, ensure that the file has the required view or access privileges.

The Media widget can play and display the file formats listed in the following table.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>.swf, .flv</td>
</tr>
<tr>
<td>Audio</td>
<td>.mp3</td>
</tr>
<tr>
<td>Graphic</td>
<td>.gif, .jpg, .png, .svg</td>
</tr>
</tbody>
</table>

The Media widget handles HTML tags in the following ways. Use the lists below to confirm the tags you plan to use will display as expected:

<table>
<thead>
<tr>
<th>Tags and Content Supported</th>
<th>Tags Not Rendered, But Content in Tags Displayed</th>
<th>Tags and Content Not Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;A&gt;</td>
<td>&lt;TABLE&gt;</td>
<td>&lt;SCRIPT&gt;</td>
</tr>
<tr>
<td>&lt;B&gt;</td>
<td>&lt;TR&gt;</td>
<td>&lt;STYLE&gt;</td>
</tr>
<tr>
<td>&lt;BR&gt;</td>
<td>&lt;TD&gt;</td>
<td>&lt;SPAN&gt;</td>
</tr>
<tr>
<td>&lt;IMG&gt;</td>
<td>&lt;DIV&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;I&gt;</td>
<td>&lt;FONT&gt; *</td>
<td></td>
</tr>
<tr>
<td>&lt;LI&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;P&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;U&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The <FONT> tag may be removed if it contains a CLASS attribute within it, for example, <font class="header">Welcome</font>.

---

To create and add a Weighted List Viewer widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. From the Insert menu, point to Widgets, then Flash, and select Media.
3 Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4 If desired, resize the widget by clicking and then dragging its handles.

**To enable the widget to be displayed**

5 Perform one of the following to enable the widget to be viewed:

- Select **Flash Mode** from the **Home** menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

- Select **Interactive Mode** from the **Home** menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285*.

**To specify the media content to display in the widget**

6 Right-click the widget and select **Properties**. The Properties dialog box opens.

7 On the General tab, from the **Content Type** drop-down list, choose the type of media to present by selecting **Video**, **Audio**, **Web Content**, or **Image**. See *Prerequisites for the Media widget, page 253* for supported file formats.

8 Specify the location of the content in the **Default Feed** field according to the following:

- If the media is stored on a network location or website, specify the network location of the file or website’s URL using the following format: `http://www.mycompany.com/SalesVideos/South.swf`. Folder paths in the form of `\computer_name\videos\South.swf` cannot be used.

- To define the widget as a target of an attribute, dashboard, or dataset selector in the dashboard:
  - Specify a dynamic path that includes the name of the object, for example: `http://www.example.com/videos/`
– Use a + character to include a space between words, for example: http://www.mycompany.com/videos/Books+Electronics+Music+Movies.

• If the Media widget will be exported to a Flash file in a dashboard so users can view and interact with it off-line, perform the following:
  – Specify only the file name, without a path, for example, South.swf.
  – Add the .mht file to the list of Adobe Flash Player trusted files on the client machine. To do this, on the Macromedia Support Site, from the Edit locations drop-down list, select Add location. Type the location of the .mht file, then click Confirm. Close and reopen the dashboard.

9 If you selected Web Content above and the web content is located on a different web domain than the one used for MicroStrategy Web, select the Use Proxy check box.

10 If you want to display a tooltip, enter text in the Tooltip Text field. For details on tooltips, see the MicroStrategy Document Creation Guide.

11 Select the background color from the Background color drop-down list.

12 If you want to display the media content when a user clicks a button in the widget, rather than automatically when the widget is executed, select the Popup content when clicked check box, then perform the following:
  a To determine how the content is displayed when the user clicks the button, from the Display Window drop-down list select Inline or New Window.
  b Enter text for the button in the Button Text field.

13 Determine the following video play options on the Play Frequency tab:
  • To display the Play button in the widget, select the Show play button control check box. If the Play button is not displayed, the media cannot be controlled by the user.
  • To play the media file automatically when the dashboard is executed, select the Auto Play on Start check box.
  • To play the video continuously in a loop, select Continuous Play (Loop).
• To play the video only once, select **Play Once**.

14 Click **OK** to save changes and display the widget.

## Creating a Microcharts widget

The Microcharts widget consists of compact representations of data that allow analysts to quickly visualize trends in data. Microcharts convey information so that a user can, at a glance, determine the trend of a metric over time or how a metric is performing compared to forecasted figures. The Microcharts widget is useful for this purpose because individual microcharts can display attribute and metric data in a small graph that would otherwise be displayed as a single value in a grid report cell.

Use a Microcharts widget to quickly visualize the trend of a metric at a glance without having to know many additional details. The bar, sparkline, and bullet microcharts used in the Microcharts widget convey information that an analyst can understand by looking at the graph once.

Each of the microcharts provides a unique way to visualize your data, as described below:

<table>
<thead>
<tr>
<th>Microchart</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar chart</td>
<td>Bar microcharts plot a metric with respect to time using a single bar, displaying a metric's current value and historical data to visualize the shape of the trend.</td>
</tr>
</tbody>
</table>
One, two, or three microcharts can be displayed in the Microcharts widget, depending on the number of metrics used on the Grid/Graph that contains the widget. For example, bar and sparkline microcharts are included on the left side of the widget shown above. These microcharts convey the trend of a metric over time, from left to right. On the right side of the widget, bullet microcharts reveal the percentage of cases that were closed, in correlation with the goals for the regions, which are represented by the vertical lines within the bullet microcharts.

### About operation modes

The Microcharts widget is displayed by default in Grid mode, which displays simple rows of data, as shown in the image above. Other operation modes are available, described in this section. Steps to set up and enable each operation mode are included in *To create and add a Microcharts widget to a document, page 259.*

You can display Grid mode with indented rows, which groups the rows logically. Users can collapse and expand the rows as needed to see more detailed data.

Vertical Scroll mode displays data one row at a time, scrolling vertically.

<table>
<thead>
<tr>
<th>Microchart</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Sparklines** | Sparkline microcharts plot a metric with respect to time using a line graph, displaying a metric’s current value and historical data to visualize the shape of the trend. Sparkline microcharts consist of the following:  
- A line graph that depicts the metric’s value over time.  
- A horizontal reference line, which provides a comparison point between the actual values and the reference values. |
| **Bullet chart** | Bullet microcharts compare the value of one metric against other metrics, typically representing a target value. One common example is comparing the year-to-date value of a metric to the annual target or the forecast of the metric. Bullet charts consist of the following:  
- A horizontal performance measure bar. This represents the actual metric value.  
- A vertical reference line, which is typically the target value for the metric.  
- Colored reference bands (Band 1, Band 2, and Band 3) that indicate a numeric range in which the metric’s values exist. |
Ticker mode displays one row at a time, scrolling side to side. A ticker can display text as well as report data. The text can be both static and variable; the values for the variables are displayed at run time. For example, a variable can alert users when profits dip below a specified target. The following example uses variables to define the text that appears. The text in braces contains the variables for a microchart, attribute, and metric.

{&sparkline} The {Region} Region has NOT reached its profit target of {Profit Target} {&bullet}

The resulting ticker is displayed below. When you click the text, a larger version of the ticker is displayed.

You can display the Microcharts widget on a mobile device with MicroStrategy Mobile (Ticker mode, Vertical Scroll mode, and Grid mode with indented rows are not available on mobile devices). When the widget is displayed on the mobile device, users can tap the metric column to toggle between different metrics on the columns of the widget. For instructions to create a Microcharts widget for mobile devices, see the *MicroStrategy Mobile Design and Administration Guide*.

**Creating a Microcharts widget**

To create and add a Microcharts widget to a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Microcharts**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the
bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4 If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

The steps below ensure that the widget can display all three microcharts (bar, sparkline, and bullet), but steps are also below to display or hide any of the microchart types.

5 To add attributes, from the **Dataset Objects** panel on the left select attributes and drag them on top of the widget, based on the following requirements:

- If KPI List mode will not be used, place at least two attributes on the rows, based on the following:
  - The elements of the first attribute are displayed as text in the first column of the widget. The number of rows in the widget represents the number of elements from the first attribute on the rows. For example, the widget above has seven rows of regional data because the Region attribute on the rows has seven different elements, or regions.
  - The last (right-most) attribute on the rows determines the X-axis values in the bar microcharts and sparkline microcharts.
  - If the rows contain at least three attributes, each attribute (except the last, right-most attribute) is combined and displayed as a row in the widget. If you want to indent these rows so users can collapse or expand them in groups, display the widget in Grid mode with indented rows; steps are included in this procedure.

- If you want to display rows as a list of KPIs, place only one attribute on the rows. Use a time-based attribute such as Month or Year since the attribute controls the time series of the bar and sparklines charts.

6 To add metrics, from the Dataset Objects panel on the left select metrics and drag them on top of the widget, based on the following requirements:

- To display all three microchart types, place at least seven metrics on the columns, as follows:
  - The first (left-most) metric determines the height of the bars in the bar microcharts and the peak points in the sparkline microcharts.
  - The second metric creates the horizontal reference lines that are displayed in the sparkline microcharts.
The third metric determines the length of the performance measure bar in the bullet microcharts. The bar represents the actual metric value.

The fourth metric determines the maximum possible values in the bullet microcharts.

The fifth metric determines the right-most boundary of the first color band, Band 1, in the bullet microcharts.

The sixth metric determines the right-most boundary of the second color band, Band 2, in the bullet microcharts.

The seventh metric determines the value of the vertical reference line in the bullet microcharts, which is typically the target value for the metric.

Any additional metrics are displayed in the columns of the widget, after the microcharts and their associated metrics.

- If you want to display the widget in ticker mode, add metrics with the following information in mind. One of two tickers is displayed, depending on the values, as described below:
  - Ticker 1 is displayed when the third metrics’ (the performance metric) values are equal to or greater than the target values represented by the seventh metric.
  - Ticker 2 is displayed when the third metric’s values are less than the target values represented by the seventh metric.

- If you want to display rows as a list of KPIs:
  - Place at least one metric on the columns. By default, each metric is calculated and displayed as an individual row in the widget.
  - To display all three microcharts types, place at least seven metrics on the columns as described above.

To enable the widget to be displayed

View and test your results in one of two ways:

- Select Flash Mode from the Home menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.
• Select **Interactive Mode** from the **Home** menu.

  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285*.

**To show or hide a microchart type**

8 From the **Home** menu, select **Flash Mode**.

9 Right-click the widget and select **Properties**. From the drop-down list, select **Options**.

  • To show or hide bar microcharts, click the **Bar** tab and select or clear the **Show bar graph** check box.

  • To show or hide sparkline microcharts, click the **Sparkline** tab and select or clear the **Show sparkline graph** check box.

  • To show or hide bullet microcharts, click the **Bullet** tab and select or clear the **Show bullet graph** check box.

10 By default, Grid mode is displayed for a Microcharts widget. Grid mode displays all the rows of microcharts at the same time. To use an alternative operation mode, follow the steps below to display the widget in Vertical Scroll mode, Ticker mode, KPI List mode, or Grid mode with indented rows for easier grouping.

**Enabling an operation mode to view and work with the Microcharts widget**

Once you have followed the steps above to create and add a Microcharts widget to a document, you can use the steps below to display the widget in a different mode. By default, a Microcharts widget displays in Grid mode, which is a list of all rows of data displayed at the same time.

**To enable Vertical Scroll mode**

In Vertical Scroll mode, one row is displayed at a time, and the rows automatically scroll from top to bottom. Users can also manually move
from one row to the next using the Previous and Next buttons on the right side of the widget, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Last 12 months</th>
<th>Revenue</th>
<th>Profit Region Level</th>
<th>Profit Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid Atlantic</td>
<td></td>
<td>$2,553,395</td>
<td>$4,007,500</td>
<td>34,120,733</td>
</tr>
</tbody>
</table>

1. To display the widget in Vertical Scroll mode, from the Home menu select **Flash Mode**, then right-click the widget and select **Properties**.

2. From the drop-down list at the top left, select **Mode**.

3. On the Mode tab, from the **Operation Mode** drop-down list, select **Vertical Scroll**.

4. To enable manual scrolling, on the Vertical Scroll tab, select the **Previous/Next buttons** check box.

5. To define the speed of the vertical scrolling, select an option from the **Motion** drop-down list.

6. Click **OK**.

---

To enable Ticker mode

In Ticker mode, microcharts and supplemental text are displayed in a scrolling ticker that moves from right to left, as shown below:

1. To display the widget in Ticker mode, from the Home menu select **Flash Mode**, then right-click the widget and select **Properties**.

2. From the drop-down list at the top left, select **Mode**.
3 On the Mode tab, from the **Operation Mode** drop-down list, select **Ticker**.

4 On the Ticker tab, type a name for the ticker in the **Title** field. This name appears above the ticker.

5 To allow users to manually scroll from row to row, select the **Previous/Next buttons** check box.

6 Select or clear the **Enable detail view** check box to allow users to click the text to display or hide a larger, detailed view of each row.

7 Define the speed of the scrolling ticker by selecting an option from the **Motion** drop-down list.

8 To define the text that appears in the tickers, type values for **Ticker 1** and **Ticker 2**. Define values based on the following:
   
   - **Microcharts**: Type one of the following to display specific types of dynamic microcharts at run time: `{&bullet}` for bullet microcharts, `{&bar}` for bar microcharts, or `{&sparkline}` for sparkline microcharts.
   
   - **Attributes and metrics**: To display dynamic attributes and metrics at run time, type attributes and metrics in braces, for example, `{Revenue}`. For objects with spaces in the name, use brackets inside the braces, for example `{{Revenue Forecast}}`.

9 From the **Ticker 1 color** and **Ticker 2 color** drop-down lists, select a font color for each ticker.

10 Click **OK** to apply the changes to the widget.
To enable KPI List mode

In KPI List mode, each KPI is represented by its own row of microcharts. Because all data for a KPI is presented in one row of the Microchart widget, trends are easier to spot, as shown below:

<table>
<thead>
<tr>
<th>Metric</th>
<th>Last 12 months trend</th>
<th>Last 12 months trend</th>
<th>This Quarter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>min: 31,800,730</td>
<td>max: 97,031,130</td>
<td>$7,581,618</td>
</tr>
<tr>
<td>Profit</td>
<td>min: 670,270</td>
<td>max: 1,219,422</td>
<td>$1,117,821</td>
</tr>
<tr>
<td>Cost</td>
<td>min: 3,102,033</td>
<td>max: 30,493,708</td>
<td>$6,463,698</td>
</tr>
</tbody>
</table>

1. To display the widget in Ticker mode, from the Home menu select Flash Mode, then right-click the widget and select Properties.

2. From the drop-down list at the top left, select Mode.

3. On the Mode tab, from the Operation Mode drop-down list, select Grid or Vertical Scroll.

4. Specify the number of metrics to use to generate the rows of microcharts for the KPIs, using the following guidelines:
   - If one metric is used per KPI, only sparkline and bar charts and their metrics are displayed. The horizontal reference line is not displayed in the sparklines.
   - If two metrics are used per KPI, sparkline and bar charts and their metrics are displayed. The horizontal reference line is displayed.
   - If three to six metrics are used per KPI, sparkline and bar charts and their metrics are displayed. Additional metrics are displayed to the right of the sparkline and bar charts and their metrics.
   - If seven or more metrics are used per KPI, sparkline, bar, and bullet charts are all displayed. Additional metrics are displayed to the right of the sparkline and bar charts.

5. You can provide a name for the column that displays the metric associated with the sparklines or bullet charts; this is the last data point.
within the sparklines and bullet charts. The example below shows “This Quarter” as a label:

<table>
<thead>
<tr>
<th>Metric</th>
<th>Last 12 months trend</th>
<th>Last 12 months trend</th>
<th>This Quarter</th>
<th>TM vs target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>$3,866,790 min: $3,866,790 max: $7,581,519</td>
<td>$19 Quarter 2016 Q4</td>
<td>$3,866,790 2016 Q4</td>
<td>$19 Quarter 2016 Q4</td>
</tr>
<tr>
<td>Profit</td>
<td>$702,790 min: $702,790 max: $1,218,493</td>
<td>$6,463,698 Cost:</td>
<td>$6,463,698 Cost:</td>
<td>$6,463,698 Cost:</td>
</tr>
<tr>
<td>Cost</td>
<td>$3,102,663 min: $3,102,663 max: $4,863,828</td>
<td>$8,463,888</td>
<td>$8,463,888</td>
<td>$8,463,888</td>
</tr>
</tbody>
</table>

- To add a label, from the drop-down list at the top left, select **Labels**.
- On the Sparkline tab, in the **Associated Metric** field, type a name for the column that contains the metric values associated with the sparklines.
- On the Bullet tab, in the **Associated Metric** field, type a name for the column that contains the metric values associated with the bullet charts.

6. Click **OK** to apply changes to the widget.

---

**To enable Grid mode with indented rows**

In Grid mode with indented rows, groups of rows can be collapsed or expanded to show different levels of detail, with each level representing a different attribute, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Metric</th>
<th>Value</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>min: $440,500</td>
<td>$1,007,989</td>
<td>20,570</td>
</tr>
<tr>
<td>Boston</td>
<td>min: $30,150</td>
<td>$164,103</td>
<td>3,506</td>
</tr>
<tr>
<td>New York</td>
<td>min: $360,549</td>
<td>$43,096</td>
<td>17,064</td>
</tr>
<tr>
<td>Northwest</td>
<td>min: $31,797</td>
<td>$191,968</td>
<td>4,138</td>
</tr>
<tr>
<td>South</td>
<td>min: $363,267</td>
<td>$638,442</td>
<td>13,861</td>
</tr>
</tbody>
</table>

1. To display the widget in Grid mode, from the **Home** menu select **Flash Mode**, then right-click the widget and select **Properties**.

2. From the drop-down list at the top left, select **Mode**.
3 On the Mode tab, from the **Operation Mode** drop-down list, select **Grid**.

4 Select the **Tree display** check box.

5 You can determine how totals for the grouped rows are displayed. To do this, select an **Aggregation function** from the drop-down list.

6 Click **OK** to apply changes to the widget.

A Microcharts widget does not need a separate selector to allow a user to interact with it. However, you can use a Microcharts widget as a selector. For an example and more information, see *Using a Microcharts widget as a selector, page 362*.

You can add links to a Microcharts widget. Linking allows users to connect from a widget in a dashboard (the source) to a document or report (the target). If you add a link to a Microcharts widget, a Links menu is displayed when a MicroStrategy Web user hovers the cursor over a bar chart or sparkline graph in the widget. The user can click a link in the Links menu to open the target. See *Linking in widgets, page 295* for instructions and examples.

## Creating a Network Visualization widget

The Network Visualization widget allows you to quickly and easily identify relationships between related items and clusters, such as when visualizing a social network or displaying a market basket analysis. Attribute elements are displayed as nodes in the widget, with lines (called edges) drawn between the nodes to represent relationships between elements. Once the widget is created, users can visualize characteristics of the nodes and the relationships between them, using display options such as node size, edge thickness, and edge color. For example, if a node is displayed for each store in a country, you
can have the widget automatically display a connection between two nodes using a thicker line if the two stores share a large number of customers.

For more information on analyzing data in a Network Visualization widget, see the MicroStrategy Web Help. You can display the Network Visualization widget on a mobile device with MicroStrategy Mobile. For background information on widgets for mobile devices, see the MicroStrategy Mobile Design and Administration Guide.

**Prerequisite**

- This procedure assumes that you have already created the document to which you want to add the Network Visualization widget.

---

**To create and add a Network Visualization widget to a document**

1. In MicroStrategy Web, open the document in Design Mode.

2. From the Insert menu, point to Widgets, then Flash. Select Network Visualization. Click the location on your document where you want to place the widget. If desired, resize the widget’s Grid/Graph by clicking and dragging its handles.

3. From the Dataset Objects panel on the left, select attributes and metrics and drag them on top of the grid, as described below.
• In order to display edges between nodes in the widget, you must place attributes on the Grid/Graph to provide the starting and ending nodes for each edge you want to display. Each row of data in the Grid/Graph corresponds to a separate edge in the widget. Place two attributes on the Grid/Graph’s rows, as follows:
  – The elements of the first attribute are displayed as nodes that serve as the starting location for each edge in the widget.
  – The elements of the second attribute are displayed as nodes that serve as the ending location for each edge in the widget.

4 Place three metrics on the Grid/Graph’s columns, as follows:

• The first metric is used to automatically size edges in the widget, with larger metric values represented by thicker edges.

• The second metric is used to automatically color edges in the widget. To do this, you must define a threshold to change the color in which the data in the Grid/Graph is displayed based on the value of the metric. For background information and steps to create a threshold, see the Document Creation Guide.

• The third metric is used to automatically size nodes in the widget, with larger metric values represented by larger nodes.

5 View and test your results by selecting Flash Mode from the Home menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

Creating an RSS Reader widget

RSS (Really Simple Syndication) is a data format used to display updated web content when you click a URL. An RSS document is called a feed, and it contains either a summary of the content from an associated website or the full text.
The RSS Reader widget helps provide a 360-degree view of your business by allowing you to compare and contrast data in your dashboard with information from external news feed sources.

![RSS Reader widget example](image)

The RSS Reader widget in the example above retrieves news from an RSS news feed, which can be displayed alongside the other components of your dashboard. The RSS feed is automatically reloaded to display the most up-to-date news about a variety of topics that you specify. When an analyst selects a news item from the list, the beginning of the article is displayed in the details section at the top. Clicking the article’s text opens the full article in a new window.

An analyst can refresh the list of news articles by clicking the Refresh icon at the top left of the widget. He can also navigate to and from different pages of news articles by using the arrows at the bottom.

Analysts can use RSS Reader widgets on a dashboard to view and update their favorite RSS news feeds as they analyze grids, graphs, and other objects in the dashboard.

For example, you are viewing a dashboard with sales figures for some of your local customers. You can configure the RSS Reader widget to display up-to-the-minute news about those customers. This allows you to view both sales data and news information about the same customers in one place. In another example, one of your reports provides sales figures for a group of stores in northern California. Using an RSS feed, you can display local industry news for that specific region, which can provide valuable background information about those sales figures.
To extend this relationship between your business data and recent news, you can configure an RSS feed to be connected to specific attributes in your dashboard. For example, you can click a customer's name on a report to view updated RSS news information about that customer. Steps for this are included in the procedure below to create the widget.

On a mobile device with MicroStrategy Mobile, the RSS Reader widget can display updated web content when the user taps a URL. For steps to create and format an RSS Reader widget for display on a mobile device, see the MicroStrategy Mobile Design and Administration Guide.

**Prerequisites**

- The RSS Reader widget supports RSS 1.0 and RSS 2.0 formats. See the MicroStrategy Readmes for the latest version support information.

- If enabling the RSS Reader widget to display content when used offline, be aware that the third-party products discussed below are manufactured by vendors independent of MicroStrategy, and the information provided is subject to change. Refer to the appropriate third-party vendor documentation for updated Flash Player support information.

---

**To create and add an RSS Reader widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **RSS Reader**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.
To enable the widget to be displayed

5 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

- Select **Interactive Mode** from the **Home** menu.
  
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285*.

To specify the RSS feed to display in the widget

6 Right-click the widget and select **Properties**. The Properties dialog box opens.

7 On the **General** tab, type a title in the **RSS reader title** field. The title appears at the top of the widget.

8 In the **Default RSS Field**, type the URL for one of the following types of RSS feeds (you can only use one RSS feed):

- **Static RSS feeds** display a default set of news about a general topic, such as business or technology. Their URLs are configured to display information on the general topic. For static feeds, type the RSS feed’s URL. For example, to view news from the Yahoo! Business News RSS feed, enter the following: http://rss.news.yahoo.com/rss/business

- **Dynamic RSS feeds** are modified to display information about a specific topic. For details about the parameters and syntax to use in the RSS feed’s URL, consult your RSS news provider’s website. For dynamic RSS feeds, specify the base URL, language/country settings, and one of the following:
  
  - To display news about a specific topic, insert the topic into the URL’s query parameter. If you are required to specify a UTF-related parameter, use UTF-8 encoding. If parameter words have a space between them, use a + character in place of each space.
To display news related to an attribute, document, or dataset, insert an auto code for the object in the URL’s query parameter. For example, http://news.search.yahoo.com/news/rss?p={[Customer State]}&ei=UTF-8&fl=0&x=wrt. For a document, use {{#name of document#}}, for a dataset, use {{#name of dataset#}}.

To display news about an attribute element, use a dynamic RSS feed URL in the widget, for example: http://news.search.yahoo.com/news/rss?p={[Category]}&ei=UTF-8&fl=0&x=wrt. The RSS widget’s template must contain the attribute, the attribute must be enabled as a selector, and the RSS widget must be set as a target of the attribute. For details about using a widget as a selector, see Chapter 7, Viewing Data Related to Widgets: Using Widgets as Selectors.

9 Specify the rate at which news items are automatically refreshed. Enter this value in minutes in the Default refresh frequency (Sec) field.

10 Specify the maximum number of news items that a user sees at a time by typing a number in the Items shown at a time field. The default value is 10.

11 Determine whether a news article is opened in a new window when it is selected in the widget. To do this, select or clear the Open full article when clicked check box.

12 If the RSS feed is accessed through a proxy server, select the Use Proxy check box.

13 Click OK to save your changes.

To enable RSS content to display when used offline

If users will access the RSS content offline, use the steps below to add the .mht file to the list of Adobe Flash Player trusted files on the client machine. The .mht file contains all data required to make a widget display and operate properly after it has been exported.


15 From the Edit locations drop-down menu on the right, select Add location.
16 Type the location of the .mht file in the field.

17 Click Confirm.

18 Close and reopen the document that contains the widget.

Creating a Thermometer widget

A Thermometer widget is a simple status indicator that displays a thermometer set to a certain temperature level. The temperature level within the thermometer is a visual representation of a single metric value. This type of widget is ideal for tracking progress toward a goal. Like the Gauge and Cylinder widgets, this type of widget is designed to display the value of a single metric.

The Thermometer widget is most useful when combined with a selector because this allows users to selectively choose specific metric values to display in the thermometer. In the image below, the thermometer level represents the number of units sold, based on the Units Sold metric.

To create and add a Thermometer widget to a document

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 From the Insert menu, point to Widgets, then Flash, and select Thermometer.

3 Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4 If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a Place one attribute on the rows. The attribute elements are displayed in the selector, to allow users to display different data in the widget.

b Place one metric on the columns. The metric values determine the temperature level displayed in the thermometer.

6 To allow users to use a selector to change the metric value displayed in the widget:

a Insert a selector next to the widget. For steps to insert a selector, see Methods to create a selector, page 117.

b Choose an attribute from the dataset that is not already in the Grid/Graph and set this attribute as the Source of the selector. Do not include this attribute in the Grid/Graph. It is used to populate the selector.

c Set the Grid/Graph as the target of the selector.

7 It can be useful to drag the dataset report from the Dataset Objects panel and place it beneath the selector. This allows users to see the report’s values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.

8 By default, the values on the side of the Thermometer widget range from 1 to 100. If metric values on your report are larger than 100 or less than 0:

a Right-click the widget and select Properties to open the Thermometer dialog box.

b In the Max Value field, enter a number larger than the largest metric value on the report. For example, if the metric values on the report
range from 60,000 to 1,000,000, enter a number such as 1,100,000 to accommodate larger values in the data.

c  In the Min Value field, enter a number that is less than the smallest metric value on the report. For example, if the metric values on the report range from -20,000 to 1,000,000, enter a number such as -30,000 to accommodate smaller values in the data.

d  Click OK to save your changes.

To enable the widget to be displayed

9 View and test your results by selecting Flash Mode from the Home menu.

   – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

Creating a Time Series Slider widget

A Time Series Slider widget is an area graph that allows an analyst to choose which section of the graph to view at a time. The widget consists of two related graphs, one positioned above the other. The top graph is the controller, and contains a slider. The bottom graph is the primary graph. You use the slider on the controller to select some portion of the controller, which determines the range of data visible in the primary graph.

Time series datasets are often long and require analysis from both a macro and micro view. Therefore, the time series slider widget requires only one attribute, preferably one with many values. This attribute is normally time-based, but it does not have to be. The widget also requires only one metric. In the graph:

• The X-axis represents the attribute. In the image below, this is the Month attribute.

• The Y-axis represents the metric. In the image below, this is the Revenue metric.
To create and add a Time Series Slider widget to a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Time Series Slider**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   
a. Place at least one attribute on the rows. The first attribute is typically time-based, such as a Day or Quarter attribute. Its elements are displayed on the X-axis.
b Place at least one metric on the columns. The metric values are displayed on the graph report’s Y-axis.
   – If you include two metrics, a line graph and an area graph are displayed together.

6 To allow users to use a selector to change the metric value displayed in the widget:

a Insert a selector next to the widget. For steps to insert a selector, see Methods to create a selector, page 117.

b Choose an attribute from the dataset that is not already in the Grid/Graph and set this attribute as the Source of the selector. Do not include this attribute in the Grid/Graph. It is used to populate the selector.

c Set the Grid/Graph as the target of the selector.

7 It can be useful to drag the dataset report from the Dataset Objects panel and place it beneath the selector. This allows users to see the report’s values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.

To enable the widget to be displayed

8 View and test your results by selecting Flash Mode from the Home menu.
   – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

A Time Series Slider widget can be used as a selector. For an example and more information, see Using a Time Series Slider widget as a selector, page 362.

Creating a Waterfall widget

A Waterfall widget highlights the increments and decrements of the values of metrics over time. Analysts can use the widget to identify aspects of their business that are contributing to the fluctuations in the values. The widget can also be used to perform “what-if” analyses.
The widget consists of a group of clustered bars displayed from left to right. The X-axis contains either attribute elements or metrics, depending on where the attributes and metrics are placed on the widget’s template. The Y-axis displays a range of values based on the metrics on the widget’s template.

In the example shown below, metrics are displayed along the X-axis. The first bar represents the amount of sales revenue generated in 2006. The remaining bars in the widget represent the other metrics on the X-axis, including the Depreciation and Tax Expense metrics. These bars depict the business factors that diminished revenue and one factor (the Other Gains and Losses metric) that increased revenue. As a group, these bars highlight the contributions of various aspects of the business on total revenue from sales. This final value is represented by the last bar on the right, which represents Net Income for 2006.

The increments and decrements in a Waterfall widget can be calculated and displayed in either of the following ways:

- Increments and decrements are calculated and displayed in the widget based on the metrics that are included on the Grid/Graph and the order of those metrics.
  - It is recommended that you use this method when the metrics are on the rows of the Grid/Graph and the attributes are on the columns of the Grid/Graph. This allows you to place the metrics along the X-axis in a specific order and view the increment and decrement bars in that order.
  - To ensure that the metrics determine how increments and decrements are calculated and displayed, select the Increments/Decrements.
Provided check box. This is included in the steps below to create the widget.

- Increments and decrements are automatically determined by the widget when it is displayed in MicroStrategy Web. They are calculated according to the metrics included on the Grid/Graph.
  
  - It is recommended that you use this method when the metrics are on the columns of the Grid/Graph and the attributes are on the rows of the Grid/Graph. Using this method requires that you have placed metrics on the columns that depict the total value for each unit of time.
  
  - To ensure that the widget automatically determines the increments and decrements, clear the Increments/Decrement Provided check box. This is included in the steps below to create the widget.

---

**To create and add a Waterfall widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the Insert menu, point to **Widgets**, then **Flash**, and select **Waterfall**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

   a. Place at least one metric on the rows or columns. Any number of metrics and attributes can be placed on the rows and columns.
      
      - To ensure that metrics generate the increment and decrement bars in the widget, place the metrics on the rows.
      
      - Attributes or metrics that are placed on the rows are displayed on the X-axis of the widget. If the rows contain both attributes and metrics, a combination of those objects is displayed.
– Attributes and metrics that are placed on the columns are displayed in the legend. If the columns contain both attributes and metrics, a combination of those objects is displayed.

**To enable the widget to be displayed**

6 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 56*.

- Select **Interactive Mode** from the **Home** menu.
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 285*.

**To specify whether the metrics should generate the increment and decrement bars**

7 Right-click the widget and select **Properties**. The Properties dialog box opens.

8 Click the **Data** tab, then do one of the following:

- To ensure that increments and decrements bars are displayed in the widget in the same order of the metrics on the Grid/Graph, select the **Increments/Decrements Provided** check box.

- To ensure that the increments and decrements bars in the widget are generated automatically, clear the **Increments/Decrements Provided** check box. It is recommended that you use this method when the metrics are placed on the columns of the Grid/Graph and the attributes are placed on the rows.

9 On the Data tab, use the **Text for Last Entry** field to specify a name or label for the bar on the far right of the widget. For example, you can create a label for the bar called Final Value or End of 2008.

10 Click **OK**.

A Waterfall widget does not need a separate selector to allow a user to interact with it. However, you can use a Waterfall widget as a selector. For an
example and more information, see *Using a Time Series Slider widget as a selector, page 362.*

**Creating a Weighted List Viewer widget**

A Weighted List Viewer widget combines the data visualization techniques of thresholds and graphical weighting into a single visualization. This enables the analyst to assess the performance of a group of items.

Thresholds in the widget highlight rows based on the value of the first metric on the Grid/Graph that contains the widget. Specifically, rows are highlighted according to the range of values from the first metric on the Grid/Graph’s columns. The rows are also ordered automatically so that metrics that are performing well are at the top and metrics that are performing poorly are at the bottom. A stacked bar graph is included next to the grid; it indicates the relative contribution, or weight, of each row.

In summary, the Weighted List Viewer widget has the following characteristics:

- A grid that provides attribute and metric values with threshold colors applied to the values from top to bottom. The color bands on the grid reflect the range of values of the first metric on the Grid/Graph that contains the widget.
In the example above, the top rows are green and represent the maximum value of the Order Count metric. The next rows are black, denoting neutral metric values, and gradually change into the red of the bottom rows. Red represents the minimum range of values of the Order Count metric.

The light-to-dark color gradient is automatically generated by the widget.

You can specify whether to divide the metric values into two or three threshold color bands. (For the steps, see Formatting a Weighted List Viewer widget, page 350.)

- A stacked contribution bar graph on the left that depicts the relative contribution or percent-to-total calculation of a metric. This bar reflects the values of the second metric on the Grid/Graph that contains the widget.

- Specific colors are used to depict good, neutral, and poor performance:
  - Green indicates good performance
  - Black indicates neutral performance
  - Red indicates poor performance

You can change these color settings, as described in Formatting a Weighted List Viewer widget, page 350.

To create and add a Weighted List Viewer widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Weighted List Viewer.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.
To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a Place at least one attribute on the rows. The attribute’s elements are displayed in the grid rows of the widget. For example, if you place the Region attribute on the rows, each region is listed in the grid in the widget, with corresponding metric values on the right and a contribution graph on the left.

b Place at least two metrics on the columns. The values of these metrics are displayed in the grid rows of the widget, along with the attribute. The metric data and corresponding colors displayed in the widget reflect the performance of different attribute elements.

– The first metric on the columns is the threshold metric. This metric is used to set the color of the rows. These colors are also displayed in the grid on the right side of the widget.

– The second metric on the columns is the weighting metric that determines the percent-to-total value for each business attribute. It is used to set the relative size of each section of the contribution graph on the left side of the widget.

– Any additional metrics are displayed in the grid, but do not have any effect on the threshold colors or contribution graph on the left side of the widget.

To enable the widget to be displayed

6 View and test your results in one of two ways:

• Select Flash Mode from the Home menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 56.

• Select Interactive Mode from the Home menu.
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 285.

A Weighted List Viewer widget does not need a separate selector to allow a user to interact with it. However, you can use a Weighted List Viewer widget
as a selector. For an example and more information, see *Using a Weighted List Viewer widget as a selector*, page 366.

**Defining how a widget is displayed in different views and modes**

You can determine how a widget is displayed in MicroStrategy Web modes, in Desktop views, on various mobile devices, and when exported. The widget can display as:

- The widget itself
- A placeholder
- Empty space; a message can be displayed in place of the widget
- The underlying Grid/Graph that contains the widget, with the Grid/Graph’s border and background formatting

The following table summarizes how widgets can be displayed. Steps to determine how a widget is displayed in each view/mode are below the table.

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Display Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroStrategy Web</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Design Mode  | • Grid/Graph placeholder (except for widgets created as selectors)  
• Selector placeholder (for widgets created as selectors) |
| Editable Mode | • Grid or graph (except for widgets created as selectors)  
• Selector (for widgets created as selectors) |
| Express Mode | • Widget (except for widgets created as selectors and the Cylinder, Interactive Stacked Graph, Thermometer, and Time Series Slider widgets)  
• Grid or graph (except for widgets created as selectors)  
• Placeholder (except for widgets created as selectors)  
• Hidden (except for widgets created as selectors)  
• Selector (for widgets created as selectors) |
| Flash Mode   | • Widget (except for widgets for SDK widgets and mobile devices)  
• Grid or graph report (except for widgets created as selectors)  
• Selector (for widgets created as selectors) |
<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Display Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactive Mode</td>
<td>• Widget (except for widgets created as selectors and the Cylinder, Interactive Stacked Graph, Thermometer, and Time Series Slider widgets)</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Placeholder (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Hidden (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector (for widgets created as selectors)</td>
</tr>
</tbody>
</table>

### Desktop

| Design View     | • Grid/Graph placeholder (except for widgets created as selectors)                                                                         |
|                 | • Selector placeholder (for widgets created as selectors)                                                                                    |

| Flash View      | • Widget (except for SDK widgets and widgets for mobile devices)                                                                          |
|                 | • Grid or graph (except for widgets created as selectors)                                                                                   |
|                 | • Selector placeholder (for widgets created as selectors)                                                                                    |

**Note:** While widgets are interactive in Flash View, the changes cannot be saved.

| HTML View       | • Grid or graph (except for widgets created as selectors)                                                                                   |
|                 | • Selector placeholder (for widgets created as selectors)                                                                                    |

| PDF View        | • Grid or graph (except for widgets created as selectors)                                                                                   |
|                 | • Placeholder (except for widgets created as selectors)                                                                                     |
|                 | • Hidden (except for widgets created as selectors)                                                                                          |
|                 | • Selector placeholder (for widgets created as selectors)                                                                                    |

### MicroStrategy Mobile

| Android         | • Widget (for Android widgets)                                                                                                              |
|                 | • Grid or graph (except for widgets created as selectors)                                                                                   |
|                 | • Selector (for widgets created as selectors)                                                                                               |

| iPad            | • Widget (for iPad widgets)                                                                                                                 |
|                 | • Grid or graph (except for widgets created as selectors)                                                                                   |
|                 | • Selector (only for widgets created as selectors)                                                                                           |

| iPhone          | • Widget (for iPhone widgets)                                                                                                               |
|                 | • Grid or graph (except for widgets created as selectors)                                                                                   |
|                 | • Selector (only for widgets created as selectors)                                                                                           |

### Exporting

| To Excel        | • Grid or graph (except for widgets created as selectors)                                                                                   |
|                 | • Placeholder (except for widgets created as selectors)                                                                                     |
|                 | • Hidden (except for widgets created as selectors)                                                                                           |
|                 | • Selector placeholder (for widgets created as selectors)                                                                                    |

| To Flash        | • Widget (except for widgets for mobile devices and SDK widgets)                                                                             |
|                 | • Grid or graph (except for widgets created as selectors)                                                                                   |
Displaying widgets in Flash

In Flash Mode in MicroStrategy Web and Flash View in Desktop, the widget is displayed by default, and a user can interact with it. Any user-initiated changes to the widget can be saved in Flash Mode (Web), but not in Flash View (Desktop).

You can specify that the widget displays as a grid or graph report instead. For example, you may want to display the same data as both a widget and a grid or graph report, to allow users to see information at a glance with the widget, and to see in-depth details with the grid or graph report.

SDK widgets and widgets for mobile devices cannot be displayed as widgets in Flash. They are displayed as grid or graph reports in Flash.

Displaying widgets in Editable Mode and Design Mode/View

In Editable Mode in MicroStrategy Web, a grid or graph report based on the widget’s data is always displayed. In Desktop’s Design View and Web’s Design Mode, the Grid/Graph container is displayed, without data.

Displaying widgets in HTML View and PDF View

You can determine how widgets are displayed in Desktop's HTML View and PDF View, by setting the Alternative Display, described in Defining how a widget is displayed in different display modes, page 289. The widget can:

- Display a grid or graph report based on the widget’s data.
- Display an empty Grid/Graph placeholder. The Grid/Graph container is shown, with border and background formatting. In Interactive Mode and Express Mode in MicroStrategy Web, the following message is displayed

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Display Options</th>
</tr>
</thead>
</table>
| To HTML      | - Grid or graph (except for widgets created as selectors)  
               - Placeholder (except for widgets created as selectors)  
               - Hidden (except for widgets created as selectors)  
               - Selector placeholder (only for widgets created as selectors) |
| To PDF       | - Grid or graph (except for widgets created as selectors)  
               - Placeholder (except for widgets created as selectors)  
               - Hidden (except for widgets created as selectors)  
               - Selector placeholder (for widgets created as selectors) |
within the container: “Flash Widgets cannot be rendered in this display”, as shown in the example below.

For information on formatting a Grid/Graph container, see the Desktop Help.

• Hide the Grid/Graph so that nothing is displayed.

If you choose to hide the Grid/Graph, you can display a message in place of the widget. To do this, add a text field behind the widget. This text field is displayed only when the widget is hidden. For an example and a procedure, see Displaying a message in place of a widget, page 291.

**Displaying widgets in Interactive Mode and Express Mode**

In Web's Interactive Mode and Express Mode, the widget can:

• Display as a widget.

• Display according to the Alternative Display setting described in Defining how a widget is displayed in different display modes, page 289.

The following widgets cannot be displayed as widgets in Interactive Mode or Express Mode: Cylinder, Date Selection widget created as a selector, Fish Eye Selector created as a selector, Interactive Stacked Graph, Thermometer, Time Series Slider, and widgets for mobile devices.
Exporting widgets

A widget exported to Excel or PDF displays according to the Alternative Display setting described in *Defining how a widget is displayed in different display modes, page 289.*

A widget exported to Flash displays as either a widget or a grid or graph report, depending on the Flash setting. SDK widgets and widgets for mobile devices are always exported to Flash as grid or graph reports.

Widgets in MicroStrategy Mobile

For MicroStrategy Mobile, you can determine whether mobile widgets are displayed as widgets or grid or graph reports on mobile devices. For steps, see *Defining how a widget is displayed in different display modes, page 289.*

Non-mobile widgets are always displayed as grid or graph reports on mobile devices.

For a list of the widget types that display on each type of mobile device, see the *MicroStrategy Mobile Design and Administration Guide.*

Defining how a widget is displayed in different display modes

If your users may view a widget in a mode that does not support widget display, use the following steps to determine alternative displays for the widget.

To determine how a widget is displayed in different display modes

1  In MicroStrategy Web, open the document in **Design** or **Editable mode.**

2  Right-click the Grid/Graph containing the widget and select **Properties and Formatting.** The Properties and Formatting dialog box opens.

3  From the left, select **Widget.**
4 From the **Alternative Display** drop-down list, select a display option to use to display the widget if it cannot be displayed as a widget in a particular display mode. The options are:

- **Show Grid or Graph**: The widget displays as a grid report or a graph report in a Grid/Graph container.
- **Show Placeholder**: A placeholder displays in place of the widget, with a message stating that the widget cannot be displayed.
- **Hide Grid or Graph**: The widget is not displayed.

5 Do one of the following:

- To display the widget as a widget, select the check box for the display mode in which you want to display the widget.
- To display the widget as specified in the Alternative Display option above, clear the check box for the display mode in which you want to display the alternative.

The **Will render as** column updates to list how the widget is displayed in each display mode.

6 Click **OK** to apply the changes.

---

### Defining which display modes are available to users

A document designer can select the modes that are available for a specific document by enabling each mode that you want to make available for users of the document. If a display mode is available to a user, it appears on the user’s View menu and on the Standard toolbar.

To enable Flash Mode, a project administrator must ensure that Flash Mode is enabled for the project, as described in the *MicroStrategy Web Administrator Help*. A document designer or analyst can also disable Flash Mode on his machine if he knows that Flash is not installed or does not want to use Flash. To do this, select **Preferences** at the top of MicroStrategy Web, select **Report Services** on the left, and select to enable or disable Flash Mode.

---

To determine which display modes a user can view a document in

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2 From the Tools menu, click Document Properties. The Properties dialog box opens.

3 From the left, select Document.

4 To make a mode available for users to display the document in, select the check box in the Available display modes column for that display mode.

5 Clear the check boxes for any display modes that you do not want users to have access to.

6 Click OK to apply your changes and return to the document. The next time the document is executed, only the display modes you selected are available in the View menu or on the Standard toolbar.

Displaying a message in place of a widget

Widgets are not displayed in PDF View in Desktop. You can select what is displayed to replace the widget. (For more information on the display options, see Defining how a widget is displayed in different views and modes, page 285.)

You can either hide the Grid/Graph to which the widget is attached, display a blank space, or display a message in place of the widget. This message indicates to users that the missing widget cannot be displayed in the current mode.

For example, the following thermometer widget is displayed in Flash Mode in MicroStrategy Web:
However, in Interactive Mode, the following message is displayed in a text field:

![Switch to Flash Mode because you're missing the thermometer widget!]

Notice that the selector is still displayed on the right, because it is separate from the widget.

In Editable Mode and Design Mode in MicroStrategy Web, the Grid/Graph connected to the widget is displayed. If the Grid/Graph does not completely cover the message and its text field, the message is visible as well.

---

**To display a message in place of a widget**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Right-click the widget and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, click **Widget**.
4. In the **Alternative Display** area, select **Show Placeholder**. A placeholder is displayed in place of the widget, with a message stating that the widget cannot be displayed.

---

**Converting an existing Grid/Graph into a widget**

You can turn any existing Grid/Graph in your dashboard into a widget that is displayed in MicroStrategy Web, as long as the Grid/Graph meets the data requirements for the selected type of widget.

For example, your dashboard contains a Grid/Graph with the Region attribute on the rows and the Profit Margin metric on the columns. You can assign a Gauge widget to this Grid/Graph. When you open the dashboard in Flash Mode in MicroStrategy Web, the Grid/Graph is no longer displayed as
a Grid/Graph but rather as a Gauge widget. Viewing the widget in Flash Mode in MicroStrategy Web allows you to better visualize the metric data in the Grid/Graph.

To convert a Grid/Graph into a widget

1. In MicroStrategy Desktop, open the dashboard in Design View.

2. Insert a Grid/Graph into the dashboard, if one is not already in the dashboard. For a procedure, see the Desktop Help.

   The Grid/Graph that you turn into a widget must follow the data and template requirements for that type of widget. For example, a Gauge widget requires one attribute on the rows and one attribute on the columns. Therefore, any Grid/Graph that you want to turn into a widget must have the same objects on its Grid/Graph. If it does not, the Grid/Graph is not displayed correctly as a widget in Flash Mode in MicroStrategy Web. For the requirements for each type of widget, refer to the section that describes that widget.

3. Right-click the Grid/Graph to turn into a widget, and select Properties. The Properties dialog box opens.

4. On the Widget tab, select the type of widget from the Widget drop-down list. In Flash Mode in MicroStrategy Web, the Grid/Graph displays as this type of widget.

5. You can determine how the widget is displayed in different Desktop views and MicroStrategy Web modes, as outlined in the steps below. For details, see Defining how a widget is displayed in different views and modes, page 285.

   - **HTML View, PDF View** in Desktop, or in **Excel**: Select one of the following from the Alternative Display drop-down list:
     - **Show grid or graph** to display the Grid/Graph to which the widget is attached.
     - **Show placeholder** to display an empty Grid/Graph placeholder instead of the widget.
     - **Hide grid or graph** to hide the widget and display nothing.
   - **Flash**: By default, the widget is displayed as a widget in Flash. To display it as a Grid/Graph instead, clear the Flash check box in the Display Widget As column. This setting affects the display of the
widget in Flash View in Desktop, Flash Mode in MicroStrategy Web, and when exported to Flash.

- **iPhone**: By default, an iPhone widget is displayed as a widget on an iPhone. To display it as a Grid/Graph instead, clear the iPhone check box in the **Display Widget As** column.

- **iPad**: By default, an iPad widget is displayed as a widget on an iPad. To display it as a Grid/Graph instead, clear the iPad check box in the **Display Widget As** column.

- **Interactive Mode, Express Mode** in MicroStrategy Web: By default, a widget is displayed as a widget in Interactive Mode and Express Mode in MicroStrategy Web. To display it based on the Alternative Display setting, clear the DHTML check box in the **Display Widget As** column.

6 Click **OK** to save the changes and return to the dashboard.

**To enable Flash Mode for Web**

You must enable Flash Mode in the dashboard so that you and other users can view the widget in Flash Mode in MicroStrategy Web.

7 From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.

8 In the **Available display modes** list on the Document tab, select the **Flash** check box.

9 You can specify that this dashboard always opens in Flash Mode when it is initially opened in MicroStrategy Web. To do this, select the **Default** radio button next to Flash.

10 Click **OK** to return to the dashboard.

**To format the widget**

11 By default, many widgets automatically inherit some of the formatting of the underlying graph report. For example, the font colors and types defined for the graph report can be displayed in the widget. If you do not want the widget to inherit this formatting, clear the Inherit graph formatting check box in the Properties dialog box in Flash Mode or Interactive Mode in MicroStrategy Web. For more information, see the MicroStrategy Web Help.
12 Each type of widget also has additional formatting specific to it. For example, the numbers of a Bubble Grid widget can display as dollars and cents, as percentages, or even as scientific notation. For a complete listing of all formatting available for a specific type of widget, see the section on that widget.

13 Save the dashboard.

Most widgets can also be displayed as widgets in Interactive Mode and Express Mode in MicroStrategy Web. For instructions, see Defining how a widget is displayed in different views and modes below.

Linking in widgets

Linking allows users to connect from a widget in a dashboard (the source) to another dashboard, document, or report (the target).

For example, you can link a widget displaying sales information by customer region to a related document, such as the top ten employees by profit. In MicroStrategy Web, the user can click the link in the widget to view this document, compare data, or retrieve additional information.

This section focuses on links in widgets. For an introduction to linking in a document, see the Document Creation Guide.

If a link is added to an attribute in the widget's Grid/Graph, the name of the target report or document displays in the tooltip associated with the attribute when the widget is displayed. In the image below, two documents have been added as links to the Region attribute. When the user hovers the cursor over
the Web region, the Links menu is displayed. The user can select a linked document from the menu to open it.

You can add links to the following widgets:

- **Data Cloud**: With a link from a Data Cloud widget to a report/document, a user can hover the cursor over an attribute element in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Call Center attribute on the widget is linked to a report on the top 10 employees per call center, a link to this report is displayed in the tooltip when the user hovers the cursor over the New York attribute element in the widget.

- **Heat Map**: With a link from a Heat Map widget to a report/document, a user can hover the cursor over a rectangle or heading in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Region attribute on the widget is linked to the report Top 10 Employees by Profit, a link to this report is displayed in the tooltip when the user hovers the cursor over the rectangle for the Web region.

- **Interactive Bubble Graph**: With a link from an Interactive Bubble Graph widget to a report/document, the user can hover the cursor over a bubble in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Region attribute on the widget is linked to the report Top 10 Employees by Profit, a link to this report is displayed in the tooltip when the user hovers the cursor over a bubble.
• **Microcharts**: With a link from a Microcharts widget to a report/document, the user can hover the cursor over a bar chart or sparkline graph in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Quarter attribute on the widget is linked to the report Top 10 Employees by Profit, a link to this report is displayed in the tooltip when the user hovers the cursor over a data point in a sparkline graph for the 2009 Q1 quarter.

For examples of what the user sees with a link in each type of widget, see the *Document Analysis Guide*.

Steps to create a link in a widget are below.

### Specifying how prompts are answered in the target

For each prompt in the target (the report or document being executed from the link), you must select a prompt answer method, which is how to answer the prompt. You also specify how to answer any other prompts that are not listed. These can be prompts that are created as the result of an answer to one of the original prompts in the target, such as a prompt-in-prompt answer. They can also be prompts added to the target later, after the link is created. These prompts are listed as the **Any other prompt** option in the list of prompts in the interface.

The prompt answer methods are briefly described in the table below. See the *Document Creation Guide* for an expanded description of each method, with an example.

<table>
<thead>
<tr>
<th>Prompt Answer Method</th>
<th>Requirements</th>
<th>Prompts in the Target Are Answered By...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer with the same prompt</td>
<td>Same prompt in the target and source</td>
<td>The prompt answer from the source</td>
</tr>
<tr>
<td>Prompt user</td>
<td>None</td>
<td>The user (prompts are displayed when the target is executed)</td>
</tr>
<tr>
<td>Default answer</td>
<td>None</td>
<td>The default prompt answer for the target prompt</td>
</tr>
</tbody>
</table>
| Dynamically | • Attribute element prompt in target  
• Value prompt in target (available only in MicroStrategy Web) | The object selected in the source (for example, the attribute element that the user clicked on) |
| Empty answer | Target prompt must not be required | Nothing (no prompt answer is provided from the source and the user is not prompted) |
Creating links in widgets

**Prerequisites**

- Create the source and target documents or reports.

- Create a Data Cloud, Heat Map, Interactive Bubble Graph, or Microcharts widget in the source dashboard. For steps, see *Converting an existing Grid/Graph into a widget, page 292*.

- Know what types of prompts the targets contain and how they will be answered.

**Adding a link to a widget**

**To add a link to a widget**

1. In MicroStrategy Web, run a document in Design mode.

2. Right-click an attribute in the widget’s Grid/Graph, then select Edit Links.

3. Type a name for the link in the URL display text field.
   - If this is the first link you are adding to this document, click New, then type the name for the link.
To define the link

4 Click the Select Target icon below Run this report or document, to find and select the report or document you want to link to (the target). The Select Target dialog box opens.

5 Navigate to and select the target report/document. Click OK to close the dialog box.

To apply prompt answers to the target if the target contains prompts

6 The box below Run this report or document contains a list of any prompts included in the target that you chose. Select a target prompt from the box.

7 Select a prompt answer method from the drop-down list:
   
   • **Answer with the same prompt from the source:** Select this option to automatically use the same prompt answers for both the source report/document and the target report/document. This option requires that the source and target use the same prompts.
   
   • **Prompt User:** Select this option to prompt the user for answers in the target. Users can enter prompt answers manually. For example, a prompt requires the user to enter a customer age. Instead of choosing the age from a list, users can type the number in the prompt answer text box.
   
   • **Answer with an empty answer:** Select this option to ignore the prompt in the target, which means that the prompt is not answered. No prompt answer is provided from the source and users are not prompted to provide answers. However, if the prompt is designed to require an answer, then the user is presented with a screen to provide an answer.
   
   • **Use default answer:** Select this option to use the default prompt answers for the target report/document.
   
   • **Answer dynamically:** Select this option to automatically answer the prompt using the object that the user clicked in the source. This option is available for attribute element prompts and value prompts.
   
   • **Answer using the current unit:** Select this option to automatically answer the prompt using the object that the user clicked in the source. This option is available for hierarchy prompts.
   
   • **Answer using all valid units:** Select this option to answer the target prompt with any object to the left of or above the object that the user
clicked in the source. This method passes all selections made on the source, rather than just the selection made for the link. This option is available for hierarchy prompts.

8 For each prompt in the target, repeat the steps above, starting with To apply prompt answers to the target if the target contains prompts, page 299.

To specify the prompt answer method for any other prompts

Any other prompts are those prompts that are not in the target report/document when you are creating the link, such as prompts added to the target later. By default, the Prompt user method is selected for these prompts, but you can change the method.

9 Select Any other prompts in the box.

10 Select a prompt answer method from the list. Each is described above.

• Answer with the same prompt from the source
• Prompt user (default)
• Answer with an empty answer
• Use default answer

11 Select the Open in new window check box to have the target report/document open in a new window. This allows the target and the source to be viewed simultaneously.

12 Click OK to save changes and return to the document.
FORMATTING WIDGETS

Introduction

You can format aspects of widgets such as colors, graph axes scaling, fonts, data markers, and more. Different formatting options are available for each type of widget. For example, you can format the type of cylinder that is displayed in a Cylinder widget or the color of the bubbles in an Interactive Bubble Graph widget.

For descriptions and examples of the different types of widgets, as well as instructions to create them, see Chapter 5, Providing Flash Analysis and Interactivity: Widgets.

To view and interact with widgets, make sure you have the appropriate version of Adobe Flash Player. See the MicroStrategy Readmes for the latest supported versions.

Inherited formatting

By default, most widgets automatically inherit some of the formatting contained in their underlying graph report (as generated from the widget’s
dataset). For example, the font colors and types defined for the underlying graph report can be displayed in the widget. Steps to determine whether or not the widget inherits the underlying graph formatting are included with each widget’s formatting steps, below.

For details to format the underlying reports and graphs that the widgets are based on, click Help in the dialog box you are using to format the widget, or see the Reports and Graphing chapters of the MicroStrategy Advanced Reporting Guide.

**Formatting a widget**

Each type of widget allows formatting specific to the type of widget. For example, you can change the number format of the metric values in a Bubble Grid widget, Cylinder widget, or Gauge widget. For an Interactive Stacked Graph widget, you can change the font of the text that appears in the graph and the color of the check boxes on the left side of the graph.

Use the appropriate link below to learn what formatting options are available for the specific type of widget you are working with, and for steps to format the widget.

- Formatting a Bubble Grid widget, page 303
- Formatting a Cylinder widget, page 305
- Formatting a Data Cloud widget, page 305
- Formatting a Date Selection widget, page 307
  - Formatting a Date Selection widget for a mobile device, page 309
- Formatting a Fish Eye Selector, page 309
- Formatting a Funnel widget, page 313
- Formatting a Gauge widget, page 315
- Formatting a Graph Matrix (deprecated) widget, page 316
- Formatting a Heat Map widget, page 318
- Formatting an Image Layout widget, page 321
- Formatting an Interactive Bubble Graph widget, page 323
- Formatting an Interactive Stacked Graph widget, page 327
• Formatting a Map widget, page 328
• Formatting a Media widget, page 328
• Formatting a Microcharts widget, page 330
• Formatting an RSS Reader widget, page 340
• Formatting an RSS Reader widget, page 340
  • Formatting an RSS Reader widget for a mobile device, page 343
• Formatting a Thermometer widget, page 343
• Formatting a Time Series Slider widget, page 344
• Formatting a Waterfall widget, page 346
• Formatting a Weighted List Viewer widget, page 350

Formatting options by widget type

Prerequisite

• The widget must be added to the document. For steps, see Creating widgets, page 197.

Formatting a Bubble Grid widget

For an image of a Bubble Grid widget and steps to add one to a document, see Creating a Bubble Grid widget, page 198.

The table below lists the different aspects of the Bubble Grid widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different
For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Color used for the bubbles representing the smallest metric values (minimum color) | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Bubble Grid dialog box opens.  
2. From the **Minimum Color** palette, select a color for the smallest metric values in the widget.  
3. Click **OK** to save the changes. |
| Color used for the bubbles representing the largest metric values (maximum color) | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Bubble Grid dialog box opens.  
2. From the **Maximum Color** palette, select a color for the largest metric values in the widget.  
3. Click **OK** to save the changes. |
| Background color of the widget | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Bubble Grid dialog box opens.  
2. From the **Background Color** palette, select a color for the background of the widget.  
3. Click **OK** to save the changes. |
| Color of the borders of the widget | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Bubble Grid dialog box opens.  
2. From the **Border Color** palette, select a color for the borders of the widget.  
3. Click **OK** to save the changes. |
| The color and font for the text in labels | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Bubble Grid dialog box opens.  
2. From the **Labels Text Color** palette, select a color for the text of the labels.  
3. From the **Labels font** drop-down list, select a font for the text of the labels.  
4. Click **OK** to save the changes. |
| Whether the widget legend is displayed or hidden | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Bubble Grid dialog box opens.  
2. Select or clear the **Show Legend** check box.  
3. Click **OK** to save the changes. |
| Maximum radius of the bubbles in the widget | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Bubble Grid dialog box opens.  
2. Enter a number in the **Maximum Radius** field to determine the radius of the largest bubble in the widget. All other bubbles are sized relative to that bubble.  
3. Click **OK** to save the changes. |
### Formatting a Cylinder widget

For an image of a Cylinder widget and steps to add one to a document, see *Creating a Cylinder widget, page 200.*

The table below lists the different aspects of the Cylinder widget that you can format, and describes the steps to format them in MicroStrategy Web.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors and shading scheme for the cylinder</td>
</tr>
<tr>
<td>How to Format It</td>
</tr>
<tr>
<td>1  In <strong>Flash Mode</strong>, right-click the widget and select Properties. The Cylinder dialog box opens.</td>
</tr>
<tr>
<td>2 From the <strong>Cylinder Type</strong> drop-down list, select a shading scheme for the cylinder.</td>
</tr>
<tr>
<td>3 Click <strong>OK</strong> to save the changes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numbers that appear at the bottom and top of the cylinder (minimum and maximum)</td>
</tr>
<tr>
<td>How to Format It</td>
</tr>
<tr>
<td>1  In <strong>Flash Mode</strong>, right-click the widget and select Properties. The Cylinder dialog box opens.</td>
</tr>
<tr>
<td>2 From the <strong>Min Value</strong> and <strong>Max Value</strong> fields, type the minimum and maximum values for the cylinder.</td>
</tr>
<tr>
<td>3 Click <strong>OK</strong> to save the changes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine whether or not to apply formatting inherited from the widget’s underlying graph report</td>
</tr>
<tr>
<td>How to Format It</td>
</tr>
<tr>
<td>1  In <strong>Editable Mode</strong>, right-click the widget, then point to View Mode and select Graph View.</td>
</tr>
<tr>
<td>2 From the <strong>Format</strong> menu, select <strong>Graph</strong>. The Format: Graph dialog box opens.</td>
</tr>
<tr>
<td>3 From the <strong>Graph type</strong> drop-down list, select <strong>Cylinder</strong>.</td>
</tr>
<tr>
<td>4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.</td>
</tr>
<tr>
<td>5 Click <strong>Apply</strong> to apply your changes, then click <strong>OK</strong> to return to the widget.</td>
</tr>
<tr>
<td>6 In <strong>Flash Mode</strong>, right-click the widget and select Properties. The Cylinder dialog box opens.</td>
</tr>
<tr>
<td>7 Do one of the following:</td>
</tr>
<tr>
<td>• To apply formatting from the widget’s underlying graph report, select the <strong>Inherit grid formatting</strong> check box.</td>
</tr>
<tr>
<td>• To display the widget without inheriting formatting, clear the <strong>Inherit grid formatting</strong> check box.</td>
</tr>
<tr>
<td>8 Click <strong>OK</strong> to save the changes.</td>
</tr>
</tbody>
</table>

### Formatting a Data Cloud widget

For an image of a Data Cloud widget and steps to add one to a document, see *Creating a Data Cloud widget, page 202.*
The table below lists the different aspects of the Data Cloud widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 285*. For steps to enable DHTML, see the *MicroStrategy Web Help*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Whether the attribute elements in the widget are sorted alphabetically | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Data Cloud dialog box opens.  
2 To sort the attribute elements alphabetically, select the **Sort Alphabetically** check box.  
3 Click **OK** to save the changes. |
| Alignment of the data cloud within the widget's borders | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Data Cloud dialog box opens.  
2 Select **Align Left**, **Align Right**, or **Justify** from the **Alignment** drop-down list.  
3 Click **OK** to save the changes. |
| Define the equation used to determine the size of attribute elements | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Data Cloud dialog box opens.  
2 Select **Square Root**, **Logarithm**, or **Linear** from the **Equation** drop-down list:  
• **Square Root**: Select this option to display your data in abrupt increments. Selecting this option is beneficial if you have large value differences between each set of data in the widget.  
• **Logarithm**: Select this option to display your data in gradual, smoother increments. Selecting this option is beneficial if you are using percentage data that drops below 0%.  
• **Linear**: Select this option to display your data as a weighted average. For example, if you want to display the average sales data for each month of the year, or the average profit for Q1 2007, this option is beneficial.  
3 Click **OK** to save the changes. |
| Font size of the smallest attribute element in the widget | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Data Cloud dialog box opens.  
2 Select or type the font size (1-15) in the **Minimum Font Size (1-15)** field.  
3 Click **OK** to save the changes. The font size of the smallest attribute element is changed; all other attribute elements are sized proportionally. |
### What to Format in the Widget | How to Format It
---|---
Colors in which the attribute elements are displayed | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2. Specify colors from the Font Color 1 and Font Color 2 palettes.  
3. Click OK to save the changes. Attribute elements in the Data Cloud widget alternate between the two font colors displayed.

Background color of the widget | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2. Specify a color from the Background Color palette.  
3. Click OK to save the changes.

Border color of the widget | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2. Specify a color from the Border Color palette.  
3. Click OK to save the changes.

Determine whether or not to apply additional formatting inherited from the widget's underlying graph report. By default, a Data Cloud widget inherits the number formatting from its underlying graph report in Editable Mode. For example, if a dollar sign ($) is used in the metric values in Editable Mode, a dollar sign is also used in the metric values in the tooltips of the widget. You can choose to inherit font formatting from the widget's graph report in addition to the number formatting. | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2. Do one of the following:  
   - To apply formatting from the widget's underlying graph report, select the Inherit Grid Formatting check box. The font type of elements displayed in the widget is inherited from the underlying graph report.  
   - To apply only the number format from the underlying graph report, clear the Inherit Grid Formatting check box.  
3. Click OK to save the changes.

---

### Formatting a Date Selection widget

For an image of a Date Selection widget and steps to add one to a document, see *Creating a Date Selection widget, page 205*.

(You can design a separate type of Date Selection widget to be displayed on a mobile device; for more information, see the MicroStrategy Mobile Design and Administration Guide.)

The table below lists the different aspects of the Date Selection widget that you can format. It also lists steps to format them in MicroStrategy Web. These options are applied only to Flash Mode. In other modes/views, how the widget displays is determined by how it was created:
• Date Selection widget created as a widget: It can be hidden or displayed as either a grid or graph report, or as a placeholder. It is displayed using Flash in DHTML interactive documents.

• Date Selection widget created as a selector: It is displayed using the DHTML style and formatting.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Background color of the calendar | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Date Selection dialog box opens.  
2 Click the **General** tab.  
3 Select a **Background color**.  
4 Click **OK** to save the changes. |
| Border color of the calendar | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Date Selection dialog box opens.  
2 Click the **General** tab.  
3 Select a **Border color**.  
4 Click **OK** to save the changes. |
| Color displayed when a user rolls over a date on the calendar | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Date Selection dialog box opens.  
2 Click the **General** tab.  
3 Select a **Border color**.  
4 Click **OK** to save the changes. |
| Color displayed when a user chooses a date on the calendar | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Date Selection dialog box opens.  
2 Click the **General** tab.  
3 Select a **Selected color**.  
4 Click **OK** to save the changes. |
| Day displayed as the first day of the week on the calendar | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Date Selection dialog box opens.  
2 Click the **General** tab.  
3 Select the **First day of the week** from the drop-down list.  
4 Click **OK** to save the changes. |
Dashboards and Widgets Creation Guide

Formatting Widgets

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Highlight the current date on the calendar | 1 In Flash Mode, right-click the widget and select Properties. The Date Selection dialog box opens.  
2 Click the General tab.  
3 Select or clear the Highlight today check box.  
4 Click OK to save the changes. |
| Set the font settings, including font color, size, and style, of different areas on the calendar | 1 In Flash Mode, right-click the widget and select Properties. The Date Selection dialog box opens.  
2 Click the Fonts tab.  
3 From the drop-down list, select a calendar area to format. Each area can be formatted individually. The options include:  
• Month + Year: The calendar header.  
• Day header: The names of the days.  
• Day number: The dates on the calendar.  
4 To italicize text, select the Italic check box.  
5 To bold text, select the Bold check box.  
6 To format another calendar area, repeat the steps above.  
7 Click OK to save the changes. |

Format a Date Selection widget for a mobile device

The Date Selection widget is available to be displayed on a mobile device with MicroStrategy Mobile.

For steps to create and format a Date Selection widget for use on a mobile device, see the MicroStrategy Mobile Design and Administration Guide.

Format a Fish Eye Selector

For an image of a Fish Eye selector and steps to add one to a document, see Creating a Fish Eye Selector, page 214.

A Fish Eye selector is displayed only in Flash Mode. In other modes/views, how the selector displays is determined by how it was created:

• If the Fish Eye selector was created as a widget, it can be hidden or displayed as either a Grid/Graph or a placeholder. For steps and examples, see Defining how a widget is displayed in different views and modes, page 285.
• If the Fish Eye selector was created as a selector, it is displayed using the DHTML style and formatting. For steps, see *Defining a selector*, page 113.

The table below provides formatting ideas and steps to format the Fish Eye selector created as a widget.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Display the list of data in the widget in text or image form    | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2 Click the **General** tab.  
3 Do one of the following:  
  • To display the list of data appearing to the left of the Grid/Graph in the widget as text, select **Text** from the **Mode** drop-down list.  
  • To display the list of data appearing to the left of the Grid/Graph in the widget as images, select **Image** from the **Mode** drop-down list. Type the web address of the image in the **Image URL** field.  
4 Click **OK** to save the changes. |
| Color of highlighted and selected items in the selector         | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2 Click the **General** tab.  
3 From the **Highlight color** palette, specify the color in which a highlighted item is displayed when you hover the cursor over it.  
4 From the **Selected color** palette, specify the color in which a selected item is displayed.  
5 Click **OK** to save the changes. |
| Automatically determine the scale, magnification speed, and item spacing | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2 Click the **Advanced** tab.  
3 Select the **Auto** check box.  
4 Click **OK** to save the changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| The scale of the items, or how large or small the items in a selector can become | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2 Click the **Advanced** tab.  
3 Clear the **Auto** check box to ensure that you can manually adjust the scaling. The scale is automatically determined if this check box is selected.  
4 Enter a value in the **Default scale** field to specify the default size of the items in the selector. By default, items are sized so that they can all be displayed.  
5 Enter a value in the **Max scale** field to specify the maximum size that an item in the selector can become when you hover the cursor over it. It is recommended that you use a **Max scale** of 0.65 for selectors that contain approximately 20 items.  
6 Enter a value in the **Scale radius** field to specify how many items adjacent to the item increase in size when you hover the cursor over an item in the selector. This number includes the selected item.  
7 Enter a number in the **Scale slope** field to specify the difference in size between a selected item and the items directly adjacent to it.  
8 Click **OK** to save the changes. |
| Speed of the magnification effect for items in the selector | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2 Click the **Advanced** tab.  
3 Clear the **Auto** check box to ensure that you can adjust the **Animation Speed** option. The speed is automatically determined if this check box is selected.  
4 Enter a number in the **Animation speed** field to determine the animation speed of the displayed data. A smaller Animation speed results in smoother transitions between items. The minimum value is .1 and the maximum value is 1. The default value is .3.  
5 Click **OK** to save the changes. |
Replacing the selector items of a Fish Eye Selector with images

The Fish Eye Selector can display a series of images from which analysts can choose. These images can replace any attribute element, metric, or panel names in the selector. When the user selects an image, any target panel stacks or Grid/Graphs are updated with related data.

In the example below, the Fish Eye Selector on the left displays a collection of flags from various countries. Each flag represents an attribute element from the Country attribute, which is the attribute used to create the Fish Eye...
Selector. An analyst can select a flag to see relevant data in the target Grid/Graph on the right.

To view images related to a specific attribute element, metric, or panel, you must specify its name when you specify the location of the image. In the example above, images of countries are named the same as the elements of the Country attribute. You specify the image when you format the Fish Eye Selector.

**Formatting a Funnel widget**

For an image of a Funnel widget and steps to add one to a document, see *Creating a Funnel widget, page 226*.

The table below lists the different aspects of the Funnel widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in
DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 285.* For steps to enable DHTML, see the *MicroStrategy Web Help.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine whether the series labels are displayed                | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select or clear the **Show series labels** check box.  
3 Click **OK** to save the changes. |
| The **Show series labels** option displays what each colored section represents, for example, a customer region like Northeast. |                                                                                                                                                       |
| Determine whether labels are displayed inside or outside the funnel | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select the **Show series labels** check box.  
3 Select **Outside** or **Inside** from the **Labels Position** drop-down list.  
4 Click **OK** to save the changes. |
| Determine whether the series values are displayed               | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select or clear the **Show series values** check box.  
3 Click **OK** to save the changes. |
| Determine whether the series values are displayed inside or outside the funnel | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select the **Show series values** check box.  
3 Select **Outside** or **Inside** from the **Values Position** drop-down list.  
4 Click **OK** to save the changes. |
| Enable legend resize                                             | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select or clear the **Resizeable Legend Area** check box.  
3 Click **OK** to save the changes. |
<p>| Enabling legend resizing allows a user to change the size of the legend area. If the widget has a lot of items on it, a user might want to expand the legend area so that he can read all of the text in the legend. |                                                                                                         |</p>
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the minimum height for the funnel layer | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Funnel dialog box opens.  
2 Enter the minimum height required in the Funnel Layer Minimum Height field. The size of the layers is representative and should not be considered to be a strict representation of the percent-to-total calculation of each layer.  
3 Click OK to save the changes. |
| Determine whether or not to apply formatting inherited from the widget’s underlying graph report | 1 In Editable Mode, right-click the widget, then point to View Mode and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 From the Graph type drop-down list, select Funnel.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.  
5 Click Apply to apply your changes, then click OK to return to the widget.  
6 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Funnel dialog box opens.  
7 Do one of the following:  
• To apply formatting from the widget’s underlying graph report, select the Inherit grid formatting check box.  
• To display the widget without inheriting formatting, clear the Inherit grid formatting check box.  
8 Click OK to save the changes. |

### Formatting a Gauge widget

For an image of a Gauge widget and steps to add one to a document, see *Creating a Gauge widget, page 228.*

The table below lists the different aspects of the Gauge widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different*
views and modes, page 285. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Show or hide the value that the gauge needle is pointing to | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Gauge dialog box opens.  
2 Select or clear the Show Data Labels check box to show or hide the indicated value in the center of the Gauge widget. For example, if the gauge needle points to $65,000, “$65,000" is displayed in the center of the gauge.  
3 Click OK to save the changes. |
| Select the series color scheme                          | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Gauge dialog box opens.  
2 Select one of the color schemes from the Default series colors drop-down list.  
3 Click OK to save the changes. |
| Show or hide the title                                 | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Gauge dialog box opens.  
2 Select or clear the Show title check box to show or hide the title. The title appears at the bottom of the gauge.  
3 Click OK to save the changes. |
| Determine whether or not to apply formatting inherited from the widget’s underlying graph report | 1 In Editable Mode, right-click the widget, then point to View Mode and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 From the Graph type drop-down list, select Gauge.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.  
5 Click Apply to apply your changes, then click OK to return to the widget.  
6 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Gauge dialog box opens.  
7 Do one of the following:  
• To apply formatting from the widget’s underlying graph report, select the Inherit grid formatting check box.  
• To display the widget without inheriting formatting, clear the Inherit grid formatting check box.  
8 Click OK to save the changes. |

### Formatting a Graph Matrix (deprecated) widget

For an image of a Graph Matrix (deprecated) widget and steps to add one to a document, see Creating a Graph Matrix (deprecated) widget, page 230.
The table below lists the different aspects of the Graph Matrix (deprecated) widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 285*. For steps to enable DHTML, see the *MicroStrategy Web Help*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine whether every area graph uses the same scale and number interval on their Y-axes  | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Graph Matrix dialog box opens.  
2. Select the **Uniform axis** option.  
3. Click **OK** to save the changes.                                                                 |
| This option makes all the grids and graphs appear to have the same empty axis values.       |                                                                                                                                                  |
| If you scroll over the X-axis, you can see that the values are unique for each object on the widget. |                                                                                                                                                  |
| Add or remove horizontal reference lines for every area graph                                | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Graph Matrix dialog box opens.  
2. Select or clear the **Reference Line** check box.  
3. Click **OK** to save the changes.                                                                 |
| The red line provides the average for all graphs in the same row; the black line provides the average for each graph. |                                                                                                                                                  |
| Show or hide the axis labels on the area graphs                                             | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Graph Matrix dialog box opens.  
2. Select or clear the **Axis Labels** check box.  
3. Click **OK** to save the changes.                                                                 |
|                                                                                                                                                          |
| Adjust how transparent or opaque the background of the widget is                            | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Graph Matrix dialog box opens.  
2. From the **Background Opacity** drop-down list, select a level of opacity. The higher the percentage, the less transparent the background is.  
3. Click **OK** to save the changes.                                                                 |
| Show or hide a legend for the area graphs                                                   | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Graph Matrix dialog box opens.  
2. Select or clear the **View Graph Legend in Zoom View** check box.  
3. Click **OK** to save the changes.                                                                 |
| The legend is displayed when you click one of the area graphs to maximize the graph         |                                                                                                                                                  |
Formatting a Heat Map widget

For an image of a Heat Map widget and steps to add one to a document, see *Creating a Heat Map widget, page 236.*

The table below lists the different aspects of the Heat Map widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different*
views and modes, page 285. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine whether to show metric values                                                       | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select or clear the Show metric values check box.  
3 Click OK to save the changes.                                                                                                           |
| This option allows you to determine whether to display the metric values - for example, revenue by state - in each section of the widget. The widget is divided into sections by attributes. For example, you add customer region, quarter, and revenue to the widget. The widget will be divided into the customer region section first and then into quarters within the customer regions. If you select the Show metric values check box, you can display revenue values for each quarter in each customer region. |                                                                                                                                                                                                                  |
| Display a legend for the heat map                                                              | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select the Show Legend check box.  
3 Click OK to save the changes.                                                                                                           |
| Determine whether to allow attributes to be removed from the widget                            | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select or clear the Remove Attributes from Template check box.  
3 Click OK to save the changes.                                                                                                           |
| Removed attributes can be restored when needed.                                               |                                                                                                                                                                                                                  |
| If the metric defining the size or color does not use SUM, do not allow attributes to be removed from the widget. |                                                                                                                                                                                                                  |
| Determine whether to display labels in each rectangle                                          | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select one of the following options from the Show Labels drop-down list:  
• On: Labels are displayed in the rectangles.  
• Off: Labels are not displayed in the rectangles.  
• Proportional: Labels are displayed in the rectangles, with the size of each label reflecting the size of the rectangle. Rectangles that reflect positive values are displayed with larger labels than rectangles that reflect negative values.  
3 Click OK to save the changes.                                                                                                           |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the algorithm used to size and position the rectangles</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 On the Display tab, select one of the following options under Layout:</td>
</tr>
<tr>
<td></td>
<td>3 Keep readability, not element order: Size the rectangles in the widget to make the data with them as easy to read as possible.</td>
</tr>
<tr>
<td></td>
<td>4 Balance readability and order: Size and position the rectangles to make the data within them as easy to read as possible, while still attempting to display them in the same order in which they appear in the widget's Grid/Graph.</td>
</tr>
<tr>
<td></td>
<td>5 Keep element order, not readability: Position the rectangles in the widget in the same order in which they appear in the widget's Grid/Graph.</td>
</tr>
<tr>
<td></td>
<td>6 Click OK to save the changes.</td>
</tr>
<tr>
<td>Select the color of the background</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 On the Format tab, select the Background color for the widget.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to save the changes.</td>
</tr>
<tr>
<td>Select the color of the borders</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 On the Format tab, select a color for the borders of the widget from the Border Color palette.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to save the changes.</td>
</tr>
<tr>
<td>Select the color of the attribute headings</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 On the Format tab, select a color for the headings from the Header Color palette.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to save the changes.</td>
</tr>
<tr>
<td>Enable scale boundaries</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.</td>
</tr>
</tbody>
</table>
| By default, the minimum and maximum range for the color slider is determined automatically by the data in the widget. If the data changes, the minimum and maximum can also change. You can instead set the minimum and maximum range for a specific metric, so that specific colors always represent specific metric values. Outlying metric values use solid colors, rather than shaded colors. | 2 On the Metric Options tab, select the metric from the drop-down list.  
3 Select the Scale Boundaries check box.  
4 Type the Minimum and Maximum values in the corresponding fields.  
5 Click OK to save the changes.                                                                                                                                 |

What to Format in the Widget

| How to Format It
|---|
| **Select the algorithm used to size and position the rectangles** | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select one of the following options under Layout:  
3 Keep readability, not element order: Size the rectangles in the widget to make the data with them as easy to read as possible.  
4 Balance readability and order: Size and position the rectangles to make the data within them as easy to read as possible, while still attempting to display them in the same order in which they appear in the widget's Grid/Graph.  
5 Keep element order, not readability: Position the rectangles in the widget in the same order in which they appear in the widget's Grid/Graph.  
6 Click OK to save the changes. |
| **Select the color of the background** | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Format tab, select the Background color for the widget.  
3 Click OK to save the changes. |
| **Select the color of the borders** | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Format tab, select a color for the borders of the widget from the Border Color palette.  
3 Click OK to save the changes. |
| **Select the color of the attribute headings** | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Format tab, select a color for the headings from the Header Color palette.  
3 Click OK to save the changes. |
| **Enable scale boundaries** | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Metric Options tab, select the metric from the drop-down list.  
3 Select the Scale Boundaries check box.  
4 Type the Minimum and Maximum values in the corresponding fields.  
5 Click OK to save the changes. |
Select the aggregation function for the widget
You can change the aggregation function used to calculate the size of the larger areas in the widget. The value of this function is displayed in a tooltip when the cursor hovers over an area.

1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Heat Map dialog box opens.
2. Click the **Metric Options** tab.
3. From the **Aggregation Function** drop-down list, select an aggregation function:
   - Sum
   - Average
   - Count
   - Maximum
   - Minimum
   - Geometric Average
4. Click **OK** to save the changes.

Determine whether or not to apply formatting inherited from the widget’s underlying graph report
This widget automatically inherits the number and date formatting from the underlying graph.

1. In **Editable Mode**, right-click the widget, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.
2. Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click **Help**.

## Formatting an Image Layout widget

For an image of an Image Layout widget and steps to add one to a document, see *Creating an Image Layout widget, page 240*.

Once you have created an Image Layout widget, you can specify formatting options to change the background image displayed in the widget, determine whether to display areas or bubble markers on top of the image, and so on. Steps to format an Image Layout widget are below.

### Prerequisites

- The procedure below assumes that you have already created the widget that you want to format.

### To format an Image Layout widget

1. Open the document in **Design** or **Editable Mode**.
2. Right-click the widget, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3 From the left, select **Widget**, then click the **Widget Properties** icon. The Image Layout Properties dialog box opens.

4 You can determine whether the widget displays areas or bubble markers. From the **Display Mode** drop-down list, select one of the following:

   - To allow MicroStrategy to decide whether to show areas or bubble markers, select **Automatic**.
   - To display areas, select **Area**.
   - To display bubble markers, select **Bubble**.

5 You can select the shape file to use to display the widget. A shape file is an HTML file that contains the image that you want to display in the widget, as well as the location of each area or bubble marker you want to display on top of the image. Web provides several default shape files for you to choose from, including a map of countries of the world and a map of states in the United States. You can define your own shape file for use in the widget, using the same steps as you would to customize an Image Layout visualization. For steps, see the MicroStrategy Web Help.

6 From the **Shape File** drop-down list, select the name of the shape file you want to use. If the attribute you placed in the Geo Attribute area has a geo role, shape files with the same geo role will be displayed as options in the drop-down list.

7 You can determine how bubble markers in the widget are sized. From the **Type** drop-down list, select one of the following:

   - To allow MicroStrategy to decide how to size the bubble markers, select **Automatic**.
   - To manually specify the maximum size of bubble markers in the widget, select **Manual**. In the **Value** field, type the maximum size of the bubble markers as a ratio between .01 and 1. For example, type 1 to display the largest bubble markers at the maximum size at which the widget can display bubble markers.

8 From the **Background Color** palette, select the default background color to display in the widget. To access additional colors, click **More Colors**.
9 From the Default Shape Color palette, select the default color in which to display areas in the widget. To access additional colors, click More Colors.

10 Click OK to save your changes.

Formatting an Interactive Bubble Graph widget

For an image of an Interactive Bubble Graph widget and steps to add one to a document, see Creating an Interactive Bubble Graph widget, page 243.

The table below lists the different aspects of the Interactive Bubble Graph widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different views and modes, page 285. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign colors to the bubbles based on the selected object</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Interactive Bubble Graph dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 On the General tab, select the Assign colors based on option, then select the object name from the drop-down list. For example, if Brand is on the widget, then each brand’s bubble will display in a different color.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to save the changes.</td>
</tr>
<tr>
<td>Determine drilling behavior</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Interactive Bubble Graph dialog box opens.</td>
</tr>
<tr>
<td>If drilling is enabled, a user can click on a bubble in the widget to drill down on that</td>
<td>2 On the Drilling tab, select or clear the Enable drilling check box. If you are enabling drilling, you must also fulfill additional data requirements for this widget. See Supporting drilling in an Interactive Bubble Graph widget, page 245.</td>
</tr>
<tr>
<td>bubble’s data. This displays a drilled-to (child) bubble with related data. To enable</td>
<td>3 To determine whether a line appears between a drilled bubble and its corresponding drilled-to (child) bubble, select or clear the Connect bubbles when drilling check box. The line allows you to better visualize which bubbles contain related information.</td>
</tr>
<tr>
<td>drilling, you must also place a second attribute to the right of the attribute in the rows.</td>
<td>4 Click OK to save the changes.</td>
</tr>
<tr>
<td>For details, see Creating an Interactive Bubble Graph widget, page 243.</td>
<td></td>
</tr>
<tr>
<td>What to Format in the Widget</td>
<td>How to Format It</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------</td>
</tr>
</tbody>
</table>
| Display the graph’s legend inside or outside the graph | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **General** tab, select or clear the **Display legend outside of graph** check box.  
3 Click OK to save the changes. |
| Determine size of bubbles in reference to parent bubbles | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **General** tab, do one of the following:  
• Select the **Use width (vs. area) to size the bubbles** check box to use the sum of the diameters of the drilled-to (child) bubbles as the diameter of the parent bubble.  
• Clear the **Use width (vs. area) to size the bubbles** check box to use the area of the child bubbles as the area of the parent bubble.  
3 You can also specify a maximum bubble size in the **Maximum bubble radius size** field.  
4 Click OK to save the changes. |
| Determine whether to display bubbles with a rounded effect | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **General** tab, select or clear the **Apply Rounded Effect to Bubbles** check box.  
3 Click OK to save the changes. |
| Enable or disable time series animation | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **Time Analysis** tab, select or clear the **Enable time series analysis** check box. If time series analysis is enabled:  
• The user can control the time series animation. To enable time series animation, make sure there is a third attribute on the rows of the widget’s Grid/Graph. For information, see **Creating an Interactive Bubble Graph widget**, page 243.  
• You can select or clear the **Auto-Hide time controls** check box, to determine whether the time series animation control bar is automatically hidden from view unless the cursor hovers over it.  
3 Click OK to save the changes. |
## Formatting Widgets

### What to Format in the Widget | How to Format It
--- | ---
Font formatting for the time series labels (the attribute header) | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.
2. On the **Time Analysis** tab, select the **Font Family**, **Font Size**, and **Color**. Some of the options may not be visible; to view all options, use the scroll bar to scroll down. These options are only available if the **Enable time series analysis** check box is selected.
3. To bold the labels, select the **Bold** check box.
4. To italicize the labels, select the **Italic** check box.
5. Click **OK** to save the changes.

Color, opacity, and size of time series animation control | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.
2. Click the **Time Analysis** tab.
3. The following options are available only if the **Enable time series analysis** check box is selected:
   - To format the background of the control: Select a color from the **Control background color** palette. Select an opacity percentage from the **Control background opacity** drop-down list to determine how opaque the background is. 100% is a solid color, 0% is transparent.
   - To format the background of the Play button, select colors from the **Button background colors** palettes. If you specify two different colors, they are blended to create a gradient effect. If you specify the same color, the button background is displayed in a single color.
4. To format the background of the Play button when the user hovers his cursor over the button, select a color from the **Control highlight color** palette.
5. From the **Control size** drop-down list, specify the size of the time series animation control.
6. Click **OK** to save the changes.

Change selection on mouse over | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.
2. On the **Selectors** tab, you can change what is displayed in the selectable area when you hover the cursor over the area that you want to see. To do this, select the **Change selection on mouse over** option.
3. Click **OK** to save the changes.
### What to Format in the Widget

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Allow the selection box (the lasso) to automatically update the targeted Grid/Graphs and panel stacks, if the widget is used as a selector. For example, when this option is enabled, an analyst can drag a selection box around two brand bubbles in the widget to automatically display those brands in the targeted Grid/Graph. | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2. On the **Selectors** tab, select **Trigger selector with lasso automatically**.  
3. Click **OK** to save the changes.  
The widget must also be enabled to be used as a selector. You must enable attributes or attribute elements in the Grid/Graph that contains the widget. For details, see *Using an Interactive Bubble Graph widget as a selector*, page 358. |
| Whether to display the widget in scatter plot mode. In scatter plot mode, each bubble in the widget is the same size, and only two metrics are displayed: the X-axis and Y-axis. You can define the radius of the bubbles in the scatter plot, but it cannot be bigger than the maximum radius. | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2. Click the **Scatter Mode** tab.  
3. Do one of the following:  
   • To display the widget as a scatter plot, select the **Scatter Plot Mode Only** check box. Type the size of the scatter plot bubbles in the **Scatter Plot Bubble Radius** field. All bubbles in the widget are displayed in this size.  
   • To display the widget as a bubble graph, clear the **Scatter Plot Mode Only** check box.  
4. Click **OK** to save the changes. |
| Enable or disable zooming and changing the metric displayed on an axis in the widget. By default, an analyst can zoom in to a specific area of the widget, or change which metrics are displayed on which axis in the widget using the drop-down lists displayed on each axis. You can enable or disable these options. | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget.  
2. Do one of the following:  
   • To enable zooming and changing the metric displayed on an axis using the drop-down lists, select **Show Interactive Controls**.  
   • To disable zooming and changing the metric displayed on an axis using the drop-down lists, select **Hide Interactive Controls**. |
| Determine whether or not to apply formatting inherited from the widget’s underlying graph report. The following formatting can be inherited from the underlying graph:  
   • Number formatting  
   • Font type, size, and color  
   • Background and border color of the widget  
   • Legend formatting, including position, background, and border color  
   • The maximum and minimum values that can be displayed in the graph  
   • The interval between tick marks on the graph axes | 1. In **Editable Mode**, right-click the widget, point to **View Mode**, and select **Graph View**.  
2. From the **Format** menu, select **Graph**. The Format: Graph dialog box opens.  
3. Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click **Help**. |
Formatting an Interactive Stacked Graph widget

For an image of an Interactive Stacked Graph widget and steps to add one to a document, see *Creating an Interactive Stacked Graph widget, page 249.*

The table below lists the different aspects of the Interactive Stacked Graph widget that you can format, and describes the steps to format them in MicroStrategy Web.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine color of the area graph's series</td>
<td>1 In Flash Mode, right-click the widget and select Properties. The Interactive Stacked Graph dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the Aggregate area series color palette, select a color for the series.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to save the changes.</td>
</tr>
<tr>
<td>Determine color of the line that appears between different series</td>
<td>1 In Flash Mode, right-click the widget and select Properties. The Interactive Stacked Graph dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the Series line color palette, select a color for the line that appears between different series when more than one attribute is selected from the checklist on the left.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to save the changes.</td>
</tr>
</tbody>
</table>
### Formatting a Map widget

The Map widget is available to be displayed in Web or on a mobile device with MicroStrategy Mobile. In order to display the Map widget in Web, you must first enable the MicroStrategy GIS Connector for Google Maps plug-in. For steps to enable this plug-in, as well as steps to create and format a Map widget for display in Web, see the GIS Integration Help. For steps to create and format a Map widget for mobile devices, see the MicroStrategy Mobile Design and Administration Guide.

### Formatting a Media widget

For an image of a Media widget and steps to add one to a document, see Creating a Media widget, page 251.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine whether the legend or the graph is selectable | 1 In Flash Mode, right-click the widget and select Properties. The Interactive Stacked Graph dialog box opens.  
2 Select either Graph or Legend from the Selectable area drop-down list.  
3 If Graph is selected, select or clear the Change selection on mouse over check box. If selected, the user can change what is displayed in the selectable area when he hovers the cursor over the area that he wants to see.  
4 Click OK to save the changes. |
| Determine whether to apply formatting inherited from the widget’s underlying graph report | 1 In Editable Mode, right-click the widget, point to View Mode, and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.  
4 Click OK to return to the widget.  
5 In Flash Mode, right-click the widget and select Properties. The Interactive Stacked Graph dialog box opens.  
6 Do one of the following:  
• To apply formatting from the widget’s underlying graph, select the Inherit grid formatting check box.  
• To display the widget without inheriting formatting, clear the Inherit grid formatting check box.  
7 Click OK to save the changes. |
The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 285*. For steps to enable DHTML, see the *MicroStrategy Web Help*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine the content type that will display in the widget</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Media dialog box opens.</td>
</tr>
<tr>
<td>You can display video, audio, web content (Flash only), or images (Flash only).</td>
<td>2 Select the <strong>General</strong> tab.</td>
</tr>
<tr>
<td>3 From the <strong>Content type</strong> drop-down list, specify the content type that will display in the widget.</td>
<td>4 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Define the text that is displayed when an analyst hovers the cursor over the widget</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Media dialog box opens.</td>
</tr>
<tr>
<td>This text can be used to identify the media in the widget.</td>
<td>2 Select the <strong>General</strong> tab.</td>
</tr>
<tr>
<td>3 In the <strong>Tooltip Text</strong> field, type the text that you want to display when users hover the cursor over the widget.</td>
<td>4 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Set the background color of the widget</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Media dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Select the <strong>General</strong> tab.</td>
</tr>
<tr>
<td>3 Select a color from the <strong>Background color</strong> drop-down list.</td>
<td>4 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Determine whether to display the widget automatically or after clicking a button</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Media dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Select the <strong>General</strong> tab.</td>
</tr>
<tr>
<td>3 Do one of the following:</td>
<td></td>
</tr>
<tr>
<td>• Clear the <strong>Popup content when clicked</strong> check box to display the widget immediately when the document is opened.</td>
<td></td>
</tr>
<tr>
<td>• Select the <strong>Popup content when clicked</strong> check box to hide the widget and display a button. The user can click the button to display the widget. From the <strong>Display Content</strong> drop-down list, select whether the widget displays in a new window or in the existing window:</td>
<td></td>
</tr>
<tr>
<td><strong>Inline</strong>: The widget will be displayed in the document after the button is clicked.</td>
<td></td>
</tr>
<tr>
<td><strong>New Window</strong>: The widget will be displayed in a new browser window after the button is clicked.</td>
<td></td>
</tr>
<tr>
<td>Type the text to display on the button in the <strong>Button Text</strong> field.</td>
<td></td>
</tr>
<tr>
<td>4 Click <strong>OK</strong> to save the changes.</td>
<td></td>
</tr>
</tbody>
</table>
Formatting a Microcharts widget

For an image of a Microcharts widget and steps to add one to a document, see *Creating a Microcharts widget, page 257.*

A Microcharts widget is made up of several small types of graphs or charts. The bar, sparkline, and bullet microcharts make up the Microcharts widget. You can format some aspects of the entire Microcharts widget, and you can also format some aspects of each type of microchart differently. The formatting options described below are grouped into the following sections:

- *Formatting a Microcharts widget, page 331*
- *Formatting bar microcharts, page 334*
- *Formatting sparkline microcharts, page 336*
- *Formatting bullet microcharts, page 337*
## Formatting a Microcharts widget

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide metrics for hidden graphs</td>
<td>1. In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens. 2. From the drop-down list, select <strong>Options</strong>. 3. Select or clear the <strong>Display metrics for hidden graphs</strong> check box. 4. Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Determine opacity of the widget's background</td>
<td>1. In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens. 2. From the drop-down list, select <strong>Opacity</strong>. 3. From the <strong>Background opacity</strong> drop-down list, select the level of opacity. The higher the percentage, the less transparent the background is. 4. Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Change how the rows of microcharts are displayed, to Grid, Vertical Scroll, or Ticker</td>
<td>1. In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens. 2. From the drop-down list, select <strong>Mode</strong>. 3. Click the <strong>Mode</strong> tab. 4. From the <strong>Operation mode</strong> drop-down list, choose a display method from one of the following:  • <strong>Grid</strong>: This is the default operation mode for a Microcharts widget. In this mode, all the rows of microcharts are displayed at the same time in a grid layout.  • <strong>Vertical Scroll</strong>: In this mode, users can view each row of microcharts as they automatically scroll from the top to the bottom. Users can also manually navigate from one row to the next using Previous and Next buttons on the right side of the widget.  • <strong>Ticker</strong>: In this mode, microcharts and supplemental text are displayed in a scrolling ticker that moves from right to left. You can add text next to each microchart to provide background information or highlight a trend displayed in the microchart. This text is displayed alongside the microcharts as they scroll horizontally. This mode is not available if the widget is set up to display in KPI List mode. For details, see <em>Creating a Microcharts widget</em>, page 257. 5. Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Define the number of metrics used to calculate each row of microcharts in KPI List mode</td>
<td>This option is only available if the widget is designed to display in KPI List mode. For details, see <em>Creating a Microcharts widget</em>, page 257.</td>
</tr>
<tr>
<td>What to Format in the Widget</td>
<td>How to Format It</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------</td>
</tr>
</tbody>
</table>
| Show or hide the column headings | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Mode tab.  
4 Select or clear the Hide column headers check box.  
5 Click OK to save the changes. |
| Show or hide the text columns | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Mode tab.  
4 Select or clear the Hide text columns check box.  
5 Click OK to save the changes. |
| Lock or unlock the Microcharts layout  
When the layout is locked, users cannot move or sort columns in the widget. | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Mode tab.  
4 Select or clear the Lock layout check box.  
5 Click OK to save the changes. |
| Show or hide the Previous and Next buttons in Vertical Scroll mode  
This option is available only if the operation mode is set to Vertical Scroll. | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Mode tab.  
4 Select or clear the Previous/Next buttons check box.  
5 Click OK to save the changes. |
| Set the scroll speed in Vertical Scroll mode  
This option is available only if the operation mode is set to Vertical Scroll. | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Vertical Scroll tab.  
4 From the Motion tab, select a scroll speed from Slow, Medium, and Fast.  
5 Click OK to save the changes. |
| Add a descriptive title to the widget in ticker mode  
This option is only available if the operation mode is set to Ticker. | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Ticker tab.  
4 Type the widget title in the Title field.  
5 Click OK to save the changes. |
| Show or hide the Previous and Next buttons in Ticker mode  
This option is only available if the operation mode is set to Ticker. | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Ticker tab.  
4 Select or clear the Previous/Next buttons check box.  
5 Click OK to save the changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display detail view when a ticker is clicked in Ticker mode</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.  2 From the drop-down list, select <strong>Mode</strong>.  3 Click the <strong>Ticker</strong> tab.  4 Select or clear the <strong>Enable detail view</strong> check box.  5 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Set the scroll speed in Ticker mode</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.  2 From the drop-down list, select <strong>Mode</strong>.  3 Click the <strong>Ticker</strong> tab.  4 In the <strong>Motion</strong> drop-down list, select a scroll speed from Slow, Normal, and Fast.  5 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Define the text displayed for the tickers in Ticker mode</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.  2 From the drop-down list, select <strong>Mode</strong>.  3 Click the <strong>Ticker</strong> tab.  4 Type a value to be displayed when the ticker is below its target value, in the <strong>Ticker 1(M3 &lt; M7)</strong> field.  5 Type a value to be displayed when the ticker is above its target value, in the <strong>Ticker 2(M3 &gt;= M7)</strong> field.  6 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Adjust the color of tickers displayed in Ticker mode</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.  2 From the drop-down list, select <strong>Mode</strong>.  3 Click the <strong>Ticker</strong> tab.  4 From the <strong>Ticker 1</strong> and <strong>Ticker 2</strong> color palettes, select a color for Ticker 1 and Ticker 2.  5 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Determine whether widget rows are shown in a tree display</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.  2 From the drop-down list, select <strong>Mode</strong>.  3 Select the <strong>Tree display</strong> check box.  4 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Set the aggregation function in the tree display</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.  2 From the drop-down list, select <strong>Mode</strong>.  3 From the <strong>Aggregation function</strong> drop-down list, select one of the following:  • Sum  • Average  • Count  • Max  • Min  4 Click <strong>OK</strong> to save the changes.</td>
</tr>
</tbody>
</table>
## Formatting Widgets Dashboard s and Widgets Creation Guide

### Formatting options by widget type © 2012 MicroStrategy, Inc.

#### Formatting bar microcharts

The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different modes*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display only a single metric column in the widget when it is displayed on the iPad Users can tap the metric column on the iPad to toggle the metric displayed in the widget. This option is available only for widgets displayed in KPI List mode or Grid mode on the iPad. For details, see <em>Creating a Microcharts widget, page 257</em>.</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select Properties. The Microcharts dialog box opens. 2 From the drop-down list, select Mode. 3 Select the Display a single metric column at a time (applies only to iPad) check box. 4 Click OK to save the changes.</td>
</tr>
<tr>
<td>Determine whether to apply formatting inherited from the widget’s underlying graph The following formatting can be inherited from the underlying graph:  • Number and date formatting  • Font type, alignment, and color  • Background and border color of row axis heading</td>
<td>1 In <strong>Editable Mode</strong>, right-click the widget, then select Properties and Formatting. The Properties and Formatting dialog box opens. 2 Format the widget's underlying graph by selecting the appropriate options to format the row axis headers and values in the Properties and Formatting dialog box. For details on each formatting option, click Help. 3 Click OK to return to the widget. 4 In <strong>Flash Mode</strong>, right-click the widget and select Properties. The Microcharts dialog box opens. 5 From the drop-down list, select Options. 6 Do one of the following:  • To apply formatting from the widget's underlying graph, select the Inherit grid formatting check box.  • To display the widget without inheriting formatting, clear the Inherit grid formatting check box. 7 Click OK to save the changes.</td>
</tr>
</tbody>
</table>
views and modes, page 285. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Show or hide the bar microcharts in the widget | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Options.  
3 Click the Bar tab.  
4 Select or clear the Show bar graph check box.  
5 Click OK to save the changes. |
| Show or hide the minimum and maximum values for the bar microcharts | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Options.  
3 Click the Bar tab.  
4 Select or clear the Min/max legend check box.  
5 Click OK to save the changes. |
| Show or hide the reference line | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Options.  
3 Click the Bar tab.  
4 Select or clear the Reference line check box.  
5 Click OK to save the changes. |
| Show or hide tooltips | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Options.  
3 Click the Bar tab.  
4 Select or clear the Show Tooltips check box.  
5 Click OK to save the changes. |
| Adjust the color of the bars (series) in the bar microcharts | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Colors.  
3 Click the Bar tab.  
4 From the Positive values palette, select a color for the positive bars.  
5 From the Negative values palette, select a color for the negative bars.  
6 From the Reference Line palette, select a color for the reference line.  
7 Click OK to save the changes. |
| Add a descriptive column header name above the bar microcharts | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Labels.  
3 Click the Bar tab.  
4 In the Header field, type a descriptive name for the column heading that is displayed above the bar charts.  
5 Click OK to save the changes. |
### Formatting sparkline microcharts

The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 285*. For steps to enable DHTML, see the *MicroStrategy Web Help*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide the sparkline microcharts in the widget</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens. 2 From the drop-down list, select <strong>Options</strong>. 3 Click the <strong>Sparkline</strong> tab. 4 Select or clear the <strong>Show sparkline graph</strong> check box. 5 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Show or hide the markers on the line graph in the sparkline microcharts</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens. 2 From the drop-down list, select <strong>Options</strong>. 3 Click the <strong>Sparkline</strong> tab. 4 To show or hide all of the markers between the first and last markers, select or clear the <strong>All points</strong> check box. 5 To show or hide the first and last markers on the line graph, select or clear the <strong>End points</strong> check box. If All points is selected above, this option is not available. 6 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Show or hide the horizontal reference line or sparkline background (reference area)</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens. 2 From the drop-down list, select <strong>Options</strong>. 3 Click the <strong>Sparkline</strong> tab. 4 Select or clear the <strong>Reference line</strong> check box to show or hide the reference line. 5 Select or clear the <strong>Reference area</strong> check box to show or hide the reference area background. 6 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>Show or hide the metric column and values associated with the sparkline microcharts</td>
<td>1 In <strong>Flash Mode</strong> or <strong>Interactive Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens. 2 From the drop-down list, select <strong>Options</strong>. 3 Click the <strong>Sparkline</strong> tab. 4 Select or clear the <strong>Associated metric</strong> check box. 5 Click <strong>OK</strong> to save the changes.</td>
</tr>
<tr>
<td>What to Format in the Widget</td>
<td>How to Format It</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------</td>
</tr>
</tbody>
</table>
| Show or hide tooltips       | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select **Options**.  
3 Click the **Sparkline** tab.  
4 Select or clear the **Show Tooltips** check box.  
5 Click **OK** to save the changes. |
| Select series line, reference line, and reference area (background) colors | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select **Colors**.  
3 Click the **Sparkline** tab.  
4 Select a color from the **Series line**, the **Reference line**, and the **Reference area** palettes.  
5 Click **OK** to save the changes. |
| Add a descriptive column heading name above the sparkline microcharts | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select **Labels**.  
3 Click the **Sparkline** tab.  
4 Type a name in the **Header** field. This text displays above the sparkline microcharts.  
5 Click **OK** to save the changes. |
| Add a descriptive heading name for the metric column associated with the sparkline microcharts | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select **Labels**.  
3 Click the **Sparkline** tab.  
4 Type a name or value in the **Associated metric** field. This text displays above the metric column.  
5 Click **OK** to save the changes.  
6 The heading name is only displayed when the **Associated metric** check box is selected from the **Sparkline** tab in the **Options** menu. |

### Formatting bullet microcharts

The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different*
views and modes, page 285. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Show or hide the bullet microcharts in the widget                                            | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2. From the drop-down list, select Options.  
3. Click the Bullet tab.  
4. Select or clear the Show bullet graph check box.  
5. Click OK to save the changes. |
| Show or hide the vertical reference line or color bands                                     | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2. From the drop-down list, select Options.  
3. Click the Bullet tab.  
4. Select or clear the Reference line check box.  
5. Select or clear the Reference bands check box to show or hide color bands.  
6. Click OK to save the changes. |
| Show or hide a legend for the bullet microcharts                                           | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2. From the drop-down list, select Options.  
3. Click the Bullet tab.  
4. Select or clear the Band legend check box.  
5. Click OK to save the changes. |
| Show or hide the metric column and values associated with the bullet microcharts           | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2. From the drop-down list, select Options.  
3. Click the Bullet tab.  
4. Select or clear the Associated metric check box.  
5. Click OK to save the changes. |
| Determine whether the bullet microchart is displayed from left to right or right to left   | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2. From the drop-down list, select Options.  
3. Click the Bullet tab.  
4. Select or clear the Invert graph axis check box.  
5. Click OK to save the changes. |
| Show or hide tooltips                                                                       | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2. From the drop-down list, select Options.  
3. Click the Bullet tab.  
4. Select or clear the Show Tooltips check box.  
5. Click OK to save the changes. |
| Define a minimum scale-setting value                                                      | 1. In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2. From the drop-down list, select Options.  
3. Click the Bullet tab.  
4. Type a value in the Minimum Value field.  
5. Click OK to save the changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust the color of the performance bar</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Colors.  3 Click the Bullet tab.  4 From the Positive values palette, select a color for the positive parts of the performance bar.  5 From the Negative values palette, select a color for the negative parts of the performance bar.  6 Click OK to save the changes.</td>
</tr>
<tr>
<td>Adjust the color of the vertical target line</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Colors.  3 Click the Bullet tab.  4 From the Reference line palette, select a color for the vertical target line.  5 Click OK to save the changes.</td>
</tr>
<tr>
<td>Adjust the color of the reference bands</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Colors.  3 Click the Bullet tab.  4 From the Band 1, Band 2, and Band 3 palettes, select a color for each reference band, from left to right.  5 Click OK to save the changes.</td>
</tr>
<tr>
<td>Add a descriptive column heading name above the bullet microcharts</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Labels.  3 Click the Bullet tab.  4 In the Header field, type a descriptive name for the column heading above the bullet charts.  5 Click OK to save the changes.</td>
</tr>
<tr>
<td>Add a descriptive heading name for the metric column associated with the bullet microcharts</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Labels.  3 Click the Bullet tab.  4 Type a name in the Associated metric field. This text displays above the metric column.  5 Click OK to save the changes.  6 The heading name is only displayed when the Associated metric check box is selected from the Bullet tab in the Options menu.</td>
</tr>
<tr>
<td>Add descriptive names to the legend that describes the different reference band colors</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Labels.  3 Click the Bullet tab.  4 In the Band 1, Band 2, and Band 3 fields, type a descriptive name for each reference band name displayed on the legend, from left to right.  5 Click OK to save the changes.</td>
</tr>
</tbody>
</table>
Formatting an RSS Reader widget

For an image of an RSS Reader widget and steps to add one to a document, see Creating an RSS Reader widget, page 269.

(You can design a separate type of RSS Reader widget to be displayed on a mobile device; for more information, see the MicroStrategy Mobile Design and Administration Guide.)

The table below lists the different aspects of the RSS Reader widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different views and modes, page 285. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Add a title to the RSS news feed | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Type a title in the RSS reader title field. This title appears in the top right of the widget.  
4 To format the color of the title, select a color from the RSS reader title color palette.  
5 Click OK to save the changes. |
| Define the web address of the RSS content displayed in the widget | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Type the web address of the RSS content in the Default RSS Field.  
4 Click OK to save the changes. |
| Determine the frequency with which the widget refreshes its content | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Type the refresh frequency in seconds in the Default refresh frequency (Sec) field.  
4 Click OK to save the changes. |
| Determine the number of RSS feed items to show on one page of the widget | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Type the number of items in the Items shown at a time field.  
4 Click OK to save the changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Open the entire article in a new window when an RSS item is clicked in the widget         | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Select the Open full article when clicked check box.  
4 Click OK to save the changes. |
| Allow the widget to display RSS content that is located on a different web domain than    | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Select the Use Proxy check box.  
4 Click OK to save the changes. |
| the one used for MicroStrategy Web                                                        |                                                                                                                                                  |
| Choose the background color of the widget                                                 | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Choose a color from the Background color palette.  
4 Click OK to save the changes.                                                          |
| Choose the border color of the widget                                                     | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the General tab.  
3 Choose a color from the Border Color palette.  
4 Click OK to save the changes.                                                          |
| Specify the area occupied by the news items                                              | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the News Items tab.  
3 From the drop-down list, select General.  
4 In the Percentage height occupied by the news items list field, specify how much of the total area the list of news items should occupy.  
5 Click OK to save the changes.                                                          |
| Determine whether news items scroll automatically, how fast, and in what direction        | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the News Items tab.  
3 From the drop-down list, select General.  
4 To allow news items to scroll automatically, select the Auto Scroll News Item List check box.  
5 From the Auto Scroll Direction drop-down list, specify the direction in which news items automatically scroll by selecting Up or Down.  
6 From the Auto Scroll Speed (Sec) drop-down list, specify the speed in seconds at which the news items scroll.  
7 Click OK to save the changes.                                                          |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the font and font size of news items                  | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 Select the **News Items** tab.  
3 From the drop-down list, select **Fonts**.  
4 From the **Font Type** and **Font Size** drop-down lists, select a font and size, respectively.  
5 Select the **Italic** and **Bold** check boxes to display the text in italics and bold, respectively.  
6 Click **OK** to save the changes.                                                                                                                                                                                                 |
| Choose the color of news items                                  | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 Select the **News Items** tab.  
3 From the drop-down list, select **Colors**.  
4 To display the news items with alternating colors, select the **Alternating color for news items** check box.  
5 From the drop-down list, specify whether to format the **Background**, **Rollover background**, **Font**, or **Rollover font**.  
6 Once you select an aspect of the news items to format, from the color palettes, select the two colors in which to display the news items.  
7 Click **OK** to save the changes.                                                                                                                                                                                                 |
| Determine how news articles that have been read are displayed   | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 Select the **News Items** tab.  
3 From the drop-down list, select **Read Articles**.  
4 To ensure that news articles that have been read are displayed in a separate color, select the **Mark as read** check box.  
5 From the color palettes, select the color in which to display all articles that have been read.  
6 Click **OK** to save the changes.                                                                                                                                                                                                 |
| Format the font of the news details section                     | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 Select the **News Detail** tab.  
3 From the **Font Type** and **Font Size** drop-down lists, select a font and font size.  
4 From the **Font color** palette, select a font color.  
5 You can also select the **Italic** and **Bold** check boxes to display the text in italics and bold, respectively.  
6 Click **OK** to save the changes.                                                                                                                                                                                                 |
| Choose the background color of the news details section         | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
2 Select the **News Detail** tab.  
3 From the **Background color** drop-down list, select a color for the background of the news details section.  
4 Click **OK** to save the changes.                                                                                                                                                                                                 |
Formatting an RSS Reader widget for a mobile device

The RSS Reader widget is available to be displayed on a mobile device with MicroStrategy Mobile.

For steps to create and format an RSS Reader widget for a mobile device, see the *MicroStrategy Mobile Design and Administration Guide*.

Formatting a Thermometer widget

For an image of a Thermometer widget and steps to add one to a document, see *Creating a Thermometer widget, page 274*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine whether the details of the first news item are displayed by default</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Select the News Detail tab.</td>
</tr>
<tr>
<td></td>
<td>3 To display the details of the first news item when the widget is initially opened, select the Show the first item by default check box.</td>
</tr>
<tr>
<td></td>
<td>4 Click OK to save the changes.</td>
</tr>
<tr>
<td>Determine whether the time and date of a news item are displayed when you hover the cursor over it</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Select the News Detail tab.</td>
</tr>
<tr>
<td></td>
<td>3 To determine whether the time and date of a news item are displayed when you hover the cursor over it, select the Update item detail on rollover check box.</td>
</tr>
<tr>
<td></td>
<td>4 Click OK to save the changes.</td>
</tr>
</tbody>
</table>
The table below lists the different aspects of the Thermometer widget that you can format, and describes the steps to format them in MicroStrategy Web.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the colors and shading scheme of the thermometer                                                              | 1 In Flash Mode, right-click the widget and select Properties. The Thermometer dialog box opens.  
2 From the Thermometer Type drop-down list, select a shading scheme for the thermometer.  
3 Click OK to save the changes.                                                                                                                                                                                                                     |
| Determine the numbers that appear at the bottom and top of the thermometer (the minimum and maximum values)               | 1 In Flash Mode, right-click the widget and select Properties. The Thermometer dialog box opens.  
2 In the Min Value and Max Value fields, type the minimum and maximum values for the thermometer.  
3 Click OK to save the changes.                                                                                                                                                                                                                     |
| Determine whether to apply formatting inherited from the widget’s underlying graph report                               | 1 In Editable Mode, right-click the widget, point to View Mode, and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 From the Graph type drop-down list, select Vertical Bar.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.  
5 Click Apply, then click OK to return to the widget.  
6 In Flash Mode, right-click the widget and select Properties. The Thermometer dialog box opens.  
7 Do one of the following:  
• To apply formatting from the widget’s underlying graph, select the Inherit grid formatting check box.  
• To display the widget without inheriting formatting, clear the Inherit grid formatting check box.  
8 Click OK to save the changes.                                                                                                                                                                                                                     |

**Formatting a Time Series Slider widget**

For an image of a Time Series Slider widget and steps to add one to a document, see *Creating a Time Series Slider widget, page 276.*
The table below lists the different aspects of the Time Series Slider widget that you can format, and describes the steps to format them in MicroStrategy Web.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Display the graph legend inside or outside the graph                                        | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select or clear the **Display legend outside of graph** check box.  
3 Click **OK** to save the changes.                                                                 |
| Maintain height of the Y-axis or have it resize automatically                               | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select or clear the **Enable fixed Y-axis** check box.  
If this check box is selected, the Y-axis of the primary graph remains at a fixed height regardless of the data or any changes to the data.  
If this check box is cleared, the Y-axis automatically resizes based on the data that is displayed.  
3 Click **OK** to save the changes.                                                                 |
| View only a subset of the dataset on the graph                                              | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select the **Enable Data Sampling** check box.  
If this check box is selected, an equally dispersed set of X-axis values are displayed on the graph to give you an overall impression about the graph’s values.  
3 Click **OK** to save the changes.                                                                 |
| Display all series as line graphs                                                          | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select the **All series as line graphs** check box.  
3 Click **OK** to save the changes.                                                                 |
| Define the slider position                                                                 | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Do one of the following:  
• To save the slider position, select the **Save Slider Position** option. When this document is saved and re-executed, the most recent slider position is used to determine what range is displayed.  
• To set a default slider position, select the **Set Default Slider Position** option. Then choose one of the following:  
  Select **Entire Available Range** to display the entire graph.  
  Select **Last Points in the Range** and type a number in the field to specify the total number of data points to display, starting from the last point in the graph. For example, type 5 in the field to display the last five data points in the graph.  
3 Click **OK** to save the changes.                                                                 |
Formatting a Waterfall widget

For an image of a Waterfall widget and steps to add one to a document, see Creating a Waterfall widget, page 278.

The table below lists the different aspects of the Waterfall widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different...
views and modes, page 285. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine colors and shadow effects for the increments and decrements bars | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.  
2 Click the Color tab.  
3 Select the Apply Increment/Decrement Color check box.  
4 Select a color for the increments bars from the Increments Base Color drop-down list.  
5 Select a color for the decrements bars from the Decrements Base Color drop-down list.  
6 Select or clear the Apply Shadow Effect on Bars check box.  
7 Click OK to save the changes.  
The first increment/decrement series uses the base color, and subsequent series are colored in a shade of the base color. If the base color is dark, additional series use lighter shades; if the base color is light, additional series use darker shades. |
| Determine border color | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.  
2 On the Color tab, select a color from the Border color palette.  
3 Click OK to save the changes. |
| Determine whether increments and decrements are calculated by the widget or based on the metrics | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.  
2 Click the Data tab.  
3 Do one of the following:  
• If the data contains the amounts of increase or decrease per period, select the Increments/Decrements Provided check box to display the increment or decrement data. To use this setting, the widget should contain metrics on the rows and attributes on the columns, which allows you to place the metrics along the X-axis in a specified order. This displays the increment and decrement bars in the order specified.  
• To have the widget calculate the increments or decrements, clear the Increments/Decrements Provided check box. To use this setting, the widget should contain metrics in the columns and attributes in the rows. The metrics should depict the total value of each unit of time.  
4 Click OK to save the changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine whether the final bar (located on the far right of the widget) is calculated by</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.</td>
</tr>
<tr>
<td>the widget or provided by the Grid/Graph data</td>
<td>2 Click the Data tab.</td>
</tr>
<tr>
<td></td>
<td>3 Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• If the data contains the information for the final bar, select the Final Bar Provided check box.</td>
</tr>
<tr>
<td></td>
<td>• If you want the widget to calculate the final bar, clear the Final Bar Provided check box. You can also define a name for the final bar (see below).</td>
</tr>
<tr>
<td></td>
<td>4 Click OK to save the changes.</td>
</tr>
<tr>
<td>Provide a label or name for the final bar</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.</td>
</tr>
<tr>
<td>The name is used as a label for the bar on the far right of the widget. By default, it is</td>
<td>2 Click the Data tab.</td>
</tr>
<tr>
<td>named Final. This option is available only if the final bar is calculated by the widget</td>
<td>3 Specify the label text in the Text for Last Entry field.</td>
</tr>
<tr>
<td>(see above).</td>
<td>4 Click OK to save the changes.</td>
</tr>
<tr>
<td>Determine whether lines connecting adjacent bars of the same series are displayed</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.</td>
</tr>
<tr>
<td>This option is available only if the widget contains a single series.</td>
<td>2 Click the Data tab.</td>
</tr>
<tr>
<td></td>
<td>3 Select or clear the Add Connecting Lines check box.</td>
</tr>
<tr>
<td></td>
<td>4 Click OK to save the changes.</td>
</tr>
<tr>
<td>Determine whether to show additional series in tooltips</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.</td>
</tr>
<tr>
<td>This option is available only if the Grid/Graph contains attributes and metrics on</td>
<td>2 Click the Data tab.</td>
</tr>
<tr>
<td>different axes.</td>
<td>3 Select or clear the Show Additional Series in Tooltip check box.</td>
</tr>
<tr>
<td></td>
<td>4 Click OK to save the changes.</td>
</tr>
<tr>
<td>Determine whether to display X-axis labels on a single line or on staggered lines</td>
<td>1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Waterfall dialog box opens.</td>
</tr>
<tr>
<td>Staggering labels allows all labels to be visible if they do not all fit below the</td>
<td>2 Click the Data tab.</td>
</tr>
<tr>
<td>widget when in a single line.</td>
<td>3 Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To stagger X-axis labels if all the labels do not fit below the widget, select the Stagger But Do Not Drop X-Axis Labels check box. All labels are</td>
</tr>
<tr>
<td></td>
<td>removed from the widget.</td>
</tr>
<tr>
<td></td>
<td>• To display the labels on a single line, clear the Stagger But Do Not Drop X-Axis Labels check box. Labels that do not fit are not displayed.</td>
</tr>
<tr>
<td></td>
<td>4 Click OK to save the changes.</td>
</tr>
</tbody>
</table>
### What to Format in the Widget | How to Format It
--- | ---
Determine whether horizontal target lines are displayed in the widget, and the number of target lines to display | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens. 2. Click the **Data** tab. 3. Do one of the following:  - To hide the target lines, select 0 in the **Number of Target Lines** field.  - To display horizontal target lines, select the number of lines in the **Number of Target Lines** field. 4. Click **OK** to save the changes. 5. If target lines are displayed, you can move the target lines up and down in the widget.

Determine whether “what-if” analysis is enabled | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens. 2. Click the **What-if** tab. 3. Select or clear the **Enable What-if Analysis** check box. 4. Click **OK** to save the changes. 5. Use the steps below to enable bar handlers so users can modify the size of bars to perform a what-if analysis.

Determine whether bar handlers are displayed | 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens. 2. Click the **What-if** tab. 3. Select or clear the **Show Bar Handlers** check box. 4. Click **OK** to save the changes.

Determine whether to apply formatting inherited from the widget’s underlying graph report | 1. In **Editable Mode**, right-click the widget, point to **View Mode**, and select **Graph View**. 2. From the **Format** menu, select **Graph**. The Format: Graph dialog box opens. 3. From the **Graph type** drop-down list, select **Vertical Bar**. 4. Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click **Help**. 5. Click **Apply**, then click **OK** to return to the widget. 6. In **Flash Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens. 7. Do one of the following:  - To apply formatting from the widget’s underlying graph, select the **Inherit grid formatting** check box.  - To display the widget without inheriting formatting, clear the **Inherit grid formatting** check box. 8. Click **OK** to save the changes.
Formatting a Weighted List Viewer widget

For an image of a Weighted List Viewer widget and steps to add one to a document, see *Creating a Weighted List Viewer widget, page 282.*

The table below lists the different aspects of the Weighted List Viewer widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 285.* For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the band colors in the widget | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Properties dialog box opens.  
2 Choose colors from the Band 1, Band 2, and Band 3 color palettes. If only two color bands are enabled, then Band 2 is not available.  
3 Click OK to save the changes. |
| Determine whether two or three color bands are displayed | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Properties dialog box opens.  
2 Select or clear the Use only two bands check box.  
3 Click OK to save the changes. |
| Show or hide the lines on the stacked graph on the left side of the widget | 1 In Flash Mode or Interactive Mode, right-click the widget and select Properties. The Properties dialog box opens.  
2 Select or clear the Graph gridlines check box.  
3 Click OK to save the changes. |
### What to Format in the Widget

<table>
<thead>
<tr>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apply a glass-like effect to the widget</strong></td>
</tr>
</tbody>
</table>
| 1. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Properties dialog box opens.  
2. Select or clear the **Glass effect** check box.  
3. Click **OK** to save the changes.  |
| **Determine whether to apply formatting inherited from the widget’s underlying graph report**         |
| The following formatting can be inherited from the underlying graph:                                  |
| • Number formatting                                                                                 |
| • Font type and color                                                                                 |
| • Background and border color of the widget                                                          |
| • Legend formatting, including background color, border color, and font used to display items in the legend |
| 1. In **Editable Mode**, right-click the widget, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.  
2. Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click **Help**.  
3. Click **OK** to return to the widget.  
4. In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Properties**. The Weighted List Viewer dialog box opens.  
5. Do one of the following:  
   • To apply formatting from the widget’s underlying graph, select the **Inherit grid formatting** check box.  
   • To display the widget without inheriting formatting, clear the **Inherit grid formatting** check box.  
6. Click **OK** to save the changes. |
VIEWING DATA RELATED TO WIDGETS: USING WIDGETS AS SELECTORS

Introduction

When a user clicks an element in a widget, data related to that element can be automatically displayed in other grid and graph reports on the dashboard. To enable this, you make the widget a selector, and the grid or graph report a target. When the user clicks the selector, all targets automatically display data related to what the user clicked. For example, clicking a bubble for the Southeast region in an Interactive Bubble Graph widget automatically updates all target grid and graph reports and panel stacks on the same dashboard, which now display Southeast data.

Widgets that can be designated as selectors are described in this chapter, along with how users interact with them when they are designated as a selector. This chapter also contains steps to designate a widget as a selector in a dashboard. For basic descriptions and images of the different types of widgets, as well as steps to create the widget, see Chapter 5, Providing Flash Analysis and Interactivity: Widgets. For an introduction to selectors, see Chapter 4, Providing Interactivity to Users: Selectors.

To view and interact with widgets, you must have a supported version of Flash Player. See the MicroStrategy Readme file for a list of supported versions.
For details on using other objects in a dashboard as a selector, such as an attribute, metric, custom group, or consolidation, see *Enabling Grid/Graphs as selectors to control other Grid/Graphs, page 183.*

**Using widgets as selectors**

You can use report objects on the widget's template as selectors. This allows a user to select which elements to display in other grid and graph reports and panel stacks in the dashboard. The widget is used as a selector targeting a grid or graph report or panel stack.

For an introduction to all types of selectors, including examples, see *Chapter 4, Providing Interactivity to Users: Selectors.*

You can create selectors from the following widgets:

- Bubble Grid, page 354
- Data Cloud, page 355
- Graph Matrix (deprecated), page 355
- Heat Map, page 357
- Interactive Bubble Graph, page 358
- Interactive Stacked Graph, page 360
- Microcharts, page 362
- Time Series Slider, page 362
- Waterfall, page 366
- Weighted List Viewer, page 366

For steps to designate a widget to be used as a selector, see *Creating the widget used as a selector, page 367.*

**Using a Bubble Grid widget as a selector**

You can enable the bubbles of a Bubble Grid widget as selectors, so that clicking a bubble displays data related to it in all target Grid/Graphs and panel stacks in the dashboard.
For example, an attribute in the widget is enabled as a selector. The elements of that attribute are displayed as bubbles in the widget. An analyst can click a bubble to update target Grid/Graphs and panel stacks in the dashboards.

You can also enable the data labels along the X and Y axes of a Bubble Grid widget as selectors.

To create a Bubble Grid widget, see *Creating a Bubble Grid widget, page 198*. For steps to enable a Bubble Grid widget as a selector, see *Creating the widget used as a selector, page 367*.

**Using a Data Cloud widget as a selector**

The attribute elements displayed in a Data Cloud widget can be defined as selectors. Users can click attribute elements within the widget (in Flash or Interactive modes in MicroStrategy Web) to display related data in targeted grid and graph reports and panel stacks in the dashboard.

If an attribute element has been designated to be used as a selector, the cursor changes to a hand pointer. For example, if the Region attribute is defined as a selector, the elements Northeast and Southeast can be used as selectors.

To create a Data Cloud widget, see *Creating a Data Cloud widget, page 202*. For steps to enable a Data Cloud widget as a selector, see *Creating the widget used as a selector, page 367*.

**Using a Graph Matrix (deprecated) widget as a selector**

A Graph Matrix (deprecated) widget consists of several attributes and elements in its column and row headers, and corresponding graphs at the intersection of those objects. You can enable these attributes, elements, graphs, and attribute names displayed in column headers as selectors. This allows an analyst to select an attribute, an attribute element, or a graph, and then view specific data related to it in grid and graphs in the dashboard. An analyst can also view data related to elements from different attributes simultaneously by clicking those elements.
The following scenarios describe how Graph Matrix (deprecated) widgets can be used as selectors:

- When you hover the cursor over an attribute name or attribute element that is enabled as a selector, the attribute name or element becomes a hyperlink. If you select the attribute name or element, all target Grid/Graphs and panel stacks display data related to it.

For example, the Electronics category and Southeast region are selected in the Graph Matrix (deprecated) widget below. Therefore, data related to the Southeast region and Electronics category is displayed in the target Grid/Graph on the right.

You cannot select multiple elements from the same attribute. If you select an attribute name from the headers, all corresponding attribute element selections are cleared. For example, if you select Category in the widget above, the Electronics category is no longer highlighted and data for all categories is displayed in the target Grid/Graph on the right.

The Category and Region attributes in the Graph Matrix (deprecated) widget can be used as selectors because they are enabled as selectors in
Editable Mode, as shown below. Notice that all categories and regions are hyperlinked because they are enabled as selectors.

- When you hover the cursor over a graph in the widget, the cursor is displayed as a hand pointer to indicate that the graph is a selector. If you click the graph, the two corresponding attribute elements in the headers are automatically selected. Therefore, all target Grid/Graphs and panel stacks display data related to those two elements. For example, if you select the graph at the intersection of the Mid-Atlantic region and Electronics product category, all data for Electronics sales in the Mid-Atlantic region is displayed.

- When you hover the cursor over a graph and click a specific data point in the graph, all data related to that data point is displayed in all target Grid/Graphs and panel stacks only if the time-based attribute on the Grid/Graph that contains the widget is enabled as a selector. You can also perform this task after maximizing a graph.

To create a Graph Matrix (deprecated) widget, see *Creating a Graph Matrix (deprecated) widget, page 230*. For steps to enable a Graph Matrix (deprecated) widget as a selector, see *Creating the widget used as a selector, page 367*.

**Using a Heat Map widget as a selector**

Report objects in a Heat Map widget can be defined as selectors, as described in *Creating the widget used as a selector, page 367*. In Flash Mode or Interactive Mode in MicroStrategy Web, users can interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard.
You can use any related area headers or rectangles in the widget as selectors. A user can hover over and select a header or rectangle in the widget to display related data in target Grid/Graphs and panel stacks. If a rectangle or header can be used as a selector, the cursor changes to a hand pointer. For example, if the Category attribute is defined as a selector, the Category header can be used as a selector. If an additional attribute such as Region is also enabled as a selector, individual rectangles can be used as selectors. All data in target Grid/Graphs and panel stacks is updated after a user selects the header or rectangle.

To create a Heat Map widget, see Creating a Heat Map widget, page 236. To use a Heat Map widget as a selector, see Creating the widget used as a selector, page 367.

Using an Interactive Bubble Graph widget as a selector

Report objects in an Interactive Bubble Graph widget can be defined as selectors, as described in Creating the widget used as a selector, page 367. In Flash Mode or Interactive Mode in MicroStrategy Web, users can interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard.

The following parts of an Interactive Bubble Graph widget can be used as selectors to display data in Grid/Graphs and panel stacks:

- The **bubbles** in the widget can be used as selectors if their corresponding attributes are enabled as selectors in the Grid/Graph that contains the widget.

  For example, in Flash Mode or Interactive Mode, a user can click a Northeast region bubble to display Northeast data in all target Grid/Graphs and panel stacks.

  In Flash Mode or Interactive Mode, a user can double-click a bubble to drill down to the child elements of that bubble and to display data in the dashboard related to the bubble. To display data related to the drill-to element, a user can click the child bubble. All target Grid/Graphs and panel stacks are updated with data related to the selection. For more information about drilling in an Interactive Bubble Graph widget, see Supporting drilling in an Interactive Bubble Graph widget, page 245.

- The **attribute elements in the legend** can be used as selectors if the columns of the Grid/Graph that contains the widget have an attribute that is enabled as a selector.
In Flash Mode or Interactive Mode, a user can click an attribute element in the legend. Only one item in the legend can be selected at a time. For example, a user can click the legend item for the Central region to display data for the Central region in all target Grid/Graphs and panel stacks.

When a user hovers the cursor over these selectable parts of the widget, the cursor turns into a hand, indicating that it can be selected.

For example, the Region attribute in the Interactive Bubble Graph widget below is enabled as a selector. When you select a region bubble from the widget, the target graph at the bottom is updated with data related to that region.

A user can also select multiple bubbles, by dragging a selection box (or lasso) around the bubbles. For example, a user drags a selection box around the two Electronics and Books bubbles in the middle of the widget. If the selection...
box is set to automatically update the target, the target graph displays data related to those bubbles. Otherwise, the user must click the Select icon in the button bar to update the target graph.

To use a widget as a selector, you first choose the target Grid/Graph and/or panel stack in Desktop. You can also do this in Design Mode or Editable Mode in MicroStrategy Web.

In Flash Mode or Interactive Mode in MicroStrategy Web, you can ensure that target Grid/Graphs and panel stacks are updated when a user hovers over a bubble or an item in the legend, instead of clicking it.

To create an Interactive Bubble Graph widget, see Creating an Interactive Bubble Graph widget, page 243. To enable an Interactive Bubble Graph widget as a selector, see Creating the widget used as a selector, page 367.

Using an Interactive Stacked Graph widget as a selector

Report objects in an Interactive Stacked Graph widget can be defined as selectors, as described in Creating the widget used as a selector, page 367. In Flash Mode in MicroStrategy Web, users can interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard.

The following parts of an Interactive Stacked Graph widget can be used as selectors to display data in Grid/Graphs and panel stacks in the dashboard:

- **The attribute elements in the legend on the left** can be used as selectors if one or more of the attributes on the columns of the Grid/Graph that contains the widget are enabled as selectors. A user can choose only one attribute element to update the target panel stacks and Grid/Graphs.

  If more than one element is chosen, only data related to the last element selected is displayed in the target panel stacks and Grid/Graphs.

- **The area graphs** can be used as selectors if the attribute used to generate the graph series is enabled as a selector. A user can select only one graph at a time.
For example, the Region attribute in an Interactive Stacked Graph widget is enabled as a selector. When a user selects a region from the widget, the target grid is updated with data related to that region.

<table>
<thead>
<tr>
<th>Region</th>
<th>Visible</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast Revenue</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic Revenue</td>
<td></td>
</tr>
<tr>
<td>Southeast Revenue</td>
<td></td>
</tr>
<tr>
<td>Central Revenue</td>
<td>✔️</td>
</tr>
<tr>
<td>South Revenue</td>
<td></td>
</tr>
<tr>
<td>Northwest Revenue</td>
<td>✔️</td>
</tr>
<tr>
<td>Southwest Revenue</td>
<td>✔️</td>
</tr>
<tr>
<td>Web Revenue</td>
<td></td>
</tr>
</tbody>
</table>

To use a widget as a selector, you first choose the target Grid/Graph and/or panel stack in Desktop. You can also do this in Design Mode or Editable Mode in MicroStrategy Web. For an Interactive Stacked Graph widget, you must then switch to Flash Mode in MicroStrategy Web to determine which part of the widget is enabled as a selector. In Flash Mode, you can also ensure that target Grid/Graphs and panel stacks are updated when a user hovers over the graph or legend, instead of clicking it.

To create an Interactive Stacked Graph widget, see *Creating an Interactive Stacked Graph widget, page 249*. To enable an Interactive Stacked Graph widget as a selector, see *Creating the widget used as a selector, page 367*. 

© 2012 MicroStrategy, Inc.
Using a Microcharts widget as a selector

The Grid/Graph that contains a Microcharts widget often consists of several attributes in the row headers and the elements of those attributes in the rows. You can enable these attributes and elements as selectors to allow analysts to select an attribute or element and view specific data related to it in other Grid/Graphs in the dashboard.

When an analyst hovers the cursor over an attribute element that is enabled as a selector, it becomes a hand pointer to indicate that a link exists. When the link is clicked, all target Grid/Graphs on the dashboard are updated with a set of data related to the attribute element that was clicked. For example, if you click Southeast, all data related to the Southeast region is displayed in the target Grid/Graphs on the dashboard.

Each attribute element in the Grid/Graph, including the attribute names in the row headers, can act as a selector. When you click an attribute name displayed in a row header, all elements of that attribute are selected. This overrides the selection of any of the individual attribute elements. The background color of the attribute in the row header appears in gray to indicate that the attribute is selected.

Note the following:

- Metric columns cannot be used as selectors.
- When multiple attributes are set as selectors, the selections occur independently of each other.

You can also use the sparklines and bar charts in the widget as selectors by enabling a time-based attribute, such as Month, on the Grid/Graph as a selector. When you hover the cursor over a sparkline or bar chart, and then click a specific data point, all data related to that data point is displayed in all target Grid/Graphs and panel stacks in the dashboard.

To create a Microcharts widget, see Creating a Microcharts widget, page 257. To enable a Microcharts widget as a selector, see Creating the widget used as a selector, page 367.

Using a Time Series Slider widget as a selector

Report objects on a Time Series Slider widget can be defined as selectors. In Flash Mode in MicroStrategy Web, users can then interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard.
In Desktop, or in Design Mode or Editable Mode in MicroStrategy Web, you must define one or more of the objects on the Grid/Graph that contains the widget as selectors. Next, switch to Flash Mode to use the primary graph at the bottom of the widget as a selector. A user can hover over and select an individual data point in the graph to display related data in the target Grid/Graphs and panel stacks. For example, a user can select the data point for January 2006 revenue, and all data in the target Grid/Graphs and panel stacks is updated.

The following dashboard is shown in Flash Mode in MicroStrategy Web. Revenue data related to the last data point in the Time Series Slider widget, in this case December 2009, is shown in the grid report below the widget.

<table>
<thead>
<tr>
<th>Month</th>
<th>Average Revenue</th>
<th>Last Month's Revenue</th>
<th>Last Quarter's Revenue</th>
<th>Last Year's Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dec 2009</td>
<td>$386,903</td>
<td>$1,506,296</td>
<td>$1,288,219</td>
<td>$1,087,697</td>
</tr>
</tbody>
</table>
If you click the data point for January 2009, the grid report displays the revenue data related to that date, as shown below.

![Chart showing revenue data for January 2009]

This example uses the primary graph as the selector, but you can change it to use the slider instead. Instead of clicking a single data point (in this case, a single month) you can instead select a range of months. In the following
example, the slider is set to January 2009 through June 2009, and the grid report displays the data for that time frame.

![Slider Example](image)

<table>
<thead>
<tr>
<th>Month</th>
<th>Metrics</th>
<th>Average Revenue</th>
<th>Last Month's</th>
<th>Last Quarter's</th>
<th>Last Year's</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 2009</td>
<td>$246,277</td>
<td>$1,087,697</td>
<td>$1,083,047</td>
<td>$749,779</td>
<td></td>
</tr>
<tr>
<td>Feb 2009</td>
<td>$253,657</td>
<td>$985,107</td>
<td>$1,096,324</td>
<td>$851,921</td>
<td></td>
</tr>
<tr>
<td>Mar 2009</td>
<td>$278,064</td>
<td>$1,014,628</td>
<td>$1,087,697</td>
<td>$897,056</td>
<td></td>
</tr>
<tr>
<td>Apr 2009</td>
<td>$231,064</td>
<td>$1,112,254</td>
<td>$985,107</td>
<td>$827,244</td>
<td></td>
</tr>
<tr>
<td>May 2009</td>
<td>$303,776</td>
<td>$1,124,255</td>
<td>$1,014,628</td>
<td>$892,637</td>
<td></td>
</tr>
<tr>
<td>Jun 2009</td>
<td>$231,280</td>
<td>$1,215,105</td>
<td>$1,112,254</td>
<td>$964,882</td>
<td></td>
</tr>
</tbody>
</table>

To change from using the primary graph as the selector to using the slider, you must format the settings of the widget in Flash Mode in MicroStrategy Web. For more information, see the *MicroStrategy Web Help*.

While the widget in this example targets a Grid/Graph, it could target multiple Grid/Graphs, a panel stack, or multiple panel stacks instead.

To use a widget as a selector, you first choose the target Grid/Graph and/or panel stack in Desktop. You can also do this in Design Mode or Editable Mode in MicroStrategy Web.

In Flash Mode in MicroStrategy Web, you can ensure that target Grid/Graphs and panel stacks are updated when a user hovers over a data point in the primary graph, instead of clicking the data point.

To create a Time Series Slider widget, see *Creating a Time Series Slider widget, page 276*. To enable a Time Series Slider widget as a selector, see *Creating the widget used as a selector, page 367*. 
Using a Waterfall widget as a selector

You can enable the bars of a Waterfall widget as selectors. In Flash Mode or Interactive Mode in MicroStrategy Web, users can click a bar or a section of a bar to display data related to it in all target Grid/Graphs and panel stacks in the dashboard.

For example, an attribute is placed on the columns of the Grid/Graph that contains the widget. This attribute is then enabled as a selector. The elements of that attribute are displayed in the widget’s legend in Flash Mode or Interactive Mode. An analyst can select items from the legend to update target Grid/Graphs and panel stacks in the dashboard. Metrics on a Waterfall widget can also be used as selectors.

To create a Waterfall widget, see Creating a Waterfall widget, page 278. To enable a Waterfall widget as a selector, see Creating the widget used as a selector, page 367.

Using a Weighted List Viewer widget as a selector

The grid in a Weighted List Viewer widget often consists of several attributes in the column headers and the elements of those attributes in the rows. You can enable these attributes and elements as selectors. This allows an analyst to select an attribute or an element, and then view specific data related to it in grids and graphs in the dashboard.

When you click an attribute element that is enabled as a selector, any targeted grids and graphs are updated with a set of data related to the attribute element. For example, if you click Southeast, all data related to the Southeast region is displayed in the grids and graphs on the dashboard. You can select elements from different attributes simultaneously by clicking those elements. However, you cannot select multiple elements from the same attribute.

Each column in the grid, including the column headers, can act as a selector. When you click an attribute name displayed in a column header, all elements of that attribute are selected. This overrides the selection of any of the individual attribute elements within the column. The background color of the attribute changes to a lighter shade to indicate that the attribute is selected.

When two or more attributes in the widget are set as selectors, both of the selections occur independently of each other.
The stacked contribution bar graph on the left side of the widget can also be used as a selector. When you hover the cursor over the graph, the cursor is displayed as a hand pointer to indicate that the graph is a selector. Since each section of the graph represents a row in the grid, the graph can be used to trigger all of the selectors enabled in the widget. Clicking a section of the stacked graph updates the Grid/Graphs within the dashboard with a set of data related to the attribute element you clicked.

If only one attribute is set as a selector in the stacked graph, when you click that section in the graph, the dashboard displays data for only that attribute’s elements.

To create a Weighted List Viewer widget, see *Creating a Weighted List Viewer widget, page 282*. To enable a Weighted List Viewer widget as a selector, see *Creating the widget used as a selector, page 367*.

### Creating the widget used as a selector

This section provides steps to designate the target Grid/Graph or panel stack as a selector.

### Enabling widgets to be used as selectors

To enable a widget to be used as a selector, the widget must be a Bubble Grid, Data Cloud, Heat Map, Interactive Bubble Graph, Interactive Stacked Graph, Time Series Slider, or Waterfall widget.

**Prerequisites**

- You have already created a widget that contains the report objects to use as selectors. For steps, see *To convert a Grid/Graph into a widget, page 293*.
- You have created the panel stack or Grid/Graph to use as the target. For steps, see *Inserting a panel stack, page 70*.
- The selector and target must have an attribute in common.
To use a widget as a selector

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. Select the Grid/Graph containing the widget.

3. Do one of the following:
   • Right-click the attribute, custom group, or consolidation in the Grid/Graph to use as the selector, and choose Use as Selector.
   • Right-click the Metrics column in the Grid/Graph, and choose Use as Selector.

4. Right-click the object or the Metrics column used as a selector, and choose Edit Selector. The Configure Selector dialog box opens.

5. Select the target Grid/Graph or panel stack in the list of available controls on the left. Click > to add it to the list of selected targets on the right. You can select multiple targets.

   The attribute, custom group, or consolidation that you selected in the Grid/Graph is the source, and the selected Grid/Graph is the target. The Action Type of the selector is set to Select Element.

   If targets are automatically maintained, the available and selected target lists are unavailable. For more information about automatically maintaining targets and steps to enable or disable automatic targets, see Automatically maintaining targets for selectors, page 134.

6. Determine whether the selector filters or slices the data, by selecting or clearing the Apply selections as a filter check box. The difference is briefly described below; for more details on the differences, including examples, see Applying selections as filters or slices, page 126.

   • The selections made in a filtering selector are used to filter the underlying dataset before the metric values are aggregated at the level of the Grid/Graph that is displayed in the document.
   • The selections made in a slicing selector are used to determine which slices of data are combined and shown in the Grid/Graph.

   The Apply selections as a filter check box is unavailable and cleared if you selected the Metrics column as the selector.
To ensure that the user can select more than one element in the widget, select the **Show option for All** check box.

Note the following:

- The data labels along the X and Y axes of a Bubble Grid widget can be used as selectors if the **Show option for All** check box is selected.
- The attribute names in the headers of a Graph Matrix (deprecated) widget, Microcharts widget, or Weighted List widget can be used as selectors if the **Show option for All** check box is selected.
- A user can select more than one element from the checklist in the Interactive Stacked Graph widget if the **Show option for All** check box is selected.
- The attribute elements in the legend of a Waterfall widget can be used as selectors if the **Show option for All** check box is selected.

If the selector slices the data (the **Apply selections as a filter** check box is cleared), the **Show option for Total** check box is available. This check box specifies whether the Total option is shown, which allows the user to display totals. For an example and more details, see *Showing totals for selectors, page 163*.

If the selector slices the data (the **Apply selections as a filter** check box is cleared), the **Automatically update when there is no data for the current selection** check box is available. This check box determines how the target displays when no data exists. For an example, see *Determining how the target of a selector displays when no data exists, page 149*.

- To display a message that no data is returned, clear the check box.
- To display an item, select the check box.

Click **OK** to apply the changes and return to the dashboard.

Press **ESC** to exit edit mode.

If you enabled an Interactive Stacked Graph widget as a selector, you must complete the steps to designate which part of the widget is enabled as a selector. You can also determine whether the target updates when the user hovers his cursor over the location. For steps, see *Designating sections of an Interactive Stacked Graph widget as a selector, page 370*.

If you enabled a Time Series Slider or Interactive Bubble Graph widget as a selector, you can designate whether the target updates when the user
hovers his cursor over the location. For steps, see *Ensuring targets are updated with hovering rather than clicking, page 371.*

**Designating sections of an Interactive Stacked Graph widget as a selector**

After you complete the steps to enable an Interactive Stacked Graph widget as a selector, you must complete the following steps to determine whether the graph or the legend serves as the selector on which the user clicks.

You can also determine whether the target is updated when the user hovers his cursor over the graph or legend, instead of requiring the user to click on the graph or legend.

**Prerequisites**

- The Interactive Stacked Graph widget has been enabled as a selector. For steps, see *Enabling widgets to be used as selectors, page 367.*
- Flash Mode must be enabled for the dashboard. For steps, see *Determining the display modes users can choose to work in, page 56.*

---

**To determine which part of an Interactive Stacked Graph widget is enabled as a selector**

1. In MicroStrategy Web, open the dashboard in **Flash Mode**.
2. Right-click the widget and select **Properties**. The Properties dialog box opens.
3. From the **Selectable Area** drop-down list, select **Graph** or **Legend**.
4. You can determine that target Grid/Graphs and panel stacks are updated when a user hovers over the cursor over the graph or legend. To do so, select the **Change Selection on Mouse Over** check box.
5. Click **OK** to apply the changes.
Ensuring targets are updated with hovering rather than clicking

For a Time Series Slider widget, an Interactive Bubble Graph widget, and an Interactive Stacked Graph widget, you can determine that target Grid/Graphs and panel stacks are updated when a user hovers the cursor over the widget instead of requiring the user to click.

Specifically, the target can be updated when the user hovers the cursor over the following:

- A data point in the primary graph of a Time Series Slider widget.
- A bubble or an item in the legend of an Interactive Bubble Graph widget.
- The graph or legend of an Interactive Stacked Graph widget.

**Prerequisites**

- The widget has been enabled as a selector. For steps, see *Enabling widgets to be used as selectors, page 367.*
- Flash Mode must be enabled for the dashboard. For steps, see *Determining the display modes users can choose to work in, page 56.*

**To ensure that targets are updated when a user hovers the cursor over the widget**

1. In MicroStrategy Web, open the dashboard in Flash Mode.
2. Right-click the widget and select Properties. The Properties dialog box opens.
3. Select the Change Selection on Mouse Over check box.
4. Click OK to apply the changes.
Introduction

A dashboard is a special type of document, commonly one page long and usually viewed online. Dashboards contain interactive features that allow analysts to control how they view data. Each user can interact with the dashboard to display only the data they are interested in (using panels and selectors) or only specific attribute elements or metrics (using a selector).

Dashboards are often used to assess performance, to provide a quick status check, or to monitor contributions to overall goals of the business. Dashboards summarize key business indicators by presenting them in visually intuitive, easy-to-read, interactive documents.

This appendix walks you through creating a dashboard that incorporates widgets in a panel stack, using data from the MicroStrategy Tutorial. You can use this appendix as a tutorial, bringing together the information described in the chapters of this book to create a dashboard.
Before you begin

This appendix assumes that you know how to create reports and documents, and that you are familiar with the terminology and basic concepts of documents and dashboards.

• For instructions on creating reports, refer to the Desktop Help or the MicroStrategy Basic Reporting Guide.
• For instructions on creating a document, refer to the Desktop Help or the Document Creation Guide.
• For background information on dashboards, refer to Chapter 2, Designing Dynamic Enterprise Dashboards.

To format some parts of widgets and to view the dashboard in Flash Mode, you must be able to access and log in to MicroStrategy Web.

Dates in the MicroStrategy Tutorial project metadata are updated to reflect the current year. The sample dashboards and images in this section, as well as the procedures, were created with dates from 2004 to 2006.

The completed dashboard

The dashboard uses a panel stack that contains three panels. Each panel is shown below with a description.

It may be helpful to print these images and refer to them as you create your own dashboard.

Panel 1: Daily Order Count

The Daily Order Count panel contains two widgets which are based on the Daily Order Count dataset. The widgets are:

• A Time Series Slider widget, which is an area graph that allows a dashboard analyst to choose which section of the graph to view at a time.

This widget displays order count data at the day level. You can change the specific days which are displayed, as well as the length of time displayed. For example, you can view the data for January, for February, or for January through March.
Dashboards and Widgets Creation Guide

- A Gauge widget, which is a simple status indicator, such as a car speedometer, that displays a needle that moves within a range of numbers displayed on its outside edges.

This widget displays the profit margin percentage at the category level, independent of time. You can select which category to display.

Exploring the Daily Order Count panel, page 390 describes this panel in more detail, providing instructions to guide you through the various features. This section assumes you have already created the dashboard. Directions to create the panel begin in Creating the Daily Order Count panel, page 380.

Panel 2: Inventory Analysis

The Inventory Analysis panel contains one widget, a Heat Map widget. The widget is based on a dataset that calculates a Growth metric from the Beginning on Hand Inventory and the End on Hand Inventory data. The Heat Map widget shows the monthly increase or decrease in inventory for each item, weighted by the Beginning on Hand Inventory. It allows you to
visualize the growth of inventory across time. You can choose which month to display by using the selector.

Notice the scroll bars. The heat map is too wide and long to appear in the browser window, so the entire widget is not displayed in the image.

A Heat Map widget presents a combination of colored rectangles, each representing an attribute element (Growth in this example), that allow you to quickly grasp the state and impact of a large number of variables at the same time. The rectangles contain a wide variety of shades and colors, which emphasize the status of the various components. In a Heat Map, the size of each rectangle represents its relative weight and the color represents the relative change in value of that rectangle.

_Exploring the Inventory Analysis panel, page 400_ describes this widget in more detail, providing instructions to guide you through the various features. This section assumes you have already created the dashboard. Directions to create this widget begin in _Creating the Inventory Analysis panel, page 393_.

**Panel 3: Employee Performance**

The Employee Performance panel contains one widget, a Interactive Bubble Graph widget. This widget allows you to visualize employee performance,
animated over time, and also to drill into the components of individual bubbles to view the distribution of the underlying data.

The bubbles represent custom group elements, which are created from groups of selected call centers. For example, the element Northeast consists of the Boston and New York call centers. The size of the bubbles indicates the number of units sold, while the position on the graph indicates the profit and revenue at the employee level. The color of the bubbles indicates the year, as shown on the color key at the bottom left.

Unlike the previous widgets, this widget does not use a selector. However, drilling has been enabled so if you click a bubble, the widget drills down to the call centers that comprise the custom group element.

*Exploring the Employee Performance panel, page 412* describes this widget in more detail, providing instructions to guide you through the various features. This section assumes you have already created the dashboard. Directions to create this widget begin in *Creating the Employee Performance panel, page 403.*
High-level steps

You will create reports to be used as datasets for the dashboard, and then use these datasets to create a dashboard. You will add a panel stack with three panels, and then add and define different widgets to the panels. You will display the dashboard in Flash Mode in MicroStrategy Web to interact with the widgets. The goal is to create a single dashboard that intelligently, efficiently, and interactively displays all of the data contained within the individual datasets.

The high-level steps for this procedure are outlined below. While each step is self-contained, the steps are meant to be completed in order.

- You should save the reports and dashboard in a folder, such as My Reports or Shared Reports, that can be accessed from MicroStrategy Web.

Creating the Daily Order Count panel

1. Creating the Daily Order Count report to be used as a dataset, page 380
2. Creating the new dashboard and selecting the dataset, page 380
3. Adding a panel stack and panels to the dashboard, page 381
4. Adding a selector to the dashboard, page 384
5. Creating a Time Series Slider widget, page 384
6. Adding a Gauge widget, page 386
7. Creating a selector for the Gauge widget, page 388
8. Specifying Flash Mode as the default display mode, page 389
9. Saving the dashboard, page 390
10. Viewing the Daily Order Count panel in Flash Mode in MicroStrategy Web, page 390
Creating the Inventory Analysis panel

11 Creating the Inventory Analysis report to be used as a dataset, page 393
12 Adding a dataset to the dashboard, page 393
13 Switching panels in Design View, page 394
14 Renaming and formatting a panel, page 394
15 Creating a Heat Map widget, page 395
16 Creating a selector for the Heat Map widget, page 398
17 Saving the dashboard, page 399
18 Viewing the Inventory Analysis panel in Flash Mode in MicroStrategy Web, page 399

Creating the Employee Performance panel

19 Creating a custom group, page 403
20 Creating the Employee Performance report to be used as a dataset, page 406
21 Adding a dataset to the dashboard, page 407
22 Switching panels in Design View, page 407
23 Renaming and formatting a panel, page 408
24 Creating a Bubble Graph widget, page 409
25 Saving the dashboard, page 410
26 Viewing the Employee Performance panel in Flash Mode in MicroStrategy Web, page 411
27 Enabling drilling and time series animation, page 411
Creating the Daily Order Count panel

Creating the Daily Order Count report to be used as a dataset

The data for a document or dashboard is derived from a report, so the preliminary step to creating any dashboard is to create a report. When the data from a report is used in a dashboard, the report is referred to as a dataset. For more information on datasets, see About Visual Insight: Analyses, page 19.

To create the report

1. In MicroStrategy Desktop, point to New from the File menu, and then select Report. The Report Editor opens. If the New Grid dialog box opens, select Blank Report as the report object template.

2. Add the following objects to the rows of the grid:
   - Category (from the Products hierarchy)
   - Day (from the Time hierarchy)

3. Add the following metrics to the columns of the grid:
   - Order Count (from the Public Objects\Metrics\Count Metrics folder)
   - Profit Margin (from the Public Objects\Metrics\Sales Metrics folder)

4. Save and close the report, naming it Daily Order Count Dataset Report.

Creating the new dashboard and selecting the dataset

Next, create the shell of the new dashboard and select the report that you just created as the dataset. Recall that the dataset provides data for the dashboard.
To create the new dashboard and select the dataset

1. In MicroStrategy Desktop, point to New from the File menu, and then select Document. The New Document dialog box opens.

2. Select Blank Dashboard and click OK. The Select a report dialog box opens.

3. To use the report that you just created as a dataset for this dashboard, navigate to the Daily Order Count Dataset Report and double-click it. The Document Editor opens.

Notice that the Layout area contains only one section, as dictated by the Blank Dashboard template. This is ideal for creating a dashboard, when all the different header and footer sections are unnecessary. For more information about the template, see Creating a dashboard: the Blank Dashboard template, page 49.

You can display additional sections by selecting Sections from the View menu, and then choosing the sections to display. For a more complete procedure, see the Desktop Help.

The Datasets pane contains the Daily Order Count Dataset Report and all the objects on that report. These objects, as well as the dataset itself, are available for use on the dashboard.

Adding a panel stack and panels to the dashboard

Next, create a panel stack, which initially contains one panel. A panel is a “page” or subset of data. A group of panels is called a panel stack. For more information about panels and panel stacks, including examples, see Chapter 3, Layering Data: Panels and Panel Stacks.

You will also add two more panels to the panel stack. In the dashboard, each panel contains at least one widget that offers the user a unique data visualization.
To add a panel stack

1. From the Insert menu, select Panel Stack. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click in the Layout area to add the panel stack.

3. Right-click the panel stack and select Properties. The Properties dialog box opens.

4. On the Layout tab, position and size the panel stack by setting the following options:
   - Left: .15 inches
   - Top: .35 inches
   - Height: 5.7 inches
   - Width: 10.1 inches

To resize the height of the title bar

5. Set Title height to .2 inches.

6. Click OK to return to the dashboard.

To add panels to the panel stack

7. Next, add a panel to the panel stack. Right-click the panel stack, point to Panels, and select Add.

8. Add a third panel by repeating the previous step.

To rename a panel

Panel names are displayed in the title bar and in the selector associated with the panel stack, so it is important to make them meaningful.

9. Right-click the panel stack, point to Panels, and select Manage. The Panels tab of the Properties dialog box opens.

10. Select Panel1 in the list of panels.

11. Click Rename.
12 Type **Daily Order Count** in the panel list, and then press **ENTER**.

   **To set the current panel to Daily Order Count**

13 Select **Daily Order Count** in the list of panels.

14 Click **Set as Current**.

15 Click **OK** to return to the dashboard.

   Notice that the title bar of the panel stack displays “Daily Order Count” (you may have to scroll the Layout area to the right to view it). Since all the panels are identical right now, this is the only indication as to which panel is being displayed.

   **To apply a gradient color to the current panel (Panel1)**

16 Right-click the panel stack and select **Format**. The Format Objects dialog box opens.

17 Select **Container** in the list of objects on the left.

18 Click the **Background** tab.

19 Select **Gradient** from the **Background style** drop-down list.

20 Select **Sea Green** from the **Color 1** drop-down list (the color name appears when you hover over the color swatches).

21 Select **Grey-25%** from the **Color 2** drop-down list.

   **To format the title bar**

22 Select **Title** in the list of objects on the left.

23 Click the **Font** tab.

24 Set **Size** to 8.

25 Set **Color** to **White**.

26 Click the **Background** tab.

27 Select **Black** from the Fill color drop-down list.

28 Click **OK** to return to the dashboard.
Adding a selector to the dashboard

A selector allows the user to control which panel is displayed in Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web. Selectors provide dashboards with interactivity, allowing each user to change how he sees the data. For more information about selectors, including examples, see Chapter 4, Providing Interactivity to Users: Selectors.

To add a selector

1. Right-click the panel stack and choose Insert Panel Stack Selector. The selector is created above the panel stack.

2. Right-click the selector and choose Properties. The Properties dialog box opens.

3. On the Layout tab, position and size the selector by setting the following options:
   - **Left**: .15 inches
   - **Top**: .05 inches
   - **Height**: .3 inches
   - **Width**: 5.0 inches

4. Click the Selector tab.

5. From the Style drop-down list, choose Button Bar.

6. Set Orientation to Horizontal.

7. Click OK to return to the dashboard.

Creating a Time Series Slider widget

To create a widget in Desktop, you must first insert a Grid/Graph into a dashboard and add report objects such as attributes and metrics to it. You then select a widget type for the Grid/Graph. In Flash Mode in Web, the Grid/Graph is displayed as a widget, and users can control how they view the data on it.
A Time Series Slider widget requires only one attribute, preferably one with many values. This attribute is normally time-based, although it does not have to be. In this dashboard, only one attribute, Day, is used. The widget also requires only one metric; Order Count is used in this widget. For more information about Time Series Slider widgets, see *Creating a Time Series Slider widget, page 276*.

---

**To create a Time Series Slider widget**

1. Create an empty Grid/Graph by selecting **Grid** from the **Insert** menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.

3. Drag **Day** from the Datasets pane and drop it on the row axis of the Grid/Graph, as shown below:

4. Drag **Order Count** from the Datasets pane and drop it on the column axis of the Grid/Graph, as shown below:

5. Format the Day attribute:
   a. From the **Format** menu, point to **Day**, and then select **Values**. The Format Cells dialog box opens.
   b. On the **Number** tab, select **Date** in the **Category** list.
   c. In the **Formatting** list, select **7/19/00**.
   d. Click **OK**.
6 The Grid/Graph is in edit mode, as indicated by its red hashed border. Press **ESC** to exit edit mode.

7 Right-click the Grid/Graph and choose **Properties**. The Properties dialog box opens.

8 On the Layout tab, set the following options to position and size the Grid/Graph:
   - **Left**: 1.5 inches
   - **Top**: .2 inches
   - **Height**: 5.25 inches
   - **Width**: 8.6 inches

9 On the **Flash** tab, turn the Grid/Graph into a widget:
   - Select **Time Series Slider** from the **Selected widget** drop-down list.

10 Click **OK** to return to the dashboard.

---

**Adding a Gauge widget**

Like creating the Time Series widget, to create a Gauge widget you must create a Grid/Graph and then turn it into a widget.

A Gauge widget is designed to display the value of a single metric, in this example, Profit Margin. The needle within the gauge is a visual representation of that single metric value. The Gauge widget is most useful when combined with a selector because then users can display specific metric values in the gauge. After you create the Gauge widget, you will create a selector for it. For more information on Gauge widgets, see *Creating a Gauge widget, page 228*.

---

**To add a Gauge widget**

1 Create an empty Grid/Graph by selecting **Grid** from the **Insert** menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2 Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.
3 Drag **Profit Margin** from the Datasets pane and drop it on the column axis of the Grid/Graph.

4 The Grid/Graph is in edit mode, as indicated by its red hashed border. Press **ESC** to exit edit mode.

5 Right-click the Grid/Graph and choose **Properties**. The Properties dialog box opens.

6 On the Layout tab, set the following options to position and size the Grid/Graph:

   - **Left**: .1 inches
   - **Top**: 2 inches
   - **Height**: 1.7 inches
   - **Width**: 1.3 inches

7 On the Flash tab, turn the Grid/Graph into a widget:
   - Select **Gauge** from the **Selected widget** drop-down list.

8 Click **OK** to return to the dashboard.

**To format the Gauge widget**

You must format the Grid/Graph that is used as the Gauge widget, so that it appears correctly in Flash Mode.

9 In the Property List, set **View mode** to **Graph**.

10 Right-click the Grid/Graph and select **Edit Graph**.

11 From the **Graph** menu, select **Grids and Scales**. The Numeric Axis Grids and Scales dialog box opens.

12 Click the **Y1 Axis** tab on the left.

13 Click the **Scales** tab at the top.

14 Select the **Use Manual Setting for Maximum Value** check box.

15 In the **Maximum Value** field, enter 1.

16 Click the **Numbers** tab at the top.
17 Choose **Percent** from the **Category** drop-down list.

18 Set **Decimal Places** to 0.

19 Click **OK**.

20 Press **ESC** to exit edit mode.

21 Note the name of the Grid/Graph at the top of the Property List; it should be GridGraph2. You will need to know this name to create the selector for this Grid/Graph.

### Creating a selector for the Gauge widget

A Gauge widget is most useful when combined with a selector because then users can display specific metric values in the gauge. The selector for the Gauge widget allows users to choose which category to display in the gauge. For more information on selectors in general, see *Chapter 4, Providing Interactivity to Users: Selectors*.

---

**To create a selector**

1. From the **Insert** menu, point to **Selector**, and then choose **Link Bar**. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click in the Layout area to add the selector.

3. Right-click the selector and choose **Properties**. The Properties dialog box opens.

4. On the Layout tab, set the following options to position and size the selector:
   - **Left**: .08 inches
   - **Top**: .5 inches
   - **Height**: 1.45 inches
   - **Width**: 1.3 inches

5. Click the **Selector** tab.
Set **Action type** to **Select attribute element**.

Select **Category** as the **Source**, so that the user can change the category.

Select **Link Bar** as the **Style**.

Select **Vertical** for the **Orientation**.

By default, the selector shows the All option, which allows the user to display all the attribute elements in the Target at the same time. Clear the **Show option for All** check box so that the all categories link is not available in the selector.

Clear the **Allow multiple selections** check box, so that a user cannot select more than one category at the same time.

Set the Gauge widget as the target of the selector:

- Select **GridGraph2** (or the name of the Grid/Graph, as noted previously) in **Available targets**.
- Click > to move GridGraph2 to Selected targets.

Click **OK** to return to the dashboard.

**Specifying Flash Mode as the default display mode**

Flash Mode in MicroStrategy Web allows you to view and interact with the widgets you have created on the dashboard. Flash Mode is automatically available for dashboards created using the Blank Dashboard template. Specifying Flash Mode as the default display mode ensures that the dashboard opens in Flash Mode in MicroStrategy Web. For more information on Flash Mode and other MicroStrategy Web display modes, see *Display modes in MicroStrategy Web, page 8*.

**To specify Flash Mode as the default display mode**

1. From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.

2. On the Document tab, select the **Default** radio button for **Flash**. The dashboard will initially open in Flash Mode in MicroStrategy Web.
3 Click **OK** to return to the dashboard.

## Saving the dashboard

Save the dashboard in a directory that you can access from MicroStrategy Web, such as My Reports.

### To save the dashboard

1. Save and close the dashboard, naming it **Dashboard Sample**.

## Viewing the Daily Order Count panel in Flash Mode in MicroStrategy Web

To interact with the widgets, you must view the dashboard in Flash Mode in MicroStrategy Web. Use Full Screen Mode to maximize the amount of the dashboard that is displayed.

### To view the dashboard in Flash Mode


2. Navigate to the Dashboard Sample dashboard in your project, and click **Dashboard Sample**. The dashboard opens in Flash Mode.

3. Switch to Full Screen mode by clicking the **Full Screen Mode** button in the toolbar. Most of the MicroStrategy toolbars and panels are hidden, which maximizes the amount of the dashboard that can be shown at the same time.

   To display the toolbars and panels, click the **Restore Normal Screen Mode** button in the toolbar.

## Exploring the Daily Order Count panel

The Gauge widget allows you to monitor the value of a single metric, in this case, Profit Margin. The selector for the Gauge widget displays a list of
categories. Click Movies to change the category displayed in the gauge; note the gauge needle moves to about 10%. Click Books, and the gauge needle now points to just above 20%. Notice that the transition between the data points is animated fluidly.

Notice that the date range for the bar graph (the Time Series Slider widget) runs from 9/13/06 to 12/31/06.

Dates in the MicroStrategy Tutorial project metadata are updated to reflect the current year. The sample was created with 2006 dates; your Tutorial project may contain different dates.

A Time Series Slider widget consists of two related graphs, one positioned above the other.

- The top graph is the controller, and contains a slider. To open the controller, hover your cursor over the down arrow at the top of the time series graph (the area graph).

- The bottom graph is the primary graph. Use the slider on the controller to select some portion of the controller, which determines the range of data visible in the primary graph.

The following sample shows the controller.
The slider allows you to change the range of dates and the length of time that is displayed. For example, click and drag the bottom of the slider (which is circled in the image above) to change the range of dates displayed. The bottom graph dynamically displays the data for the dates. To change the length of time displayed, drag an edge of the slider (as indicated by the arrows in the image above). For example, the sample below displays data for the period 1/15/2005 to 5/3/2006. Notice that the length of the slider is longer than in the previous sample, indicating a longer length of time that is displayed in the bottom graph.

Notice also that the cursor is hovered over a particular day, 8/8/2005, and a pop-up displays information for that day.

A series of tabs is displayed across the top of the dashboard. Daily Order Count is selected. Click Panel2. A blank rectangle is displayed, since no objects have been added to this panel. The next section of this tutorial contains the procedures to define this panel.

You can log out of MicroStrategy Web, as you will be working in Desktop again.
Creating the Inventory Analysis panel

Creating the Inventory Analysis report to be used as a dataset

Inventory data is not included on the Daily Order Count report you created earlier. However, you can have multiple datasets on the same dashboard. To use inventory data on the dashboard, create a report to be used as a dataset. For more information on datasets, see About Visual Insight: Analyses, page 19.

To create the report


   If the New Grid dialog box opens, select Blank Report as the report object template.

2. Add the following attributes to the rows of the grid:
   - Month (from the Time hierarchy)
   - Category (from the Products hierarchy)
   - Item (from the Products hierarchy)

3. Add the following metrics to the columns of the grid:
   - Begin on Hand (from the Public Objects\Metrics\Inventory Metrics folder)
   - End on Hand (from the Public Objects\Metrics\Inventory Metrics folder)

4. Save and close the report, naming it Inventory Analysis Dataset Report.

Adding a dataset to the dashboard

Add the dataset report to the dashboard to access the inventory data.
To add a dataset

1. If the Dashboard Sample dashboard is not open, open it in the Document Editor in Desktop.

2. From the Data menu, select Add Dataset. The Select a report dialog box opens.

3. Locate and select the Inventory Analysis Dataset Report.

4. Click Open.

   The dataset and all the objects on that report are now displayed in the Datasets pane.

Switching panels in Design View

The first panel, Daily Order Count, is displayed. The inventory data needs to be added to a separate panel.

To switch panels

1. Right-click the panel stack, point to Panels, and then choose Display Next.

   Panel2 is displayed (you may have to scroll to the right to see its name on the title bar). Panel2 is a blank rectangle, without any objects.

   This also sets Panel2 as the current panel. When you open the dashboard in MicroStrategy Web, this panel will be displayed initially, rather than Daily Order Count.

Renaming and formatting a panel

The default name of the panel, Panel2, is not very informative. Rename it to be more useful. Also, the white background is dull, so apply a gradient for a more professional look.
To rename a panel

1. Right-click the panel stack, point to Panels, and then select Manage. The Panels tab of the Properties dialog box opens.

2. Select Panel2 in the list of panels.

3. Click Rename.

4. Type Inventory Analysis, and then press ENTER.

5. Click OK to return to the dashboard.

To apply a gradient to a panel

1. Right-click the panel and select Format. The Formatting Objects dialog box opens.

2. Select Container in the list of objects on the left.

3. Click the Background tab.

4. From the Background style drop-down list, select Gradient.

5. Select Light Turquoise from the Color 1 drop-down list (the color name appears when you hover over the color swatches).

6. Select Light Green from the Color 2 drop-down list.

7. Click OK to return to the dashboard.

Creating a Heat Map widget

As with the other widgets for this dashboard, to create a Heat Map widget you must first create a Grid/Graph and then turn it into a widget.

A Heat Map widget must have one or more attributes on the rows of the Grid/Graph and two metrics on the columns. For an in-depth explanation of what the different objects on the widget represent, see Creating a Heat Map widget, page 236.
The Grid/Graph used as the Heat Map widget must contain the percentage growth of inventory in a month, otherwise the heat map will not display properly. The inventory growth is computed by subtracting the beginning inventory from the ending inventory, and then dividing by the beginning inventory. While this metric is not present on the dataset, it can be calculated from the metrics on the dataset, Begin on Hand and End on Hand. A new metric created from the metrics on the dataset is called a derived metric. For a brief description of the various types of metrics that you can create in dashboards, including derived metrics, see *Objects in a document: Controls, page 11*; for a more in-depth discussion, including a comparison between derived metrics and calculated expressions, see the *Document Creation Guide* or *Desktop Help*. 

To create a Heat Map widget

1. Create an empty Grid/Graph by selecting **Grid** from the **Insert** menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.

3. Drag the following from the Datasets pane to the row axis of the Grid/Graph:
   - **Category**
   - **Item**

4. Drag **Begin on Hand** from the Datasets pane and drop it on the column axis of the Grid/Graph.

5. The Grid/Graph is in edit mode, as indicated by its red hashed border. Press **ESC** to exit edit mode.

6. Right-click the Grid/Graph and choose **Properties**. The Properties dialog box opens.

7. On the Layout tab, set the following options to position and size the Grid/Graph:
   - **Left**: .04 inches
   - **Top**: .4 inches
   - **Height**: 5 inches
• **Width**: 11 inches

8 Click **OK** to return to the dashboard.

**To create a derived metric**

9 Right-click **Inventory Analysis Dataset Report** in the Datasets pane and select **New Metric**. The Input Metric Formula dialog box opens.

10 Double-click **End on Hand** in the list on the left, to add it to the metric expression.

11 Click the minus sign (−) in the toolbar.

12 Double-click **Begin on Hand** in the list on the left.

13 Click the division symbol (/) on the toolbar.

14 Double-click **Begin on Hand** in the list on the left.

15 The metric expression should look like the following:

\[
\frac{([\text{End on hand}] - [\text{Begin on Hand}])}{[\text{Begin on Hand}]}
\]

16 Click **Validate** to ensure that the expression is complete. If the expression is not valid, click **Clear** to delete the entire expression and start again, or modify the expression until it is valid.

17 In the Metric Name text field on the upper right, type **Percent Growth**.

18 Click **OK** to add the new metric to the dashboard. The Input Metric Formula dialog box closes. The new metric is added to the Inventory Analysis Dataset Report in the Datasets pane.

19 Right-click Percent Growth in the Datasets pane and select **Number Format**. The Number Format dialog box opens.

20 In the **Category** list, select **Percent**.

21 Set **Decimal places** to 0 (zero).

22 Click **OK** to return to the dashboard.

23 Select the Grid/Graph.
24 Drag Percent Growth from the Datasets pane and drop it on the column axis of the Grid/Graph.

25 The Grid/Graph is once again in edit mode, as indicated by its red hashed border; press ESC to exit edit mode.

To turn the Grid/Graph into a widget

26 Select the Grid/Graph.

27 In the Property List, choose Heat Map from the Selected widget drop-down list.

28 Note the name of the Grid/Graph at the top of the Property List; it should be GridGraph3. You will need to know this name to create the selector for this widget.

Creating a selector for the Heat Map widget

A dynamic Heat Map widget has a selector that targets or controls it. The selector allows a user to choose a different attribute element to be displayed by the heat map. For information on dynamic Heat Map widgets, see Creating a Heat Map widget, page 236. For more information on selectors in general, see Chapter 4, Providing Interactivity to Users: Selectors.

To create a selector

1 From the Insert menu, point to Selector, and then choose Drop-down. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2 Click in the Layout area to add the selector.

3 Right-click the selector and choose Properties. The Properties dialog box opens.

4 On the Layout tab, set the following options to position and size the selector:
   • Left: .1 inches
   • Top: .1 inches
- **Height**: .25 inches  
- **Width**: 2 inches

5. Click the **Selector** tab.

6. Set **Action type** to **Select attribute element**.

7. Select **Month** as the **Source**, so that the user can change the month.

8. Clear the **Show option for All** check box, so that the user cannot select all the months at the same time.

9. Set the Heat Map widget as the target of the selector:
   a. Select **GridGraph3** (or the name of the Grid/Graph, as noted previously) in **Available targets**.
   b. Click > to move GridGraph2 to Selected targets.

10. Click **OK** to return to the dashboard.

**Saving the dashboard**

Save the dashboard so that you can view the new widget in MicroStrategy Web.

**Viewing the Inventory Analysis panel in Flash Mode in MicroStrategy Web**

To interact with the widgets, you must view the dashboard in Flash Mode in MicroStrategy Web.

---

**To view the dashboard in Flash Mode**


2. Navigate to the Dashboard Sample dashboard in your project, and click **Dashboard Sample**. The dashboard opens in Flash Mode.
Switch to Full Screen mode by clicking the **Full Screen Mode** button in the toolbar. Most of the MicroStrategy toolbars and panels are hidden, which maximizes the amount of the dashboard that can be shown at the same time.

To display the toolbars and panels, click the **Restore Normal Screen Mode** button in the toolbar.

---

**Exploring the Inventory Analysis panel**

The Inventory Analysis panel is displayed first. You set it as the current panel, and hence the initial panel, when you switched panels.

The largest rectangles, which themselves contain more rectangles, on the heat map are generated by the first attribute on the rows of the Grid/Graph. This is Category in this sample heat map. In the following image, which shows only a portion of the entire heat map, the Categories displayed are Movies, Books, and Electronics. The smaller rectangles are generated by the second attribute, Item, on the rows of the Grid/Graph.

![Heat Map Image]

The size of each rectangle, large or small, represents its relative weight, as determined by the first metric on the columns of the Grid/Graph, which is Begin on Hand. The portion of the heat map shown above indicates that the Movies category is weighted more heavily than Books. More movies than
books were on hand at the beginning of the month. (The entire Movies rectangle is not shown in this image.)

Similarly, the smaller rectangles are also sized according to the beginning inventory. The rectangles in the first row of the Movies rectangle are larger than the rectangles in the first row of the Books rectangle. This indicates that more copies of each movie were on hand than copies of each book.

The colors displayed in the widget represent the state of the individual items (positive or negative growth). In this heat map, blue denotes positive growth and green denotes negative growth. The colors applied to each rectangle are generated by the second metric on the Grid/Graph, Percent Growth. For example, all the items in the image above had negative growth during the month, since more items were sold than were added to inventory. The exception is one item in Electronics, the Hewlett Packard CD-Writer Plus, displayed in green in the previous image. As shown in the following image, its inventory grew 20%.

In Flash Mode in MicroStrategy Web, you can change the colors used to denote positive and negative growth. For the steps to do this, see Formatting a Heat Map widget, page 318.

When you hover over a rectangle in the heat map, information about that rectangle is displayed. For example, in the sample above, the cursor is pointing to the rectangle representing the Hewlett Packard CD-Writer Plus. The information displays the metric data for that attribute element, in this case, Begin on Hand and Percent Growth.

Compare the data for the Hewlett Packard CD-Writer Plus shown above with the data for the Beatles Anthology displayed below. Note the difference in the size of the rectangles, since the album had 320 copies on hand at the beginning of the month, compared to only 40 CD-Writers. The CD-Writer rectangle is green, representing positive inventory growth, while the album is blue-green, representing a small negative growth. The rectangles around the
title Music are bluer than the Beatles rectangle, because their growth percentage was more negative.

The selector at the top of the panel stack allows you to choose the month to display. The previous images were calculated for January 2004. When November 2004 is selected, the data changes, so the size, position, and color of the rectangles are different. A portion of the November 2004 heat map is shown below. Note that Books is now to the left of Music and is larger than in
January. The rectangle for the Beatles Anthology is about half the size it was in January, and is now greener since its inventory growth is positive, at 32%.

You can log out of MicroStrategy Web, as you will be working in Desktop again.

Creating the Employee Performance panel

Creating a custom group

An Interactive Bubble Graph widget is a conventional bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. The data structure for an interactive bubble graph is very specific. At minimum, one attribute and three metrics are required. The dataset report for this widget contains Month of Year and Region, and the metrics Revenue per Employee, Profit per Employee, and Units Sold.

To enable drilling on a Bubble Graph widget, an additional attribute is added to the dataset report. This attribute must be a child attribute of a parent attribute already on the rows. In this case, the child attribute is a custom group element that contains call centers, and its parent attribute is Region.
The custom group organizes the data in a form that can be used by the Drilling Bubble Graph widget. The data in the grid for the child attribute must be displayed so that the total for the child attribute is in the top row of data, followed by the data for the child attribute. You can specify this structure in a custom group. For a more detailed explanation of these requirements, with examples, see *Supporting drilling using a custom group*, page 245.

The following procedure guides you through creating a custom group with two elements, Northeast and Central. Northeast contains the New York and Boston call centers, while Central contains the Milwaukee and Fargo call centers.

For more information about custom groups in general, see the *MicroStrategy Advanced Reporting Guide*.

---

**To create the custom group**

1. In MicroStrategy Desktop, point to **New** from the **File** menu, and then select **Custom Group**. The Custom Group Editor opens.
   
   If the New Custom Group dialog box opens, select **Empty Custom Group** as the custom group object template.

2. Double-click **Geography (Browsing)** in the Object Browser to open the Geography hierarchy.

   **To create the Northeast element**

3. Drag **Call Center** from the Object Browser and drop it in the Custom Group definition pane (which displays the message “Double-click here or drag an object”). The Attribute Qualification pane opens.

4. To indicate that a list of attribute elements will comprise this custom group element:
   
   a. From the **Qualify On** drop-down list, choose **Elements**.
   
   b. From the ** Operator** drop-down list, choose **In List**.

5. To specify the list of Call Center elements to include:
   
   a. Click **Add**. The Select Objects dialog box opens.
   
   b. In the **Available objects** list, select **Boston** and **New York**.
c  Click > to add them to the Selected objects list.

d  Click OK to return to the Attribute Qualification pane.

6  Click OK to return to the custom group.

7  Right-click Custom Group Element1 and select Rename.

8  Type Northeast and press ENTER.

   To create the Central element

9  Repeat steps 3 through 6 above, selecting Milwaukee and Fargo instead of Boston and New York.

   Drop Call Center on the “Double-click here or drag an object” text, not the “[Add Qualification]” text.

10 Right-click Custom Group Element2 and select Rename.

11 Type Central and press ENTER.

   To format the custom group elements

   To ensure that the Bubble Graph widget works correctly, the custom group elements must be formatted to display data in a format that can be used by the widget.

12 Right-click Northeast and select Show Display Options. The Choose a display option dialog box opens.

13 Select Show element names, individual items within this element and also, expand these individual items if possible.

14 Click OK.

15 Repeat steps 12 through 14 for the Central element.

16 From the Custom Group menu, select Options. The Options dialog box opens.

17 Clear the Enable Hierarchical Display check box.

18 Select the Enable Subtotals Display check box.

19 Ensure that Above child elements is selected for Custom Group Element Header Display Position.
20 Click OK.

To save the custom group

21 Save and close the custom group, naming it Call Center CG.

Creating the Employee Performance report to be used as a dataset

Employee performance data is not included on any of the dataset reports that you created earlier. To use employee performance data on the dashboard, create another report to be used as a dataset. For more information on datasets, see About Visual Insight: Analyses, page 19.

To create the report

1 In MicroStrategy Desktop, point to New from the File menu, and then select Report. The Report Editor opens.

   If the New Grid dialog box opens, select Blank Report as the report object template.

2 Add the following objects to the rows of the grid:
   • Year (from the Time hierarchy)
   • Month of Year (from the Time hierarchy)
   • Region (from the Geography hierarchy)
   • Call Center CG (that you created in the previous procedure)

3 Add the following metrics to the columns of the grid:
   • Units Sold (from the Public Objects\Metrics\Sales Metrics folder)
   • Revenue per Employee (from the Public Objects\Metrics\Sales Metrics folder)
   • Profit per Employee (from the Public Objects\Metrics\Sales Metrics folder)

4 Save and close the report, naming it Employee Performance Dataset Report.
Adding a dataset to the dashboard

To access the employee performance data, add the dataset report to the dashboard.

To add a dataset

1. If the Dashboard Sample dashboard is not open, open it in the Document Editor in Desktop.

2. From the Data menu, select Add Dataset. The Select a report dialog box opens.

3. Locate and select the Employee Performance Dataset Report.

4. Click Open.

   The dataset and all the objects on that report are now displayed in theDatasets pane.

Switching panels in Design View

The Inventory Analysis panel is displayed. The employee performance data needs to be added to a separate panel.

To switch panels

1. Right-click the panel stack, point to Panels, and then choose Display Next.

   Panel3 is displayed (you may have to scroll to the right to see its name on the title bar). Panel3 is a blank rectangle, without any objects.

   This also sets Panel3 as the current panel. When you open the dashboard in MicroStrategy Web, this panel will be displayed initially, rather than Daily Order Count or Inventory Analysis.
Renaming and formatting a panel

The default name of the panel, Panel3, is not very informative. Rename it to be more useful. Also, the white background is dull, so apply a gradient for a more professional look.

To rename a panel

1. Right-click the panel stack, point to Panels, and then select Manage. The Panels tab of the Properties dialog box opens.
2. In the list of panels, select Panel3.
3. Click Rename.
4. Type Employee Performance, and press ENTER.
5. Click OK to return to the dashboard.

To apply a gradient to a panel

1. Right-click the panel and select Format. The Formatting Objects dialog box opens.
2. Select Container in the list of objects on the left.
3. Click the Background tab.
4. From the Background style drop-down list, select Gradient.
5. Select Tan from the Color 1 drop-down list (the color name appears when you hover over the color swatches).
6. Select Dark Teal from the Color 2 drop-down list.
7. Click OK to return to the dashboard.
Creating a Bubble Graph widget

As with creating the other widgets for this dashboard, you must first create a Grid/Graph and then turn it into a widget.

A Bubble Graph widget must have at least one attribute on the rows of the Grid/Graph and three metrics on the columns. These metrics are displayed along the X-axis, Y-axis, and Z-axis (the size of the bubble) of the widget, in order from left to right. In this widget, the X-axis is the Profit per Employee metric, the Y-axis is the Revenue per Employee metric, and the Z-axis is the Units Sold metric.

To display a different color bubble (series) for each attribute element on the bubble graph, an attribute is placed above the three metrics on the columns. In this widget, that attribute is Year. For an in-depth explanation of the different objects on the widget, see Creating an Interactive Bubble Graph widget, page 243.

To enable drilling on the bubble graph, an attribute must be placed to the right of the attribute in the rows. This attribute must be a child of the attribute already on the rows. The custom group you created in Creating a custom group, page 403 provides the correct structure for this attribute. For detailed information on this requirement, with an example, see Supporting drilling using a custom group, page 245.

To create a Bubble Graph widget

1. Create an empty Grid/Graph by selecting **Grid** from the **Insert** menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.

3. Drag the following objects from the Datasets pane to the row axis of the Grid/Graph:
   - **Month of Year**
   - **Region**
   - **Call Center CG**

4. Drag the following objects from the Datasets pane to the column axis of the Grid/Graph:
• Revenue per Employee
• Profit per Employee
• Units Sold
• Year

It is imperative that these objects are placed in the correct order on the Grid/Graph for the widget to work properly. Year must be placed on the columns.

5 The Grid/Graph is in edit mode, as indicated by its red hashed border. Press ESC to exit edit mode.

6 Right-click the Grid/Graph and choose Properties. The Properties dialog box opens.

7 On the Layout tab, set the following options to position and size the Grid/Graph:
   • Left: .04 inches
   • Top: .1 inches
   • Height: 5.3 inches
   • Width: 8.5 inches

8 Click OK to return to the dashboard.

To turn the Grid/Graph into a widget

9 Select the Grid/Graph.

10 In the Property List, choose Interactive Bubble Graph from the Selected widget drop-down list.

Saving the dashboard

Save the dashboard so that you can view the new widget in MicroStrategy Web.
Viewing the Employee Performance panel in Flash Mode in MicroStrategy Web

To interact with the widgets, you must view the dashboard in Flash Mode in MicroStrategy Web.

To view the dashboard in Flash Mode

2. Navigate to the Dashboard Sample dashboard in your project, and click Dashboard Sample. The dashboard opens in Flash Mode.
3. Switch to Full Screen mode by clicking the Full Screen Mode button in the toolbar. Most of the MicroStrategy toolbars and panels are hidden, which maximizes the amount of the dashboard that can be shown at the same time.

To display the toolbars and panels, click the Restore Normal Screen Mode button in the toolbar.

Enabling drilling and time series animation

The widget shows all of the parents (custom group elements) and children (call centers) together. When drilling is enabled, only the custom groups are displayed initially. Users can then drill to the call centers.

For an image of the widget showing the custom group elements and call centers combined, see Panel 3: Employee Performance, page 376.

The time series animation moves the bubble values through time, to provide rapid insight into business trends. A user can run through the entire animation, rewind, fast forward, or move a slider to a specific time. The time range in this widget is January through December.
To enable drilling and time series animation

You must be in Flash Mode in MicroStrategy Web; you cannot enable drilling and time series animation in Desktop or in any other mode in MicroStrategy Web.

1 Right-click the Interactive Bubble Graph widget and select Properties. The Properties dialog box opens.

2 Select the Enable drilling check box.

3 Select the Enable time series analysis check box.

4 Click OK to return to the dashboard.

Exploring the Employee Performance panel

Now that drilling has been enabled, the bubbles represent the custom group elements only. The following image shows that the larger red bubble represents the Northeast. When you hover the cursor over a bubble in the widget, information about that bubble is displayed, as shown below.
The color of the bubbles is derived from the attribute placed on the columns of the Grid/Graph. In this widget, that attribute is Year, as indicated by the color key at the bottom left of the widget. If you hover over a year, the related bubbles are highlighted on the widget.

The metrics on the Grid/Graph determine the position and size of the bubbles, as described below:

- The value of the first metric on the Grid/Graph defines the position of each bubble on the X-axis.
- The value of the second metric defines the position of each bubble on the Y-axis.
- The value of the third metric determines the size of each bubble.

Double-click the January 2006 Northeast bubble to drill down to the call centers that comprise the Northeast (the children). The drilling is animated, so you can follow the bubbles as they split and separate. In the sample below, New York is highlighted. Notice that the bubbles from the earlier view remain for comparison, but are shaded to focus attention on the drilled bubbles.
The widget can display more than one drilled-down attribute. Double-click the January 2005 Northeast bubble, and the widget drills down to the call centers that comprise the Northeast, as shown below.

To return to the original graph, click one of the child bubbles, and the drilled bubbles return to the parent attribute.

The time series animation moves the bubble values through time, in this case from January to December. Note that in the preceding images, January is displayed in the upper right corner. To start the time series animation, hover your cursor at the top left corner of the widget, just below the title bar. Click the play button that appears, and notice the months changing in the upper right corner, and the bubbles moving around the graph.

The time series animation moves the bubble values through time, to provide rapid insight into business trends. A user can run the entire animation, rewind, fast forward, or move a slider to a specific time. In this widget, the time range is from January through December.
The widget in the following image shows the values for May, and also displays the time controls that allow you to interact with the time series animation.

By default, the time controls display only when you hover the cursor over the left corner, but you can choose to always display them.

You can change this setting only in Flash Mode in MicroStrategy Web.

**To always display the time controls for a widget**

1. In Flash Mode, right-click the widget and select **Properties**. The Properties dialog box opens.
2. Clear the **Auto-Hide time controls** check box.
3. Click **OK** to return to the dashboard.
4. Save the dashboard.
Troubleshooting Dashboards

Introduction

This section provides explanations of some of the most common issues you may encounter when creating dashboards, in a question and answer format. For more detailed discussions, refer to the relevant sections of this guide.

Troubleshooting selectors

I cannot change the target of a selector.

Automatic target maintenance is enabled on this layout, which means that all attribute and metric selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector. You can do any of the following:

- Disable automatic target maintenance. This affects the entire layout, so be sure you want to do this. After you disable it, you must manually maintain selector targets. For instructions on disabling this feature, see
Disabling automatic target maintenance to allow manual target selection, page 141.

- When targets are automatically maintained, you can control what target is chosen for a selector, by placing controls in different document sections.

- If you cannot move controls to different document sections, you can place them in different panel stacks in the same document section.

For more information about the last two options, including examples, see Controlling targets when targets are automatically maintained, page 138.

Selector targets have changed in my document.

Automatic target maintenance was probably enabled after you created the selectors. When automatic target maintenance is enabled, the targets of all existing attribute and metric selectors are replaced with all the Grid/Graphs and panel stacks that are in the same panel or document section as the selector. Automatic target maintenance affects all the selectors on a layout. For more information about the effects of automatic target maintenance, see Enabling automatic target maintenance, page 143.

If this is the case, you cannot change the targets unless you disable automatic target maintenance. However, be sure that you do want to disable it. For instructions, see Disabling automatic target maintenance to allow manual target selection, page 141.

When targets are automatically maintained, you can control what target is chosen for a selector by either:

- Moving controls to different document sections
- Placing controls in different panel stacks in the same document section

For more information, including examples, see Controlling targets when targets are automatically maintained, page 138.
Troubleshooting during document execution

I cannot open a document.

If a document has embedded Transaction Services, the document does not open. Instead, a message is displayed, indicating that transaction-enabled documents are not supported in Desktop. Open the document in MicroStrategy Web.

An image does not display in PDF View, when exported to PDF, or in MicroStrategy Mobile.

Ensure that the image is saved in one of the image types listed below; other image types cannot be displayed in PDF View, when exported to PDF, or in MicroStrategy Mobile.

- bmp
- jpg
- jpeg
- gif

If the image file path is using an http reference to a central Web Server machine, such as http://microstrategy/Test/myimage.jpg, ensure that the URL does not contain any spaces. You can remove the space from the image name or replace the space with %20.

For more information about inserting images into documents, see the Document Creation Guide.

Troubleshooting common Flash Mode issues

This section describes some common issues you may encounter as you use Flash Mode while viewing a document. The issues described in this section are not necessarily issues related to defects in the software itself, but rather notes about how Flash Mode is designed to work.
I cannot switch to Flash Mode in MicroStrategy Web; it is not an option in the View menu.

To display a document in Flash Mode in MicroStrategy Web, Flash Mode must be enabled for the document, the user, and the project, as described below.

- A user with the appropriate privileges can enable Flash Mode for a document using either MicroStrategy Web or Desktop. The instructions below are for Desktop.
  a Edit the document in Desktop.
  c In the Available display modes list on the Document tab, select the Flash check box.
  d You can specify that this document always opens in Flash Mode when it is initially opened in Web. To do this, select the Default radio button next to Flash.

- Enable Flash Mode in your User Preferences in MicroStrategy Web.
  a To do this, click the MicroStrategy icon at the top of the page and select Preferences.
  b On the left, click Report Services.
  c Select the Enable Flash Mode check box.

- In MicroStrategy Web, a project administrator can enable Flash Mode for a project, using the project default preference. Contact your project administrator to enable it.

In MicroStrategy Web, a graph displays in Interactive Mode but does not display properly in Flash Mode.

Some graph styles are not supported in Flash Mode. You may also encounter issues with other aspects of graph formatting which are not supported in Flash Mode. If issues such as these occur, you must change the graph style of the report to a supported style.
The following graph styles are the only graph styles supported in Flash Mode:

<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Graph Sub-type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Bar</td>
<td>• Clustered</td>
</tr>
<tr>
<td></td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Percent</td>
</tr>
<tr>
<td></td>
<td>• Stacked</td>
</tr>
<tr>
<td></td>
<td>• Clustered Dual-axis</td>
</tr>
<tr>
<td>Horizontal Bar</td>
<td>• Clustered</td>
</tr>
<tr>
<td></td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Percent</td>
</tr>
<tr>
<td></td>
<td>• Stacked</td>
</tr>
<tr>
<td></td>
<td>• Clustered Dual-axis</td>
</tr>
<tr>
<td>Vertical Line</td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Absolute</td>
</tr>
<tr>
<td>Horizontal Line</td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Dual-axis Absolute</td>
</tr>
<tr>
<td>Vertical Area</td>
<td>• Absolute</td>
</tr>
<tr>
<td></td>
<td>• Percent</td>
</tr>
<tr>
<td></td>
<td>• Stacked</td>
</tr>
<tr>
<td>Horizontal Area</td>
<td>• Absolute</td>
</tr>
<tr>
<td>Pie</td>
<td>• Pie</td>
</tr>
<tr>
<td></td>
<td>• Ring Pie</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Pie graphs may appear slightly larger in Flash Mode than they do in other display modes.</td>
</tr>
<tr>
<td>Stock</td>
<td>• Hi-Low-Open-Close</td>
</tr>
<tr>
<td>Scatter</td>
<td>• X-Y Scatter</td>
</tr>
<tr>
<td></td>
<td>• X-Y Scatter Dual-axis</td>
</tr>
<tr>
<td>Bubble</td>
<td>• Bubble</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The minimum, maximum, and interval settings for the Bubble graph may not be displayed in Flash Mode exactly as it does in other display modes.</td>
</tr>
</tbody>
</table>

Combination graphs that use a combination of only two styles of graph, as long as the graph styles used in the combination are listed in this table. All other combination graphs are not supported.

**Note:** The alignment of the Y-axis labels may appear differently in Flash Mode than they do in other display modes.
Other display issues include the following:

- Nested labels in graphs are not displayed in Flash Mode. If the graph currently uses nested labels, switch to another label type before opening the graph in Flash Mode.

- If a graph legend is positioned manually rather than automatically, the graph legend may not be displayed in exactly the same position in Flash Mode.

- Donut bevel effects for circular data markers in a graph may appear different in Flash mode. For a more consistent look across modes, consider using a different bevel effect, such as Sphere or Smooth Edge.

For more information on working with graphs, see the *MicroStrategy Advanced Reporting Guide*.

**In MicroStrategy Web, an image displays in Interactive Mode but does not display in Flash Mode.**

The image file path may be incorrect or unsupported in Flash Mode. The file location of the image must use an HTTP-based path, not a network or local image path. For information about adding images to documents and using the correct image path, see the *Document Creation Guide*.

**In MicroStrategy Web, a widget is not displayed in Flash Mode.**

The widget may not have been designed correctly. Each widget must contain a specific number of attributes and metrics on its template. For more information on these requirements, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets*.
 auto text code  Dynamic text that is populated by the document or dataset, consisting of the document’s or dataset’s settings rather than data from the data warehouse. Examples of auto text codes, which can be considered as a type of variable, are document name, page number, and execution time. Auto text codes are contained in text field controls on a document.

See also:

• Data field
• Text field

cache  A special data store holding recently accessed information for quick future access. Caching is normally done for frequently requested reports or documents so that they execute faster, because they need not run against the data warehouse. Results from the data warehouse are stored separately and can be used by new job requests that require the same data.

In the MicroStrategy environment, when a user runs a report for the first time, the job is submitted to the database for processing. However, if the results of that report are cached, the results can be returned immediately without having to wait for the database to process the job the next time the report is run.

Document caching generates the document only once—the first time that you execute a document in a specific mode (such as Express Mode or Interactive Mode) in MicroStrategy
Web. Subsequent document executions in the same mode use the cache. If document caching is disabled, the document query is submitted to your data warehouse every time that you execute the document in a different mode.

**calculated expression** A metric obtained dynamically, directly from metrics on a document dataset, by using at least one of the metrics in the document. Calculated expressions allow you to use simple arithmetic operators (+, -, *, /) to combine metrics from different datasets in the document.

See also:

- Derived metric

**conditional formatting** Used to format specified controls in a document depending on predefined criteria. It allows certain settings of controls, including sections, to be controlled by data-driven conditions. Conditional formatting in documents is similar to thresholds in reports.

**control** Any item in the document’s Layout area that you can select. This can be a text field, line, rectangle, image, panel stack, selector, Grid/Graph, or HTML container. These different kinds of controls are referred to as control types.

See also:

- Grid/Graph
- HTML container
- Panel stack
- Selector
- Text field

**control default** A set of options that can be set for each type of control and each section in a document. You can set the defaults according to the control that is currently selected; afterward, its format is applied to any object of the same type that you create in the document.
**dashboard**  
A visually intuitive display of data that summarizes key business indicators for a quick status check. A special type of document, dashboards usually provide interactive features that let users change how they view the dashboard’s data.

**data field**  
Dynamic text that is populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache). A data field is only a reference to the metric, attribute, consolidation, or custom group on a report. Data fields are contained in text field controls on a document.

See also:
- *Auto text code*
- *Text field*

**dataset**  
A MicroStrategy report that retrieves data from the data warehouse or cache. It is used to define the data available on a document.

**Datasets**  
1. A pane in the Document Editor that shows all objects (grouped by datasets) that can be used in the document.

   2. All objects that can be used in the document as supplied by the datasets. Dataset objects are attributes, consolidations, custom groups, and metrics.

**data warehouse**  
1. A database, typically very large, containing the historical data of an enterprise. Used for decision support or business intelligence, it organizes data and allows coordinated updates and loads.

   2. A copy of transaction data specifically structured for query, reporting, and analysis.

**derived metric**  
A metric based on data already available from metrics on a document dataset. It is calculated on the Intelligence Server, not in the database. Use a derived metric to perform calculations on other metrics (column math), on data after it has been returned from the database.
See also:

- **Calculated expression**

**drill** A link from one document to another document, report, or HTML document. Prompt answers for the destination can be included in the drill.

**document** 1. A container for objects representing data coming from one or more reports, as well as positioning and formatting information. A document is used to format data from multiple reports in a single display of presentation quality.

2. The MicroStrategy object that supports the functionality defined in (1).

**Grid/Graph** A control placed in a document that displays information in the same way a MicroStrategy report does.

**grouping** A way to create a hierarchical structure for a document.

**HTML container** A control that either displays real-time information from the web or displays formatted HTML.

**area** The middle panel of the Document Editor in which you place data or other controls to determine the appearance of the document when it is viewed as a PDF.

**link** A connection from a document to another document or a report. A link lets an analyst execute another document or report (the target) from a document (the source), and to pass parameters to answer any prompts that are in the target.

**page-by** Interactively displaying groups on separate pages in PDF View. It allows the end user to dynamically select group elements as criteria for analysis. The PDF that results from this selection is called a page of the original document.
**panel**  A way of grouping data in a document so that users can navigate subsets of data as if the subsets were pages in a smaller document. Each “page”, or layer of data, is a panel; a group of panels is called a panel stack.

**panel stack**  The holder for a collection of panels, or layers of data, in a document. A user can navigate or flip through the panels in a panel stack; only one panel is displayed at a time.

**project**  
1. The MicroStrategy object in which you define all of the schema and application objects, which together provide a flexible reporting environment. A project is the highest-level intersection of a data warehouse, metadata repository, and user community, containing reports, filters, metrics, and functions.

2. An object containing the definition of a project, as defined in (1). The project object is specified when requesting the establishment of a session.

**Property List**  The list of settings used to specify the appearance or any other characteristic of a control on a document.

**selector**  A type of control in a document that allows a user to:

- Flip through the panels in a panel stack, to see different predefined layers of data, or “pages”, in the same document
- Display different attribute elements or metrics in a Grid/Graph

**summary metric**  A shortcut to a subtotal, or a subtotal metric allowing explicit aggregation in documents. A summary metric allows you to select the function to use to calculate the subtotal.
**text field**  A type of control in a document that displays text in the document. These different types of text content are:

- Static text, which does not change and serves as a label
- Dynamic text, which is populated by the document or dataset. There are two types of dynamic text:
  - Data field, which is populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache). A data field is only a reference to an object on a report.
  - Auto text code, which is populated by the document or dataset, consisting of their settings rather than data from the data warehouse
- A combination of any or all of the above types in one text field

See also:

- **Data field**
- **Auto text code**

**widget**  A type of control that presents data in a visual and interactive way; an interactive Flash-only graph that dynamically updates when a new set of data is selected. Some types include Gauge, Heat Map, and Stacked Area widgets.
INDEX

A
analysis (Visual Insight) 19
animation 57
audience for manual xxiii
automatic submission for selectors 146
automatic target maintenance
  panel stack and 68
  target selection mode and 120
automatically applying selector changes 146
automatically maintaining targets for selectors 134
controlling targets 138
disabling 141
enabling 143
panel stack 42
quick switch for a Grid/Graph 45
selector 45
tooltip 45
Blank Document template 53
Bubble Grid widget 198
  creating 199
  example 198
  formatting 303
  using as a selector 354
bullet microchart 258

C
conditional formatting and selector totals 164
current panel of a panel stack 78
control defined on 11
types of 11, 17
cylinder widget 200
  creating 201
  example 30, 201
  formatting 305
D

dashboard defined on 1, 23
  best practices 38, 40
  creating 49
  designing 38
  example 24, 373
  exporting to Flash 55
  formatting 56
  interactive 26
  opening 4
  printing 4
  tutorial 373
  See also document.

Data Cloud widget 202
  creating 203
  example 202
  formatting 305
  Grid/Graph and 204
  link in 204, 296
  using as a selector 355

data layering 62
dataset 9
  best practices 41
  Intelligent Cube 10
  multiple 10
dataset object 17

Date Selection widget 205
  creating as a selector 211
  example 206
  creating as a widget 208
  example 205
  example 205
  formatting 307
  MicroStrategy Mobile 206
  selector vs. widget 207
  widget vs. selector 207

Design Mode 8

Design View (Desktop), opening a document in 4
designing a dashboard 35

Desktop 191
disabling automatic maintenance of selector targets 141
display mode for MicroStrategy Web 8
default 56
  selecting 56
document defined on 1
  creating 9, 10
  dataset 9
  designing xxiii, 2
  does not open 419
  FAQs 417
  multi-layout 19
  previewing for printing 3
  printing 4
document section 17
document template 49
  creating 54
  displaying Object Templates folder 54
  exporting to another project 54
  importing from another project 55
  predefined 49
drilling and selector 110
drilling in an Interactive Bubble Graph widget
  using a custom group 245
  using subtotals 246

E

Editable Mode 8
  enabling 56
  quick switch for a Grid/Graph 33
  selector display 113
  widget display 191
enabling
  automatic maintenance of selector
targets 143
display modes for MicroStrategy
  Web 56
Flash View 5
HTML View 5
transition animation for Flash
  Mode 58

example
dashboard 25, 35, 41, 64, 373
  button bar in 26, 27
filter panel 85
Full Screen mode 58
Grid/Graph
  background when used as a
  selector 186
  controlling another
  Grid/Graph 183
key performance indicators
dashboard 36
multiple dashboards in a single
document 64
panel stack. See also example - panel
  stack. 63
selector. See also example -
  selector. 106
slider in a dashboard 27
widget. See example - widget.
example - panel stack 63
  formatting 92
layering Grid/Graphs 63
panel selector arrows 73
rounded corners 97
title bar 71
example - selector
  attribute 106
  automatic target maintenance 134
    disabling 142
    enabling 143
dynamic text field 108
  element display and sort 167
filtering 127
filtering a metric 123, 124
metric condition 123, 124
panel stack 106
sizing items 174
slicing 127
style 113
title bar 167
updated by another selector 149
example - widget
Bubble Grid 198
Cylinder 30, 201
Data Cloud 202
Date Selection 205
  created as a selector 206
  created as a widget 205
Fish Eye Selector 214
  created as a selector 216
  created as a widget 214
  targeting a panel stack 216
  with images 312
Funnel 227
Gauge 229
Graph Matrix 235
Graph Matrix (deprecated) 230
  used as a selector 356
Heat Map 237
Image Layout 240
Interactive Bubble Graph 33, 189, 244
  used as a selector 359
Interactive Stacked Graph 249
  used as a selector 361
link 295
Media 251
message behind 291
Microcharts 257
Network Visualization 267
### Index

**Dashboards and Widgets Creation Guide**

- **RSS Reader** 270
- **Thermometer** 30, 274
- **Time Series Slider** 276
  - used as a selector 363
- **Waterfall** 279
- **Weighted List Viewer** 282

#### Exporting

- Document as a template to another project 54
- Formatting a panel stack for template to another project 54
- To a browser (HTML) 6
- To Flash 55
  - File format 55
- To HTML 6

#### Express Mode

- Enabling 56
- Filter panel 86

#### Information Window

- 82

#### Internet Explorer version requirements

- 8

#### Panel selector

- 67

#### Selector display

- 113

#### Widget

- 288

### Filtering Selector

- Example 127
- Initial display 109
- Viewed off-line 129

#### Fish Eye Selector

- Creating as a selector 222
- Creating as a widget 219
- Display in various views and modes 218
  - Example 214
  - Panel stack 216
  - Selector 216
  - Widget 214
  - With images 312
  - Formatting 309
  - Images in 312
  - Selector vs. widget 218
  - Widget vs. selector 218
- Fixed size for selector items 174

#### Flash File

- 55

#### Flash Mode

- Enabling 56, 420
- Filter panel 86
- Graph not displaying in 420
- Graph styles supported in 421
- Image not displaying in 422
- Information Window 82
- Selector display 115
  - Custom 180
  - Switching to 420
  - Transition animation 57
  - Troubleshooting 419
  - Widget 189
  - Widget not displaying in 422

#### Flash View (Desktop)

- Enabling 5
- Opening 6
- Prerequisites for 5

#### Flash Widget

- 189

© 2012 MicroStrategy, Inc.
<table>
<thead>
<tr>
<th>Formatting</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best practices</td>
<td>46</td>
</tr>
<tr>
<td>Dashboard</td>
<td>56</td>
</tr>
<tr>
<td>Gauge widget</td>
<td>315</td>
</tr>
<tr>
<td>Selector</td>
<td>170</td>
</tr>
<tr>
<td>Background</td>
<td>177</td>
</tr>
<tr>
<td>Item text</td>
<td>175</td>
</tr>
<tr>
<td>Weighted List Viewer widget</td>
<td>350</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Formatting a widget</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bubble Grid widget</td>
<td>303</td>
</tr>
<tr>
<td>Cylinder widget</td>
<td>305</td>
</tr>
<tr>
<td>Data Cloud widget</td>
<td>305</td>
</tr>
<tr>
<td>Date Selection widget</td>
<td>307</td>
</tr>
<tr>
<td>Fish Eye Selector</td>
<td>309</td>
</tr>
<tr>
<td>Funnel widget</td>
<td>313</td>
</tr>
<tr>
<td>Graph Matrix (deprecated) widget</td>
<td>316</td>
</tr>
<tr>
<td>Heat Map widget</td>
<td>318</td>
</tr>
<tr>
<td>Image Layout widget</td>
<td>321</td>
</tr>
<tr>
<td>Inherited from graph report</td>
<td>301</td>
</tr>
<tr>
<td>Interactive Bubble Graph widget</td>
<td>323</td>
</tr>
<tr>
<td>Interactive Stacked Graph widget</td>
<td>327</td>
</tr>
<tr>
<td>Map widget</td>
<td>328</td>
</tr>
<tr>
<td>Media widget</td>
<td>328</td>
</tr>
<tr>
<td>Microcharts widget</td>
<td>330</td>
</tr>
<tr>
<td>RSS Reader widget</td>
<td>340</td>
</tr>
<tr>
<td>Thermometer widget</td>
<td>343</td>
</tr>
<tr>
<td>Time Series Slider widget</td>
<td>344</td>
</tr>
<tr>
<td>Waterfall widget</td>
<td>346</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Full Screen mode</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting a document to open in</td>
<td>60</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Funnel widget</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating</td>
<td>226</td>
</tr>
<tr>
<td>Example</td>
<td>227</td>
</tr>
<tr>
<td>Formatting</td>
<td>313</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>G</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gauge widget</td>
<td>228</td>
</tr>
<tr>
<td>Creating</td>
<td>229</td>
</tr>
<tr>
<td>Example</td>
<td>229</td>
</tr>
<tr>
<td>Formatting</td>
<td>315</td>
</tr>
<tr>
<td>Google Graph Visualization widget</td>
<td>196</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Graph Matrix (deprecated) widget</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating</td>
<td>233</td>
</tr>
<tr>
<td>Example</td>
<td>230</td>
</tr>
<tr>
<td>Formatting</td>
<td>316</td>
</tr>
<tr>
<td>Using as a selector</td>
<td>355</td>
</tr>
<tr>
<td>Example</td>
<td>356</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Graph Matrix widget</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating</td>
<td>234</td>
</tr>
<tr>
<td>Example</td>
<td>235</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Graph not displaying in Flash Mode</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph styles for a dashboard</td>
<td>34</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Grid/Graph</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Controlling another Grid/Graph</td>
<td>184</td>
</tr>
<tr>
<td>Converting to a widget</td>
<td>292</td>
</tr>
<tr>
<td>Formatting background of selected items</td>
<td>186</td>
</tr>
<tr>
<td>Selector and</td>
<td>106</td>
</tr>
<tr>
<td>Transition animation</td>
<td>57</td>
</tr>
<tr>
<td>Used as a selector</td>
<td>184</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat Map widget</td>
<td>236</td>
</tr>
<tr>
<td>Creating</td>
<td>238</td>
</tr>
<tr>
<td>Example</td>
<td>237</td>
</tr>
<tr>
<td>Formatting</td>
<td>318</td>
</tr>
<tr>
<td>Link in</td>
<td>240, 296</td>
</tr>
<tr>
<td>Using as a selector</td>
<td>357</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HTML container</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML export</td>
<td>6</td>
</tr>
</tbody>
</table>
HTML View (Desktop) 5
   enabling 5
   opening 6
   prerequisites for 5

I
image
   missing in Flash Mode 422
   missing in MicroStrategy Mobile 419
   missing in PDF View 419
   missing when exported to PDF 419
Image Layout widget 240
   creating 241
   example 240
   formatting 321
   MicroStrategy Mobile 241
importing
   document as template from another project 55
   template from another project 55
Information Window 81
   defining 84
   Express Mode 82
   Flash Mode 82
   iPad 81
   panel stack 81
Interactive Bubble Graph widget 243
   creating 247
   data structure 243
   drilling 245
      using a custom group 245
      using subtotals 246
   example 33, 189, 244
   formatting 323
   link in 248, 296
   using as a selector 358
      example 359
   updating targets by hovering 371
interactive dashboard 26
Interactive Mode 8
   enabling 56
   quick switch for a Grid/Graph 33
   selector display 113
   widget 288
Interactive Stacked Graph widget 249
   creating 250
   example 249
   formatting 327
   using as a selector 360
      defining the selector 370
      example 361
   updating targets by hovering 371
international support xxxiii
iPad, Information Window for 82

L
Layout area, controls in 11
layouts of a document 19
linking in a widget
   attribute 295
   creating 298
   Data Cloud 296
   example 295
   Heat Map 296
   Interactive Bubble Graph 296
   Microcharts 297
   prompt answer method 297
loading panels in MicroStrategy Web 79

M
Map Visualization widget 196
Map widget 251
   formatting 328
Media widget 251
   creating 253
   example 251
   formatting 328
   prerequisites 253

metric condition selector 123
   qualification 124
   qualification types 125
   slider 123

Microcharts widget 257
   bar microchart 257
   bullet microchart 258
   creating 259
   example 257
   formatting 330
      bar microchart 334
      bullet microchart 337
      sparkline microchart 336

Grid mode 262
   indented rows 266

KPI List mode 265
   link in 267, 297

microchart types 257

MicroStrategy Mobile 259
   operation modes 258
   sparkline microchart 258
   Ticker mode 263
   using as a selector 362
   Vertical Scroll mode 262

MicroStrategy Mobile
defined on 62
   filter panel 86
      image missing 419
   widget 195

MicroStrategy Web
display mode 56
   filter panel 84
   Full Screen mode 58
   loading panels 79
panel loading 79
   selecting available display modes 56
   selecting default display mode 56
   mobile device, widget for 195
   multi-layout document 19

N

Network Visualization widget 267
   creating 268
   example 267
   MicroStrategy Mobile 268

O

object template 54

P
panel defined on 62
   adding to a panel stack 75
   copying 76
   current 78
   current panel 67
   display order of 77
   exporting all or only current 100
   formatting 91
   loading 79
      current panel only 79
      on demand 79
   pre-loading 79
   renaming 77
panel stack defined on 62, 66
   automatic target maintenance and 68
   best practices 42
   clipped for export 99
   filter panel. See also filter panel. 84
formatting 91, 93
  example 92
  export options 99
  rounded corners 97
Information Window 81
inserting 69, 70
panel selector arrows 73
  displaying 74
  hiding 75
panel. See also panel. 66
  adding to 75
  display order 77
selector and 67, 105
  title bar. See panel stack title bar.
transition animation 57
panel stack title bar 67, 71
  displaying 73
  example 71
  height 75
  hiding 74
PDF export, selector display in 180
PDF View (Desktop) 3
  image missing 419
  opening a document in 4
  panel selector in 67
printing a document 4
prompt answer method 297
proportional selector items 174

Q
quick switch for a Grid/Graph 33
  best practices 45

R
Really Simple Syndication (RSS). See RSS Reader widget.
RSS Reader widget 269
  creating 271
  example 270
  formatting 340
    MicroStrategy Mobile 343
    MicroStrategy Mobile 271

S
SDK widget 196
section of a document 17
selector defined on 105
  All option 148
    renaming 148
  automatically applying changes 146
  automatically applying selector changes 146
  automatically updating when there is no data for the current selection 151
  best practices 45
  cascading 151, 184
    creating 117
  current state. See also selector - current state. 155
  Date Selection widget 205
  disabling autosubmission 146
  drilling and 110
  element form
    displaying 166
    sorting 166
  filter panel and 84
  filtering on metric values 123
  filtering. See filtering selector.
  Fish Eye 214
  Flash-only interactive 205, 214
  formatting. See selector formatting.
  Grid/Graph 106, 121
  initial display 109
  interactive Flash-only 205, 214

© 2012 MicroStrategy, Inc.
metric condition 123
panel stack and 67, 105
PDF export display 180
selection types 132
slicing. See slicing selector.
style 113
target. See also selector target. 117
title bar 167
totals 163
conditional formatting and 164
updating another selector 151
widget as 354
selector - current state
defining 161
filtering selector and 157
multiple targets and 159
slicing selector and 155
selector formatting 170, 172
container vs. title bar 170
item 175, 177
selector item
formatting 175, 177
multiple 145
showing all simultaneously 147
disabling 147
size 174
fixed 174
proportional 174
selector target 117
automatic maintenance 134
widget and 197
cannot be changed 417
display (current state) 155
selection mode 120
setting interactively 120
slicing selector 126
example 127
initial display 110
viewed off-line 129
sparkline microchart 258
Store Layout widget 196
support
international xxxiii
support. See technical support.
T
Table widget 196
target of selector 117
cannot be changed 417
changed 418
target selection mode 120
automatic target maintenance and 120
technical support xxxiv
template 49
creating a document template 54
displaying Object Templates folder 54
exporting to another project 54
importing from another project 55
predefined document template 49
text field 12
Thermometer widget 274
creating 274
example 30, 274
formatting 343
Time Series Slider widget 276
creating 277
example 276
formatting 344
using as a selector 362
example 363
updating targets by hovering 371
Timeline widget 196
title bar 32
panel stack 71
selector 167
totals for a selector 163
conditional formatting and 164
Transaction Services 419
transition 57
transition animation 57
troubleshooting 417
Flash Mode 419
True Type font on UNIX 2
tutorial, dashboard 373

U
UNIX, True Type font on 2
USA Map widget 196

V
viewing a document (PDF View) 3
Visual Insight 19

W
Waterfall widget 278
creating 280
displaying increments and decrements 279
example 279
formatting 346
using as a selector 366
Weighted List Viewer widget 282
creating 283
example 282
formatting 350
using as a selector 366
widget defined on 189
automatic target maintenance for a selector and 197
creating, prerequisites for 197
custom display. See also widget display. 285
displaying a message behind 291
example 291
formatting. See also formatting a widget. 302
Grid/Graph converted to 292
linking. See also linking in a widget. 295
MicroStrategy Desktop views 191
MicroStrategy Mobile display 191
MicroStrategy Web modes 191
mobile device 195
not displaying in Flash Mode 422
SDK 196
selector and 180
types. See also widget types. 192
using as a selector 354
creating 367
updating targets by hovering 371
viewing data related to 354
widget display
defining 289
Design Mode/View 287
Editable Mode 287
export 289
Express Mode 288
Flash Mode/View 287
HTML View 287
Interactive Mode 288
MicroStrategy Mobile 289
PDF View 287
selecting display modes 290
widget types 192
Bubble Grid 198
Cylinder 200
Data Cloud 202
Funnel 226
Gauge 228
Graph Matrix 234
Graph Matrix (deprecated) 230
Heat Map 236
Image Layout 240
Interactive Bubble Graph 243
Interactive Stacked Graph 249
Map 251
Media 251
Microcharts 257
Network Visualization 267
RSS Reader 269
SDK
  Google Graph Visualization 196
  Map Visualization 196
  Store Layout 196
  Tablet 196
  Timeline 196
  USA Map 196
Thermometer 274
Time Series Slider 276
Waterfall 278
Weighted List Viewer 282